The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

Notwithstanding any other warranty herein, all document files and software of these suppliers are provided "as is" with all faults. Cisco and the above-named suppliers disclaim all warranties, expressed or implied, including, without limitation, those of merchantability, fitness for a particular purpose and noninfringement or arising from a course of dealing, usage, or trade practice.

In no event shall Cisco or its suppliers be liable for any indirect, special, consequential, or incidental damages, including, without limitation, lost profits or loss or damage to data arising out of the use or inability to use this manual, even if Cisco or its suppliers have been advised of the possibility of such damages.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

© 2012 Cisco Systems, Inc. All rights reserved.
CONTENTS

Preface xiii

Purpose xiii

Audience xiv

Organization xiv

Related documentation xvi

Conventions xvi

Support xviii

Cryptographic features xviii

PART I Cisco Unified Serviceability for Cisco Unified CM 1

CHAPTER 1 Cisco Unified Serviceability 3

Introduction 3

Overview 3

Reporting tools 4

Remote serviceability tools 5

Log-on message 6

Browser support 6

Installation 7

Access 7

Install server certificate 8

HTTPS 8

Install Internet Explorer 7 certificate 9

Serviceability interface 10

Accessibility features 12

CHAPTER 2 Cisco Unified CM Alarms 13
Alarms 13
  Alarm overview 13
  Alarm configuration 14
  Alarm definitions 15
  Alarm information 16
  Set up alarms 16
Alarm service setup 17
  Syslog agent enterprise parameters 17
  Set up alarm service 18
  Service groups 19
  Alarm configuration settings 20
Alarm definitions 24
  View alarm definitions 24
  System alarm catalog descriptions 25
  CallManager alarm catalog descriptions 26

CHAPTER 3  Cisco Unified CM Trace 29

  Trace 29
    Trace configuration 29
    Trace settings 30
    Trace collection 30
    Called Party tracing 31
    Set up trace configuration 31
  Configure trace 32
    Set up trace parameters 32
    Service groups in trace configuration 33
    Debug trace level settings 36
    Trace field descriptions 37
      Database layer monitor trace fields 38
      Cisco RIS data collector trace fields 39
      Cisco CallManager SDI trace fields 39
      Cisco CallManager SDL trace fields 41
      Cisco CTIManager SDL trace fields 43
      Cisco Extended Functions trace fields 44
      Cisco Extension Mobility trace fields 45
Cisco IP manager assistant trace fields 45
Cisco IP voice media streaming app trace fields 46
Cisco TFTP trace fields 47
Cisco Web Dialer web service trace fields 47
Trace output settings 47
Set up troubleshooting trace settings 48

CHAPTER 4
Cisco Unified CM Tools 51

Services 51
Feature services 51
Database and admin services 52
Performance and monitoring services 53
CM services 54
CTI services 57
CDR services 58
Security services 58
Directory services 59
Voice quality reporter services 59
Network services 59
Performance and monitoring services 60
Backup and restore services 61
System services 61
Platform services 62
Security services 64
DB services 65
SOAP services 65
CM services 66
CDR services 66
Admin services 67
Service activation 67
Control center 68
Set up services 68
Serviceability Reports Archive 68
Serviceability reporter service parameters 69
Device statistics report 70
Contents

Server statistics report  73
Service Statistics Report  75
Call activities report  78
Alert summary report  83
Performance protection report  85
Set up serviceability reports archive  86
Configuring services  87
  Activate feature services  87
  Cluster service activation recommendations  88
  Set up status of services  90
  Command line interface  91
Set up Serviceability Reports Archive  92
CDR Repository Manager  92
  Set up general parameters  94
  General parameter settings  95
  Set up application billing servers  97
  Application billing server parameter settings  97
  Delete application billing servers  98
Audit logs  99
  Audit logging  99
  Set up audit log  102
  Audit log configuration settings  102
Locations  105
  Locations Topology  105
    View locations topology  106
    View assertion details  106
  Locations discrepancy  107
    View locations discrepancy  107
  Effective path  107
    View effective path  108
  Disconnected groups  108
    View disconnected groups  109

CHAPTER 5
Cisco Unified CM SNMP  111
  Simple Network Management Protocol  111
Simple Network Management Protocol support 111
  SNMP basics 112
  SNMP configuration requirements 113
  SNMP version 1 support 114
  SNMP version 2c support 114
  SNMP version 3 support 114
  SNMP services 114
  SNMP community strings and users 115
  SNMP traps and informs 115
  SNMP Management Information Base (MIB) 118

SNMP trace configuration 126

Set up SNMP 126
SNMP V1 and V2c 127
  Find community string 127
  Set up community string 127
  Community string configuration settings 128
  Delete community string 129
  SNMP notification destination 130
  Find notification destination 130
  Set up notification destination 131
  Notification destination configuration settings 132
  Delete notification destination 132
SNMP V3 133
  Find SNMP user 133
  Set up SNMP user 134
  SNMP user configuration settings 135
  Delete SNMP user 136
  SNMP notification destination 137
  Find notification destination 137
  Set up notification destination 138
  Notification destination configuration settings 138
  Delete notification destination 139
SNMP system group 140
  Set up MIB2 system group 140
  MIB2 system group configuration settings 141
SNMP trap settings 141
  CISCO-SYSLOG-MIB trap parameters 141
  CISCO-CCM-MIB trap parameters 142
  CISCO-UNITY-MIB trap parameters 142

CHAPTER 6  Cisco Unified CM Call Home 143
  Call Home 143
    Smart Call Home 143
    Smart Call Home interaction 145
    Pre-requisites for Call Home 146
    Access Call Home 146
    Call Home settings 146
    Call Home configuration 147
    Limitations 149
    References for Call Home 149

PART II  Cisco Unified Serviceability for IM and Presence Service 151

CHAPTER 7  Introduction 153
  Cisco Unified Serviceability overview 153
  Cisco Unified Serviceability access 154
    Remote serviceability tools 154
    Access Cisco Unified IM and Presence Serviceability 154
    About the Cisco Unified IM and Presence Serviceability interface 155
    Cisco Unified IM and Presence Serviceability interface 155
    Accessibility features 156
    More information 157

CHAPTER 8  Alarm setup and definitions in Cisco Unified Serviceability 159
  Set up Cisco Unified IM and Presence Serviceability alarms 159
  Alarm setup and update for a service 160
    Alarm setup for a service 160
    Set up or update alarm for a service 160
  Alarm definitions and user-defined description additions 162
    Alarm definitions and user-defined descriptions 162
View alarm definitions and add user-defined descriptions 163

Alarm Catalog descriptions 164

System Alarm Catalog descriptions 164

IM and Presence Alarm Catalog descriptions 165

CHAPTER 9

Trace setup 167

Set up trace 167

Trace parameter configuration 168

Service groups in trace configuration 169

Set up trace parameters 172

Audit log configuration 175

System audit logs 175

Application audit logs 176

Database audit logs 178

Configure audit log settings 178

Audit log settings 178

Trace setting troubleshooting 182

Troubleshoot trace settings window 182

Troubleshoot trace settings 183

CHAPTER 10

Feature and network services 185

Feature services 185

Database and admin services 186

Performance and monitoring services 186

IM and Presence services 186

Network services 188

Performance and monitoring services 188

Backup and restore services 189

System services 189

Platform services 190

Database services 191

SOAP services 191

Admin services 192

IM and Presence services 192

Serviceability Reports Archive 194
Server statistic reports 194
  Percentage of CPU per server 194
  Percentage of memory usage per server 194
  Percentage of hard disk usage of largest partition per server 194

Alert Summary Reports 194
  Number of alerts per server 195
  Number of alerts per severity for cluster 195
  Top 10 alerts in cluster 195

Access to Serviceability Reports Archive 196
  Activate Serviceability Reports Archive 196
  Access Serviceability Reports Archive 196

CHAPTER 11

Services setup and viewing services 197

Set up services 197

Feature services activation and deactivation 197

Recommendations for activation of services in a cluster 198

Activate and deactivate feature services 201

Start, stop, and restart services in Control Center or CLI 201

Start, stop, restart, and refresh services status in Control Center 202

Start, stop, and restart services with Command Line Interface 202

CHAPTER 12

Simple Network Management Protocol 205

Simple Network Management Protocol support 205

SNMP basics 205

SNMP version 1 support 206

SNMP version 2c support 206

SNMP version 3 support 207

SNMP services 207

SNMP community strings and users 207

SNMP traps and informs 208

SNMP Management Information Base (MIB) 209

Set up SNMP 212

Troubleshooting SNMP 213

CHAPTER 13

SNMP V1/V2c setup 215
SNMP community strings 215
   Set up community string 215
   Find community string 217
   Delete community string 218

SNMP notification destinations 218
   Configure notification destination for SNMP V1/V2c 218
   Find notification destination for SNMP V1/V2c 220
   Delete notification destination for SNMP V1/V2c 221

CHAPTER 14

SNMP V3 setup 223
   SNMP users 223
      Set up SNMP V3 user 223
      Find SNMP user 225
      Delete SNMP user 226
   SNMP notification destinations 226
      Set up notification destination for SNMP V3 226
      Find notification destination for SNMP V3 228
      Delete notification destination for SNMP V3 229

CHAPTER 15

MIB2 system group 231
   Set up MIB2 system group 231

CHAPTER 16

Trace field descriptions 233
   Cisco Access Log trace fields 233
      Cisco Authentication trace fields 233
      Cisco Calendar trace fields 234
      Cisco CTI Gateway trace fields 234
      Cisco Database Layer Monitor trace fields 234
      Cisco Enum trace fields 234
      Cisco Method/Event trace fields 235
      Cisco Number Expansion trace fields 235
      Cisco Parser trace fields 235
      Cisco Privacy trace fields 235
      Cisco Proxy trace fields 236
      Cisco RIS Data Collector trace fields 236
Cisco Registry trace fields 237
Cisco Routing trace fields 237
Cisco Server trace fields 237
Cisco SIP Message and State Machine trace fields 237
Cisco SIP TCP trace fields 238
Cisco SIP TLS trace fields 238
Cisco Web Service trace fields 238
Trace output settings descriptions and defaults 238
Preface

• Purpose, page xiii
• Audience, page xiv
• Organization, page xiv
• Related documentation, page xvi
• Conventions, page xvi
• Support, page xviii
• Cryptographic features, page xviii

Purpose

The Cisco Unified Serviceability Administration Guide provides descriptions and procedures for configuring alarms, traces, SNMP, and so on, through Cisco Unified Serviceability for the following:

• Cisco Unified Communications Manager
• Cisco Unified Communications Manager Business Edition 5000
• IM and Presence service on Cisco Unified Communications Manager
• Cisco Unity Connection

Use this guide with the documentation for your configuration.

|-------------------------------------|----------------------------------------------------------------------------------------------------------------------------------|
These documents provide the following information:

- **Cisco Unified Communications Manager CDR Analysis and Reporting Administration Guide** - This document describes how to configure and use Cisco Unified Communications Manager CDR Analysis and Reporting (CAR), a tool that is used to create user, system, device, and billing reports.

- **Cisco Unified Communications Manager Call Detail Records Administration Guide** - This document includes Call Detail Record (CDR) definitions.

- **Cisco Unified Real-Time Monitoring Tool Administration Guide** - This document describes how to use RTMT, a tool that allows you to monitor many aspects of the system (critical services, alerts, performance counters, and so on).

- **Cisco Unity Connection Serviceability Administration Guide** - This document provides descriptions and procedures for using alarms, traces, clusters, reports, and so on, through Cisco Unity Connection Serviceability.

For Cisco Unity Connection, you must perform serviceability-related tasks in both Cisco Unified Serviceability and Cisco Unity Connection Serviceability; for example, you may need to start and stop services, view alarms, and configure traces in both applications to troubleshoot a problem. Cisco Unified Serviceability supports the functionality that is described in the **Cisco Unified Serviceability Administration Guide**; for tasks that are specific to Cisco Unity Connection Serviceability, refer to the **Cisco Unity Connection Serviceability Administration Guide**.

## Audience

The Cisco Unified Serviceability Administration Guide assists administrators that configure, troubleshoot, and support Cisco Unified Communications Manager, Cisco Unified Communications Manager Business Edition 5000, or Cisco Unity Connection. This guide requires knowledge of telephony and IP networking technology.

## Organization

The following table shows the organization for this guide:
<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part 1</td>
<td>“Cisco Unified Serviceability for Cisco Unified CM”</td>
</tr>
<tr>
<td></td>
<td>Provides information about Cisco Unified Serviceability for Unified CM and configuration procedures.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified Serviceability — Overview of Cisco Unified Serviceability, including browser support and information on how to access and use the GUI.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified CM Alarms — Overview of Cisco Unified Serviceability alarms and alarm definitions, procedures for configuring alarms in Cisco Unified Serviceability, and for searching and editing Cisco Unified Serviceability alarm definitions.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified CM Trace — Overview of trace parameter configuration in Cisco Unified Serviceability, and an overview of trace collection in the Cisco Unified Real-Time Monitoring Tool. Provides procedures for configuring trace parameters for Cisco Unified Serviceability network and feature services, and for configuring the troubleshooting trace settings for services in Cisco Unified Serviceability.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified CM Tools — Description of each network and feature service that displays in Cisco Unified Serviceability; provides procedures and recommendations for activating, deactivating, starting, and stopping Cisco Unified Serviceability feature and network services. Provides an overview on the reports that are generated by the Cisco Serviceability Reporter service; provides procedures for viewing reports that are generated by the Cisco Serviceability Reporter service.</td>
</tr>
<tr>
<td></td>
<td>• Unified CM and Unified CM BE only: Provides information on using the CDR Management Configuration window to set the amount of disk space to allocate call detail record (CDR) and call management record (CMR) files, configure the number of days to preserve files before deletion, and configure billing application server destinations for CDRs.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified CM SNMP — Overview of Cisco Unified Communications Manager support of SNMP versions 1, 2c, and 3, and configuration procedures.</td>
</tr>
<tr>
<td></td>
<td>• Cisco Unified CM Call Home — Overview of the Cisco Unified Communications Manager Call Home service and describes how to configure the Cisco Unified CM Call Home feature.</td>
</tr>
</tbody>
</table>
Part 2 “Cisco Unified IM and Presence serviceability”
Provides information about Cisco Unified Serviceability for IM and Presence, and configuration procedures.

- Introduction—Highlights the functionality provided by Cisco Unified Serviceability for IM and Presence, including how to access the interface and use the associated features.
- Alarm definitions and user-defined descriptions—Provides instructions on how to configure and update alarms as well as view alarm definitions and add user-defined descriptions. Descriptions for system alarms are also provided.
- Trace setup—Details trace parameter configuration and troubleshooting information.
- Feature and network services—Provides an overview of supported feature and network services along with detailed information about the reports that can be generated and how to access them.
- Services setup and viewing services—Provides configuration information about how to turn feature services on and off and how to start, stop, and restart those services.
- SNMP V1/V2c setup—Defines community strings and how you can add, modify, and delete strings via the SNMP String Configuration window. Information about configuring, finding, and deleting notification destinations for SNMP V1/V2c is also provided.
- SNMP V3 setup—Provides configuration information about SNMP users. Information about configuring, finding, and deleting notification destinations for SNMP V3 is also provided.
- MIB2 system group—Provides system contact and location object configuration information for the MIB2 system group.
- Trace field descriptions—Provides a list of services for which trace can be activated and associated field names and descriptions.

### Related documentation

### Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Commands and keywords are in <strong>boldface</strong>.</td>
</tr>
<tr>
<td>italic font</td>
<td>Arguments for which you supply values are in italics.</td>
</tr>
<tr>
<td>Convention</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>[]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>{ x</td>
<td>y</td>
</tr>
<tr>
<td>[ x</td>
<td>y</td>
</tr>
<tr>
<td>string</td>
<td>A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.</td>
</tr>
<tr>
<td>screen font</td>
<td>Terminal sessions and information the system displays are in screen font.</td>
</tr>
<tr>
<td>boldface screen font</td>
<td>Information you must enter is in boldface screen font.</td>
</tr>
<tr>
<td>italic screen font</td>
<td>Arguments for which you supply values are in italic screen font.</td>
</tr>
<tr>
<td>^</td>
<td>The symbol ^ represents the key labeled Control—for example, the key combination ^D in a screen display means hold down the Control key while you press the D key.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Nonprinting characters, such as passwords, are in angle brackets.</td>
</tr>
</tbody>
</table>

Notes use the following conventions:

### Note

Means reader take note. Notes contain helpful suggestions or references to material not covered in the publication.

Timesavers use the following conventions:

### Timesaver

Means the described action saves time. You can save time by performing the action described in the paragraph.

Tips use the following conventions:

### Tip

Means the information contains useful tips.

Cautions use the following conventions:

### Caution

Means reader be careful. In this situation, you might do something that could result in equipment damage or loss of data.

Warnings use the following conventions:
This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, you must be aware of the hazards involved with electrical circuitry and familiar with standard practices for preventing accidents.

Support

For information on obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and also recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Cryptographic features

This product contains cryptographic features and is subject to United States and local country laws governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors and users are responsible for compliance with U.S. and local country laws. By using this product you agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local laws, return this product immediately.

Further information regarding U.S. export regulations may be found at http://www.access.gpo.gov/bis/ear/ear_data.html.
Cisco Unified Serviceability for Cisco Unified CM

- Cisco Unified Serviceability, page 3
- Cisco Unified CM Alarms, page 13
- Cisco Unified CM Trace, page 29
- Cisco Unified CM Tools, page 51
- Cisco Unified CM SNMP, page 111
- Cisco Unified CM Call Home, page 143
Cisco Unified Serviceability

Introduction

This document uses the following abbreviations to identify administration differences for these Cisco products:

Unified CM refers to Cisco Unified Communications Manager
Unified CM BE 5000 refers to Cisco Unified Communications Manager Business Edition 5000
Connection refers to Cisco Unity Connection

Overview

Cisco Unified Serviceability, a web-based troubleshooting tool, provides the following functionality:

- Saves alarms and events for troubleshooting and provides alarm message definitions.
- Saves trace information to various log files for troubleshooting.
- Monitors real-time behavior of components through the Cisco Unified Real-Time Monitoring Tool (RTMT).
- Unified CM and Unified CM BE only: Generates Cisco Unified Communications Manager reports for Quality of Service, traffic, and billing information through Cisco Unified Communications Manager CDR Analysis and Reporting (CAR).
- Provides audit capability by logging any configuration changes to the system by a user or as a result of the user action. This functionality supports the Information Assurance feature of Cisco Unified Communications Manager and Cisco Unity Connection.
- Provides feature services that you can activate, deactivate, and view through the Service Activation window.
• Provides an interface for starting and stopping feature and network services.
• Generates and archives daily reports; for example, alert summary or server statistic reports.
• Allows Cisco Unified Communications Manager and Cisco Unity Connection to work as a managed device for SNMP remote management and troubleshooting.
• Monitors the disk usage of the log partition on a server.
• Monitors the number of threads and processes in the system; uses cache to enhance the performance.

Cisco RIS Data Collector provides Process and Thread statistic counters in the Cisco Unified Real-Time Monitoring Tool. To configure the maximum number of processes and threads that are allowed, so Cisco RIS Data Collector can provide these associated counters, access the Maximum Number of Threads and Process service parameter for the Cisco RIS Data Collector service in the administration interface for your configuration.

Unified CM and Unified CM BE: For information on configuring service parameters, refer to the Cisco Unified Communications Manager Administration Guide.

Connection: For information on configuring service parameters, refer to the System Administration Guide for Cisco Unity Connection.

Tip
Unified CM BE and Connection only: For Cisco Unity Connection, you must perform serviceability-related tasks in both Cisco Unified Serviceability and Cisco Unity Connection Serviceability; for example, you may need to start and stop services, view alarms, and configure traces in both applications to troubleshoot a problem.

Cisco Unified Serviceability supports the functionality that is described in the Cisco Unified Serviceability Administration Guide; for tasks that are specific to Cisco Unity Connection Serviceability, refer to the Cisco Unity Connection Serviceability Administration Guide.

Reporting tools
Cisco Unified Serviceability provides the following reporting tools:

• Cisco Unified Real-Time Monitoring Tool (RTMT) - Monitors real-time behavior of components through RTMT; creates daily reports that you can access through the Serviceability Reports Archive. For more information, refer to the Cisco Unified Real-Time Monitoring Tool Administration Guide.

• Serviceability Reports Archive - Archives reports that the Cisco Serviceability Reporter service generates.

• Unified CM and Unified CM BE only: Cisco Unified Communications Manager CDR Analysis and Reporting (CAR) - Generates Cisco Unified Communications Manager reports for Quality of Service, traffic, and billing information through Cisco Unified Communications Manager CDR Analysis and Reporting (CAR). For more information, refer to the CDR Analysis and Reporting Administration Guide.

• Unified CM and Unified CM BE only: Cisco Unified Communications Manager Dialed Number Analyzer - Allows you to test and diagnose a deployed Cisco Unified Communications Manager dial plan configuration, analyze the test results, and use the results to tune the dial plan. For more information on how to access and use Dialed Number Analyzer, refer to the Cisco Unified Communications Manager Dialed Number Analyzer Guide.
• Unified CM and Unified CM BE only: Cisco Unified Reporting Web Application - Allows you to inspect or troubleshoot data for a standalone server or a cluster. This application, which is separate from Cisco Unified Serviceability, combines data by category from all accessible Cisco Unified Communications Manager servers in a cluster into one output view. Some reports run health checks to identify conditions that could impact server or cluster operations. If you are an authorized user, you access Cisco Unified Reporting in the main navigation menu in Cisco Unified Communications Manager Administration or with the File > Cisco Unified Reporting link on the RTMT menu. Refer to the Cisco Unified Reporting Administration Guide for more information.

Note
On Cisco Unified Communications Manager Business Edition 5000 servers, the Cisco Unified Reporting application captures data for Cisco Unified Communications Manager only. Due to size constraints, the application does not capture data for Cisco Unity Connection. On these servers, you can use this tool to gather important information about your Cisco Unified Communications Manager installation.

Remote serviceability tools

The content in this section does not apply to Cisco Unity Connection.

To supplement the management and administration of the Cisco Unified Communications Manager system, you can use remote serviceability tools. Using these tools, you can gather system and debug information for diagnostic help or remote troubleshooting. The tools can process and report on a collection of local or remote Cisco Unified Communications Manager configuration information. With customer permission, technical support engineers log on to a Cisco Unified Communications Manager server and get a desktop or shell that allows them to perform any function that could be done from a local logon session.

Cisco Unified Communications Manager supports the following capabilities for remote serviceability:

• Simple Network Management Protocol (SNMP) - Provides remote management for managed devices such as Cisco Unified Communications Manager

• Show Command Line Interface - Displays Cisco Unified Communications Manager system data.

• CiscoWorks Lan Management Solution - Purchased separately from Cisco Unified Communications Manager, supports maintenance of Cisco networks and devices. The following features, which serve as examples only, show how you can use CiscoWorks Lan Management Solution to manage Cisco Unified Communications Manager operations:
  
  Path Analysis defines Cisco Unified Communications Manager system paths in the form of maps, trace logs, or discovery tables. Path Analysis, which traces connectivity between two specified points in your network, requires that you enable CDR logging in Cisco Unified Communications Manager Administration.

  Syslog Analysis tools monitor and manage a wide range of events and error messages concurrently on each Cisco Unified Communications Manager server and other Cisco devices at your site.

  Cisco Discovery Protocol (CDP) enables discovery of Cisco Unified Communications Manager servers and management of those servers by CiscoWorks Lan Management Solution. After you use the CDP cache MIB of the direct neighboring device to discover Cisco Unified Communications Manager, you can use CiscoWorks Lan Management Solution to query other Cisco Unified Communications Manager-supported MIBs for provisions or statistics information about topology services, user tracking,
path analysis, and other network management services. When you use CiscoWorks Lan Management Solution, you must keep the CDP driver enabled at all times to discover Cisco Unified Communications Manager.

**Log-on message**

You can upload a text file that contains a customized log-on message that appears on the initial Cisco Unified Serviceability window.

For more information and the procedure for uploading your customized log-on message, refer to the Cisco Unified Communications Operating System Administration Guide.

**Browser support**

Cisco supports these browsers with Cisco Unified Serviceability:

<table>
<thead>
<tr>
<th>You can access Cisco Unified Communications Manager with this browser...</th>
<th>...if you use one of these operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer 7</td>
<td>Microsoft Windows XP SP3</td>
</tr>
</tbody>
</table>
| Microsoft Internet Explorer 8 | • Microsoft Windows XP SP3  
• Microsoft Windows Vista SP2 |
| Mozilla Firefox 3.x | • Microsoft Windows XP SP 3  
• Microsoft Windows Vista SP  
• Apple Mac OS X |
| Safari 4.x | Apple Mac OS X |

To access Cisco Unified Serviceability, you must browse to the application from a machine that runs the supported browser.

**Note**

Cisco Unified Communications Manager CDR Analysis and Reporting, which is a Cisco Unified Serviceability tool, supports these same browsers. Cisco Unified Real-Time Monitoring Tool, a separate plug-in, supports a different set of browsers. Refer to the Cisco Unified Real-Time Monitoring Tool Administration Guide for more information.

Cisco Unified Serviceability uses HTTPS to establish secure connections.
Installation

Access

You can access the Serviceability application

- by entering https://<server name or IP address>:8443/ccmservice/ in a browser window and then entering a valid username and password.
- by choosing Cisco Unified Serviceability in the Navigation menu in the Cisco Unified Communications Manager Administration console.
- by choosing Application > Serviceability Webpage in the Real-Time Monitoring Tool (RTMT) menu and then entering a valid username and password
- by choosing Cisco Unified Serviceability in the Navigation menu in Cisco Unity Connection.

Tip
After you log in to Cisco Unified Serviceability, you can access all administrative applications that display in the Navigation menu, except for Cisco Unified OS Administration and Disaster Recovery System, without logging in again. The web pages that you can access within Cisco Unified Serviceability depend on your assigned roles and privileges. Cisco Unified OS Administration and Disaster Recovery System require a separate authentication procedure.

The system uses the Cisco Tomcat service to authenticate users before allowing access to the web application.

Tip
Unified CM and Unified CM BE only: Any user who has the “Standard CCM Admin Users” role assigned can access Cisco Unified Serviceability. For information on how to assign this role to a user, refer to the Cisco Unified Communications Manager Administration Guide.

Tip
Connection only: Any user who has the System Administrator role or Technician role assigned can access Cisco Unified Serviceability. For information on how to assign this role to a user, refer to the User Moves, Adds, and Changes Guide for Cisco Unity Connection.

If you get a security alert that the site is not trusted, this indicates that the server certificate has not yet downloaded.

To access Cisco Unified Serviceability, perform the following procedure:
Procedure

Step 1  In a supported browser, browse to the server where the Cisco Unified Serviceability service runs.

Tip  In the supported browser, enter https://<server name or IP address>:8443/ccmservice/, where server name or IP address equals the server where the Cisco Unified Serviceability service runs and 8443 equals the port number for HTTPS.

Tip  If you enter http://<server name or IP address>:8080 in the browser, the system redirects you to use HTTP. HTTP uses the port number, 8080.

Step 2  If the system prompts you about certificates, see topics related to installing the server certificate.

Step 3  Enter a valid username and password; click Login.

To clear the username and password, click Reset.

Related Topics

Install server certificate, on page 8

Install server certificate

Note  For additional information about using HTTPS with Cisco Unified Communications Manager, refer to Cisco Unified Communications Manager Security Guide.

Hypertext Transfer Protocol over Secure Sockets Layer (SSL), which secures communication between the browser client and the Tomcat web server, uses a certificate and a public key to encrypt the data that is transferred over the internet. HTTPS, which ensures the identity of the server, supports applications, such as Cisco Unified Serviceability. HTTPS also ensures that the user login password transports securely via the web.

Note  Due to the way IE 7 handles certificates, this browser displays an error status after you import the server certificate. This status persists if you reenter the URL or refresh or relaunch the browser and does not indicate an error. Refer to the Install Internet Explorer 7 certificate, on page 9 for more information.

HTTPS

On the first attempt to access Cisco Unified Serviceability, a Security Alert dialog box, which indicates that the server is not trusted because the server certificate does not exist in the trusted folder, displays. When the dialog box displays, perform one of the following tasks:

• By clicking Yes, you choose to trust the certificate for the current web session only. If you trust the certificate for the current session only, the Security Alert dialog box displays each time that you access the application: that is, until you install the certificate in the trusted folder.
• By clicking View Certificate > Install Certificate, you indicate that you intend to perform certificate installation tasks, so you always trust the certificate. If you install the certificate in the trusted folder, the Security Alert dialog box does not display each time that you access the web application.

• By clicking No, you cancel the action. No authentication occurs, and you cannot access the web application.

---

Note
The system issues the certificate by using the hostname. If you attempt to access a web application by using the IP address, the Security Alert dialog box displays, even though you installed the certificate.

---

**Install Internet Explorer 7 certificate**

Internet Explorer 7 adds security features that change the way that the browser handles Cisco certificates for website access. Because Cisco provides a self-signed certificate for the Cisco Unified Communications Manager or Cisco Unity Connection server, Internet Explorer 7 flags the Cisco Unified Communications Manager Administration or Cisco Unity Connection website as untrusted and provides a certificate error, even when the trust store contains the server certificate.

---

Note
Internet Explorer 7, which is a Windows Vista feature, also runs on Windows XP Service Pack 2 (SP2), Windows XP Professional x64 Edition, and Windows Server 2003 Service Pack 1 (SP1). Java Runtime Environment (JRE) must be present to provide Java-related browser support for IE.

---

Be sure to import the Cisco Unified Communications Manager or Cisco Unity Connection certificate to Internet Explorer 7 to secure access without having to reload the certificate every time that you restart the browser. If you continue to a website that has a certificate warning and the certificate is not in the trust store, Internet Explorer 7 remembers the certificate for the current session only.

After you download the server certificate, Internet Explorer 7 continues to display certificate errors for the website. You can ignore the security warnings when the Trusted Root Certificate Authority trust store for the browser contains the imported certificate.

The following procedure describes how to import the Cisco Unified Communications Manager or Cisco Unity Connection certificate to the root certificate trust store for Internet Explorer 7.

**Procedure**

---

**Step 1**
Browse to application on the Tomcat server by entering the hostname (server name) or IP address in the browser.
The browser displays a Certificate Error: Navigation Blocked message to indicate that this website is untrusted.

**Step 2**
To access the server, click **Continue to this website (not recommended)**
The administration window displays, and the browser displays the address bar and Certificate Error status in red.

**Step 3**
To import the server certificate, click the Certificate Error status box to display the status report. Click the View Certificates link in the report.

**Step 4**
Verify the certificate details.
The Certification Path tab displays “This CA Root certificate is not trusted because it is not in the Trusted Root Certification Authorities store.”

**Step 5**
Select the General tab in the Certificate window and click **Install Certificate**.
The Certificate Import Wizard launches.

**Step 6**
To start the Wizard, click **Next**.
The Certificate Store window displays.

**Step 7**
Verify that the Automatic option, which allows the wizard to select the certificate store for this certificate type, is selected and click **Next**.

**Step 8**
Verify the setting and click **Finish**.
A security warning displays for the import operation.

**Step 9**
To install the certificate, click **Yes**.
The Import Wizard displays “The import was successful.”

**Step 10**
Click **OK**. The next time that you click the View certificates link, the Certification Path tab in the Certificate window displays “This certificate is OK.”

**Step 11**
To verify that the trust store contains the imported certificate, click **Tools** > **Internet Options** in the Internet Explorer toolbar and select the Content tab. Click **Certificates** and select the Trusted Root Certifications Authorities tab. Scroll to find the imported certificate in the list. After importing the certificate, the browser continues to display the address bar and a Certificate Error status in red. The status persists even if you reenter the hostname or IP address or refresh or relaunch the browser.

---

**Serviceability interface**

In addition to performing troubleshooting and service-related tasks in Cisco Unified Serviceability, you can perform the following tasks:

- Unified CM and Unified CM BE only: To access Dialed Number Analyzer to test and diagnose a deployed Cisco Unified Communications Manager dial plan configuration, analyze the test results and use the results to tune the dial plan, activate the Cisco Dialed Number Analyzer service by choosing **Tools** > **Service Activation** and choosing **Tools** > **Dialed Number Analyzer**.

  The Cisco Dialed Number Analyzer Server service needs to be activated along with The Cisco Dialed Number Analyzer service by choosing **Tools** > **Service Activation** and choosing **Tools** > **Dialed Number Analyzer Server**. This service needs to be activated only on the node that is dedicated specifically for the Cisco Dialed Number Analyzer service.

  For more information on how to use the Dialed Number Analyzer, refer to the *Cisco Unified Communications Manager Dialed Number Analyzer Guide*.

- Unified CM and Unified CM BE only: To access Cisco Unified Communications Manager CDR Analysis and Reporting from **Tools** > **CDR Analysis and Reporting**, perform the required procedures, as described in the *CDR Analysis and Reporting Administration Guide*. 
You cannot access the Cisco Unified Communications Manager CDR Analysis and Reporting tool unless you are a member of the Cisco CAR Administrators user group. Refer to the “Configuring the CDR Analysis and Reporting Tool” chapter in the CDR Analysis and Reporting Administration Guide for information on how to become a member of the Cisco CAR Administrators user group.

• To display documentation for a single window, choose Help > This Page in Cisco Unified Serviceability.

• To display a list of documents that are available with this release (or to access the online help index), choose Help > Contents in Cisco Unified Serviceability.

• To verify the version of Cisco Unified Serviceability that runs on the server, choose Help > About or click the About link in the upper, right corner of the window.

• To go directly to the home page in Cisco Unified Serviceability from a configuration window, choose Cisco Unified Serviceability from the Navigation drop-down list box in the upper, right corner of the window.

In some scenarios, you cannot access the Cisco Unified Serviceability from Cisco Unified OS Administration. A “Loading, please wait” message displays indefinitely. If the redirect fails, log out from Cisco Unified OS Administration, select Cisco Unified Serviceability from the navigation menu, and log in to Cisco Unified Serviceability.

• To access other application GUIs, choose the appropriate application from the Navigation drop-down list box in the upper, right corner of the window; then, click Go.

• To log out of Cisco Unified Serviceability, click the Logout link in the upper, right corner of the Cisco Unified Serviceability window.

• In each Cisco Unified Serviceability configuration window, configuration icons display that correspond to the configuration buttons at the bottom of the window; for example, you can either click the Save icon or the Save button to complete the task.

Cisco Unified Serviceability does not support the buttons in your browser. Do not use the browser buttons, for example, the Back button, when you perform configuration tasks.

When a session has been idle for more than 30 minutes, the Cisco Unified Serviceability user interface allows you to make changes before indicating that the session has timed out and redirecting you to the login window. After you log in again, you may have to repeat those changes. This behavior occurs in the Alarm, Trace, Service Activation, Control Center, and SNMP windows. If you know that the session has been idle for more than 30 minutes, log out by using the Logout button before making any changes in the user interface.
Accessibility features

Cisco Unified Serviceability provides functionality for users that allows them to access buttons on the window without using a mouse. These navigation shortcuts assist visually impaired or blind attendants to use the application.

Use Table 3: Navigation Shortcuts for Cisco Unified Serviceability, on page 12 as a guide for navigating the interface by using keyboard shortcuts.

Table 3: Navigation Shortcuts for Cisco Unified Serviceability

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt</td>
<td>Moves focus to the browser menu bar.</td>
</tr>
<tr>
<td>Enter</td>
<td>Chooses the item with focus (menu option, button, and so on.)</td>
</tr>
<tr>
<td>Alt, arrow keys</td>
<td>Moves between browser menus.</td>
</tr>
<tr>
<td>Alt+underlined letter</td>
<td>Takes you to the menu; for example, Alt+A moves you to the Alarms menu.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Toggles control; for example, checks and unchecks a check box.</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves focus to the next item in the tab order or to next control group.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves focus to the previous item or group in the tab order.</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves among controls within a group.</td>
</tr>
<tr>
<td>Home</td>
<td>Moves to the top of the window if more than one screenful of information exists. Also, moves to the beginning of a line of user-entered text.</td>
</tr>
<tr>
<td>End</td>
<td>Moves to the end of a line of user-entered text. Moves to the bottom of the window if more than one screenful of information exists.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scrolls up one screen.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scrolls down one screen.</td>
</tr>
</tbody>
</table>
Cisco Unified CM Alarms

Alarms overview

Cisco Unified Serviceability alarms provide information on runtime status and the state of the system, so you can troubleshoot problems that are associated with your system; for example, to identify issues with the Disaster Recovery System. Alarm information, which includes an explanation and recommended action, also includes the application name, machine name, and so on, to help you perform troubleshooting. If you have clusters, this is even true for problems that are not on your local Cisco Unified Communications Manager or Cisco Unity Connection server.

You configure the alarm interface to send alarm information to multiple locations, and each location can have its own alarm event level (from debug to emergency). You can direct alarms to the Syslog Viewer (local syslog), Syslog file (remote syslog), an SDI trace log file, an SDL trace log file (for Cisco CallManager and CTIManager services only), or to all destinations.

When a service issues an alarm, the alarm interface sends the alarm information to the locations that you configure (and that are specified in the routing list in the alarm definition) (for example, SDI trace). The system can either forward the alarm information, as is the case with SNMP traps, or the system can write the alarm information to its final destination (such as a log file).

Note

Cisco Unified Communications Manager supports SNMP traps in Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 systems. Cisco Unity Connection SNMP does not support traps.
For the Remote Syslog Server, do not specify a Cisco Unified Communications Manager server, which cannot accept syslog messages from other servers.

You use the Trace and Log Central option in the Cisco Unified Real-Time Monitoring Tool (RTMT) to collect alarms that get sent to an SDI trace log file or SDL trace log file (for Cisco CallManager and CTIManager services only). You use the SysLog Viewer in RTMT to view alarm information that gets sent to the local syslog.

**Alarm configuration**

You can configure alarms for services, such as Cisco Database Layer Monitor, in Cisco Unified Serviceability. Then, you configure the location(s), such as Syslog Viewer (local syslog), where you want the system to send the alarm information. With this option, you can

- Configure alarms for services on a particular server or on all servers (Unified CM clusters only)
- Configure different remote syslog servers for the configured service(s) or server(s)
- Configure different alarm event level settings for different destinations

Cisco Syslog Agent enterprise parameters in Cisco Unified Communications Manager Administration allow you to forward all alarms that meet or exceed the configured threshold to a remote syslog server with these two settings: remote syslog server name and syslog severity. To access these Cisco Syslog Agent parameters, go to the applicable window for your configuration:

<table>
<thead>
<tr>
<th>Cisco Unified Communications Manager</th>
<th>In Cisco Unified Communications Manager Administration, choose System &gt; Enterprise Parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified Communications Manager Business Edition 5000</td>
<td>In Cisco Unified Communications Manager Administration, choose System &gt; Enterprise Parameters.</td>
</tr>
<tr>
<td>Cisco Unity Connection</td>
<td>In Cisco Unity Connection Administration, choose System Setting &gt; Enterprise Parameters.</td>
</tr>
</tbody>
</table>

The alarms include system (OS/hardware platform), application (services), and security alarms. If you have a Cisco Unified Communications Manager Business Edition 5000 server, the system also forwards Cisco Unity Connection alarms.

**Note**

If you configure both the Cisco Syslog Agent alarm enterprise parameters and application (service) alarms in Cisco Unified Serviceability, the system can send the same alarm to the remote syslog twice.

If local syslog is enabled for an application alarm, the system sends the alarm to the enterprise remote syslog server only when the alarm exceeds both the local syslog threshold and the enterprise threshold.

If remote syslog is also enabled in Cisco Unified Serviceability, the system forwards the alarm to the remote syslog server by using the application threshold that is configured in Cisco Unified Serviceability, which may result in the alarm getting sent to the remote syslog server twice.
The event level/severity settings provide a filtering mechanism for the alarms and messages that the system collects. This setting helps to prevent the Syslog and trace files from becoming overloaded. The system forwards only alarms and messages that exceed the configured threshold.

For more information about the severity levels attached to alarms and events, see the Alarm definitions, on page 15.

**Alarm definitions**

Used for reference, alarm definitions describe alarm messages: what they mean and how to recover from them. You search the Alarm Definitions window for alarm information. When you click any service-specific alarm definition, a description of the alarm information (including any user-defined text that you have added) and a recommended action display.

You can search for definitions of all alarms that display in Cisco Unified Serviceability. To aid you with troubleshooting problems, the definitions, which exist in a corresponding catalog, include the alarm name, description, explanation, recommended action, severity, parameters, monitors, and so on.

When the system generates an alarm, it uses the alarm definition name in the alarm information, so you can identify the alarm. In the alarm definition, you can view the routing list, which specifies the locations where the system can send the alarm information. The routing list may include the following locations, which correlate to the locations that you can configure in the Alarm Configuration window:

- Unified CM and Unified CM BE only: SDL - The system sends the alarm information to the SDL trace if you enable the alarm for this option and specify an appropriate event level in the Alarm Configuration window.

- SDI - The system sends the alarm information to the SDI trace if you enable the alarm for this option and specify an appropriate event level in the Alarm Configuration window.

- Sys Log - The system sends the alarm information to the remote syslog server if you enable the alarm for this option, specify an appropriate event level in the Alarm Configuration window, and enter a server name or IP address for the remote syslog server.

- Event Log - The system sends the alarm information to the local syslog, which you can view in the SysLog Viewer in the Cisco Unified Real-Time Monitoring Tool (RTMT), if you enable the alarm for this option and specify an appropriate event level in the Alarm Configuration window.

- Data Collector - System sends the alarm information to the real-time information system (RIS data collector) (for alert purposes only). You cannot configure this option in the Alarm Configuration window.

- Unified CM and Unified CM BE only: SNMP Traps - System generates an SNMP trap. You cannot configure this option in the Alarm Configuration window.

---

**Note**

Cisco Unified Communications Manager supports SNMP traps in Unified CM and Unified CM BE systems. Cisco Unity Connection SNMP does not support traps in either Unified CM BE or Connection systems.
If the SNMP Traps location displays in the routing list, the system forwards the alarm information to the CCM MIB SNMP agent, which generates the appropriate traps according to the definition in CISCO-CCM-MIB.

The system sends an alarm if the configured alarm event level for the specific location in the Alarm Configuration window is equal to or lower than the severity that is listed in the alarm definition. For example, if the severity in the alarm definition equals WARNING ALARM, and, in the Alarm Configuration window, you configure the alarm event level for the specific destination as Warning, Notice, Informational, or Debug, which are lower event levels, the system sends the alarm to the corresponding destination. If you configure the alarm event level as Emergency, Alert, Critical, or Error, the system does not send the alarm to the corresponding location.

For each Cisco Unified Serviceability alarm definition, you can include an additional explanation or recommendation. All administrators have access to the added information. You directly enter information into the User Defined Text pane that displays in the Alarm Details window. Standard horizontal and vertical scroll bars support scrolling. Cisco Unified Serviceability adds the information to the database.

### Alarm information

You view alarm information to determine whether problems exist. The method that you use to view the alarm information depends on the destination that you chose when you configured the alarm. You can view alarm information that is sent to the SDI trace log file, or SDL trace log file (Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 only) by using the Trace and Log Central option in RTMT or by using a text editor. You can view alarm information that gets sent to local syslog by using the SysLog Viewer in RTMT.

**Tip**

Unified CM and Unified CM BE only: For Cisco Unified Communications Manager, you can also use CiscoWorks Lan Management Solution report viewer to view remote syslog messages.

### Set up alarms

Perform the following steps to configure alarms.

**Procedure**

1. **Step 1**
   In Cisco Unified Communications Manager Administration or in Cisco Unity Connection Administration, configure the Cisco Syslog Agent enterprise parameters to send system, application (services), and security alarms/messages to a remote syslog server that you specify. Skip this step to configure application (services) alarms/messages in Cisco Unified Serviceability.

2. **Step 2**
   In Cisco Unified Serviceability, configure the server(s), service(s), destination(s), and event level(s) for the applications (services) alarm information that you want to collect.

3. **Step 3** (Optional)
   Add a definition to an alarm.
   - All services can go to the SDI log (but must be configured in Trace also).
   - All services can go to the SysLog Viewer.
• Unified CM and Unified CM BE only: Only the Cisco CallManager and Cisco CTIManager services use the SDL log.

• To send syslog messages to the Remote Syslog Server, check the Remote Syslog destination and specify a host name. If you do not configure the remote server name, Cisco Unified Serviceability does not send the Syslog messages to the remote syslog server.

  Tip  Do not configure a Cisco Unified Communications Manager server as a remote Syslog server.

**Step 4**  If you chose an SDI trace file or SDL trace file (Unified CM and Unified CM BE only) as the alarm destination, collect traces and view the information with the Trace and Log Central option in RTMT.

**Step 5**  If you chose local syslog as the alarm destination, view the alarm information in the SysLog Viewer in RTMT.

**Step 6**  See the corresponding alarm definition for the description and recommended action.

**Related Topics**

- [Syslog agent enterprise parameters, on page 17](#)
- [Alarm overview, on page 13](#)
- [Set up alarm service, on page 18](#)
- [Alarm configuration settings, on page 20](#)
- [Alarm definitions, on page 15](#)
- [View alarm definitions, on page 24](#)

**Alarm service setup**

**Syslog agent enterprise parameters**

You can configure the Cisco Syslog Agent enterprise parameters to send system, application, and security alarms/messages that exceed the configured threshold to a remote syslog server that you specify. To access the Cisco Syslog Agent parameters, go to the applicable window for your configuration:

<table>
<thead>
<tr>
<th>Cisco Unified Communications Manager</th>
<th>In Cisco Unified Communications Manager Administration, choose <strong>System &gt; Enterprise Parameters.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified Communications Manager Business Edition 5000</td>
<td>In Cisco Unified Communications Manager Administration, choose <strong>System &gt; Enterprise Parameters.</strong></td>
</tr>
<tr>
<td>Cisco Unity Connection</td>
<td>In Cisco Unity Connection Administration, choose <strong>System Setting &gt; Enterprise Parameters.</strong></td>
</tr>
</tbody>
</table>

Next, configure the remote syslog server names (Remote Syslog Server Name 1, Remote Syslog Server Name 2, Remote Syslog Server Name 3, Remote Syslog Server Name 4, and Remote Syslog Server Name 5) and syslog severity. Ensure that you specify valid IP addresses while configuring the server names. The syslog severity is applicable to all the remote syslog servers that you configure. Then click **Save.** For the valid values to enter, click the? button. If no server name is specified, Cisco Unified Serviceability does not send the Syslog messages.
While configuring remote syslog servers in Cisco Unified Communications Manager, do not add duplicate entries for remote syslog server names. If you add duplicate entries, the Cisco Syslog Agent will ignore the duplicate entries while sending messages to the remote syslog servers.

Do not configure a Cisco Unified Communications Manager as a remote syslog server. The Cisco Unified Communications Manager server does not accept Syslog messages from another server.

Set up alarm service

This section describes how to add or update an alarm for a feature or network service that you manage through Cisco Unified Serviceability.

Cisco recommends that you do not change SNMP Trap and Catalog configurations.

Cisco Unity Connection also uses alarms, which are available in Cisco Unity Connection Serviceability. You cannot configure alarms in Cisco Unity Connection Serviceability. For details, see the Cisco Unity Connection Serviceability Administration Guide.

Refer to your online OS documentation for more information on how to use your standard registry editor.

Procedure

Step 1  Choose Alarm > Configuration.
The Alarm Configuration window displays.

Step 2  From the Server drop-down list box, choose the server for which you want to configure the alarm; then, click Go.

Step 3  From the Service Group drop-down list box, choose the category of service, for example, Database and Admin Services, for which you want to configure the alarm; then, click Go.

Tip  For a list of services that correspond to the service groups, see Service groups, on page 19.

Step 4  From the Service drop-down list box, choose the service for which you want to configure the alarm; then, click Go.

Only services that support the service group and your configuration display.

Tip  The drop-down list box displays active and inactive services.

In the Alarm Configuration window, a list of alarm monitors with the event levels displays for the chosen service. In addition, the Apply to All Nodes check box displays.

Step 5  Unified CM only: If you want to do so, you can apply the alarm configuration for the service to all servers in the cluster by checking the Apply to All Nodes check box, provided your configuration supports clusters.

Step 6  Configure the settings, as described in Alarm configuration settings, on page 20, which includes descriptions for monitors and event levels.

Step 7  To save your configuration, click the Save button.
To set the default, click the Set Default button; then, click Save.

Services That Use Cisco Tomcat
The following services use Cisco Tomcat for alarm generation:

- Cisco Extension Mobility Application
- Cisco IP Manager Assistant
- Cisco Extension Mobility
- Cisco Web Dialer Web

The system login alarm AuthenticationFailed also uses Cisco Tomcat. To generate alarms for these services, perform the following procedure.

**Step 8**  In Cisco Unified Serviceability, choose **Alarm > Configuration**.

**Step 9**  From the Server drop-down list box, choose the server for which you want to configure the alarm; then, click Go.

**Step 10**  From the Services Group drop-down list box, choose **Platform Services**; then, click Go.

**Step 11**  From the Services drop-down list box, choose **Cisco Tomcat**; then, click Go.

**Step 12**  Unified CM only: If you want to do so, you can apply the alarm configuration for the service to all servers in the cluster by checking the **Apply to All Nodes** check box, if your configuration supports clusters.

**Step 13**  Configure the settings, as described in **Alarm configuration settings**, on page 20, which includes descriptions for monitors and event levels.

**Step 14**  To save your configuration, click the **Save** button.

---

**What to Do Next**

**Tip**  The system sends the alarm if the configured alarm event level for the specific destination in the Alarm Configuration window is equal to or lower than the severity that is listed in the alarm definition. For example, if the severity in the alarm definition equals WARNING_ALARM, and, in the Alarm Configuration window, you configure the alarm event level for the specific destination as Warning, Notice, Informational, or Debug, which are lower event levels, the system sends the alarm to the corresponding destination. If you configure the alarm event level as Emergency, Alert, Critical, or Error, which are higher severity levels, the system does not send the alarm to the corresponding location.

To access the alarm definitions for the Cisco Extension Mobility Application service, Cisco IP Manager Assistant service, Cisco Extension Mobility service, and the Cisco Web Dialer Web Service, choose the **Java Applications** catalog in the Alarm Messages Definitions window described in **Alarm definitions**, on page 15.

---

**Service groups**

The following table lists the services that correspond to the options in the Service Group drop-down list box in the Alarm Configuration window.

**Note**  Not all listed service groups and services apply to all system configurations.
### Table 4: Service Groups in Alarm Configuration

<table>
<thead>
<tr>
<th>Service Group</th>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM Services</td>
<td>Cisco CTIManager, Cisco CallManager, Cisco CallManager Cisco IP Phone Service, Cisco DHCP Monitor Service, Cisco Dialed Number Analyzer, Cisco Dialed Number Analyzer Server, Cisco Extended Functions, Cisco IP Voice Media Streaming App, Cisco Messaging Interface, and Cisco Tftp</td>
</tr>
<tr>
<td>CDR Services</td>
<td>Cisco CDR Agent and Cisco CDR Repository Manager</td>
</tr>
<tr>
<td>Database and Admin Services</td>
<td>Cisco Bulk Provisioning Service, Cisco Database Layer Monitor, and Cisco License Manager</td>
</tr>
<tr>
<td>Performance and Monitoring Services</td>
<td>Cisco AMC Service and Cisco RIS Data Collector</td>
</tr>
<tr>
<td>Directory Services</td>
<td>Cisco DirSyne</td>
</tr>
<tr>
<td>Backup and Restore Services</td>
<td>Cisco DRF Local and Cisco DRF Master</td>
</tr>
<tr>
<td>System Services</td>
<td>Cisco Trace Collection Service</td>
</tr>
<tr>
<td>Platform Services</td>
<td>Cisco Tomcat</td>
</tr>
</tbody>
</table>

### Alarm configuration settings

The following table describes all alarm configuration settings, even though the service may not support the settings.

#### Table 5: Alarm Configuration Settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>From the drop-down box, choose the server for which you want to configure the alarm; then, click Go.</td>
</tr>
<tr>
<td>Service Group</td>
<td>Cisco Unity Connection supports only the following service groups: Database and Admin Services, Performance and Monitoring Services, Backup and Restore Services, System Services, and Platform Services. From the drop-down box, choose the category of services, for example, Database and Admin Services, for which you want to configure the alarm; then, click Go.</td>
</tr>
</tbody>
</table>
From the Service drop-down box, choose the service for which you want to configure the alarm; then, click **Go**.

Only services that support the service group and your configuration display.

**Tip**    
The drop-down list box displays active and inactive services.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>From the Service drop-down box, choose the service for which you want to configure the alarm; then, click <strong>Go</strong>. Only services that support the service group and your configuration display.</td>
</tr>
<tr>
<td>Unified CM only: Apply to All Nodes</td>
<td>To apply the alarm settings for the service to all servers in a cluster, check the check box.</td>
</tr>
<tr>
<td>Enable Alarm for Local Syslogs</td>
<td>The SysLog viewer serves as the alarm destination. The program logs errors in the Application Logs within SysLog Viewer and provides a description of the alarm and a recommended action. You can access the SysLog Viewer from the Cisco Unified Real-Time Monitoring Tool. For information on viewing logs with the SysLog Viewer, refer to the <em>Cisco Unified Real-Time Monitoring Tool Administration Guide</em>.</td>
</tr>
</tbody>
</table>
The Syslog file serves as the alarm destination. Check this check box to enable the Syslog messages to be stored on a Syslog server and to specify the Syslog server name. If this destination is enabled and no server name is specified, Cisco Unified Serviceability does not send the Syslog messages.

The configured AMC primary and failover collectors use the remote syslog settings. The remote syslog settings used by the collectors are those configured on the respective individual nodes.

If the remote syslog is only configured on AMC primary collector without configuring remote syslog on AMC failover collector and failover occurs in AMC primary collector, then no remote syslogs will be generated.

You must configure exactly the same settings on all nodes, to send the remote syslog alarms to the same remote syslog server.

When failover occurs in AMC controller or when the collector configuration changes to a different node, the remote syslog settings on backup or newly configured node is used.

To prevent too many alarms flooding the system, you can check the **Exclude End Point Alarms** checkbox. This ensures that the endpoint phone-related events get logged into a separate file.

**Exclude End Point Alarms** checkbox is displayed only for the Call Manager services, and is not selected by default. You need to select the **Apply to All Nodes** also, while selecting this checkbox. The configuration options for endpoint alarms are given in [Alarm configuration settings](#), page 20.

**Tip** In the Server field, enter the name or IP address of the remote Syslog server that you want to use to accept Syslog messages. For example, if you want to send the alarms to CiscoWorks Lan Management Solution, specify the CiscoWorks Lan Management Solution server name.

Do not specify a Cisco Unified Communications Manager server as the destination because the Cisco Unified Communications Manager server does not accept syslog messages from another server.

### Remote Syslog Servers

In each of the Server Name 1, Server Name 2, Server Name 3, Server Name 4, and Server Name 5 fields, enter the name or IP address of the remote syslog server that you want to use to accept syslog messages. For example, if you want to send the alarms to Cisco Unified Operations Manager, specify the Cisco Unified Operations Manager as the server name.

**Tip** Do not specify a Cisco Unified Communications Manager server as the destination because the Cisco Unified Communications Manager server does not accept syslog messages from another server.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Alarm for Remote Syslogs</td>
<td>The Syslog file serves as the alarm destination. Check this check box to enable the Syslog messages to be stored on a Syslog server and to specify the Syslog server name. If this destination is enabled and no server name is specified, Cisco Unified Serviceability does not send the Syslog messages. The configured AMC primary and failover collectors use the remote syslog settings. The remote syslog settings used by the collectors are those configured on the respective individual nodes. If the remote syslog is only configured on AMC primary collector without configuring remote syslog on AMC failover collector and failover occurs in AMC primary collector, then no remote syslogs will be generated. You must configure exactly the same settings on all nodes, to send the remote syslog alarms to the same remote syslog server. When failover occurs in AMC controller or when the collector configuration changes to a different node, the remote syslog settings on backup or newly configured node is used. To prevent too many alarms flooding the system, you can check the <strong>Exclude End Point Alarms</strong> checkbox. This ensures that the endpoint phone-related events get logged into a separate file. <strong>Exclude End Point Alarms</strong> checkbox is displayed only for the Call Manager services, and is not selected by default. You need to select the <strong>Apply to All Nodes</strong> also, while selecting this checkbox. The configuration options for endpoint alarms are given in <a href="#">Alarm configuration settings</a>, page 20. <strong>Tip</strong> In the Server field, enter the name or IP address of the remote Syslog server that you want to use to accept Syslog messages. For example, if you want to send the alarms to CiscoWorks Lan Management Solution, specify the CiscoWorks Lan Management Solution server name. Do not specify a Cisco Unified Communications Manager server as the destination because the Cisco Unified Communications Manager server does not accept syslog messages from another server.</td>
</tr>
<tr>
<td>Remote Syslog Servers</td>
<td>In each of the Server Name 1, Server Name 2, Server Name 3, Server Name 4, and Server Name 5 fields, enter the name or IP address of the remote syslog server that you want to use to accept syslog messages. For example, if you want to send the alarms to Cisco Unified Operations Manager, specify the Cisco Unified Operations Manager as the server name. <strong>Tip</strong> Do not specify a Cisco Unified Communications Manager server as the destination because the Cisco Unified Communications Manager server does not accept syslog messages from another server.</td>
</tr>
</tbody>
</table>
The SDI trace library serves as the alarm destination. To log alarms in the SDI trace log file, check this check box and check the Trace On check box in the Trace Configuration window for the chosen service. For information on configuring settings in the Trace Configuration window in Cisco Unified Serviceability, see the Set up trace parameters, on page 32.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Alarm for SDI Trace</td>
<td>The SDI trace library serves as the alarm destination. To log alarms in the SDI trace log file, check this check box and check the Trace On check box in the Trace Configuration window for the chosen service. For information on configuring settings in the Trace Configuration window in Cisco Unified Serviceability, see the Set up trace parameters, on page 32.</td>
</tr>
<tr>
<td>Unified CM and Unified CM BE only: Enable Alarm for SDL Trace</td>
<td>The SDL trace library serves as the alarm destination. This destination applies only to the Cisco CallManager service and the CTIManager service. Configure this alarm destination by using Trace SDL configuration. To log alarms in the SDL trace log file, check this check box and check the Trace On check box in the Trace Configuration window for the chosen service. For information on configuring settings in the Trace Configuration window in Cisco Unified Serviceability, see the Set up trace parameters, on page 32.</td>
</tr>
</tbody>
</table>

### Alarm Event Level

From the drop-down list box, choose one of the following options:

- **Emergency**
  - This level designates system as unusable.

- **Alert**
  - This level indicates that immediate action is needed.

- **Critical**
  - The system detects a critical condition.

- **Error**
  - This level signifies an error condition exists.

- **Warning**
  - This level indicates that a warning condition is detected.

- **Notice**
  - This level designates a normal but significant condition.

- **Informational**
  - This level designates information messages only.

- **Debug**
  - This level designates detailed event information that Cisco TAC engineers use for debugging.

The following table describes the default alarm configuration settings.
Alarm definitions

This section provides procedural information to search, view, and create user information for alarm definitions that display in Cisco Unified Serviceability.

View alarm definitions

This section describes how to search for and view an alarm definition in Cisco Unified Serviceability.

Tip

Unified CM BE and Connection only: You can view Cisco Unity Connection alarm definitions in Cisco Unity Connection Serviceability. You cannot add user-defined descriptions to alarm definitions in Cisco Unity Connection Serviceability.

Cisco Unity Connection also uses certain alarm definitions in Cisco Unified Serviceability, and they must be viewed in Cisco Unified Serviceability. Be aware that alarms that are associated with the catalogs in Table 6: System Catalogs, on page 25 are available for viewing.

Procedure

Step 1
In Cisco Unified Serviceability, choose Alarm > Definitions. The Alarm Message Definitions window displays.

Step 2
From the Find alarms where drop-down list box, choose the catalog for which you want to view the definitions.

Step 3
From the Equals drop-down list box, choose a catalog of alarm definitions or enter the alarm name in the Enter Alarm Name field. For a list of System Alarm Catalog options, see Table 6: System Catalogs, on page 25. For a list of CallManager Alarm Catalog options (Unified CM and Unified CM BE only), see Table 7: CallManager Alarm Catalog, on page 26.

Step 4
Click the Find button. The definitions list displays for the alarm catalog that you chose.

Tip
Multiple pages of alarm definitions may exist. To choose another page, click the appropriate navigation button at the bottom of the Alarm Message Definitions window or enter a page number in the Page field. To change the number of alarms that display in the window, choose a different value from the Rows per Page drop-down list box.
Step 5  In the list, click the hyperlink alarm definition for which you want to view alarm details, such as a description, alarm severity, and so on. The Alarm Information window displays.

Step 6  If you want to add information to the alarm, enter text in the User Defined Text pane and click the Save button. Tip To delete the description from the User Defined Text pane, click the Clear All button.

Step 7  To return to the Alarm Message Definitions window, choose Back to Find/List Alarms from the Related Links drop-down list box; then, click Go.

System alarm catalog descriptions

Table 6: System Catalogs, on page 25 contains the System Alarm Catalog alarm descriptions. The System Alarm Catalog supports Cisco Unified Communications Manager and Cisco Unity Connection.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClusterManagerAlarmCatalog</td>
<td>All cluster manager alarm definitions that are related to the establishment of security associations between servers in a cluster.</td>
</tr>
<tr>
<td>DBAlarmCatalog</td>
<td>All Cisco database (aupair) alarm definitions</td>
</tr>
<tr>
<td>DRFAAlarmCatalog</td>
<td>All Disaster Recovery System alarm definitions</td>
</tr>
<tr>
<td>GenericAlarmCatalog</td>
<td>All generic alarm definitions that all applications share</td>
</tr>
<tr>
<td>JavaApplications</td>
<td>All Java Applications alarm definitions</td>
</tr>
<tr>
<td>EMAAlarmCatalog</td>
<td>Alarms for Extension Mobility</td>
</tr>
<tr>
<td>LoginAlarmCatalog</td>
<td>All login-related alarm definitions</td>
</tr>
<tr>
<td>LpmTctCatalog</td>
<td>All log partition monitoring and trace collection alarm definitions</td>
</tr>
<tr>
<td>RTMTAlarmCatalog</td>
<td>All Cisco Unified Real-Time Monitoring Tool alarm definitions</td>
</tr>
</tbody>
</table>

Tip Unified CM and Unified CM BE only: Cisco License Manager, which supports Cisco Unified Communications Manager, uses this catalog. You cannot configure JavaApplications alarms by using the alarm configuration GUI. For Cisco Unified Communications Manager and Cisco Unity Connection, you generally configure these alarms to go to the Event Logs; for Cisco Unified Communications Manager, you can configure these alarms to generate SNMP traps to integrate with CiscoWorks LAN Management Solution. Use the registry editor that is provided with your operating system to view or change alarm definitions and parameters.
### Alarm definitions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SystemAccessCatalog</td>
<td>All alarm definitions that are used for tracking whether SystemAccess provides all thread statistic counters together with all the process statistic counters.</td>
</tr>
<tr>
<td>ServiceManagerAlarmCatalogs</td>
<td>All service manager alarm definitions that are related to the activation, deactivation, starting, restarting, and stopping of services.</td>
</tr>
<tr>
<td>TFTPAlarmCatalog</td>
<td>All Cisco TFTP alarm definitions</td>
</tr>
<tr>
<td>TVSAAlarmCatalog</td>
<td>Alarms for Trust Verification Service</td>
</tr>
<tr>
<td>TestAlarmCatalog</td>
<td>All alarm definitions that are used for sending test alarms through SNMP traps from the Command Line Interface (CLI). For information on the CLI, refer to the Command Line Interface Reference Guide for Cisco Unified Solutions.</td>
</tr>
<tr>
<td>Tip</td>
<td>Cisco Unified Communications Manager supports SNMP traps in Unified CM and Unified CM BE systems. Cisco Unity Connection SNMP does not support traps in either Unified CM BE or Connection systems.</td>
</tr>
<tr>
<td>CertMonitorAlarmCatalog</td>
<td>All certificate expiration definitions.</td>
</tr>
<tr>
<td>CTLproviderAlarmCatalog</td>
<td>Alarms for Certificate Trust List (CTL) Provider service</td>
</tr>
<tr>
<td>CDPAlarmCatalog</td>
<td>Alarms for Cisco Discovery Protocol (CDP) service</td>
</tr>
<tr>
<td>IMSAlarmCatalog</td>
<td>All user authentication and credential definitions.</td>
</tr>
</tbody>
</table>

**CallManager alarm catalog descriptions**

The information in this section does not apply to Cisco Unity Connection.

*Table 7: CallManager Alarm Catalog, on page 26 contains the CallManager Alarm Catalog descriptions.*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallManager</td>
<td>All Cisco CallManager service alarm definitions</td>
</tr>
<tr>
<td>CDRRepAlarmCatalog</td>
<td>All CDRRep alarm definitions</td>
</tr>
<tr>
<td>CARAlarmCatalog</td>
<td>All CDR analysis and reporting alarm definitions</td>
</tr>
<tr>
<td>CEFAlarmCatalog</td>
<td>All Cisco Extended Functions alarm definitions</td>
</tr>
<tr>
<td>CMIAlarmCatalog</td>
<td>All Cisco messaging interface alarm definitions</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CtiManagerAlarmCatalog</td>
<td>All Cisco computer telephony integration (CTI) manager alarm definitions</td>
</tr>
<tr>
<td>IpVmsAlarmCatalog</td>
<td>All IP voice media streaming applications alarm definitions</td>
</tr>
<tr>
<td>TCDSRVAAlarmCatalog</td>
<td>All Cisco telephony call dispatcher service alarm definitions</td>
</tr>
<tr>
<td>Phone</td>
<td>Alarms for phone-related tasks, such as downloads</td>
</tr>
<tr>
<td>CAPFAAlarmCatalog</td>
<td>Alarms for Certificate Authority Proxy Function (CAPF) service</td>
</tr>
</tbody>
</table>
Cisco Unified CM Trace

- Trace, page 29
- Configure trace, page 32
- Set up troubleshooting trace settings, page 48

Trace

Cisco Unified Serviceability provides trace tools to assist you in troubleshooting issues with your voice application. Cisco Unified Serviceability supports SDI (System Diagnostic Interface) trace, SDL (Signaling Distribution Layer) trace (for Cisco CallManager and Cisco CTIManager services, applicable to Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 only), and Log4J trace (for Java applications).

You use the Trace Configuration window to specify the level of information that you want traced as well the type of information that you want to be included in each trace file.

Unified CM and Unified CM BE only: If the service is a call-processing application such as Cisco CallManager or Cisco CTIManager, you can configure a trace on devices such as phones and gateway.

(Unified CM and Unified CM BE only: In the Alarm Configuration window, you can direct alarms to various locations, including SDI trace log files, or SDL trace log files. If you want to do so, you can configure trace for alerts in the Cisco Unified Real-Time Monitoring Tool (RTMT).

After you have configured information that you want to include in the trace files for the various services, you can collect and view trace files by using the trace and log central option in the Cisco Unified Real-Time Monitoring Tool.

Trace configuration

You can configure trace parameters for any feature or network service that displays in Cisco Unified Serviceability. If you have clusters (Cisco Unified Communications Manager only), you can configure trace parameters for any feature or network service that is available on any Cisco Unified Communications Manager server in the cluster. Use the Trace Configuration window to specify the parameters that you want to trace for troubleshooting problems.

You can configure the level of information that you want traced (debug level), what information you want to trace (trace fields), and information about the trace files (such as number of files per service, size of file, and
time that the data is stored in the trace files.) If you have clusters (Cisco Unified Communications Manager only), you can configure trace for a single service or apply the trace settings for that service to all servers in the cluster.

If you want to use predetermined troubleshooting trace settings rather than choosing your own trace fields, you can use the Troubleshooting Trace window. For more information on troubleshooting trace, see the Trace settings, on page 30.

After you have configured information that you want to include in the trace files for the various services, you can collect trace files by using the trace and log central option in RTMT. For more information regarding trace collection, see the Trace collection, on page 30.

### Trace settings

The Troubleshooting Trace Settings window allows you to choose the services in Cisco Unified Serviceability for which you want to set predetermined troubleshooting trace settings. In this window, you can choose a single service or multiple services and change the trace settings for those services to the predetermined trace settings. If you have clusters (Cisco Unified Communications Manager only), you can choose the services on different Cisco Unified Communications Manager servers in the cluster, so the trace settings of the chosen services get changed to the predetermined trace settings. You can choose specific activated services for a single server, all activated services for the server, specific activated services for all servers in the cluster, or all activated services for all servers in the cluster. In the window, N/A displays next to inactive services.

Note

The predetermined troubleshooting trace settings for a Cisco Unified Communications Manager feature or network service include SDL (Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 only), SDI, and Log4j trace settings. Before the troubleshooting trace settings get applied, the system backs up the original trace settings. When you reset the troubleshooting trace settings, the original trace settings get restored.

When you open the Troubleshooting Trace Settings window after you apply troubleshooting trace settings to a service, the service that you set for troubleshooting displays as checked. In the Troubleshooting Trace Settings window, you can reset the trace settings to the original settings.

After you apply Troubleshooting Trace Setting to a service, the Trace Configuration window displays a message that troubleshooting trace is set for the given service(s). From the Related Links drop-down list box, you can choose the Troubleshooting Trace Settings option if you want to reset the settings for the service. For the given service, the Trace Configuration window displays all the settings as read-only, except for some parameters of trace output settings; for example, Maximum No. of Files. You can modify these parameters even after you apply troubleshooting trace settings.

### Trace collection

Use Trace and Log Central, an option in the Cisco Unified Real-Time Monitoring Tool, to collect, view, and zip various service traces and/or other log files. With the Trace and Log Central option, you can collect SDL/SDI traces, Application Logs, System Logs (such as Event View Application, Security, and System logs), and crash dump files.
Tip
Do not use NotePad to view collected trace files to view collected trace files, because NotePad does not properly display line breaks.

Note
Unified CM and Unified CM BE only: For devices that support encryption, the SRTP keying material does not display in the trace file.

For more information on trace collection, refer to the Cisco Unified Real-Time Monitoring Tool Administration Guide.

Called Party tracing

Called Party Tracing allows you to configure a directory number or list of directory numbers that you want to trace. You can request on-demand tracing of calls using the Session Trace Tool.

For more information, see the Cisco Unified Real-Time Monitoring Tool Administration Guide.

Set up trace configuration

The following steps provide an overview of the steps for configuring and collecting trace for feature and network services in Cisco Unified Serviceability.

Procedure

Step 1 Configure the values of the TLC Throttling CPU Goal and TLC Throttling IOWait Goal service parameters (Cisco RIS Data Collector service) by doing the applicable step:

a) Unified CM and Unified CM BE only: Choose System > Service Parameters in Cisco Unified Communications Manager Administration and configure the values of the TLC Throttling CPU Goal and TLC Throttling IOWait Goal service parameters (Cisco RIS Data Collector service).
b) Connection only: Choose System Settings > Service Parameters in Cisco Unity Connection Administration and configure the values of the TLC Throttling CPU Goal and TLC Throttling IOWait Goal service parameters (Cisco RIS Data Collector service).

Step 2 Configure the trace setting for the service for which you want to collect traces. If you have clusters (Cisco Unified Communications Manager only), you can configure trace for the service on one server or on all servers in the cluster.

To configure trace settings, choose what information you want to include in the trace log by choosing the debug level and trace fields.

If you want to run predetermined traces on services, set troubleshooting trace for those services.

Step 3 Install the Cisco Unified Real-Time Monitoring Tool on a local PC.

Step 4 If you want to generate an alarm when the specified search string exists in a monitored trace file, enable the LogFileSearchStringFound alert in RTMT.

You can find the LogFileSearchStringFound alarm in the LpmTctCatalog. (In Cisco Unified Serviceability, choose Alarms > Definitions. In the Find alarms where drop-down list box, choose the System Alarm Catalog; in the Equals drop-down list box, choose LpmTctCatalog.)
Step 5 If you want to automatically capture traces for alerts such as CriticalServiceDown and CodeYellow, check the Enable Trace Download check box in the Set Alert/Properties dialog box for the specific alert in RTMT; configure how often that you want the download to occur.

Step 6 Collect the traces.

Step 7 View the log file in the appropriate viewer.

Step 8 If you enabled troubleshooting trace, reset the trace settings services, so the original settings get restored.

Note Leaving Troubleshooting trace enabled for a long time increases the size of the trace files and may impact the performance of the services.

Related Topics
Set up troubleshooting trace settings, on page 48

Configure trace

This section provides information for configuring trace settings.

Note Enabling trace decreases system performance; therefore, enable trace only for troubleshooting purposes. For assistance in using trace, contact your technical support team.

Set up trace parameters

This section describes how to configure trace parameters for feature and network services that you manage through Cisco Unified Serviceability.

Tip Unified CM BE and Connection only: For Cisco Unity Connection, you may need to run trace in Cisco Unified Serviceability and Cisco Unity Connection Serviceability to troubleshoot Cisco Unity Connection issues. To troubleshoot services that are supported in Cisco Unified Serviceability, you run trace in Cisco Unified Serviceability. Similarly, to troubleshoot Cisco Unity Connection components, you run trace in Cisco Unity Connection Serviceability. For information on how to run trace in Cisco Unity Connection Serviceability, refer to the Cisco Unity Connection Serviceability Administration Guide.

Procedure

Step 1 Choose Trace > Configuration. The Trace Configuration window displays.

Step 2 From the Server drop-down list box, choose the server that is running the service for which you want to configure trace; then, click Go.

Step 3 From the Service Group drop-down list box, choose the service group for the service that you want to configure trace; then, click Go.

Tip Table 8: Service Groups in Trace Configuration, on page 33 lists the services and trace libraries that correspond to the options that display in the Service Group drop-down list box.
Configure trace

Step 4 From the Service drop-down list box, choose the service for which you want to configure trace; then, click Go.

The drop-down list box displays active and inactive services.

Tip Unified CM and Unified CM BE only: For the Cisco CallManager and CTIManager services, you can configure SDL trace parameters. To do so, open the Trace Configuration window for one of those services, and click the Go button that is next to the Related Links drop-down list box.

If you configured Troubleshooting Trace for the service, a message displays at the top of the window that indicates that the Troubleshooting Traces feature is set, which means that the system disables all fields in the Trace Configuration window except for Trace Output Settings. To configure the Trace Output Settings, go to step 11. To reset Troubleshooting Trace, see the Set up troubleshooting trace settings, on page 48.

The trace parameters display for the service that you chose. In addition, the Apply to All Nodes check box displays (Cisco Unified Communications Manager only).

Step 5 Unified CM only: If you want to do so, you can apply the trace settings for the service or trace library to all servers in the cluster by checking the Apply to All Nodes check box; that is, if your configuration supports clusters.

Step 6 Check the Trace On check box.

Step 7 Unified CM and Unified CM BE only: If you are configuring SDL trace parameters, go to step 10.

Step 8 From the Debug Trace Level drop-down list box, choose the level of information that you want traced, as described in Debug trace level settings, on page 36.

Step 9 Check the Trace Fields check box for the service that you chose; for example, Cisco Log Partition Monitoring Tool Trace Fields.

Step 10 If the service does not have multiple trace settings where you can specify the traces that you want to activate, check the Enable All Trace check box. If the service that you chose has multiple trace settings, check the check boxes next to the trace check boxes that you want to enable, as described in Trace field descriptions, on page 37.

Step 11 To limit the number and size of the trace files, specify the trace output setting. See Table 24: Trace Output Settings, on page 48 for descriptions.

Step 12 To save your trace parameters configuration, click the Save button.

The changes to trace configuration take effect immediately for all services except Cisco Messaging Interface (Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 only). The trace configuration changes for Cisco Messaging Interface take effect in 3 to 5 minutes.

Note To set the default, click the Set Default button.

Service groups in trace configuration

The following table lists the services and trace libraries that correspond to the options in the Service Group drop-down list box in the Trace Configuration window.
Table 8: Service Groups in Trace Configuration

<table>
<thead>
<tr>
<th>Service Group</th>
<th>Services and Trace Libraries</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM and Unified CM BE only:</td>
<td>Cisco CTIManager, Cisco CallManager, Cisco CallManager Cisco IP Phone Service, Cisco DHCP Monitor Service, Cisco Dialed Number Analyzer, Cisco Dialed Number Analyzer Server, Cisco Extended Functions, Cisco Extension Mobility, Cisco Extension Mobility Application, Cisco IP Voice Media Streaming App, Cisco Messaging Interface, Cisco TFTP, and Cisco Unified Mobile Voice Access Service</td>
<td>For most services in the CM Services group, you run trace for specific components, instead of enabling all trace for the service. The Trace field descriptions, on page 37 lists the services for which you can run trace for specific components.</td>
</tr>
<tr>
<td>CM Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CM and Unified CM BE only:</td>
<td>Cisco IP Manager Assistant, and Cisco Web Dialer Web Service</td>
<td>For these services, you can run trace for specific components, instead of enabling all trace for the service; see the Trace field descriptions, on page 37.</td>
</tr>
<tr>
<td>CTI Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CM and Unified CM BE only:</td>
<td>Cisco CAR Scheduler, Cisco CAR Web Service, Cisco CDR Agent, and Cisco CDR Repository Manager</td>
<td>You enable all trace for each service, instead of running trace for specific components.</td>
</tr>
<tr>
<td>CDR Services</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In CAR, when reports are run that call stored procedures, CAR checks the configured debug trace level for the Cisco CAR Scheduler service and the Cisco CAR Web Service in the Trace Configuration window before stored procedure logging begins. For pregenerated reports, CAR checks the level for the Cisco CAR Scheduler service; for on-demand reports, CAR checks the level for the Cisco CAR Web Service. If you choose Debug from the Debug Trace Level drop-down list box, stored procedure logging gets enabled and continues until you choose another option from the drop-down list box. The following CAR reports use stored procedure logging: Gateway Utilization report, Route and Line Group Utilization report, Route/Hunt List Utilization report, Route Pattern/Hunt Pilot Utilization report, Conference Call Details report, Conference Call Summary report, Conference Bridge Utilization report, Voice Messaging Utilization report, and the CDR Search report.
<table>
<thead>
<tr>
<th>Service Group</th>
<th>Services and Trace Libraries</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database and Admin Services</td>
<td>Cisco AXL Web Service, Cisco CCM DBL Web Library, Cisco CCMAdmin Web Service, Cisco CCMUser Web Service, Cisco Database Layer Monitor, and Cisco UXL Web Service Unified CM and Unified CM BE only: Cisco Bulk Provisioning Service, Cisco GRT Communications Web Service, Cisco Role-based Security, Cisco TAPS Service, and Cisco Unified Reporting Web Service Unified CM BE only: Cisco License Manager</td>
<td>Choosing the Cisco CCM DBL Web Library option activates the trace for database access for Java applications. For database access for C++ applications, activate trace for Cisco Database Layer Monitor, as described in the Cisco Extended Functions trace fields, on page 44. Choosing the Cisco Role-based Security option, which supports Cisco Unified Communications Manager, activates trace for user-role authorization. For most services in the Database and Admin Services group, you enable all trace for the service/library, instead of enabling trace for specific components. For Cisco Database Layer Monitor, you can run trace for specific components.</td>
</tr>
<tr>
<td>Unified CM and Unified CM BE only:</td>
<td>Cisco CTL Provider, Cisco Certificate Authority Proxy Function, and Cisco Trust Verification Service.</td>
<td>You enable all trace for each service, instead of running trace for specific components.</td>
</tr>
<tr>
<td>Security Services</td>
<td>Unified CM and Unified CM BE only: Cisco DirSync</td>
<td>You enable all trace for this service, instead of running trace for specific components.</td>
</tr>
<tr>
<td>Unified CM and Unified CM BE only:</td>
<td>Backup and Restore Services</td>
<td>You enable all trace for each service, instead of running trace for specific components.</td>
</tr>
</tbody>
</table>
Service Group | Services and Trace Libraries | Notes
--- | --- | ---
Choosing the Cisco Common User Interface option activates trace for the common code that multiple applications use; for example, Cisco Unified Operating System Administration and Cisco Unified Serviceability.
Choosing the Cisco CCMService Web Service option activates trace for the Cisco Unified Serviceability web application (GUI).
You enable all trace for each option/service, instead of running trace for specific components.

SOAP Services | Cisco SOAP Web Service and Cisco SOAPMessage Service | Choosing the Cisco SOAP Web Service option activates the trace for the AXL Serviceability API.
You enable all trace for this service, instead of running trace for specific components.

Platform Services | Cisco Unified OS Admin Web Service | The Cisco Unified OS Admin Web Service supports Cisco Unified Operating System Administration, which is the web application that provides management of platform-related functionality such as certificate management, version settings, and installations and upgrades.
You enable all trace for this service, instead of running trace for specific components.

### Debug trace level settings

*Table 9: Debug Trace Levels for Services,* on page 36 describes the debug trace level settings for services.

#### Table 9: Debug Trace Levels for Services

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>Traces alarm conditions and events. Used for all traces that are generated in abnormal path. Uses minimum number of CPU cycles.</td>
</tr>
</tbody>
</table>
### Table 10: Debug Trace Levels for Servlets

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fatal</td>
<td>Traces very severe error events that may cause the application to abort.</td>
</tr>
<tr>
<td>Error</td>
<td>Traces alarm conditions and events. Used for all traces that are generated in abnormal path.</td>
</tr>
<tr>
<td>Warn</td>
<td>Traces potentially harmful situations.</td>
</tr>
<tr>
<td>Info</td>
<td>Traces the majority of servlet problems and has a minimal effect on system performance.</td>
</tr>
<tr>
<td>Debug</td>
<td>Traces all State Transition conditions plus media layer events that occur during normal operation. Trace level that turns on all logging.</td>
</tr>
</tbody>
</table>

**Trace field descriptions**

For some services, you can activate trace for specific components, instead of enabling all trace for the service. The following list includes the services for which you can activate trace for specific components. Clicking...
one of the cross-references takes you to the applicable section where a description displays for each trace field for the service. If a service does not exist in the following list, the Enable All Trace check box displays for the service in the Trace Configuration window.

The following services are applicable to Cisco Unified Communications Manager, Cisco Unified Communications Manager Business Edition 5000, and Cisco Unity Connection:

- Database layer monitor trace fields, on page 38
- Cisco RIS data collector trace fields, on page 39

The following services are applicable to Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 only:

- Cisco CallManager SDI trace fields, on page 39
- Cisco CallManager SDL trace fields, on page 41
- Cisco CTIManager SDL trace fields, on page 43
- Cisco Extended Functions trace fields, on page 44
- Cisco Extension Mobility trace fields, on page 45
- Cisco IP manager assistant trace fields, on page 45
- Cisco IP voice media streaming app trace fields, on page 46
- Cisco TFTP trace fields, on page 47
- Cisco Web Dialer web service trace fields, on page 47

### Database layer monitor trace fields

Table 11: Cisco Database Layer Monitor Trace Fields, on page 38 describes the Cisco Database Layer Monitor trace fields. The Cisco Database Layer Monitor service supports Cisco Unified Communications Manager and Cisco Unity Connection.

**Table 11: Cisco Database Layer Monitor Trace Fields**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DB Library Trace</td>
<td>Activates database library trace for C++ applications.</td>
</tr>
<tr>
<td>Enable Service Trace</td>
<td>Activates service trace.</td>
</tr>
<tr>
<td>Enable DB Change Notification Trace</td>
<td>Activates the database change notification traces for C++ applications.</td>
</tr>
<tr>
<td>Enable Unit Test Trace</td>
<td>Do not check this check box. Cisco engineering uses it for debugging purposes.</td>
</tr>
</tbody>
</table>
Cisco RIS data collector trace fields

Table 12: Cisco RIS Data Collector Trace Fields, on page 39 describes the Cisco RIS Data Collector trace fields. The Cisco RIS Data Collector service supports Cisco Unified Communications Manager and Cisco Unity Connection.

Table 12: Cisco RIS Data Collector Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable RISDC Trace</td>
<td>Activates trace for the RISDC thread of the RIS data collector service (RIS).</td>
</tr>
<tr>
<td>Enable System Access Trace</td>
<td>Activates trace for the system access library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable Link Services Trace</td>
<td>Activates trace for the link services library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable RISDC Access Trace</td>
<td>Activates trace for the RISDC access library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable RISDB Trace</td>
<td>Activates trace for the RISDB library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable PI Trace</td>
<td>Activates trace for the PI library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable XML Trace</td>
<td>Activates trace for the input/output XML messages of the RIS data collector service.</td>
</tr>
<tr>
<td>Enable Perfmon Logger Trace</td>
<td>Activates trace for the troubleshooting perfmon data logging in the RIS data collector. Used to trace the name of the log file, the total number of counters that are logged, the names of the application and system counters and instances, calculation of process and thread CPU percentage, and occurrences of log file rollover and deletion.</td>
</tr>
</tbody>
</table>

Cisco CallManager SDI trace fields

Table 13: Cisco CallManager SDI Trace Fields, on page 39 describes the Cisco CallManager SDI trace fields. The Cisco CallManager service supports Cisco Unified Communications Manager.

Table 13: Cisco CallManager SDI Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable H245 Message Trace</td>
<td>Activates trace of H245 messages.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable DT-24+/DE-30+ Trace</td>
<td>Activates the logging of ISDN type of DT-24+/DE-30+ device traces.</td>
</tr>
<tr>
<td>Enable PRI Trace</td>
<td>Activates trace of primary rate interface (PRI) devices.</td>
</tr>
<tr>
<td>Enable ISDN Translation Trace</td>
<td>Activates ISDN message traces. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable H225 &amp; Gatekeeper Trace</td>
<td>Activates trace of H.225 devices. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable Miscellaneous Trace</td>
<td>Activates trace of miscellaneous devices.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Do not check this check box during normal system operation.</td>
</tr>
<tr>
<td>Enable Conference Bridge Trace</td>
<td>Activates trace of conference bridges. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable Music on Hold Trace</td>
<td>Activates trace of music on hold (MOH) devices. Used to trace MOH device status such as registered with Cisco Unified Communications Manager, unregistered with Cisco Unified Communications Manager, and resource allocation processed successfully or failed.</td>
</tr>
<tr>
<td>Enable Unified CMReal-Time Information Server Trace</td>
<td>Activates Cisco Unified Communications Manager real-time information traces that the real-time information server uses.</td>
</tr>
<tr>
<td>Enable SIP Stack Trace</td>
<td>Activates trace of SIP stack.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Enabling SIP Stack Trace can cause extreme performance degradation especially during high traffic hours.</td>
</tr>
<tr>
<td>Enable Annunciator Trace</td>
<td>Activates trace for the annunciator, a SCCP device that uses the Cisco IP Voice Media Streaming Application service to enable Cisco Unified Communications Manager to play prerecorded announcements (.wav files) and tones to Cisco Unified IP Phones, gateways, and other configurable devices.</td>
</tr>
<tr>
<td>Enable CDR Trace</td>
<td>Activates traces for CDR.</td>
</tr>
<tr>
<td>Enable Analog Trunk Trace</td>
<td>Activates trace of all analog trunk (AT) gateways.</td>
</tr>
<tr>
<td>Enable All Phone Device Trace</td>
<td>Activates trace of phone devices. Trace information includes SoftPhone devices. Used for normal debugging.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable MTP Trace</td>
<td>Activates trace of media termination point (MTP) devices. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable All Gateway Trace</td>
<td>Activates trace of all analog and digital gateways.</td>
</tr>
<tr>
<td>Enable Forward and Miscellaneous Trace</td>
<td>Activates trace for call forwarding and all subsystems that are not covered by another check box. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable MGCP Trace</td>
<td>Activates trace for media gateway control protocol (MGCP) devices. Used for normal debugging.</td>
</tr>
<tr>
<td>Enable Media Resource Manager Trace</td>
<td>Activates trace for media resource manager (MRM) activities.</td>
</tr>
<tr>
<td>Enable SIP Call Processing Trace</td>
<td>Activates trace for SIP call processing.</td>
</tr>
<tr>
<td>Enable SCCP Keep Alive Trace</td>
<td>Activates trace for SCCP keepalive trace information in the Cisco CallManager traces. Because each SCCP device reports keepalive messages every 30 seconds, and each keepalive message creates 3 lines of trace data, the system generates a large amount of trace data when this check box is checked.</td>
</tr>
<tr>
<td>Enable SIP Keep Alive (REGISTER Refresh) Trace</td>
<td>Activates trace for SIP keepalive (REGISTER refresh) trace information in the Cisco CallManager traces. Because each SIP device reports keepalive messages every 2 minutes, and each keepalive message can create multiple lines of trace data, the system generates a large amount of trace data when this check box is checked.</td>
</tr>
</tbody>
</table>

**Cisco CallManager SDL trace fields**

Table 24: Trace Output Settings, on page 48 describes the Cisco CallManager SDL trace filter settings. Table 15: Cisco CallManager SDL Configuration Trace Characteristics, on page 42 describes the Cisco CallManager SDL configuration characteristics. The Cisco CallManager service supports Cisco Unified Communications Manager.

---

**Note**

Cisco recommends that you use the defaults unless a Cisco engineer instructs you to do otherwise.
### Table 14: Cisco CallManager SDL Configuration Trace Filter Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable all Layer 1 traces.</td>
<td>Activates traces for Layer 1.</td>
</tr>
<tr>
<td>Enable detailed Layer 1 traces.</td>
<td>Activates detailed Layer 1 traces.</td>
</tr>
<tr>
<td>Enable all Layer 2 traces.</td>
<td>Activates traces for Layer 2.</td>
</tr>
<tr>
<td>Enable Layer 2 interface trace.</td>
<td>Activates Layer 2 interface traces.</td>
</tr>
<tr>
<td>Enable Layer 2 TCP trace.</td>
<td>Activates Layer 2 Transmission Control Program (TCP) traces.</td>
</tr>
<tr>
<td>Enable detailed dump Layer 2 trace.</td>
<td>Activates detailed traces for dump Layer 2.</td>
</tr>
<tr>
<td>Enable all Layer 3 traces.</td>
<td>Activates traces for Layer 3.</td>
</tr>
<tr>
<td>Enable all call control traces.</td>
<td>Activates traces for call control.</td>
</tr>
<tr>
<td>Enable miscellaneous polls trace.</td>
<td>Activates traces for miscellaneous polls.</td>
</tr>
<tr>
<td>Enable miscellaneous trace (database signals).</td>
<td>Activates miscellaneous traces such as database signals.</td>
</tr>
<tr>
<td>Enable message translation signals trace.</td>
<td>Activates traces for message translation signals.</td>
</tr>
<tr>
<td>Enable UUIE output trace.</td>
<td>Activates traces for user-to-user informational element (UUIE) output.</td>
</tr>
<tr>
<td>Enable gateway signals trace.</td>
<td>Activates traces for gateway signals.</td>
</tr>
<tr>
<td>Enable CTI trace.</td>
<td>Activates CTI trace.</td>
</tr>
<tr>
<td>Enable network service data trace</td>
<td>Activates network service data trace.</td>
</tr>
<tr>
<td>Enable network service event trace</td>
<td>Activates network service event trace.</td>
</tr>
<tr>
<td>Enable ICCP admin trace</td>
<td>Activates ICCP administration trace.</td>
</tr>
<tr>
<td>Enable default trace</td>
<td>Activates default trace.</td>
</tr>
</tbody>
</table>

### Table 15: Cisco CallManager SDL Configuration Trace Characteristics

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SDL link states trace.</td>
<td>Activates trace for intracell cluster communication protocol (ICCP) link state.</td>
</tr>
</tbody>
</table>
### Characteristics

<table>
<thead>
<tr>
<th>Description</th>
<th>Setting Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate trace for low-level SDL.</td>
<td>Enable low-level SDL trace.</td>
</tr>
<tr>
<td>Activate trace for ICCP link poll.</td>
<td>Enable SDL link poll trace.</td>
</tr>
<tr>
<td>Activate trace for ICCP raw messages.</td>
<td>Enable SDL link messages trace.</td>
</tr>
<tr>
<td>Activate traces for signal data dump.</td>
<td>Enable signal data dump trace.</td>
</tr>
<tr>
<td>Activate traces for correlation tag mapping.</td>
<td>Enable correlation tag mapping trace.</td>
</tr>
<tr>
<td>Activate traces for SDL process states.</td>
<td>Enable SDL process states trace.</td>
</tr>
<tr>
<td>Disable trace for pretty print of SDL.</td>
<td>Disable pretty print of SDI trace.</td>
</tr>
<tr>
<td>Activate SDL TCP event trace.</td>
<td>Enable SDL TCP event trace.</td>
</tr>
</tbody>
</table>

### Cisco CTIManager SDL trace fields

Table 16: Cisco CTIManager SDL Configuration Trace Filter Settings, on page 43 describes the Cisco CTIManager SDL configuration trace filter settings. Table 17: Cisco CTIManager SDL Configuration Trace Characteristics, on page 44 describes the Cisco CTIManager SDL configuration trace characteristics. The Cisco CTIManager service supports Cisco Unified Communications Manager.

Tip
Cisco recommends that you use the defaults unless a Cisco engineer instructs you to do otherwise.

Tip
When you choose the CTIManager service from the Service Groups drop-down list box, the Trace Configuration window displays for SDI traces for this service. To activate SDI trace for the Cisco CTI Manager service, check the Enable All Trace check box in the Trace Configuration window for the Cisco CTIManager service. To access the SDI Configuration window, choose SDL Configuration from the Related Links drop-down list box; the settings that are described in Table 16: Cisco CTIManager SDL Configuration Trace Filter Settings, on page 43 and Table 17: Cisco CTIManager SDL Configuration Trace Characteristics, on page 44 display.

Table 16: Cisco CTIManager SDL Configuration Trace Filter Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable miscellaneous polls trace.</td>
<td>Activates traces for miscellaneous polls.</td>
</tr>
<tr>
<td>Enable miscellaneous trace (database signals).</td>
<td>Activates miscellaneous traces such as database signals.</td>
</tr>
</tbody>
</table>
### Setting Name | Description
---|---
Enable CTI trace. | Activates CTI trace.
Enable Network Service Data Trace | Activates network service data trace.
Enable Network Service Event Trace | Activates network service event trace.
Enable ICCP Admin Trace | Activates ICCP administration trace.
Enable Default Trace | Activates default trace.

**Table 17: Cisco CTIManager SDL Configuration Trace Characteristics**

| Characteristics | Description |
---|---|
Enable SDL link states trace. | Activates trace for ICCP link state.
Enable low-level SDL trace. | Activates trace for low-level SDL.
Enable SDL link poll trace. | Activates trace for ICCP link poll.
Enable SDL link messages trace. | Activates trace for ICCP raw messages.
Enable signal data dump trace. | Activates traces for signal data dump.
Enable correlation tag mapping trace. | Activates traces for correlation tag mapping.
Enable SDL process states trace. | Activates traces for SDL process states.
Disable pretty print of SDL trace. | Disables trace for pretty print of SDL. Pretty print adds tabs and spaces in a trace file without performing post processing.
Enable SDL TCP Event trace | Activates SDL TCP event trace.

**Cisco Extended Functions trace fields**

Table 18: Cisco Extended Functions Trace Fields, on page 44 describes the Cisco Extended Functions trace fields. The Cisco Extended Functions service supports Cisco Unified Communications Manager.

**Table 18: Cisco Extended Functions Trace Fields**

| Field Name | Description |
---|---|
Enable QBE Helper TSP Trace | Activates telephony service provider trace.
Enable QBE Helper TSPI Trace | Activates QBE helper TSP interface trace.
### Field Name

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable QRT Dictionary Trace</td>
<td>Activates quality report tool service dictionary trace.</td>
</tr>
<tr>
<td>Enable DOM Helper Traces</td>
<td>Activates DOM helper trace.</td>
</tr>
<tr>
<td>Enable Redundancy and Change Notification Trace</td>
<td>Activates database change notification trace.</td>
</tr>
<tr>
<td>Enable QRT Report Handler Trace</td>
<td>Activates quality report tool report handler trace.</td>
</tr>
<tr>
<td>Enable QBE Helper CTI Trace</td>
<td>Activates QBE helper CTI trace.</td>
</tr>
<tr>
<td>Enable QRT Service Trace</td>
<td>Activates quality report tool service related trace.</td>
</tr>
<tr>
<td>Enable QRT DB Traces</td>
<td>Activates QRT DB access trace.</td>
</tr>
<tr>
<td>Enable Template Map Traces</td>
<td>Activates standard template map and multimap trace.</td>
</tr>
<tr>
<td>Enable QRT Event Handler Trace</td>
<td>Activates quality report tool event handler trace.</td>
</tr>
<tr>
<td>Enable QRT Real-Time Information Server Trace</td>
<td>Activates quality report tool real-time information server trace.</td>
</tr>
</tbody>
</table>

### Cisco Extension Mobility trace fields

Table 19: Cisco Extension Mobility Trace Fields, on page 45 describes the Cisco Extension Mobility trace fields. The Cisco Extension Mobility service supports Cisco Unified Communications Manager.

### Table 19: Cisco Extension Mobility Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable EM Service Trace</td>
<td>Activates trace for the extension mobility service.</td>
</tr>
</tbody>
</table>

**Tip**

When you activate trace for the Cisco Extension Mobility Application service, you check the Enable All Trace check box in the Trace Configuration window for the Cisco Extension Mobility Application service.

### Cisco IP manager assistant trace fields

Table 20: Cisco IP Manager Assistant Trace Fields, on page 46 describes the Cisco IP Manager Assistant trace fields. The Cisco IP Manager Assistant service supports Cisco Unified Communications Manager Assistant.
Table 20: Cisco IP Manager Assistant Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable IPMA Service Trace</td>
<td>Activates trace for the Cisco IP Manager Assistant service.</td>
</tr>
<tr>
<td>Enable IPMA Manager Configuration Change Log</td>
<td>Activates trace for the changes that you make to the manager and assistant configurations.</td>
</tr>
<tr>
<td>Enable IPMA CTI Trace</td>
<td>Activates trace for the CTI Manager connection.</td>
</tr>
<tr>
<td>Enable IPMA CTI Security Trace</td>
<td>Activates trace for the secure connection to CTIManager.</td>
</tr>
</tbody>
</table>

Cisco IP voice media streaming app trace fields

The information in this section does not apply to Cisco Unity Connection.


Table 21: Cisco IP Voice Media Streaming Application Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Service Initialization Trace</td>
<td>Activates trace for initialization information.</td>
</tr>
<tr>
<td>Enable MTP Device Trace</td>
<td>Activates traces to monitor the processed messages for media termination point (MTP).</td>
</tr>
<tr>
<td>Enable Device Recovery Trace</td>
<td>Activates traces for device-recovery-related information for MTP, conference bridge, and MOH.</td>
</tr>
<tr>
<td>Enable Skinny Station Messages Trace</td>
<td>Activates traces for skinny station protocol.</td>
</tr>
<tr>
<td>Enable WinSock Level 2 Trace</td>
<td>Activates trace for high-level, detailed WinSock-related information.</td>
</tr>
<tr>
<td>Enable Music On Hold Manager Trace</td>
<td>Activates trace to monitor MOH audio source manager.</td>
</tr>
<tr>
<td>Enable Annunciator Trace</td>
<td>Activates trace to monitor annunciator.</td>
</tr>
<tr>
<td>Enable DB Setup Manager Trace</td>
<td>Activates trace to monitor database setup and changes for MTP, conference bridge, and MOH.</td>
</tr>
<tr>
<td>Enable Conference Bridge Device Trace</td>
<td>Activates traces to monitor the processed messages for conference bridge.</td>
</tr>
</tbody>
</table>
Configure trace

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Device Driver Trace</td>
<td>Activates device driver traces.</td>
</tr>
<tr>
<td>Enable WinSock Level 1 Trace</td>
<td>Activates trace for low-level, general, WinSock-related information.</td>
</tr>
<tr>
<td>Enable Music on Hold Device Trace</td>
<td>Activates traces to monitor the processed messages for MOH.</td>
</tr>
<tr>
<td>Enable TFTP Downloads Trace</td>
<td>Activates trace to monitor the download of MOH audio source files.</td>
</tr>
</tbody>
</table>

Cisco TFTP trace fields

Table 22: Cisco TFTP Trace Fields, on page 47 describes the Cisco TFTP trace fields. The Cisco TFTP service supports Cisco Unified Communications Manager.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Service System Trace</td>
<td>Activates trace for service system.</td>
</tr>
<tr>
<td>Enable Build File Trace</td>
<td>Activates trace for build files.</td>
</tr>
<tr>
<td>Enable Serve File Trace</td>
<td>Activates trace for serve files.</td>
</tr>
</tbody>
</table>

Cisco Web Dialer web service trace fields

Table 23: Cisco Web Dialer Web Service Trace Fields, on page 47 describes the Cisco Web Dialer Web Service trace fields. The Cisco Web Dialer Web Service supports Cisco Unified Communications Manager.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Web Dialer Servlet Trace</td>
<td>Activates trace for Cisco Web Dialer servlet.</td>
</tr>
<tr>
<td>Enable Redirector Servlet Trace</td>
<td>Activates trace for the Redirector servlet.</td>
</tr>
</tbody>
</table>

Trace output settings

Table 24: Trace Output Settings, on page 48 contains the trace log file descriptions.
Set up troubleshooting trace settings

When you change either the Maximum No. of Files or the Maximum File Size settings in the Trace Configuration window, the system deletes all service log files except for the current file, that is, if the service is running; if the service has not been activated, the system deletes the files immediately after you activate the service. Before you change the Maximum No. of Files setting or the Maximum File Size setting, download and save the service log files to another server if you want to keep a record of the log files; to perform this task, use Trace and Log Central in RTMT.

Table 24: Trace Output Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of files</td>
<td>This field specifies the total number of trace files for a given service. Cisco Unified Serviceability automatically appends a sequence number to the file name to indicate which file it is; for example, cus299.txt. When the last file in the sequence is full, the trace data begins writing over the first file. The default varies by service.</td>
</tr>
<tr>
<td>Maximum file size (MB)</td>
<td>This field specifies the maximum size of the trace file in megabytes. The default varies by service.</td>
</tr>
</tbody>
</table>

Set up troubleshooting trace settings

The Troubleshooting Trace Settings window allows you to choose the services for which you want to set predetermined troubleshooting trace settings. This chapter contains information on how to set and reset troubleshooting trace settings for services that exist in Cisco Unified Serviceability.

Note

Leaving Troubleshooting Trace enabled for a long time increases the size of the trace files and may impact the performance of the services.

Procedure

Step 1 In Cisco Unified Serviceability, choose Trace > Troubleshooting Trace Settings.

Step 2 From the Server drop-down list box, choose the server where you want to troubleshoot trace settings; then, click Go.

Note A list of services displays. The services that are not activated display as N/A.

Step 3 Perform one of the following tasks:

a) To check specific services for the server that you chose in the Server drop-down list box, check the service(s) check box(es) in the Services pane; for example, the Database and Admin Services, Performance and Monitoring Services, or the Backup and Restore Services pane (and so on).
This task affects only the server that you chose in the Server drop-down list box.

b) Check one of the following check boxes:

- **Check All Services** - Automatically checks all check boxes for the services on the current server that you chose in the Server drop-down list box.

- Unified CM clusters only: **Check Selected Services on All Nodes** - Allows you to check specific service check boxes in the Troubleshooting Trace Setting window. This setting applies for all servers in the cluster where the service is activated.

- Unified CM clusters only: **Check All Services on All Nodes** - Automatically checks all check boxes for all services for all servers in the cluster. When you check this check box, the **Check All Services** and **Check Selected Services on All Nodes** check boxes automatically get checked.

**Step 4** Click the **Save** button.

**Caution** If you have checked **Check All Services** check box, ensure that you uncheck Cisco Location Bandwidth Manager check box before you click **Save**. If this check box is not checked, the trace settings for some of the services will not get enabled.

**Step 5** After you configure troubleshooting trace for one or more services, you can restore the original trace settings. If you want to restore the original trace settings, click one of the following buttons:

a) **Reset Troubleshooting Traces** - Restores the original trace settings for the services on the server that you chose in the Server drop-down list box; also displays as an icon that you can click.

b) Unified CM clusters only: **Reset Troubleshooting Traces On All Nodes** - Restores the original trace settings for the services on all servers in the cluster.

After you click the **reset** button, the window refreshes, and the service check boxes display as unchecked.
Set up troubleshooting trace settings
Cisco Unified CM Tools

- Services, page 51
- Serviceability Reports Archive, page 68
- Configuring services, page 87
- Set up Serviceability Reports Archive, page 92
- CDR Repository Manager, page 92
- Audit logs, page 99
- Locations, page 105

Services

This section provides a description of services/servlets, Service Activation, and Control Center.
Cisco Unified Serviceability service management includes working with feature and network services and servlets, which are associated with the Tomcat Java Webserver. Feature services allow you to use application features, such as Serviceability Reports Archive, while network services are required for your system to function.
If something is wrong with a service or servlet, an alarm gets written to an alarm monitor. After viewing the alarm information, you can run a trace on the service. Be aware that services and servlets display different trace levels in the Trace Configuration window.

Feature services

In Cisco Unified Serviceability, you can activate, start, and stop feature services. Activation turns on and starts the service. After you activate a service in the Service Activation window, you do not need to start it in the Control Center - Feature Services window. If the service does not start for any reason, you must start it in the Control Center - Features Services window.
After the system is installed, it does not automatically activate feature services, which are related services that are required if you want to use your configuration features; for example, the Serviceability Reports Archive feature.
Unified CM and Unified CM BE only: After you activate feature services, you can modify associated service parameters in Cisco Unified Communications Manager Administration.

Connection only: After you activate feature services, you can modify associated settings in Cisco Unity Connection Administration.

Unified CM only: If you are upgrading Cisco Unified Communications Manager, those services that you activated on the system prior to the upgrade automatically activate and start after the upgrade.

In the Service Activation window, Cisco Unified Serviceability categorizes feature services into the following groups:

- Database and admin services, on page 52
- Performance and monitoring services, on page 53
- CM services, on page 54
- CTI services, on page 57
- CDR services, on page 58
- Security services, on page 58
- Directory services, on page 59
- Voice quality reporter services, on page 59

In the Control Center - Feature Services window, Cisco Unified Serviceability categorizes services into the same groups that display in the Service Activation window.

**Tip**
For service activation recommendations, see the Service activation, on page 67 and the Activate feature services, on page 87.

**Database and admin services**

This section describes the Database and Admin Services.

**Locations Bandwidth Manager**

A service that assembles a network model from configured Location and Link data in one or more clusters, determines the Effective Paths between pairs of Locations, determines whether to admit calls between a pair of Locations based on the availability of bandwidth for each type of call, and deducts (reserves) bandwidth for the duration of each call that is admitted.

**Cisco AXL Web Service**

The Cisco AXL Web Service allows you to modify database entries and execute stored procedures from client-based applications that use AXL.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

**Cisco UXL Web Service**

The TabSync client in Cisco IP Phone Address Book Synchronizer uses the Cisco UXL Web Service for queries to the Cisco Unified Communications Manager database, which ensures that Cisco IP Phone Address
Book Synchronizer users have access only to end-user data that pertains to them. The Cisco UXL Web Service performs the following functions:

- Conducts authentication checks by verifying the end user name and password when an end user logs in to Cisco IP Phone Address Book Synchronizer.
- Conducts a user authorization check by only allowing the user that is currently logged in to Cisco IP Phone Address Book Synchronizer to perform functions such as listing, retrieving, updating, removing, and adding contacts.

**Cisco Bulk Provisioning Service**

This service does not support Cisco Unity Connection.

If your configuration supports clusters (Cisco Unified Communications Manager only), you can activate the Cisco Bulk Provisioning Service only on the first server. If you use the Cisco Unified Communications Manager Bulk Administration Tool (BAT) to administer phones and users, you must activate this service.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

**Cisco TAPS Service**

This service does not support Cisco Unity Connection.

The Cisco TAPS Service supports the Cisco Unified Communications Manager Auto-Register Phone Tool, which allows a user to upload a customized configuration on an auto registered phone after a user responds to Interactive Voice Response (IVR) prompts.

If your configuration supports clusters (Cisco Unified Communications Manager only), you activate this service on the first server. When you want to create dummy MAC addresses for the tool, ensure that the Cisco Bulk Provisioning Service is activated on the same server.

---

**Tip**

The Cisco Unified Communications Manager Auto-Register Phone Tool relies on Cisco Customer Response Solutions (CRS). Before the tool can work as designed, verify that the CRS server is configured and running, as described in the CRS documentation.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

---

**Performance and monitoring services**

This section describes the Performance Monitoring Services.

**Cisco Serviceability Reporter**

The Cisco Serviceability Reporter service generates the daily reports that are described in Serviceability Reports Archive, on page 68.

If your configuration supports clusters (Cisco Unified Communications Manager only), this service gets installed on all the Cisco Unified Communications Manager servers in the cluster. Reporter generates reports once a day based on logged information. You can access the reports that Reporter generates in Cisco Unified Serviceability from the Tools menu. Each summary report comprises different charts that display the statistics for that particular report. After you activate the service, report generation may take up to 24 hours.
In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager and Cisco Unity Connection.

**Cisco CallManager SNMP Service**

This service does not support Cisco Unity Connection.

This service, which implements the CISCO-CCM-MIB, provides SNMP access to provisioning and statistics information that is available for Cisco Unified Communications Manager.

If your configuration supports clusters (Cisco Unified Communications Manager only), activate this service on all servers in the cluster.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager.

**CM services**

This section describes the CM Services and does not apply to Cisco Unity Connection.

**Cisco CallManager**

The Cisco CallManager service provides software-only call processing as well as signaling and call control functionality for Cisco Unified Communications Manager.

**Tip**

Unified CM clusters only: Before you activate this service, verify that the Cisco Unified Communications Manager server displays in the Find and List Cisco Unified CMs window in Cisco Unified Communications Manager Administration. If the server does not display, add the Cisco Unified Communications Manager server before you activate this service. For information on how to find and add the server, refer to the Cisco Unified Communications Manager Administration Guide.

Unified CM clusters only: If you deactivate the Cisco CallManager or CTIManager services in Service Activation, the Cisco Unified Communications Manager server where you deactivated the service no longer exists in the database, which means that you cannot choose that Cisco Unified Communications Manager server for configuration operations in Cisco Unified Communications Manager Administration because it does not display in the graphical user interface (GUI). If you then reactivate the services on the same Cisco Unified Communications Manager server, the database creates an entry for Cisco Unified Communications Manager again and adds a “CM_” prefix to the server name or IP address; for example, if you reactivate the Cisco CallManager or CTIManager service on a server with an IP address of 172.19.140.180, then CM_172.19.140.180 displays in Cisco Unified Communications Manager Administration. You can now choose the server, with the new “CM_” prefix, in Cisco Unified Communications Manager Administration.

The following services rely on Cisco CallManager service activation:

- Cisco CTIManager, on page 56
- CDR services, on page 58

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.
Cisco TFTP
Cisco Trivial File Transfer Protocol (TFTP) builds and serves files that are consistent with the trivial file transfer protocol, a simplified version of FTP. Cisco TFTP serves embedded component executable, ringer files, and device configuration files.

Unified CM only: A configuration file includes a list of Cisco Unified Communications Managers to which devices (telephones and gateways) make connections. When a device boots, the component queries a Dynamic Host Configuration Protocol (DHCP) server for its network configuration information. The DHCP server responds with an IP address for the device, a subnet mask, a default gateway, a Domain Name System (DNS) server address, and a TFTP server name or address. The device requests a configuration file from the TFTP server. The configuration file contains a list of Cisco Unified Communications Managers and the TCP port through which the device connects to those Cisco Unified Communications Managers. The configuration file contains a list of Cisco Unified Communications Managers and the TCP port through which the device connects to those Cisco Unified Communications Managers.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco Messaging Interface
The Cisco Messaging Interface allows you to connect a simplified message desk interface (SMDI)-compliant external voice-messaging system with the Cisco Unified Communications Manager. The SMDI defines a way for a phone system to provide a voice-messaging system with the information that is needed to intelligently process incoming calls.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco Unified Mobile Voice Access Service
The Cisco Unified Voice Access Service starts the mobile voice access capability within Cisco Unified Mobility; mobile voice access, which is an integrated voice response (IVR) system, allows Cisco Unified Mobility users to perform the following tasks:

- Make calls from the cellular phone as if the call originated from the desk phone.
- Turn Cisco Unified Mobility on.
- Turn Cisco Unified Mobility off.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco IP Voice Media Streaming App
The Cisco IP Voice Media Streaming Application service provides voice media streaming functionality for Cisco Unified Communications Manager for use with MTP, conferencing, music on hold (MOH), and annunciator. The Cisco IP Voice Media Streaming Application relays messages from Cisco Unified Communications Manager to the IP voice media streaming driver, which handles RTP streaming.

The Cisco IP Voice Media Streaming Application service does not generates the Call Management Record (CMR) files for call legs that involve any IP Voice Media Streaming App components like conference, MOH, Annunciator or MTP.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.
Cisco CTIManager

The Cisco CTI Manager contains the CTI components that interface with applications. This service allows applications to monitor/control phones and virtual devices to perform call control functionality.

Unified CM clusters only: With CTI Manager, applications can access resources and functionality of all Cisco Unified Communications Managers in the cluster and have improved failover capability. Although one or more CTI Managers can be active in a cluster, only one CTI Manager can exist on an individual server. An application (JTAPI/TAPI) can have simultaneous connections to multiple CTI Managers; however, an application can only use one connection at a time to open a device with media termination.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco Extension Mobility

This service, which supports the Cisco Extension Mobility feature, performs the login and automatic logout functionality for the feature.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager.

Cisco Dialed Number Analyzer

The Cisco Dialed Number Analyzer service supports Cisco Unified Communications Manager Dialed Number Analyzer. When activated, this application consumes a lot of resources, so activate this service only during off-peak hours when minimal call-processing interruptions may occur.

Unified CM clusters only: Cisco does not recommend that you activate the service on all the servers in a cluster. Cisco recommends that you activate this service only on one of the servers of a cluster where call-processing activity is the least.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco Dialed Number Analyzer Server

The Cisco Dialed Number Analyzer Server service along with The Cisco Dialed Number Analyzer service supports Cisco Unified Communications Manager Dialed Number Analyzer. This service needs to be activated only on the node that is dedicated specifically for the Cisco Dialed Number Analyzer service.

Unified CM clusters only: Cisco does not recommend that you activate the service on all the servers in a cluster. Cisco recommends that you activate this service only on one of the servers of a cluster where call-processing activity is the least.

In a Cisco Unified Communications Manager Business Edition system, this service supports Cisco Unified Communications Manager only.

Cisco DHCP Monitor Service

Cisco DHCP Monitor Service monitors IP address changes for IP phones in the database tables. When a change is detected, it modifies the /etc/dhcpd.conf file and restarts the DHCPD daemon.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.
Cisco Intercluster Lookup Service

The Intercluster Lookup Service (ILS) runs on a cluster-wide basis. ILS allows you to create networks of remote Cisco Unified Communications Manager clusters. The ILS cluster discovery feature allows Cisco Unified Communications Manager to connect to remote clusters without the need for an administrator having to manually configure connections between each cluster. The ILS URI Replication feature enables clusters in the ILS network with the ability to exchange directory URI catalogs with the other clusters in an ILS network. URI Replication provides support for intercluster URI dialing.

ILS can be activated from the ILS Configuration window that can be accessed in Cisco Unified CM Administration by selecting **Advanced Features > ILS Configuration**.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

CTI services

This section describes the CTI Services and does not apply to Cisco Unity Connection.

Cisco IP Manager Assistant

This service supports Cisco Unified Communications Manager Assistant. After service activation, Cisco Unified Communications Manager Assistant enables managers and their assistants to work together more effectively. Cisco Unified Communications Manager Assistant supports two modes of operation: proxy line support and shared line support.

The feature comprises a call-routing service, enhancements to phone capabilities for the manager, and desktop interfaces that are primarily used by the assistant.

The service intercepts calls that are made to managers and routes them to selected assistants, to managers, or to other targets on the basis of preconfigured call filters. The manager can change the call routing dynamically; for example, by pressing a softkey on the phone, the manager can instruct the service to route all calls to the assistant and can receive status on these calls.

Cisco Unified Communications Manager users comprise managers and assistants. The routing service intercepts manager calls and routes them appropriately. An assistant user handles calls on behalf of a manager.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco WebDialer Web Service for Cisco Unified Communications Manager Systems

Cisco Web Dialer provides click-to-dial functionality. It allows users inside a Cisco Unified Communications Manager cluster to initiate a call to other users inside or outside the cluster by using a web page or a desktop application. Cisco Web Dialer provides a web page that enables users to call each other within a cluster. Cisco Web Dialer comprises two components: Web Dialer servlet and Redirector servlet.

The Redirector servlet provides the ability for third-party applications to use Cisco Web Dialer. The Redirector servlet finds the appropriate Cisco Unified Communications Manager cluster for the Cisco Web Dialer user and redirects the request to the Cisco Web Dialer in that cluster. The Redirector functionality only applies for HTTP/HTML-based Web Dialer client applications because it is not available for Simple Object Access Protocol (SOAP)-based Web Dialer applications.

Cisco WebDialer Web Service for Cisco Unified Communications Manager Business Edition 5000 Systems

Cisco Web Dialer, which is used in conjunction with Cisco Unified Communications Manager, allows Cisco Unified IP Phone users to make calls from web and desktop applications. For example, Cisco Web Dialer uses hyperlinked telephone numbers in a company directory to allow users to make calls from a web page by clicking on the telephone number of the person that they are trying to call.
This service supports Cisco Unified Communications Manager.

**CDR services**

This section describes the CDR Services and does not apply to Cisco Unity Connection.

**Cisco SOAP - CDR on Demand Service**

The Cisco SOAP - CDR on Demand Service, a SOAP/HTTPS-based service, runs on the CDR Repository server. It receives SOAP requests for CDR file name lists that are based on a user-specified time interval (up to a maximum of 1 hour) and returns a list of file names that fit the time duration that is specified in the request. This service also receives requests for delivery of a specific CDR/CMR file with the file name and the transfer method (SFTP/FTP, server name, login info, directory) that is specified in the request. If you are using a third-party billing application that accesses CDR data via an HTTPS/SOAP interface, activate this service.

**CAR Web Service**

The Cisco CAR Web Service loads the user interface for CAR, a web-based reporting application that generates either CSV or PDF reports by using CDR data.

**Security services**

This section describes the Security Services and does not apply to Cisco Unity Connection.

**Cisco CTL Provider**

Unified CM only: The Cisco CTL Provider service, which runs with local system account privileges, works with the Cisco CTL Provider Utility, a client-side plug-in, to change the security mode for the cluster from nonsecure to mixed mode. When you install the plug-in, the Cisco CTL Provider service retrieves a list of all Cisco Unified Communications Manager and Cisco TFTP servers in the cluster for the CTL file, which contains a list of security tokens and servers in the cluster. You must install and configure the Cisco CTL Client and activate this service for the cluster-wide security mode to change from nonsecure to secure.

Unified CM BE only: The Cisco CTL Provider service, which runs with local system account privileges, works with the Cisco CTL Provider Utility, a client-side plug-in, to change the clusterwide security mode for the server from nonsecure to mixed mode. You must install and configure the Cisco CTL Client and activate this service for the security mode to change from nonsecure to secure.

After you activate the service, the Cisco CTL Provider service reverts to the default CTL port, which is 2444. If you want to change the port, refer to the Cisco Unified Communications Manager Security Guide for more information.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

**Cisco Certificate Authority Proxy Function (CAPF)**

Working in conjunction with the CAPF application, the Cisco Certificate Authority Proxy Function (CAPF) service can perform the following tasks, depending on your configuration:

- Issue locally significant certificates to supported Cisco Unified IP Phone models.
- Using SCEP, request certificates from third-party certificate authorities on behalf of supported Cisco Unified IP Phone models.
- Upgrade existing certificates on the phones.
- Retrieve phone certificates for troubleshooting.
- Delete locally significant certificates on the phone.

**Note**  
Unified CM only: When you view real-time information in RTMT, the Cisco Certificate Authority Proxy Function (CAPF) service displays only for the first server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager.

**Directory services**

This section describes the Directory Services.

**Cisco DirSync**

Cisco Unified Communications Manager Business Edition 5000: This service displays in Cisco Unified Serviceability, but the system does not save the configuration for the activation; after you attempt to activate the service, a message displays in the Service Activation window to tell you that you cannot activate this service for Cisco Unified Communications Manager Business Edition 5000.

Unified CM: The Cisco DirSync service ensures that the Cisco Unified Communications Manager database stores all user information. If you use an integrated corporate directory, for example, Microsoft Active Directory or Netscape/iPlanet Directory, with Cisco Unified Communications Manager, the Cisco DirSync service migrates the user data to the Cisco Unified Communications Manager database. The Cisco DirSync service does not synchronize the passwords from the corporate directory.

Cisco Unity Connection: When Connection is integrated with an LDAP directory, the Cisco DirSync service synchronizes a small subset of user data (first name, last name, alias, phone number, and so on) in the Cisco Unified CM database on the Connection server with the corresponding data in the LDAP directory. Another service (CuCmDbEventListener) synchronizes data in the Connection user database with data in the Cisco Unified CM database. When a Connection cluster is configured, the Cisco DirSync service runs only on the publisher server.

**Voice quality reporter services**

This section describes the Voice Quality Reporter Services and does not apply to Cisco Unity Connection.

**Cisco Extended Functions**

The Cisco Extended Functions service provides support for Cisco Unified Communications Manager voice-quality features, including Quality Report Tool (QRT). For more information about individual features, refer to the Cisco Unified Communications Manager System Guide and the Cisco Unified IP Phone Administration Guide for Cisco Unified Communications Manager.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

**Network services**

Installed automatically, network services include services that the system requires to function; for example, database and platform services. Because these services are required for basic functionality, you cannot activate them in the Service Activation window. If necessary, for example, for troubleshooting purposes, you may need to stop and start (or restart) a network service in the Call Control - Network Services window.
After the installation of your application, network services start automatically, as noted in the Call Control - Network Services window. In the Control Center - Network Services window, Cisco Unified Serviceability categorizes services into the following groups:

- Performance and monitoring services, on page 60
- Backup and restore services, on page 61
- System services, on page 61
- Platform services, on page 62
- Security services, on page 64
- DB services, on page 65
- SOAP services, on page 65
- CM services, on page 66
- CDR services, on page 58
- Admin services, on page 67

Performance and monitoring services

This section describes the Performance and Monitoring Services.

Cisco CallManager Serviceability RTMT

The Cisco CallManager Serviceability RTMT servlet supports the Cisco Unified Real-Time Monitoring Tool (RTMT), which allows you to collect and view traces, view performance monitoring objects, work with alerts, and monitor devices, system performance, CTI applications, and so on.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco RTMT Reporter Servlet

The Cisco RTMT Reporter servlet allows you to publish reports for RTMT.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco Log Partition Monitoring Tool

The Cisco Log Partition Monitoring Tool service supports the Log Partition Monitoring feature, which monitors the disk usage of the log partition on a server (or all servers in the cluster) by using configured thresholds and a polling interval.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco Tomcat Stats Servlet

The Cisco Tomcat Stats Servlet allows you to monitor the Tomcat perfmon counters by using RTMT or the Command Line Interface. Do not stop this service unless you suspect that this service is using too many resources, such as CPU time.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco RIS Data Collector
The Real-time Information Server (RIS) maintains real-time information such as device registration status, performance counter statistics, critical alarms generated, and so on. The Cisco RIS Data Collector service provides an interface for applications, such as the Cisco Unified Real-Time Monitoring Tool (RTMT), SOAP applications, and so on, to retrieve the information that is stored in the RIS server (or in all RIS servers in the cluster).

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco AMC Service

Used for the Cisco Unified Communications Manager Cisco Unified Real-Time Monitoring Tool (RTMT), this service, Alert Manager and Collector service, allows RTMT to retrieve real-time information that exists on the server (or on all servers in the cluster).

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco Audit Event Service

The Cisco Audit Event Service monitors and logs any configuration change to the Cisco Unified Communications Manager system by a user or as a result of the user action.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco RisBean Library

Cisco RisBean Library comprises a library that some webapps use to communicate with other internal services. You should leave trace settings at default level unless you are instructed by TAC to change them to debug an issue.

Backup and restore services

This section describes the Backup and Restore Services.

Cisco DRF Master

The Cisco DRF Master Agent service supports the DRF Master Agent, which works with the Disaster Recovery System graphical user interface (GUI) or command line interface (CLI) to schedule backups, perform restorations, view dependencies, check status of jobs, and cancel jobs, if necessary. The Cisco DRF Master Agent also provides the storage medium for the backup and restoration process.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco DRF Local

The Cisco DRF Local service supports the Cisco DRF Local Agent, which acts as the workhorse for the DRF Master Agent. Components register with the Cisco DRF Local Agent to use the disaster recovery framework. The Cisco DRF Local Agent executes commands that it receives from the Cisco DRF Master Agent. Cisco DRF Local Agent sends the status, logs, and command results to the Cisco DRF Master Agent.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

System services

This section describes the System Services.
Cisco CallManager Serviceability

The Cisco CallManager Serviceability service supports Cisco Unified Serviceability, the web application/interface that you use to troubleshoot issues and manage services. This service, which is installed automatically, allows you access to the Cisco Unified Serviceability graphical user interface (GUI). If you stop this service, you cannot access the Cisco Unified Serviceability GUI when you browse into that server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco CDP

Cisco CDP advertises the voice application to other network management applications, so the network management application, for example, SNMP or CiscoWorks Lan Management Solution, can perform network management tasks for the voice application.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco Trace Collection Servlet

The Cisco Trace Collection Servlet, along with the Cisco Trace Collection Service, supports trace collection and allows users to view traces by using RTMT. If you stop this service on a server, you cannot collect or view traces on that server.

For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet and the Cisco Trace Collection Service must run on the server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco Trace Collection Service

The Cisco Trace Collection Service, along with the Cisco Trace Collection Servlet, supports trace collection and allows users to view traces by using the RTMT client. If you stop this service on a server, you cannot collect or view traces on that server.

For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet and the Cisco Trace Collection Service must run on the server.

Tip

If necessary, Cisco recommends that, to reduce the initialization time, you restart the Cisco Trace Collection Service before restarting Cisco Trace Collection Servlet.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Platform services

This section describes the Platform Services.

A Cisco DB

A Cisco DB service supports the Progres database engine.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

A Cisco DB Replicator
Unified CM only: The A Cisco DB Replicator service ensures database configuration and data synchronization between the first and subsequent servers in the cluster.

Cisco Tomcat

The Cisco Tomcat service supports the web server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

SNMP Master Agent

This service, which acts as the agent protocol engine, provides authentication, authorization, access control, and privacy functions that relate to SNMP requests.

---

Tip

After you complete SNMP configuration in Cisco Unified Serviceability, you must restart the SNMP Master Agent service in the Control Center - Network Features window.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

MIB2 Agent

This service provides SNMP access to variables, which are defined in RFC 1213, that read and write variables; for example, system, interfaces, IP, and so on.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager and Cisco Unity Connection.

Host Resources Agent

This service provides SNMP access to host information, such as storage resources, process tables, device information, and installed software base. This service implements the HOST-RESOURCES-MIB.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Native Agent Adaptor

This service, which supports vendor MIBs, allows you to forward SNMP requests to another SNMP agent that runs on the system.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

System Application Agent

This service provides SNMP access to the applications that are installed and executing on the system. This implements the SYSAPPL-MIB.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco CDP Agent

This service uses the Cisco Discovery Protocol to provide SNMP access to network connectivity information on the Cisco Unified Communications Manager or Cisco Unity Connection server. This service implements the CISCO-CDP-MIB.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.
Cisco Syslog Agent
This service supports gathering of syslog messages that various components generate. This service implements the CISCO-SYSLOG-MIB.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Caution
Stopping any SNMP service may result in loss of data because the network management system no longer monitors the network. Do not stop the services unless the your technical support team tells you to do so.

Cisco Certificate Expiry Monitor
This service periodically checks the expiration status of certificates that the system generates and sends notification when a certificate gets close to its expiration date. You manage the certificates that use this service in Cisco Unified Operating System Administration.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco License Manager
This service is not supported by Cisco Unity Connection.

Cisco License Manager keeps track of the Cisco Unified Communications Manager-related licenses that a customer purchases and uses. It controls license checkins and checkouts, and it takes responsibility for issuing and reclaiming Cisco Unified Communications Manager-related licenses. For Cisco Unified Communications Manager, Cisco License Manager manages the Cisco Unified Communications Manager application and the number of IP phone unit licenses. When the number of phones exceeds the number of licenses, it issues alarms.

Unified CM clusters only: This service runs on all the servers, but the service on the first server has the responsibility for issuing and reclaiming licenses.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Tip
Unified CM BE only: For information on issuing Cisco Unity Connection licenses, refer to the Cisco Unified Communications Manager System Guide.

Security services
This section describes the Security Services.

Cisco Trust Verification Service
Cisco Trust Verification Service is a service running on a CallManager server or a dedicated server, that authenticates certificates on behalf of phones and other endpoints. It associates a list of roles for the owner of the certificate. A certificate or the owner can be associated with one or many roles.

The protocol between phones and Trust Verification Service allows phones to request for verification. Trust Verification Service validates the certificate and returns a list of roles associated with it. The protocol allows Trust Verification Service to authenticate a request and conversely, a phone to authenticate the response from Trust Verification Service. The protocol protects the integrity of the request and the response. Confidentiality of the request and the response is not required.
Multiples instances of Cisco Trust Verification Service run on different servers in the cluster to provide scalability. These servers may or may not be the same as the ones hosting the Cisco Unified CallManager. Phones obtain a list of Trust Verification Services in the network and connect to one of them using a selection algorithm (example: Round Robin). If the contacted Trust Verification Service does not respond, the phone switches to the next Trust Verification Service in the list.

**DB services**

This section describes the DB Services.

Cisco Database Layer Monitor

The Cisco Database Layer Monitor service monitors aspects of the database layer. This service takes responsibility for change notification and monitoring.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

---

**Note**

Cisco Unified CM uses Automatic Update Statistics, an intelligent statistics update feature that monitors the changes made in the database tables and updates only tables that need statistic updates. This feature saves considerable bandwidth, especially on VMware deployments of Cisco Unified CM. Automatic Update Statistics is the default indexing method.

---

**SOAP services**

This section describes the SOAP Services.

Cisco SOAP-Real-Time Service APIs

The Cisco SOAP-Real-Time Service APIs allow you to collect real-time information for devices and CTI applications. This service also provides APIs for activating, starting, and stopping services.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco SOAP-Performance Monitoring APIs

The Cisco SOAP-Performance Monitoring APIs service allows you to use performance monitoring counters for various applications through SOAP APIs; for example, you can monitor memory information per service, CPU usage, performance monitoring counters, and so on.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

Cisco SOAP-Log Collection APIs

The Cisco SOAP-Log Collection APIs service allows you to collect log files and to schedule collection of log files on a remote SFTP server. Examples of log files that you can collect include syslog, core dump files, Cisco application trace files, and so on.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.
CM services

This section describes the CM Services and does not apply to Cisco Unity Connection.

Cisco CallManager Personal Directory

The Cisco CallManager Personal Directory service supports Cisco Personal Directory.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco Extension Mobility Application

The Cisco Extension Mobility Application service allows you to define login settings such as duration limits on phone configuration for the Cisco Extension Mobility feature.

Unified CM only: The Cisco Extension Mobility feature allows users within a Cisco Unified Communications Manager cluster to temporarily configure another phone in the cluster as their own phone by logging in to that other phone. After a user logs in, the phone adopts the personal phone number(s), speed dials, services links, and other user-specific properties of the user. After logout, the phone adopts the original user profile.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco CallManager Cisco IP Phone Services

The Cisco CallManager Cisco IP Phone Service initializes the service URLs for the Cisco Unified IP Phone services that you configured in Cisco Unified Communications Manager Administration.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

CDR services

This section describes the CDR Services and does not apply to Cisco Unity Connection.

Cisco CDR Repository Manager

This service maintains and moves the generated CDRs that are obtained from the Cisco CDR Agent service. In a system that supports clusters (Cisco Unified Communications Manager only), the service exists on the first server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco CDR Agent

Note

Cisco Unified Communications Manager supports Cisco CDR Agent in Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 systems. This service does not support Cisco Unity Connection.

This service does not support Cisco Unity Connection.

The Cisco CDR Agent service transfers CDR and CMR files that are generated by Cisco Unified Communications Manager from the local host to the CDR repository server, where the CDR Repository Manager service runs over a SFTP connection.

This service transfers CDR and CMR files generated from the local host to the CDR repository server in a cluster. The CDR Agent in the CDR Repository Node/Standalone server (Files generated in the Standalone
server itself) transfers the files to the Cisco CDR Repository Manager, over a SFTP connection, which maintains /moves the files.

For this service to work, activate the Cisco CallManager service on the server and ensure that it is running. If your configuration supports clusters (Cisco Unified Communications Manager only), activate the Cisco CallManager service on the first server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Cisco CAR Scheduler

This service does not support Cisco Unity Connection.

The Cisco CAR Scheduler service allows you to schedule CAR-related tasks; for example, you can schedule report generation or CDR file loading into the CAR database.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Admin services

This section describes the Admin Services and does not apply to Cisco Unity Connection.

Cisco CallManager Admin

The Cisco CallManager Admin service supports Cisco Unified Communications Manager Administration, the web application/interface that you use to configure Cisco Unified Communications Manager settings. After the Cisco Unified Communications Manager installation, this service starts automatically and allows you to access the graphical user interface (GUI). If you stop this service, you cannot access the Cisco Unified Communications Manager Administration graphical user interface when you browse into that server.

In a Cisco Unified Communications Manager Business Edition 5000 system, this service supports Cisco Unified Communications Manager only.

Service activation

You can activate or deactivate multiple feature services or choose default services to activate from the Service Activation window in Cisco Unified Serviceability.

Note

Starting with Cisco Unified Communications Manager Release 6.1.1, end users can no longer access Cisco Unified Serviceability to start and stop services.

Cisco Unified Serviceability activates feature services in automatic mode and checks for service dependencies. When you choose to activate a feature service, Cisco Unified Serviceability prompts you to select all the other services, if any, that depend on that service to run. When you click the Set Default button, Cisco Unified Serviceability chooses those services that are required to run on the server.

Unified CM only: Even in a configuration that supports clusters, this process is based on a single-server configuration.

Activating a service automatically starts the service. You start/stop services from Control Center.
Control center

From Control Center in Cisco Unified Serviceability, you can view status and start and stop one service at a time. In a cluster configuration (Cisco Unified Communications Manager only), you can perform these functions for one server in the cluster. To perform these tasks, Cisco Unified Serviceability provides two Control Center windows. To start, stop, and restart network services, access the Control Center - Network Services window. To start, stop, and restart feature services, access the Control Center - Feature Services window.

Tip
Use the Related Links drop-down list box and the Go button to navigate to Control Center and Service Activation windows.

Unified CM only: Starting and stopping a feature service causes all Cisco Unified IP Phones and gateways that are currently registered to that service to fail over to their secondary service. Devices and phones need to restart only if they cannot register with their secondary service. Starting and stopping a service may cause other installed applications (such as a conference bridge or Cisco Messaging Interface) that are homed to that Cisco Unified Communications Manager to start and stop as well.

Caution
Unified CM and Unified CM BE only: Stopping a service also stops call processing for all devices that the service controls. When a service is stopped, calls from an IP phone to another IP phone stay up; calls in progress from an IP phone to a Media Gateway Control Protocol (MGCP) gateway also stay up, but other types of calls drop.

Set up services

The following steps provide information about working with services.

Procedure

Step 1 Activate the feature services that you want to run.
Step 2 Configure the appropriate service parameters.
Step 3 If necessary, troubleshoot problems by using the Cisco Unified Serviceability trace tools.

Related Topics

Feature services, on page 51
Activate feature services, on page 87

Serviceability Reports Archive

The Cisco Serviceability Reporter service generates daily reports in Cisco Unified Serviceability. Each report provides a summary that comprises different charts that display the statistics for that particular report. Reporter generates reports once a day on the basis of logged information.
Unified CM clusters only: Because the Cisco Serviceability Reporter is only active on the first server, at any time, Reporter generates reports only on the first server, not the other servers.

You view reports from **Cisco Unified Serviceability > Tools > Serviceability Reports Archive**. You must activate the Cisco Serviceability Reporter service before you can view reports. After you activate the service, report generation may take up to 24 hours.

The reports contain 24-hour data for the previous day. A suffix that is added to the report names shows the date for which Reporter generated them; for example, AlertRep_mm_dd_yyyy.pdf. The Serviceability Reports Archive window uses this date to display the reports for the relevant date only. The reports generate from the data that is present in the log files, with the timestamp for the previous day. The system considers log files for the current date and the previous two days for collecting data. For cluster configurations (Cisco Unified Communications Manager only), this takes into account the time zone differences between the server locations.

The time that is shown in the report reflects the server “System Time.” In cluster configurations (Cisco Unified Communications Manager only), the time that is shown in the report reflects the first server “System Time.” If the first server and subsequent server(s) are in different time zones, the first server “System Time” shows in the report.

You can pick up log files from the server while you are generating reports, or in a cluster configuration (Cisco Unified Communications Manager only), from all servers in the cluster.

The Cisco Unified Reporting web application provides snapshot views of data into one output and runs data checks. In a cluster configuration (Cisco Unified Communications Manager only), this includes cluster data from all accessible servers. The application also allows you to archive generated reports. See the **Cisco Unified Reporting Administration Guide** for more information.

**Serviceability reporter service parameters**

Cisco Serviceability Reporter uses the following service parameters:

- RTMT Reporter Designated Node - Specifies the designated node on which RTMT Reporter runs. This default equals the IP address of the server on which the Cisco Serviceability Reporter service is first activated.
  
  Unified CM only: Because the Serviceability Reporter service is CPU intensive, Cisco recommends that you specify a non-call processing node.

- Report Generation Time - Specifies the number of minutes after midnight. Reports generate at this time for the most recent day. The minimum value equals 0 and the maximum value equals 1439.

- Report Deletion Age - Specifies the number of days that the report must be kept on the disk. The system deletes reports that are older than the specified age. The minimum value equals 0, and the maximum value equals 30.
You can disable reports by setting the service parameter Report Deletion Age to a value of 0.

For more information about service parameter configuration, refer to the following guides:

- Unified CM and Unified CM BE only: *Cisco Unified Communications Manager Administration Guide*
- Connection only: *System Administration Guide for Cisco Unity Connection*

Unified CM only: If a node gets removed completely from the network (the node should be removed from the network and also from the list of servers in Cisco Unified Communications Manager Administration), Reporter does not consider this node while it is generating reports, even if the log file contains the data for that node.

---

**Device statistics report**

The Device Statistics Report does not apply to Cisco Unity Connection.

The Device Statistics Report provides the following line charts:

- **Number of Registered Phones per Server**, on page 70
- **Number of H.323 Gateways in the Cluster**, on page 72
- **Number of Trunks in the Cluster**, on page 72

In a Cisco Unified Communications Manager Business Edition 5000 system, the Device Statistics Report supports Cisco Unified Communications Manager only.

**Number of Registered Phones per Server**

A line chart displays the number of registered phones for each Cisco Unified Communications Manager server (and cluster in a Cisco Unified Communications Manager cluster configuration). Each line in the chart represents the data for a server for which data is available, and one extra line displays the clusterwide data (Cisco Unified Communications Manager clusters only). Each data value in the chart represents the average number of phones that are registered for a 15-minute duration. If a server shows no data, Reporter does not generate the line that represents that server. If no data exists for the server (or for all servers in a Cisco Unified Communications Manager cluster configuration), for registered phones, Reporter does not generate the chart. The message “No data for Device Statistics report available” displays.
This figure shows an example of a line chart representing the number of registered phones per Cisco Unified Communications Manager server in a Cisco Unified Communications Manager cluster configuration.

**Figure 1: Line Chart That Depicts Number of Registered Phones Per Server**

![Line Chart](image1)

---

**Number of MGCP Gateways Registered in the Cluster**

A line chart displays the number of registered MGCP FXO, FXS, PRI, and T1CAS gateways. Each line represents data only for the Cisco Unified Communications Manager server (or cluster in a Cisco Unified Communications Manager cluster configuration); so, four lines show server (or clusterwide) details for each gateway type. Each data value in the chart represents the average number of MGCP gateways that are registered for a 15-minute duration. If no data exists for a gateway for the server (or all the servers in a cluster), Reporter does not generate the line that represents data for that particular gateway. If no data exists for all gateways for the server (or for all servers in a cluster), Reporter does not generate the chart.

This figure shows an example of a line chart representing the number of registered gateways per cluster, in a Cisco Unified Communications Manager cluster configuration.

**Figure 2: Line Chart That Depicts Number of Registered Gateways Per Cluster**

![Line Chart](image2)
Number of H.323 Gateways in the Cluster

A line chart displays the number of H.323 gateways. One line represents the details of the H.323 gateways (or the clusterwide details in a Cisco Unified Communications Manager cluster configuration). Each data value in the chart represents the average number of H.323 gateways for a 15-minute duration. If no data exists for H.323 gateways for the server (or for all servers in a cluster), Reporter does not generate the chart.

This figure shows an example line chart representing the number of H.323 gateways per cluster in a Cisco Unified Communications Manager cluster configuration.

Figure 3: Line Chart That Depicts Number of Registered H.323 Gateways Per Cluster

Number of Trunks in the Cluster

A line chart displays the number of H.323 and SIP trunks. Two lines represent the details of the H.323 trunks and SIP trunks (or the clusterwide details in a Cisco Unified Communications Manager cluster configuration). Each data value in the chart represents the average number of H.323 and SIP trunks for a 15-minute duration. If no data exists for H.323 trunks for the server (or for all servers in a cluster), Reporter does not generate the line that represents data for the H.323 trunks. If no data exists for SIP trunks for the server (or for all servers in the cluster), Reporter does not generate the line that represents data for SIP trunks. If no data exists for trunks at all, Reporter does not generate the chart.
This figure shows an example line chart representing the number of trunks per cluster in a Cisco Unified Communications Manager cluster configuration.

**Figure 4: Line Chart That Depicts Number of Trunks Per Cluster**

The server (or each server in the cluster) contains log files that match the file name pattern `DeviceLog_mm_dd_yyyy_hh_mm.csv`. The following information exists in the log file:

- Number of registered phones on the server (or on each server in a Cisco Unified Communications Manager cluster)
- Number of registered MGCP FXO, FXS, PRI, and T1CAS gateways on the server (or on each server in a Cisco Unified Communications Manager cluster)
- Number of registered H.323 gateways on the server (or on each server in a Cisco Unified Communications Manager cluster)
- Number of SIP trunks and H.323 trunks

**Server statistics report**

The Server Statistics Report provides the following line charts:

- Percentage of CPU per Server, on page 73
- Percentage of Memory Usage per Server, on page 74
- Percentage of Hard Disk Usage of the Largest Partition per Server, on page 75

In a Cisco Unified Communications Manager Business Edition 5000 system, the Server Statistics Report supports both Cisco Unified Communications Manager and Cisco Unity Connection.

**Percentage of CPU per Server**

A line chart displays the percentage of CPU usage for the server (or for each server in a Cisco Unified Communications Manager cluster). The line in the chart represents the data for the server (or one line for each server in a Cisco Unified Communications Manager cluster) for which data is available. Each data value in the chart represents the average CPU usage for a 15-minute duration. If no data exists for the server (or for any one server in a Cisco Unified Communications Manager cluster), Reporter does not generate the line that
represents that server. If there are no lines to generate, Reporter does not create the chart. The message “No data for Server Statistics report available” displays.

This figure shows a line chart example representing the percentage of CPU usage per server in a Cisco Unified Communications Manager cluster configuration.

**Figure 5: Line Chart That Depicts the Percentage of CPU Per Server**

![CPU chart example](chart1.png)

**Percentage of Memory Usage per Server**

A line chart displays the percentage of Memory Usage for the Cisco Unified Communications Manager server (%MemoryInUse). In a Cisco Unified Communications Manager cluster configuration, there is one line per server in the cluster for which data is available. Each data value in the chart represents the average memory usage for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate the line that represents that server.

This figure shows a line chart example representing the percentage of memory usage per Cisco Unified Communications Manager server in a Cisco Unified Communications Manager cluster configuration.

**Figure 6: Line Chart That Depicts Percentage of Memory Usage Per Server**

![Memory chart example](chart2.png)
Percentage of Hard Disk Usage of the Largest Partition per Server

A line chart displays the percentage of disk space usage for the largest partition on the server (%DiskSpaceInUse), or on each server in a Cisco Unified Communications Manager cluster configuration. Each data value in the chart represents the average disk usage for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one server in a cluster configuration, Reporter does not generate the line that represents that server.

This figure shows a line chart example representing the percentage of hard disk usage for the largest partition per server in a Cisco Unified Communications Manager cluster configuration.

Figure 7: Line Chart That Depicts Percentage of Hard Disk Usage of the Largest Partition Per Server

The server (or each server in a Cisco Unified Communications Manager cluster configuration) contains log files that match the file name pattern ServerLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- % CPU usage on the server (or each server in a Cisco Unified Communications Manager cluster)
- % Memory usage (%MemoryInUse) on the server (or on each server in a Cisco Unified Communications Manager cluster)
- % Hard disk usage of the largest partition (%DiskSpaceInUse) on the server (or on each server in a Cisco Unified Communications Manager cluster)

Service Statistics Report

The Service Statistics Report does not support Cisco Unity Connection.

The Service Statistics Report provides the following line charts:

- Cisco CTI Manager: Number of Open Devices, on page 76
- Cisco CTI Manager: Number of Open Lines, on page 76
- Cisco TFTP: Number of Requests, on page 77
- Cisco TFTP: Number of Aborted Requests, on page 78
In a Cisco Unified Communications Manager Business Edition 5000 system, the Service Statistics Report supports Cisco Unified Communications Manager only.

**Cisco CTI Manager: Number of Open Devices**

A line chart displays the number of CTI Open Devices for the CTI Manager (or for each CTI Manager in a Cisco Unified Communications Manager cluster configuration). Each line chart represents the data for the server (or on each server in a Cisco Unified Communications Manager cluster) on which service is activated. Each data value in the chart represents the average number of CTI open devices for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate the line that represents that server. The message “No data for Service Statistics report available” displays.

This figure shows a line chart example representing the number of open devices per Cisco CTI Manager in a Cisco Unified Communications Manager cluster configuration.

*Figure 8: Line Chart That Depicts Cisco CTI Manager: Number of Open Devices*

**Cisco CTI Manager: Number of Open Lines**

A line chart displays the number of CTI open lines for the CTI Manager (or per CTI Manager in a Cisco Unified Communications Manager cluster configuration). A line in the chart represents the data for the server (or one line for each server in a Cisco Unified Communications Manager cluster configuration) where the Cisco CTI Manager service is activated. Each data value in the chart represents the average number of CTI open lines for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate the line that represents that server.
This figure shows a line chart example representing the number of open lines per Cisco CTI Manager in a Cisco Unified Communications Manager cluster configuration.

**Figure 9: Line Chart That Depicts Cisco CTI Manager: Number of Open Lines**

![Cisco CTI Manager: Number of Open Lines](image)

**Cisco TFTP: Number of Requests**

A line chart displays the number of Cisco TFTP requests for the TFTP server (or per TFTP server in a Cisco Unified Communications Manager cluster configuration). A line in the chart represents the data for the server (or one line for each server in a Cisco Unified Communications Manager cluster) where the Cisco TFTP service is activated. Each data value in the chart represents the average number of TFTP requests for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate the line that represents that server.

This figure shows a line chart example representing the number of Cisco TFTP requests per TFTP server.

**Figure 10: Line Chart That Depicts Cisco TFTP: Number of Requests**

![Cisco TFTP: Number of Requests](image)
Cisco TFTP: Number of Aborted Requests

A line chart displays the number of Cisco TFTP requests that were aborted for the TFTP server (or per TFTP server in a Cisco Unified Communications Manager cluster configuration). A line in the chart represents the data for the server (or one line for each server in a Cisco Unified Communications Manager cluster) where the Cisco TFTP service is activated. Each data value in the chart represents the average of TFTP requests that were aborted for a 15-minute duration. If no data exists, Reporter does not generate the chart. If no data exists for any one server in a Cisco Unified Communications Manager cluster configuration, Reporter does not generate the line that represents that server.

This figure shows a line chart example that represents the number of Cisco TFTP requests that were aborted per TFTP server.

**Figure 11: Line Chart That Depicts Cisco TFTP: Number of Aborted Requests**

The server (or each server in a Cisco Unified Communications Manager cluster) contains log files that match the file name pattern ServiceLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- For each CTI Manager - Number of open devices
- For each CTI Manager - Number of open lines
- For each Cisco TFTP server - TotalTftpRequests
- For each Cisco TFTP server - TotalTftpRequestsAborted

**Call activities report**

The Call Activities Report does not support Cisco Unity Connection.

The Call Activities Report provides the following line charts:

- Cisco Unified Communications Manager Call Activity for the Cluster, on page 79
- H.323 Gateways Call Activity for the Cluster, on page 79
- MGCP Gateways Call Activity for the Cluster, on page 80
- MGCP Gateways, on page 81
- Trunk Call Activity for the Cluster, on page 82
In a Cisco Unified Communications Manager Business Edition 5000 system, the Server Statistics Report supports Cisco Unified Communications Manager only.

**Cisco Unified Communications Manager Call Activity for the Cluster**

A line chart displays the number of Cisco Unified Communications Manager calls that were attempted and calls that were completed. In a Cisco Unified Communications Manager cluster configuration, the line chart displays the number of calls attempted and completed for the entire cluster. The chart comprises two lines, one for the number of calls that were attempted and another for the number of calls that were completed. For a Cisco Unified Communications Manager cluster configuration, each line represents the cluster value, which is the sum of the values for all the servers in the cluster (for which data is available). Each data value in the chart represents the total number of calls that were attempted or calls that were completed for a 15-minute duration.

If no data exists for Cisco Unified Communications Manager calls that were completed, Reporter does not generate the line that represents data for the calls that were completed. If no data exists for Cisco Unified Communications Manager calls that were attempted, Reporter does not generate the line that represents data for the calls that were attempted. In a Cisco Unified Communications Manager cluster configuration, if no data exists for a server in the cluster, Reporter does not generate the line that represents calls attempted or completed on that server. If no data exists for Cisco Unified Communications Manager call activities at all, Reporter does not generate the chart. The message “No data for Call Activities report available” displays.

This figure shows a line chart representing the number of attempted and completed calls for a Cisco Unified Communications Manager cluster.

*Figure 12: Line Chart That Depicts Cisco Unified Communications Manager Call Activity for a Cluster*

**H.323 Gateways Call Activity for the Cluster**

A line chart displays the number of calls that were attempted and calls that were completed for H.323 gateways. In a Cisco Unified Communications Manager cluster configuration, the line chart displays the number of calls attempted and completed for the entire cluster. The chart comprises two lines, one for the number of calls that were attempted and another for the number of calls that were completed. For a Cisco Unified Communications Manager cluster configuration, each line represents the cluster value, which equals the sum of the values for all the servers in the cluster (for which data is available). Each data value in the chart represents the total number of calls that were attempted or calls that were completed for a 15-minute duration. If no data exists for H.323 gateways calls that were completed, Reporter does not generate the line that represents data for calls that were completed. If no data exists for H.323 gateways calls that were attempted, Reporter does not
generate the line that represents data for calls that were attempted. In a Cisco Unified Communications Manager cluster configuration, if no data exists for a server in the cluster, Reporter does not generate the line that represents calls attempted or completed on that server. If no data exists for H.323 gateways call activities at all, Reporter does not generate the chart.

This figure shows a line chart representing the H.323 gateway call activity for a Cisco Unified Communications Manager cluster.

*Figure 13: Line Chart That Depicts H.323 Gateways Call Activity for the Cluster*

**MGCP Gateways Call Activity for the Cluster**

A line chart displays the number of calls that were completed in an hour for MGCP FXO, FXS, PRI, and T1CAS gateways. In a Cisco Unified Communications Manager cluster configuration, the chart displays the number of calls that were completed for the entire Cisco Unified Communications Manager cluster. The chart comprises four lines at the most, one for the number of calls that were completed for each of the gateway types (for which data is available). Each data value in the chart represents the total number of calls that were completed for a 15-minute duration. If no data exists for a gateway, Reporter does not generate the line that represents data for calls that were completed for a particular gateway. If no data exists for all gateways, Reporter does not generate the chart.
This figure shows a line chart representing the MGCP gateways call activity for a Cisco Unified Communications Manager cluster.

**Figure 14: Line Chart That Depicts MGCP Gateways Call Activity for the Cluster**

![Line Chart](image)

**MGCP Gateways**

A line chart displays the number of Ports In Service and Active Ports for MGCP FXO, FXS gateways and the number of Spans In Service or Channels Active for PRI, T1CAS gateways. For a Cisco Unified Communications Manager cluster configuration, the chart displays the data for the entire Cisco Unified Communications Manager cluster. The chart comprises eight lines, two lines each for the number of Ports In Service for MGCP FXO and FXS, and two lines each for the number of Active Ports for MGCP FXO and FXS. Four more lines for the number of Spans In Service and Channels Active for PRI and T1CAS gateways exist. For a Cisco Unified Communications Manager cluster configuration, each line represents the cluster value, which is the sum of the values for all servers in the cluster (for which data is available). Each data value in the chart represents the total Number of Ports In Service, Number of Active Ports, Spans In Service or Channels Active for a 15-minute duration. If no data exists for the number of Spans In Service or the Channels Active for a gateway (MGCP PRI, T1CAS) for all servers, Reporter does not generate the line that represents data for that particular gateway.
This figure shows a line chart representing the MGCP gateways.

**Figure 15: Line Chart That Depicts MGCP Gateways**

![MGCP Gateways Chart](image)

**Trunk Call Activity for the Cluster**

A line chart displays the number of calls that were completed and calls that were attempted in an hour for SIP trunk and H.323 trunk. For a Cisco Unified Communications Manager cluster configuration, the chart displays the number of calls that were completed and calls that were attempted for the entire Cisco Unified Communications Manager cluster. The chart comprises four lines, two for the number of calls that were completed for each SIP and H.323 trunk (for which data is available) and two for the number of calls that were attempted. For a Cisco Unified Communications Manager cluster configuration, each line represents the cluster value, which is the sum of the values for all nodes in the cluster (for which data is available). Each data value in the chart represents the total number of calls that were completed or number of calls that were attempted for a 15-minute duration. If no data exists for a trunk, Reporter does not generate the line that represents data for the calls that were completed or the calls that were attempted for that particular trunk. If no data exists for both trunk types, Reporter does not generate the chart.

This figure shows a line chart representing the trunk call activity for a Cisco Unified Communications Manager cluster.

**Figure 16: Line Chart That Depicts Trunk Call Activity for the Cluster**

![Trunk Call Activity Chart](image)
The server (or each server in a Cisco Unified Communications Manager cluster configuration) contains log files that match the file name pattern CallLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- Calls that were attempted and calls that were completed for Cisco Unified Communications Manager (or for each server in a Cisco Unified Communications Manager cluster)
- Calls that were attempted and calls that were completed for the H.323 gateways (or for the gateways in each server in a Cisco Unified Communications Manager cluster)
- Calls that were completed for the MGCP FXO, FXS, PRI, and T1CAS gateways (or for the gateways in each server in a Cisco Unified Communications Manager cluster)
- Ports in service, active ports for MGCP FXO and FXS gateways and spans in service, channels active for PRI, and T1CAS gateways (in each server in a Cisco Unified Communications Manager cluster)
- Calls that were attempted and calls that were completed for H.323 trunks and SIP trunks

**Alert summary report**

The Alert Summary Report provides the details of alerts that are generated for the day. The Alert report comprises the charts shown.

In a Cisco Unified Communications Manager Business Edition 5000 system, the Server Statistics Report supports both Cisco Unified Communications Manager and Cisco Unity Connection.

**Number of Alerts per Server**

Unified CM only: A pie chart provides the number of alerts per Cisco Unified Communications Manager node. The chart displays the serverwide details of the alerts that are generated. Each sector of the pie chart represents the number of alerts generated for a particular server in the Cisco Unified Communications Manager cluster. The chart includes as many number of sectors as there are servers (for which Reporter generates alerts in the day) in the cluster. If no data exists for a server, no sector in the chart represents that server. If no data exists for all servers, Reporter does not generate the chart. The message “No alerts were generated for the day” displays.

Unified CM BE and Connection only: A pie chart provides the number of alerts for the server. The chart displays the serverwide details of the alerts that are generated. If no data exists for the server, Reporter does not generate the chart. The message “No alerts were generated for the day” displays.
The following chart shows a pie chart example that represents the number of alerts per server in a Cisco Unified Communications Manager cluster.

**Figure 17: Pie Chart That Depicts Number of Alerts Per Server**

![Pie Chart](image)

Number of Alerts per Severity for the Cluster

A pie chart displays the number of alerts per alert severity. The chart displays the severity details of the alerts that are generated. Each sector of the pie chart represents the number of alerts that are generated of a particular severity type. The chart provides as many number of sectors as there are severities (for which Reporter generates alerts in the day). If no data exists for a severity, no sector in the chart represents that severity. If no data exists, Reporter does not generate the chart.

The following chart shows a pie chart example that represents the number of alerts per severity for a Cisco Unified Communications Manager cluster.

**Figure 18: Pie Chart That Depicts Number of Alerts Per Severity for the Cluster**

![Pie Chart](image)

Top 10 Alerts in the Cluster

A bar chart displays the number of alerts of a particular Alert Type. The chart displays the details of the alerts that are generated on the basis of the alert type. Each bar represents the number of alerts for an alert type. The
chart displays details only for the first 10 alerts based on the highest number of alerts in descending order. If no data exists for a particular alert type, no bar represents that alert. If no data exists for any alert type, RTMT does not generate the chart.

The following chart shows a bar chart example that represents the top 10 alerts in a Cisco Unified Communications Manager cluster.

**Figure 19: Bar Chart That Depicts Top 10 Alerts in the Cluster**

The server (or each server in a Cisco Unified Communications Manager cluster) contains log files that match the file name pattern AlertLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- Time - Time at which the alert occurred
- Alert Name - Descriptive name
- Node Name - Server on which the alert occurred
- Monitored object - The object that is monitored
- Severity - Severity of this alert

**Performance protection report**

The Performance Protection Report does not apply to Cisco Unity Connection.

The Performance Protection Report provides a summary that comprises different charts that display the statistics for that particular report. Reporter generates reports once a day on the basis of logged information.

The Performance Protection Report provides trend analysis information on default monitoring objects for the last seven that allows you to track information about Cisco Intercompany Media Engine. The report includes the Cisco IME Client Call Activity chart that shows the total calls and fallback call ratio for the Cisco IME client.

The Performance Protection report comprises the following charts:

- Cisco Unified Communications Manager Call Activity, on page 86
- Number of registered phones and MGCP gateways, on page 86
For a Cisco Unified Communications Manager Business Edition 5000 system, the Server Statistics Report supports Cisco Unified Communications Manager only.

**Cisco Unified Communications Manager Call Activity**

A line chart displays the hourly rate of increase or decrease for number of calls that were attempted and calls that were completed as the number of active calls. For a Cisco Unified Communications Manager cluster configuration, the data is charted for each server in the cluster. The chart comprises three lines, one for the number of calls that were attempted, one for the calls that were completed, and one for the active calls. If no data exists for call activity, Reporter does not generate the chart.

**Number of registered phones and MGCP gateways**

A line chart displays the number of registered phones and MGCP gateways. For a Cisco Unified Communications Manager cluster configuration, the chart displays the data for each server in the cluster. The chart comprises two lines, one for the number of registered phones and another for the number of MGCP gateways. If no data exists for phones or MGCP gateways, Reporter does not generate the chart.

**System Resource Utilization**

A line chart displays the CPU load percentage and the percentage of memory that is used (in bytes) for the server (or for the whole cluster in a Cisco Unified Communications Manager cluster configuration). The chart comprises two lines, one for the CPU load and one for the memory usage. In a Cisco Unified Communications Manager cluster, each line represents the cluster value, which is the average of the values for all the servers in the cluster (for which data is available). If no data exists for phones or MGCP gateways, Reporter does not generate the chart.

**Device and Dial Plan Quantities**

Two tables display information from the Cisco Unified Communications Manager database about the numbers of devices and number of dial plan components. The device table shows the number of IP phones, Unity connection ports, H.323 clients, H.323 gateways, MGCP gateways, MOH resources, and MTP resources. The dial plan table shows the number of directory numbers and lines, route patterns, and translation patterns.

### Set up serviceability reports archive

The following steps provide information for configuring the serviceability report archive feature.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Activate the Cisco Serviceability Reporter service.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Configure the Cisco Serviceability Reporter service parameters.</td>
</tr>
<tr>
<td>Step 3</td>
<td>View the reports that the Cisco Serviceability Reporter service generates.</td>
</tr>
</tbody>
</table>
### Configuring services

This section provides information on configuring services.

#### Activate feature services

You activate and deactivate feature services in the Service Activation window in Cisco Unified Serviceability. Services that display in the Service Activation window do not start until you activate them.

Cisco Unified Serviceability allows you to activate and deactivate only features services (not network services). You may activate or deactivate as many services as you want at the same time. Some feature services depend on other services, and the dependent services get activated before the feature service activates.

**Tip**
Unified CM only: Before you activate services in the Service Activation window, review [Cluster service activation recommendations](#), on page 88.

To activate or deactivate feature services in Cisco Unified Serviceability, perform the following procedure:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose <strong>Tools &gt; Service Activation</strong>. The Service Activation window displays.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>From the Server drop-down list box, choose the server where you want to activate the service; then, click <strong>Go</strong>. For the server that you chose, the window displays the service names and the activation status of the services.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>To activate all services in the Service Activation window, check the <strong>Check All Services</strong> check box.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>You can choose all services that are required to run on a single server by clicking the <strong>Set Default</strong> button. This action not only chooses all required services but also checks for service dependencies. To activate services for a single-server configuration, click the <strong>Set Default</strong> button or activate the services that you want to use.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Unified CM only: For a cluster configuration, review <a href="#">Cluster service activation recommendations</a>, on page 88 for service activation recommendations; then, check the check boxes next to the services that you want to activate.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>After you check the check boxes for the services that you want to activate, click <strong>Save</strong>. <strong>Tip</strong> To deactivate services that you activated, uncheck the check boxes next to the services that you want to deactivate; then, click <strong>Save</strong>. <strong>Tip</strong> To obtain the latest status of the services, click the <strong>Refresh</strong> button.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Activate feature services, on page 87
- Serviceability reporter service parameters, on page 69
Cluster service activation recommendations

This section does not apply to Cisco Unified Communications Manager Business Edition 5000 or Cisco Unity Connection.

Before you activate services in a cluster, review Table 25: Service Activation Recommendations, on page 88, which provides service recommendations for multiserver configurations.

Table 25: Service Activation Recommendations

<table>
<thead>
<tr>
<th>Service/Servlet</th>
<th>Activation Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM Services</td>
<td>This service supports Cisco Unified Communications Manager. In the Control Center - Network Services, ensure that the Cisco RIS Data Collector service and Database Layer Monitor service are running on the node.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Before you activate this service, verify that the Cisco Unified Communications Manager server displays in the Cisco Unified Communications Manager Find/List window in Cisco Unified Communications Manager Administration. If the server does not display, add the Cisco Unified Communications Manager server before you activate this service. For information on how to add the Cisco Unified Communications Manager server, refer to the Cisco Unified Communications Manager Administration Guide.</td>
</tr>
<tr>
<td>Cisco Messaging Interface</td>
<td>Activate only if using an SMDI integration to a 3rd party Voicemail system using a server-attached USB-to-serial adapter.</td>
</tr>
<tr>
<td>Cisco Unified Mobile Voice Access Service</td>
<td>For mobile voice access to work, you must activate this service on the first node in the cluster after you configure the H.323 gateway to point to the first VXML page. In addition, make sure that the Cisco CallManager and the Cisco TFTP services run on one server in the cluster, not necessarily the same server where the Cisco Unified Mobile Voice Access Service runs.</td>
</tr>
<tr>
<td>Cisco IP Voice Media Streaming App</td>
<td>If you have more than one node in the cluster, activate on one or two servers per cluster. You may activate on a node that is dedicated specifically for music on hold. This service requires that you activate Cisco TFTP on one node in the cluster. Do not activate this service on the first node or on any nodes that run the Cisco CallManager service.</td>
</tr>
<tr>
<td>Cisco CTIManager</td>
<td>Activate on each node to which JTAPI/TAPI applications will connect. CTIManager activation requires the Cisco CallManager service also to be activated on the node. See the CM services, on page 54 for more information on CTIManager and Cisco CallManager services interaction.</td>
</tr>
<tr>
<td>Cisco Extension Mobility</td>
<td>Activate on all nodes in the cluster.</td>
</tr>
<tr>
<td>Cisco Extended Functions</td>
<td>Activate this service, which supports the Quality Report Tool (QRT), on one or more servers that run the Cisco RIS Data Collector. Make sure that you activate the Cisco CTIManager service on a node in the cluster.</td>
</tr>
<tr>
<td>Service/Servlet</td>
<td>Activation Recommendations</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cisco DHCP Monitor Service</td>
<td>When the DHCP Monitor service is enabled, it detects changes in the database that affect IP addresses for the IP phones, modifies the /etc/dhcpd.conf file, and stops and restarts the DHCPD daemon with the updated configuration file. Activate this service on the node that has DHCP enabled.</td>
</tr>
<tr>
<td>Cisco Dialed Number Analyzer Server</td>
<td>If you have more than one node in the cluster, activate this service on one node that is dedicated specifically for the Cisco Dialed Number Analyzer service.</td>
</tr>
<tr>
<td>Cisco Dialed Number Analyzer</td>
<td>If you are planning to use Cisco Unified Communications Manager Dialed Number Analyzer, activate this service. This service may consume a lot of resources, so only activate this service on the node with the least amount of call-processing activity or during off-peak hours.</td>
</tr>
<tr>
<td>Cisco TFTP</td>
<td>If you have more than one node in the cluster, activate this service on one node that is dedicated specifically for the Cisco TFTP service. Configure Option 150 if you activate this service on more than one node in the cluster.</td>
</tr>
<tr>
<td>CTI Services</td>
<td></td>
</tr>
<tr>
<td>Cisco IP Manager Assistant</td>
<td>If you are planning to use Cisco Unified Communications Manager Assistant, activate this service on any two servers (Primary and Backup) in the cluster. Ensure that Cisco CTI Manager service is activated in the cluster. Refer to Cisco Unified Communications Manager Features and Services Guide for other recommendations.</td>
</tr>
<tr>
<td>Cisco WebDialer Web Service</td>
<td>Activate on one node per cluster.</td>
</tr>
<tr>
<td>CDR Services</td>
<td></td>
</tr>
<tr>
<td>Cisco SOAP-CDROnDemand Service</td>
<td>You can activate the Cisco SOAP-CDROnDemand Service only on the first server, and it requires that the Cisco CDR Repository Manager and Cisco CDR Agent services are running on the same server.</td>
</tr>
<tr>
<td>Cisco CAR Web Service</td>
<td>You can activate the Cisco CAR Web Service only on the first server, and it requires that the Cisco CAR Scheduler service is activated and running on the same server and that the CDR Repository Manager service also is running on the same server.</td>
</tr>
<tr>
<td>Database and Admin Services</td>
<td></td>
</tr>
<tr>
<td>Cisco AXL Web Service</td>
<td>Activate on the first node only. Failing to activate this service causes the inability to update Cisco Unified Communications Manager from client-based applications that use AXL.</td>
</tr>
<tr>
<td>Cisco Bulk Provisioning Service</td>
<td>You can activate the Cisco Bulk Provisioning Service only on the first node. If you use the Bulk Administration Tool (BAT) to administer phones and users, you must activate this service.</td>
</tr>
<tr>
<td>Service/Servlet</td>
<td>Activation Recommendations</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cisco TAPS Service</td>
<td>Before you can use the Cisco Unified Communications Manager Auto-Register Phone Tool, you must activate this service on the first node. When you create dummy MAC addresses for the Cisco Unified Communications Manager Auto-Register Phone Tool, ensure that the Cisco Bulk Provisioning Service is activated on the same node.</td>
</tr>
<tr>
<td>Performance and Monitoring Services</td>
<td></td>
</tr>
<tr>
<td>Cisco Serviceability Reporter</td>
<td>Activate on only the first node.</td>
</tr>
<tr>
<td>Note</td>
<td>The service only generates reports on the first node even if you activate the service on other nodes.</td>
</tr>
<tr>
<td>Cisco CallManager SNMP Service</td>
<td>If you use SNMP, activate this service on all servers in the cluster.</td>
</tr>
<tr>
<td>Security Services</td>
<td></td>
</tr>
<tr>
<td>Cisco CTL Provider</td>
<td>Activate on all servers in the cluster.</td>
</tr>
<tr>
<td>Cisco Certificate Authority</td>
<td>Activate on only the first node.</td>
</tr>
<tr>
<td>Proxy Function (CAPF)</td>
<td></td>
</tr>
<tr>
<td>Directory Services</td>
<td></td>
</tr>
<tr>
<td>Cisco DirSync</td>
<td>Activate only on the first node.</td>
</tr>
</tbody>
</table>

### Set up status of services

Unified CM only: Control Center in Cisco Unified Serviceability allows you to view status, refresh the status, and to start, stop, and restart feature and network services.

Unified CM only: Starting, stopping, or restarting a service causes all Cisco Unified IP Phones and gateways that are currently registered to that service to fail over to their secondary Cisco CallManager service. Devices and phones need to restart only if they cannot register with another service.

Unified CM and Unified CM BE only: Starting, stopping, or restarting a service causes other installed applications (such as conference bridge or Cisco Messaging Interface) that are homed to the Cisco Unified Communications Manager to start and stop as well.

Note: Unified CM only: If you are upgrading Cisco Unified Communications Manager, those services that were already started on your system automatically start after the upgrade.
Unified CM and Unified CM BE only: Stopping a service also stops call processing for all devices that the service controls. When a service is stopped, calls from an IP phone to another IP phone stay up; calls in progress from an IP phone to a Media Gateway Control Protocol (MGCP) gateway also stay up, and other types of calls get dropped.

Perform the following procedure to start, stop, restart, or view the status of services for a server (or for a server in a cluster in a Cisco Unified Communications Manager cluster configuration). You can start, stop, or refresh only one service at a time. Be aware that when a service is stopping, you cannot start it until after the service is stopped. Likewise, when a service is starting, you cannot stop it until after the service is started.

**Procedure**

**Step 1**
Depending on the service type that you want to start/stop/restart/refresh, perform one of the following tasks:

a) Choose **Tools > Control Center - Feature Services**.
   
   **Tip** Before you can start/stop/restart a feature service, it must be activated. To activate a service, see the [Activate feature services](#) on page 87.

b) Choose **Tools > Control Center - Network Services**.

**Step 2**
From the Server drop-down list box, choose the server; then, click **Go**.

The window displays the following items:

a) The service names for the server that you chose.

b) The service group.

c) The service status; for example, Started, Running, Not Running, and so on. (Status column)

d) The exact time that the service started running. (Start Time column)

e) The amount of time that the service has been running. (Up Time column)

**Step 3**
Perform one of the following tasks:

a) Click the radio button next to the service that you want to start and click the **Start** button.
   
   The Status changes to reflect the updated status.

b) Click the radio button next to the service that you want to stop and click the **Stop** button.
   
   The Status changes to reflect the updated status.

c) Click the radio button next to the service that you want to restart and click the **Restart** button.
   
   A message indicates that restarting may take a while. Click **OK**.

d) To get the latest status of the services, click the **Refresh** button.

e) To go to the Service Activation window or to the other Control Center window, choose an option from the Related Links drop-down list box and click **Go**.

**Command line interface**

You can start and stop some services through the Command Line Interface (CLI). For a list of services that you can start and stop through the CLI and for information on how to perform these tasks, refer to the Command Line Interface Reference Guide for Cisco Unified Solutions.
You must start and stop most services from Control Center in Cisco Unified Serviceability.

Set up Serviceability Reports Archive

The Cisco Serviceability Reporter service generates daily reports in Cisco Unified Serviceability. Each report provides a summary that comprises different charts that display the statistics for that particular report. Reporter generates reports once a day on the basis of logged information.

This section describes how to use the Serviceability Reports Archive window.

Before You Begin

Activate the Cisco Serviceability Reporter service, which is CPU intensive. After you activate the service, report generation may take up to 24 hours.

Unified CM only: Cisco recommends that you activate the service on a non-call processing server.

Procedure

Step 1 Choose **Tools > Serviceability Reports Archive**.

The Serviceability Reports Archive window displays the month and year for which the reports are available.

Step 2 From the Month-Year pane, choose the month and year for which you want to display reports.

A list of days that correspond to the month displays.

Step 3 To view reports, click the link that corresponds to the day for which reports were generated.

The report files for the day that you chose display.

Step 4 To view a particular PDF report, click the link of the report that you want to view.

Tip If you browsed into Cisco Unified Serviceability by using the server name, you must log in to Cisco Unified Serviceability before you can view the report.

If your network uses Network Address Translation (NAT) and you are trying to access serviceability reports inside the NAT, enter the IP address for the private network that is associated with the NAT in the browser URL. If you are trying to access the reports outside the NAT, enter the public IP address, and NAT will accordingly translate/map to the private IP address.

To view PDF reports, you must install Acrobat® Reader on your machine. To download Acrobat® Reader, click the link at the bottom of the Serviceability Reports Archive window.

A window opens and displays the PDF file of the report that you chose.

CDR Repository Manager

Use the CDR Management Configuration window to set the amount of disk space to allocate to call detail record (CDR) and call management record (CMR) files, configure the number of days to preserve files before deletion, and configure up to three billing application server destinations for CDRs. The CDR repository manager service repeatedly attempts to deliver CDR and CMR files to the billing servers that you configure.
in the CDR Management Configuration window until it delivers the files successfully, until you change or
delete the billing application server on the CDR Management Configuration window, or until the files fall
outside the preservation window and are deleted.

Unified CM BE only: The CDR and CMR files get offloaded to the external billing application servers by
using the time interval that you have previously specified in the **CDR File Time Interval** enterprise parameter
in Cisco Unified Communications Manager. After the Communications Manager generates the files, the CDR
Agent and CDR Repository Manager take over. On each Communications Manager server, the CDR agent
pushes the CDR flat files to the publisher. The CDR Repository Manager pushes the files to the external
billing application servers.

---

**Note**

To access the Enterprise Parameters Configuration window, open Cisco Unified Communications Manager
Administration and choose **System > Enterprise Parameters**. The **CDR File Time Interval** parameter
specifies the time interval for collecting CDR data. For example, if this value is set to 1, each file will
contain 1 minute of CDR data (CDRs and CMRs, if enabled). The external billing server and CAR database
will not receive the data in each file until the interval has expired, so consider how quickly you want access
to the CDR data when you decide what interval to set for this parameter. For example, setting this parameter
to 60 means that each file will contain 60 minutes worth of data, but that data will not be available until
the 60-minute period has elapsed, and the records are written to the CAR database. and the CDR files are
sent to the configured billing server(s). The default value equals 1. The minimum value specifies 1, and
the maximum value specifies 1440. The unit of measure for this required field represents a minute.

Both the CDR Agent and the CDR Repository Manager process files with an interval that is independent of
the CDR File Time Interval. The CDR Repository Manager sends all existing CDR files to the billing application
servers, sleeps for 6 seconds before checking the new files to send, and continues that 6-second interval. If
the destination (the external billing application servers) does not respond, the system attempts the process
again by using a doubled length of the sleep interval (12 seconds). Each delivery failure results in double the
sleep time (6, 12, 24, 48, and so on, seconds) until 2 minutes occurs, then stays at 2-minute intervals until
successful delivery occurs. After successful delivery, the 6-second interval automatically resumes.

Users cannot configure the 6-second processing time, with the sleep time interval doubling in case of failure.
Users can configure only the **CDR File Time Interval** enterprise parameter. No alert gets sent after the first
file delivery failure. By default, the system generates the CDRFileDeliveryFailed alert after the second delivery
failure of the Cisco CDR Repository Manager service to deliver files to any billing application server. You
can configure the alert to send you an e-mail or to page you. For information on configuring alerts, see the
“Working with Alerts” chapter in the *Cisco Unified Real-Time Monitoring Tool Administration Guide*.

The system generates the CDRFileDeliveryFailureContinues syslog alarm upon subsequent failures to deliver
the files to the billing application servers.

The CDR Agent behaves in almost the same manner. First, it sends all the existing CDR files to the publisher. If
no additional files to send exist, the CDR Agent sleeps for 6 seconds before checking for new files. Each
delivery failure results in the immediate change of the sleep interval to 1 minute, then says at 1-minute intervals
until successful delivery. After the first successful delivery of files, the 6-second interval resumes.

The system sends no alert after the first file delivery failure by the CDR Agent. By default, the system generates
the CDRAgentSendFileFailed alert after the second delivery failure of the CDR Agent. You can configure
the alert to send you an e-mail or to page you. For information on configuring alerts, see the “Working with
Alerts” chapter in the *Cisco Unified Real-Time Monitoring Tool Administration Guide*.

The system generates the CDRAgentSendFileFailedContinues syslog alarm upon subsequent failures to deliver
the files.
If you need to start or restart the file transfer timer for any reason, you can restart the Cisco CDR Repository Manager or CDR Agent process by going to the Cisco Unified Serviceability window and selecting **Tools > Control Center > Network Services**.

When you enable the file deletion based on high water mark parameter, the CDR repository manager service monitors the amount of disk space that CDR and CMR files use. If disk usage exceeds the high water mark that you configure, the system purges the CDR and CMR files that have been successfully delivered to all destinations and loaded into the CAR database (if CAR is activated) until the disk space reaches the low water mark or the system deletes all successfully delivered files. If disk usage still exceeds the high water mark after the system deletes all successfully delivered files, it does not delete any more files, unless the disk usage still exceeds the disk allocation that you configure. If the disk usage still exceeds the disk allocation that you configure, the system purges files beginning with the oldest, regardless of whether the files fall within the preservation window or have been successfully delivered, until the disk usage falls below the high water mark.

---

**Note**

Regardless of whether you enable the deletion of files based on the high water mark parameter, if disk usage exceeds the disk allocation that you configure, the CDR repository manager service deletes CDR and CMR files, beginning with the oldest, until disk utilization falls below the high water mark.

The Cisco Log Partition Monitoring Tool service monitors the disk usage of CDR and CMR flat files that have not been delivered to the CDR repository manager.

Unified CM only: If the disk usage of the log partition on a server exceeds the configured limit and the service has deleted all other log and trace files, the log partition monitor service deletes CDR/CMR files on the subsequent nodes that have not been delivered to the CDR repository manager.

For more information on log partition monitoring, refer to the *Cisco Unified Real-Time Monitoring Tool Administration Guide*.

### Set up general parameters

To set disk utilization and file preservation parameters for CDRs, perform the following procedure:

**Procedure**

---

**Step 1**

Choose **Tools > CDR Management**.

The CDR Management window displays.

**Step 2**

Click the CDR Manager general parameter value that you want to change.

**Step 3**

Enter the appropriate parameters, as described in Table 26: CDR Repository Manager General Parameter Settings, on page 95.

**Step 4**

Click **Update**.

**Tip**

At any time, you can click **Set Default** to specify the default values. After you set the defaults, click **Update** to save the default values.

---

If you need to start or restart the file transfer timer for any reason, you can restart the Cisco CDR Repository Manager or CDR Agent process by going to the Cisco Unified Serviceability window and selecting **Tools > Control Center > Network Services**.

When you enable the file deletion based on high water mark parameter, the CDR repository manager service monitors the amount of disk space that CDR and CMR files use. If disk usage exceeds the high water mark that you configure, the system purges the CDR and CMR files that have been successfully delivered to all destinations and loaded into the CAR database (if CAR is activated) until the disk space reaches the low water mark or the system deletes all successfully delivered files. If disk usage still exceeds the high water mark after the system deletes all successfully delivered files, it does not delete any more files, unless the disk usage still exceeds the disk allocation that you configure. If the disk usage still exceeds the disk allocation that you configure, the system purges files beginning with the oldest, regardless of whether the files fall within the preservation window or have been successfully delivered, until the disk usage falls below the high water mark.

---

**Note**

Regardless of whether you enable the deletion of files based on the high water mark parameter, if disk usage exceeds the disk allocation that you configure, the CDR repository manager service deletes CDR and CMR files, beginning with the oldest, until disk utilization falls below the high water mark.

The Cisco Log Partition Monitoring Tool service monitors the disk usage of CDR and CMR flat files that have not been delivered to the CDR repository manager.

Unified CM only: If the disk usage of the log partition on a server exceeds the configured limit and the service has deleted all other log and trace files, the log partition monitor service deletes CDR/CMR files on the subsequent nodes that have not been delivered to the CDR repository manager.

For more information on log partition monitoring, refer to the *Cisco Unified Real-Time Monitoring Tool Administration Guide*.

### Set up general parameters

To set disk utilization and file preservation parameters for CDRs, perform the following procedure:

**Procedure**

---

**Step 1**

Choose **Tools > CDR Management**.

The CDR Management window displays.

**Step 2**

Click the CDR Manager general parameter value that you want to change.

**Step 3**

Enter the appropriate parameters, as described in Table 26: CDR Repository Manager General Parameter Settings, on page 95.

**Step 4**

Click **Update**.

**Tip**

At any time, you can click **Set Default** to specify the default values. After you set the defaults, click **Update** to save the default values.

---
**General parameter settings**

The following table describes the available settings in the General Parameters section of the CDR Management Configuration window.

**Table 26: CDR Repository Manager General Parameter Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk Allocation (MB)</td>
<td>Choose the number of megabytes that you want to allocate to CDR and CMR flat file storage. The default disk allocation and range vary depending on the size of the server hard drive.</td>
</tr>
</tbody>
</table>

**Note**

The maximum CAR database size equals 6 GB for a Cisco Unified Communications Manager server and 3 GB for a Cisco Unified Communications Manager Business Edition 5000 server.

If disk usage exceeds the allocated maximum disk space for CDR files, the system generates the CDRMaximumDiskSpaceExceeded alert and deletes all successfully processed files (those delivered to billing servers and loaded to CAR). If disk usage still exceeds the allocated disk space, the system deletes undelivered files and files within the preservation duration, starting with the oldest, until disk utilization falls below the high water mark.

If you have a large system and do not allocate enough disk space, the system may delete the CDR and CMR files before the CAR Scheduler loads the files into the CAR database. For example, if you configure the CAR Scheduler to run once a day and you set the disk allocation to a value that is not large enough to hold the CDR and CMR files that are generated in a day, the system will delete the files before they are loaded into the CAR database.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| High Water Mark (%)                          | This field specifies the maximum percentage of the allocated disk space for CDR and CMR files. For example, if you choose 2000 megabytes from the Disk Allocation field and 80% from the High Water Mark (%) field, the high water mark equals 1600 megabytes. In addition to the high water mark percentage, the number of CDRs in the CAR database cannot exceed two million records for a Cisco Unified Communications Manager server and one million records for a Cisco Unified Communications Manager Business Edition 5000 server.  
When the disk usage exceeds the percentage that you specify, or the total number of CDRs is exceeded, and the Disable CDR/CMR Files Deletion Based on HWM check box is unchecked, the system automatically purges all successfully processed CDR and CMR files (those delivered to billing servers and loaded to CAR) beginning with the oldest files to reduce disk usage to the amount that you specify in the Low Water Mark (%) drop-down list box.  
If the disk usage still exceeds the low water mark or high water mark, the system does not delete any undelivered or unloaded files, unless the disk usage exceeds the disk allocation.  
If you check the Disable CDR/CMR Files Deletion Based on HWM check box, the system does not delete CDRs and CMRs based on the percentage that you specify in this field.  
**Note** If CDR disk space exceeds the high water mark, the system generates the CDRHWMExceeded alert.                                                                                                                                                                                                                                                                                                                                                      |
| Low Water Mark (%)                           | This field specifies the percentage of disk space that is allocated to CDR and CMR files that is always available for use. For example, if you choose 2000 megabytes from the Disk Allocation field and 40% from the Low Water Mark (%) field, the low water mark equals 800 megabytes.                                                                                                                                                                                                                                                                                                                                                                      |
| CDR / CMR Files Preservation Duration (Days) | Choose the number of days that you want to retain CDR and CMR files. The CDR Repository Manager deletes files that fall outside the preservation window.  
**Note** If you continuously receive the CDRMaximumDiskSpaceExceeded alarm, you either must increase the disk allocation or lower the number of preservation days.                                                                                                                                                                                                                                                                                                                                                     |
| Disable CDR/CMR Files Deletion Based on HWM  | **Note** Regardless of whether you enable the deletion of files based on the high-water mark parameter, if disk usage exceeds the disk allocation that you configure, the maximum database size, or the maximum number of records for your installation, the CDR repository manager service deletes CDR and CMR files, beginning with the oldest files, until disk utilization falls below the high water mark.  
If you do not want to delete CDRs and CMRs even if disk usage exceeds the percentage that you specify in the High Water Mark (%) field, check this check box. By default, this check box remains unchecked, so the system deletes CDRs and CMRs if disk usage exceeds the high water mark.                                                                                                                                                                                                                   |
| CDR Repository Manager Host Name             | This field lists the host name of the CDR repository manager server.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
**Set up application billing servers**

Use the following procedure to configure application billing servers to which you want to send CDRs. You can configure up to three billing servers.

**Procedure**

**Step 1** Choose Tools > CDR Management Configuration. The CDR Management Configuration window displays.

**Step 2** Perform one of the following tasks:
   a) To add a new application billing server, click the Add New button.
   b) To update an existing application billing server, click the server hostname/IP address.

**Step 3** Enter the appropriate settings, as described in Table 27: Application Billing Server Parameter Settings, on page 97.

**Step 4** Click Add or Update.

---

**Application billing server parameter settings**

The following table describes the available settings in the Billing Application Server Parameters section of the CDR Management Configuration window.

**Table 27: Application Billing Server Parameter Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Host Name/IP Address   | Enter the host name or IP address of the application billing server to which you want to send CDRs. If you change the value in this field, a prompt asks whether you want to send the undelivered files to the new destination. Perform one of the following tasks:  
   • To deliver the files to the new server, click Yes.  
   • To change the server host name/IP address without sending undelivered files, click No. The CDR Management service marks the CDR and CMR files as successfully delivered. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Enter the user name of the application billing server.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Choose the protocol, either FTP or SFTP, that you want to use to send the CDR files to the configured billing servers.</td>
</tr>
<tr>
<td>Directory Path</td>
<td>Enter the directory path on the application billing server to which you want to send the CDRs. You should end the path that you specify with a “/” or “\”, depending on the operating system that is running on the application billing server. <strong>Note</strong>: Make sure the FTP user has write permission to the directory.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that is used to access the application billing server.</td>
</tr>
<tr>
<td>Resend on Failure</td>
<td>When you check the Resend on Failure box, this option informs CDRM to send outdated CDR and CMR files to the billing server after the FTP or SFTP connection is restored. When the box is checked, the Resend on Failure flag is set to True. When the box is not checked, the Resend on Failure flag is set to False.³</td>
</tr>
<tr>
<td>Generate New Key</td>
<td>Click on the Reset button to generate new keys and reset the connection to the SFTP server.</td>
</tr>
</tbody>
</table>

There are several different scenarios that can occur. When the billing server Resend on Failure flag is set to True, all CDR files get moved to the billing server. When the Resend On Failure flag is set to False, CDR files that get generated during shutdown of the billing server get moved to the processed folder, but do not get moved to the billing server. When the Resend on Failure flag gets set to True at the beginning, and then gets changed several times, the result is that the CDR files get moved to the billing server whenever the Resend on Failure box gets checked.

**Delete application billing servers**

Use the following procedure to delete an application billing server.

**Procedure**

**Step 1** Choose **Tools > CDR Management**.

The CDR Management Configuration window displays.

**Step 2** Check the check box next to the application billing server that you want to delete and click **Delete Selected**.

A message displays that indicates that if you delete this server, any CDR or CMR files that have not been sent to this server will not be delivered to this server and will be treated as successfully delivered files.

**Tip** When you delete a server, the system does not generate the CDRFileDeliveryFailed alert for the files that are not sent to that server.
Step 3  To complete the deletion, click OK.

Audit logs

With audit logging, configuration changes to the Cisco Unified Communications Manager or Cisco Unity Connection system get logged in separate log files for auditing.

Audit logging

With audit logging, configuration changes to the Cisco Unified Communications Manager or Cisco Unity Connection system get logged in separate log files for auditing. The Cisco Audit Event Service, which displays under Control Center - Network Services in Cisco Unified Serviceability, monitors and logs any configuration change to the Cisco Unified Communications Manager or Cisco Unity Connection system by a user or as a result of the user action. For a Cisco Unified Communications Manager Business Edition 5000 system, this service supports both Cisco Unified Communications Manager and Cisco Unity Connection.

You access the Audit Log Configuration window in Cisco Unified Serviceability to configure the settings for the audit logs.

Audit logging contains the following parts:

- **Audit logging framework** - The framework comprises an API that uses an alarm library to write audit events into audit logs. An alarm catalog that is defined as GenericAlarmCatalog.xml applies for these alarms. Different Cisco Unified Communications Manager or Cisco Unity Connection components provide their own logging.

  The following example displays an API that a Cisco Unified Communications Manager component can use to send an alarm:

  ```
  User ID: CCMAdministratorClient IP Address: 172.19.240.207
  Severity: 3
  EventType: ServiceStatusUpdated
  ResourceAccessed: CCMService
  EventStatus: Successful
  Description: CallManager Service status is stopped
  ```

- **Audit event logging** - An audit event represents any event that is required to be logged. The following example displays a sample audit event:

  ```
  CCM_TOMCAT-GENERIC-3-AuditEventGenerated: Audit Event Generated
  UserID: CCMAdministrator Client IP Address: 172.19.240.207 Severity: 3
  EventType: ServiceStatusUpdated ResourceAccessed: CCMService
  EventStatus: Successful Description: Call Manager Service status is stopped App ID: Cisco Tomcat Cluster ID: StandAloneCluster Node ID: sa-cml-3
  ```
Be aware that audit event logging is centralized and enabled by default. An alarm monitor called Syslog Audit writes the logs. By default, the logs are configured to rotate. If the AuditLogAlarmMonitor cannot write an audit event, the AuditLogAlarmMonitor logs this failure as a critical error in the syslog file. The Alert Manager reports this error as part of a SeverityMatchFound alert. The actual operation continues even if the event logging fails. All audit logs get collected, viewed and deleted from Trace and Log Central in the Cisco Unified Real-Time Monitoring Tool.

Cisco Unified Serviceability logs the following events:

- Activation, deactivation, start, or stop of a service.
- Changes in trace configurations and alarm configurations.
- Changes in SNMP configurations.
- Changes in CDR management. (Cisco Unified Communications Manager only)
- Review of any report in the Serviceability Reports Archive. This log gets viewed on the reporter node. (Cisco Unified Communications Manager only)

Cisco Unified Real-Time Monitoring Tool logs the following events with an audit event alarm:

- Alert configuration.
- Alert suspension.
- E-mail configuration.
- Set node alert status.
- Alert addition.
- Add alert action.
- Clear alert.
- Enable alert.
- Remove alert action.
- Remove alert.

Cisco Unified Communications Manager CDR Analysis and Reporting

Cisco Unified Communications Manager CDR Analysis and Reporting (CAR) creates audit logs for these events:

- Loader scheduling.
- Daily, weekly, and monthly reports scheduling.
- Mail parameters configuration.
- Dial plan configuration.
- Gateway configuration.
- System preferences configuration.
- Autopurge configuration.
- Rating engine configurations for duration, time of day, and voice quality.
- QoS configurations.
- Automatic generation/alert of pregenerated reports configurations.
- Notification limits configuration.

Cisco Unified Communications Manager Administration

The following events get logged for various components of Cisco Unified Communications Manager Administration:

- User logging (user logins and user logouts).
- User role membership updates (user added, user deleted, user role updated).
- Role updates (new roles added, deleted, or updated).
- Device updates (phones and gateways).
- Server configuration updates (changes to alarm or trace configurations, service parameters, enterprise parameters, IP addresses, host names, Ethernet settings, and Cisco Unified Communications Manager server additions or deletions).

Command-Line Interface

All commands issued via the command-line interface are logged (for both Cisco Unified Communications Manager and Cisco Unity Connection).

Cisco Unity Connection Administration

Cisco Unity Connection Administration logs the following events:

- User logging (user logins and user logouts).
- All configuration changes, including but not limited to users, contacts, call management objects, networking, system settings, and telephony.
- Task management (enabling or disabling a task).
- Bulk Administration Tool (bulk creates, bulk deletes).
- Custom Keypad Map (map updates)

Cisco Personal Communications Assistant (Cisco PCA)

The Cisco Personal Communications Assistant client logs the following events:

- User logging (user logins and user logouts).
- All configuration changes made via the Messaging Assistant.

Cisco Unity Connection Serviceability

Cisco Unity Connection Serviceability logs the following events:

- User logging (user logins and user logouts).
- All configuration changes.
Activating, deactivating, starting or stopping services.

Cisco Unity Connection Clients that Use the Representational State Transfer APIs

Cisco Unity Connection clients that use the Representational State Transfer (REST) APIs log the following events:

- User logging (user API authentication).
- API calls that utilize Cisco Unity Connection Provisioning Interface (CUPI).

Set up audit log

To configure the audit log, perform the following procedure:

**Procedure**

1. **Step 1** In Cisco Unified Serviceability, choose **Tools > Audit Log Configuration**. The Audit Log Configuration window displays.
2. **Step 2** Configure the settings in Table 28: Audit Log Configuration Settings, on page 103.
3. **Step 3** Click **Save**.

**Tip** At any time, you can click **Set to Default** to specify the default values. After you set the defaults, click **Save** to save the default values.

Audit log configuration settings

Table 28: Audit Log Configuration Settings, on page 103 describes the settings that you can configure in the Audit Log Configuration window in Cisco Unified Serviceability.

**Before You Begin**

Be aware that only a user with an audit role can change the audit log settings. By default, for Cisco Unified Communications Manager, the CCMAdministrator possesses the audit role after fresh installs and upgrades. The CCMAdministrator can assign any user that has auditing privileges to the Standard Audit Users group in the User Group Configuration window in Cisco Unified Communications Manager Administration. If you want to do so, you can then remove CCMAdministrator from the Standard Audit Users group.

For Cisco Unity Connection, the application administration account that was created during installation has the Audit Administrator role and can assign other administrative users to the role. You can also remove the Audit Administrator role from this account.

The Standard Audit Log Configuration role in Cisco Unified Communications Manager provides the ability to delete audit logs and to read/update access to Cisco Unified Real-Time Monitoring Tool, Trace Collection Tool, RTMT Alert Configuration, Control Center - Network Services in Cisco Unified Serviceability, RTMT Profile Saving, Audit Configuration in Cisco Unified Serviceability, and a resource that is called Audit Traces.

The Audit Administrator role in Cisco Unity Connection provides the ability to view, download and delete audit logs in Cisco Unified Real-Time Monitoring Tool.
For information on roles, users, and user groups in Cisco Unified Communications Manager, refer to the *Cisco Unified Communications Manager Administration Guide*. For information on roles and users in Cisco Unity Connection, refer to the *User Moves, Adds, and Changes Guide for Cisco Unity Connection*.

**Table 28: Audit Log Configuration Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Server</td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td>Choose the server where you want to configure audit logs; then, click <strong>Go</strong>.</td>
</tr>
<tr>
<td>Apply to All Nodes</td>
<td>If you want to apply the audit log configuration to all nodes in the cluster, check the <strong>Apply to all Nodes</strong> box.</td>
</tr>
<tr>
<td>Application Audit Log Settings</td>
<td></td>
</tr>
<tr>
<td>Enable Audit Log</td>
<td>When you enable this check box, an audit log gets created for the application audit log.</td>
</tr>
<tr>
<td></td>
<td>For Cisco Unified Communications Manager, the application audit log supports configuration updates for Cisco Unified Communications Manager graphical user interfaces (GUIs), such as Cisco Unified Communications Manager Administration, Cisco Unified Real-Time Monitoring Tool, Cisco Unified Communications Manager CDR Analysis and Reporting, and Cisco Unified Serviceability.</td>
</tr>
<tr>
<td></td>
<td>For Cisco Unity Connection, the application audit log supports configuration updates for Cisco Unity Connection graphical user interfaces, including Cisco Unity Connection Administration, Cisco Unity Connection Serviceability, Cisco Personal Communications Assistant, and clients that use the Connection REST APIs.</td>
</tr>
<tr>
<td></td>
<td>This setting displays as enabled by default.</td>
</tr>
<tr>
<td>Enable Purging</td>
<td>The Log Partition Monitor (LPM) looks at the Enable Purging option to determine whether it needs to purge audit logs. When you check this check box, LPM purges all the audit log files in RTMT whenever the common partition disk usage goes above the high water mark; however, you can disable purging by unchecking the check box.</td>
</tr>
<tr>
<td></td>
<td>If purging is disabled, the number of audit logs continues to increase until the disk is full. This action could cause a disruption of the system. A message that describes the risk of disabling the purge displays when you uncheck the Enable Purging check box. Be aware that this option is available for audit logs in an active partition. If the audit logs reside in an inactive partition, the audit logs get purged when the disk usage goes above the high water mark.</td>
</tr>
<tr>
<td></td>
<td>You can access the audit logs by choosing <strong>Trace and Log Central &gt; Audit Logs</strong> in RTMT.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Log Rotation</td>
<td>The system reads this option to determine whether it needs to rotate the audit log files or it needs to continue to create new files. The maximum number of files cannot exceed 5000. When the Enable Rotation option is checked, the system begins to overwrite the oldest audit log files after the maximum number of files gets reached. <strong>Tip</strong> When log rotation is disabled (unchecked), audit log ignores the Maximum No. of Files setting.</td>
</tr>
<tr>
<td>Maximum No. of Files</td>
<td>Enter the maximum number of files that you want to include in the log. The default setting specifies 250. The maximum number specifies 5000.</td>
</tr>
<tr>
<td>Maximum File Size</td>
<td>Enter the maximum file size for the audit log. The file size value must remain between 1 MB and 10 MB. You must specify a number between 1 and 10.</td>
</tr>
<tr>
<td>Database Audit Log Filter Settings</td>
<td>When you enable this check box, an audit log gets created for the Cisco Unified Communications Manager and Cisco Unity Connection databases. Use this setting in conjunction with the Debug Audit Level setting, which allows you create a log for certain aspects of the database.</td>
</tr>
<tr>
<td>Enable Audit Log</td>
<td>This setting allows you to choose which aspects of the database you want to audit in the log. From the drop-down list box, choose one of the following options. Be aware that each audit log filter level is cumulative.</td>
</tr>
<tr>
<td>Debug Audit Level</td>
<td>This setting allows you to choose which aspects of the database you want to audit in the log. From the drop-down list box, choose one of the following options. Be aware that each audit log filter level is cumulative.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Schema</strong> - Tracks changes to the setup of the audit log database (for example, the columns and rows in the database tables).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Administrative Tasks</strong> - Tracks all administrative changes to the Cisco Unified Communications Manager system (for example, any changes to maintain the system) plus all <strong>Schema</strong> changes. <strong>Tip</strong> Most administrators will leave the Administrative Tasks setting disabled. For users who want auditing, use the Database Updates level.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Database Updates</strong> - Tracks all changes to the database plus all <strong>schema</strong> changes and all <strong>administrative tasks</strong> changes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Database Reads</strong> - Tracks every read to the Cisco Unified Communications Manager system, plus all schema changes, administrative tasks changes, and database updates changes. <strong>Tip</strong> Choose the Database Reads level only when you want to get a quick look at the Cisco Unified Communications Manager or Cisco Unity Connection system. This level uses significant amounts of system resources and only should be used for a short time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Audit Log Rotation</td>
<td>The system reads this option to determine whether it needs to rotate the database audit log files or it needs to continue to create new files. When the Audit Enable Rotation option is checked, the system begins to overwrite the oldest audit log files after the maximum number of files gets reached. When this setting is unchecked, audit log ignores the Maximum No. of Files setting.</td>
</tr>
<tr>
<td>Maximum No. of Files</td>
<td>Enter the maximum number of files that you want to include in the log. Ensure that the value that you enter for the Maximum No. of Files setting is greater than the value that you enter for the No. of Files Deleted on Log Rotation setting. You can enter a number from 4 (minimum) to 40 (maximum).</td>
</tr>
<tr>
<td>No. of Files Deleted on Log Rotation</td>
<td>Enter the maximum number of files that the system can delete when database audit log rotation occurs. The minimum that you can enter in this field is 1. The maximum value is 2 numbers less than the value that you enter for the Max No. of Files setting; for example, if you enter 40 in the Maximum No. of Files field, the highest number that you can enter in the No. of Files Deleted on Log Rotation field is 38.</td>
</tr>
</tbody>
</table>

**Locations**

This section explains the Locations feature (Tools > Locations) in Cisco Unified Serviceability. This feature enables an administrator to view details of the configured locations in an enterprise, understand the link and intra-location discrepancies, view effective path between the two locations, and identify disconnected groups of locations.

**Locations Topology**

Cisco Unified Serviceability Locations Topology provides details of configured locations in your enterprise. Location Topology refers to a modeled topology representing the flow of media in a network.

Listed below are some commonly used terms and their definitions:

**Assertion**

An assertion refers to the location and link bandwidth and weight values configured in a cluster. Asserted values may be replicated to another cluster.

**Discrepancy**

A discrepancy occurs if there is a difference in the location bandwidth values or link bandwidth and weight values asserted across various clusters.

**Effective Path**

An Effective Path is a sequence of intermediate locations connecting two end locations, with weight assigned to each link between each adjacent pair of locations. The Effective Path, as determined by the least cumulative weight, is the only path used for bandwidth deductions between any two end locations.
View locations topology

Cisco Unified Serviceability Locations Topology helps an administrator view the graphical locations topology in a tabular format. The administrator can filter required location names using the Find filter. The locations topology data includes the intralocation details and link details for a selected location. This section describes how to search and view location topology in Cisco Unified Serviceability.

Procedure

Step 1 In Cisco Unified Serviceability, choose Tools > Locations > Topology
The Locations Topology window appears.

Step 2 From the Find Locations Where Location Name drop-down box, choose the filter criteria.

Step 3 Enter the search string in the Find Locations Where Location Name field and then click Find.
Note The Find Locations Where Location Name field is not case-sensitive.
The list of locations is displayed for the chosen filter criteria.

Step 4 In the list, click to expand any location to view its intralocation details and link details.
The intralocation details include audio, video, and immersive bandwidth whereas the link details contain the details of the link connecting two locations such as its weight, audio, video and immersive bandwidth.
Tip If the list of locations is long, it may run into multiple pages. To view another page, click the appropriate navigation button at the bottom of the Locations Topology window or enter a page number in the Page field. To change the number of locations that display in the window, choose a different value from the Rows Per Page drop-down box.
Tip If a location is highlighted by a Caution symbol, this indicates a discrepancy. To view the details of this discrepancy, click View Assertion Details link.

Step 5 To view the assertion details of any location, click View Assertion Details link at the bottom of the expanded details section.
The Assertion Details window appears.

Step 6 To return to the Locations Topology window, click Close.
Note To download the locations topology data in xml format, click Download Topology at the bottom of the Locations Topology window or Download Topology icon in the toolbar at the top.
For more information about the topology data in xml format, refer Cisco Unified Communications Manager XML Developers Guide.

View assertion details

The following details are displayed when you click the View Assertion Details link in Locations Topology screen (Tools > Locations > Locations Topology).

- Intra-location configuration assertions—Includes the intra-location assertion details such as Asserted by Cluster, Audio, Video and Immersive bandwidth. Asserted by Cluster column lists the names of all the clusters that assert a particular location.
- Link assertions—Includes the assertion details of the link connecting two locations such as Asserted by Cluster, Weight, Audio, Video and Immersive bandwidth.
Procedure

Locations discrepancy

The Locations Discrepancy screen displays the conflicts in assertions for various locations configurations. The following details are displayed:

- Link Configuration Discrepancy—Includes the discrepancy details of the link connecting two locations such as Weight, Audio, Video and Immersive bandwidth.
- Intra-Location Configuration Discrepancy—Includes intra-location discrepancy details such as Audio, Video, and Immersive bandwidth.

View locations discrepancy

This section describes how to view a location discrepancy in Cisco Unified Serviceability.

Procedure

Step 1
In Cisco Unified Serviceability, choose **Tools > Locations > Discrepancy**. The Location Discrepancy window appears.

Step 2
The list of link configuration discrepancies and intralocation configuration discrepancies is displayed. The Link Configuration Discrepancy section lists only those link names where discrepancy has been detected. Link names are listed in the format `<Location Name 1> <--> <Location Name 2>`. The Intra-location Configuration Discrepancy section lists only those location names where such discrepancy has been detected. The elements in the list are sorted in lexical order.

If no discrepancies are found, the following status message is displayed:

**No discrepancies found**

Step 3
In the list, click on a link name or location name to expand and view its configuration details as asserted by different clusters, in a tabular view.

The bottom row displays the effective values considered for audio, video, and immersive bandwidth pools and weight (in the case of links). The values that do not match with the effective values are highlighted in red.

**Note** The Effective Value is the least of the values in a particular column. For example, the Effective Value of audio bandwidth is the minimum value in the Audio Bandwidth column.

Effective path

The Cisco Unified Serviceability Effective Path screen provides details of the effective path that media takes for audio, video, or immersive calls made between two locations provided by the administrator. This screen displays the Available bandwidth and the Configured bandwidth across each link and intra-location in the effective path. An administrator can use this report to determine bandwidth availability across a link and intra-location when there are bandwidth issues in making calls.
can also be used to troubleshoot bandwidth issues in making calls and find out where the bandwidth availability is low.

The Cisco Unified Serviceability Effective Path screen displays the following details between two selected locations:

- **Quick Path Overview** — Displays the cumulative weight and the least of the configured and available Audio, Video and Immersive Bandwidth values across the effective path.

- **Detailed Path View** — Displays the weight and bandwidth values (Available and Configured) for Audio, Video and Immersive calls for locations and links constituting the effective path, in a tabular view ordered from source location at top to the destination location at bottom.

---

**Note**
The Available bandwidth values displayed in the report are the value at the time of viewing the Effective Path. You can view the real time values in the Cisco Unified Real-Time Monitoring Tool.

---

**View effective path**

**Procedure**

**Step 1** In Cisco Unified Serviceability, choose **Tools > Locations > Effective Path**. The Effective Path window appears.

**Step 2** From the **Location** drop-down boxes, select any two locations between which effective path is required and then click **Find**.
Alternatively, start typing the location name in the input box to shortlist the matching location names and then click **Find**.

The Effective path details which include the Quick Path Overview and Detailed Path View sections are displayed. If there is no path between the two selected locations, the following status message is displayed:

*No path exists between <From_Location> and <To_Location>*.

---

**Disconnected groups**

Cisco Unified Serviceability Disconnected Groups screen enables an administrator to view and analyze any disconnect between the locations that are part of the topology. It displays a list of disconnected groups of locations which helps an administrator understand which locations need to be connected.

The disconnect in the topology can occur when a link between two locations is not configured or a shared location name is misspelled.

---

**Note**
The Disconnected Groups screen only displays and compares disconnected groups of locations. For information on connecting locations, refer "Location Configuration" chapter in Cisco Unified Communications Manager Administration Guide.
View disconnected groups

This section describes how to view disconnected groups in Cisco Unified Serviceability.

Procedure

In Cisco Unified Serviceability, choose **Tools > Locations > Disconnected Groups**.
The Disconnected Groups screen appears.

The following table describes the settings displayed on the Disconnected Groups screen.

*Table 29: Settings on the Disconnected Groups screen*

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Disconnected Groups</td>
<td>Check this box to select a disconnected group to be compared with another disconnected group.</td>
</tr>
<tr>
<td>Select</td>
<td>Check this box to select a disconnected group to be compared with another disconnected group.</td>
</tr>
<tr>
<td>Caution</td>
<td>You can select only two groups for comparison.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Auto-generated unique identification number of the selected group is displayed here.</td>
</tr>
<tr>
<td>Description</td>
<td>The names of the first and last location (as per the alphabetical order) in the group are displayed here.</td>
</tr>
<tr>
<td>Note</td>
<td>If a disconnected group has only one node, only the name of that node is displayed here.</td>
</tr>
<tr>
<td>No of Locations</td>
<td>The number of locations in a group is displayed here.</td>
</tr>
<tr>
<td>Compare Selected Groups</td>
<td>Click this button to display and compare the selected groups. After you click this button, the details pertaining to the selected groups are displayed. For every group you select, names of the locations that are part of that group and the corresponding clusters that assert a location are displayed. See Comparison view for the selected groups below.</td>
</tr>
<tr>
<td>Location Name</td>
<td>The names of all the locations that are part of a group are listed in this column.</td>
</tr>
<tr>
<td>Asserted by Cluster</td>
<td>The names of all the clusters that assert a particular location are listed in this column.</td>
</tr>
</tbody>
</table>

If there are no disconnected groups of locations, the following status message is displayed:
No disconnected groups of locations found

Note
The List of Disconnected Groups can be sorted by any column. By default, the groups are sorted by the No of Locations column.
Simple Network Management Protocol

This section provides information for configuring SNMP.

Simple Network Management Protocol support

SNMP, an application layer protocol, facilitates the exchange of management information among network devices, such as nodes, routers, and so on. As part of the TCP/IP protocol suite, SNMP enables administrators to remotely manage network performance, find and solve network problems, and plan for network growth.

Note

Cisco allows you to use any SFTP server product but recommends SFTP products that have been certified with Cisco through the Cisco Technology Developer Partner program (CTDP). CTDP partners, such as GlobalSCAPE, certify their products with specified version of Cisco Unified Communications Manager. For information on which vendors have certified their products with your version of Cisco Unified Communications Manager, refer to the following URL:

http://www.cisco.com/cgi-bin/ctdp/Search.pl

For information on using GlobalSCAPE with supported Cisco Unified Communications versions, refer to the following URL:


Cisco uses the following servers for internal testing. You may use one of the servers, but you must contact the vendor for support:

• Open SSH (refer to http://sshwindows.sourceforge.net/)

• Simple Network Management Protocol, page 111
• SNMP V1 and V2c, page 127
• SNMP V3, page 133
• SNMP system group, page 140
• SNMP trap settings, page 141
• Cygwin (refer to http://www.cygwin.com/)

Titan (refer to http://www.titanftp.com/)

For issues with third-party products that have not been certified through the CTDP process, contact the third-party vendor for support.

You use Cisco Unified Serviceability to configure SNMP-associated settings, such as community strings, users, and notification destinations for V1, V2c, and V3. The settings that you configure in Cisco Unified Serviceability apply to the local node; however, if your Cisco Unified Communications Manager or Cisco Unity Connection configuration supports clusters, you can apply settings to all servers in the cluster with the “Apply to All Nodes” option in the SNMP configuration windows.

Tip
Unified CM only: SNMP configuration parameters that you specified in Cisco Unified CallManager or Cisco Unified Communications Manager 4.X do not migrate during a Cisco Unified Communications Manager 6.0 and later upgrade. You must perform the SNMP configuration procedures again in Cisco Unified Serviceability.

SNMP supports IPv4, although the CISCO-CCM-MIB includes columns and storage for IPv6 addresses, preferences, and so on.

This section contains information on the following topics:

• SNMP basics, on page 112
• SNMP configuration requirements, on page 113
• SNMP version 1 support, on page 114
• SNMP version 2c support, on page 114
• SNMP version 3 support, on page 114
• SNMP services, on page 114
• SNMP community strings and users, on page 115
• SNMP trace configuration, on page 126
• SNMP Management Information Base (MIB), on page 118

SNMP basics

An SNMP-managed network comprises three key components: managed devices, agents, and network management systems.

• Managed device - A network node that contains an SNMP agent and resides on a managed network. Managed devices collect and store management information and make it available by using SNMP.

Unified CM BE only: The server where Cisco Unified Communications Manager is installed acts as the managed device.

Unified CM only: In a configuration that supports clusters, the first node in the cluster acts as the managed device.

• Agent - A network-managed software module that resides on a managed device. An agent contains local knowledge of management information and translates it into a form that is compatible with SNMP.
Cisco Unified Communications Manager and Cisco Unity Connection use a master agent and subagent components to support SNMP. The master agent acts as the agent protocol engine and performs the authentication, authorization, access control, and privacy functions that relate to SNMP requests. Likewise, the master agent contains a few MIB variables that relate to MIB-II. The master agent also connects and disconnects subagents after the subagent completes necessary tasks. The SNMP master agent listens on port 161 and forwards SNMP packets for Vendor MIBs.

The Cisco Unified Communications Manager subagent interacts with the local Cisco Unified Communications Manager only. The Cisco Unified Communications Manager subagents send trap and information messages to the SNMP Master Agent, and the SNMP Master Agent communicates with the SNMP trap receiver (notification destination).

- Network Management System (NMS) - A SNMP management application (together with the PC on which it runs) that provides the bulk of the processing and memory resources that are required for network management. An NMS executes applications that monitor and control managed devices. Cisco Unified Communications Manager works with the following NMS:
  - CiscoWorks Lan Management Solution
  - HP OpenView
  - Third-party applications that support SNMP and Cisco Unified Communications Manager SNMP interfaces

**SNMP configuration requirements**

The system provides no default SNMP configuration. You must configure SNMP settings after installation to access MIB information. Cisco supports SNMP V1, V2c, and V3 versions.

SNMP agent provides security with community names and authentication traps. You must configure a community name to access MIB information. Table 30: SNMP Configuration Requirements, on page 113 provides the required SNMP configuration settings.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Cisco Unified Serviceability Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1/V2c Community String</td>
<td>SNMP &gt; V1/V2c &gt; Community String</td>
</tr>
<tr>
<td>V3 Community String</td>
<td>SNMP &gt; V3 &gt; User</td>
</tr>
<tr>
<td>System Contact and Location for MIB2</td>
<td>SNMP &gt; SystemGroup &gt; MIB2 System Group</td>
</tr>
<tr>
<td>Trap Destinations (V1/V2c)</td>
<td>SNMP &gt; V1/V2c &gt; Notification Destination</td>
</tr>
<tr>
<td>Trap Destinations (V3)</td>
<td>SNMP &gt; V3 &gt; Notification Destination</td>
</tr>
</tbody>
</table>
SNMP version 1 support

SNMP version 1 (SNMPv1), the initial implementation of SNMP that functions within the specifications of the Structure of Management Information (SMI), operates over protocols, such as User Datagram Protocol (UDP) and Internet Protocol (IP).

The SNMPv1 SMI defines highly structured tables (MIBs) that are used to group the instances of a tabular object (that is, an object that contains multiple variables). Tables contain zero or more rows, which are indexed, so SNMP can retrieve or alter an entire row with a supported command.

With SNMPv1, the NMS issues a request, and managed devices return responses. Agents use the Trap operation to asynchronously inform the NMS of a significant event.

In Cisco Unified Serviceability, you configure SNMP v1 support in the V1/V2c Configuration window.

SNMP version 2c support

As with SNMPv1, SNMPv2c functions within the specifications of the Structure of Management Information (SMI). MIB modules contain definitions of interrelated managed objects. The operations that are used in SNMPv1 are similar to those that are used in SNMPv2. The SNMPv2 Trap operation, for example, serves the same function as that used in SNMPv1, but it uses a different message format and replaces the SNMPv1 Trap.

The Inform operation in SNMPv2c allows one NMS to send trap information to another NMS and to then receive a response from the NMS.

In Cisco Unified Serviceability, you configure SNMP v2c support in the V1/V2c Configuration window.

SNMP version 3 support

SNMP version 3 provides security features such as authentication (verifying that the request comes from a genuine source), privacy (encryption of data), authorization (verifying that the user allows the requested operation), and access control (verifying that the user has access to the objects requested.) To prevent SNMP packets from being exposed on the network, you can configure encryption with SNMPv3.

Instead of using community strings like SNMP v1 and v2, SNMP v3 uses SNMP users, as described in the SNMP community strings and users, on page 115.

In Cisco Unified Serviceability, you configure SNMP v3 support in the V3 Configuration window.

SNMP services

The services in the following table support SNMP operations.

<table>
<thead>
<tr>
<th>MIB</th>
<th>Service</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>CISCO-CCM-MIB</td>
<td>Cisco CallManager SNMP service</td>
<td>Cisco Unified Serviceability &gt; Tools &gt; Control Center - Feature Services. Choose a server; then, choose Performance and Monitoring category.</td>
</tr>
</tbody>
</table>
For a description of each service, see the Services, on page 51.

Stopping any SNMP service may result in loss of data because the network management system no longer monitors the Cisco Unified Communications Manager or Cisco Unity Connection network. Do not stop the services unless your technical support team tells you to do so.

SNMP community strings and users

Although SNMP community strings provide no security, they authenticate access to MIB objects and function as embedded passwords. You configure SNMP community strings for SNMP V1 and V2c only.

SNMP V3 does not use community strings. Instead, version 3 uses SNMP users. These users serve the same purpose as community strings, but users provide security because you can configure encryption or authentication for them.

In Cisco Unified Serviceability, no default community string or user exists.

SNMP traps and informs

An SNMP agent sends notifications to NMS in the form of traps or informs to identify important system events. Traps do not receive acknowledgments from the destination whereas informs do receive acknowledgments. You configure the notification destinations by using the SNMP Notification Destination Configuration windows in Cisco Unified Serviceability.

Note

Cisco Unified Communications Manager supports SNMP traps in Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 systems.
For all notifications, the system sends traps immediately if the corresponding trap flags are enabled. In the case of the syslog agent, the CallManager alarms and system level log messages get sent to syslog daemon for logging. Also, some standard third-party applications send the log messages to syslog daemon for logging. These log messages get logged locally in the syslog files and also get converted into SNMP traps/notifications.

The following list contains Cisco Unified Communications Manager SNMP trap/inform messages that are sent to a configured trap destination:

- Cisco Unified Communications Manager failed
- Phone failed
- Phones status update
- Gateway failed
- Media resource list exhausted
- Route list exhausted
- Gateway layer 2 change
- Quality report
- Malicious call
- Syslog message generated

Tip

Before you configure notification destination, verify that the required SNMP services are activated and running. Also, make sure that you configured the privileges for the community string/user correctly.

You configure the SNMP trap destination by choosing SNMP > V1/V2 > Notification Destination or SNMP > V3 > Notification Destination in Cisco Unified Serviceability.

The following table comprises information about Cisco Unified Communications Manager trap/inform parameters that you configure on the Network Management System (NMS). You can configure the values in the table by issuing the appropriate commands on the NMS, as described in the SNMP product documentation that supports the NMS.

Note

All the parameters that are listed in the table are part of CISCO-CCM-MIB except for the last two parameters. The last two, clogNotificationsEnabled and clogMaxSeverity, comprise part of CISCO-SYSLOG-MIB.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Default Value</th>
<th>Generated Traps</th>
<th>Configuration Recommendations</th>
</tr>
</thead>
</table>
| ccmCallManagerAlarmEnable      | True          | ccmCallManagerFailed
  ccmMediaResourceListExhausted
  ccmRouteListExhausted
  ccmTLSConnectionFailure        | Keep the default specification.                     |
### Configuration Recommendations

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Default Value</th>
<th>Generated Traps</th>
<th>Configuration Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>ccmGatewayAlarmEnable</td>
<td>True</td>
<td>ccmGatewayFailed, ccmGatewayLayer2Change</td>
<td>None. The default specifies this trap as enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ccmPhoneStatusUpdateStorePeriod</td>
<td>1800</td>
<td>ccmPhoneStatusUpdate</td>
<td>Set the <code>ccmPhoneStatusUpdateStorePeriod</code> to a value between 30 and 3600. See CISCO-CCM-MIB trap parameters, on page 142.</td>
</tr>
<tr>
<td>ccmPhoneStatusUpdateAlarmInterval</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ccmPhoneFailedStorePeriod</td>
<td>1800</td>
<td>ccmPhoneFailed</td>
<td>Set the <code>ccmPhoneFailedStorePeriod</code> to a value between 30 and 3600. See CISCO-CCM-MIB trap parameters, on page 142.</td>
</tr>
<tr>
<td>ccmPhoneFailedAlarmInterval</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ccmMaliciousCallAlarmEnable</td>
<td>True</td>
<td>ccmMaliciousCall</td>
<td>None. The default specifies this trap as enabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Parameter Name | Default Value | Generated Traps | Configuration Recommendations
--- | --- | --- | ---
ccmQualityReportAlarmEnable | True | Note: This trap gets generated only if the Cisco Extended Functions service is activated and running on the server; or, in the case of a cluster configuration (Cisco Unified Communications Manager only), on the local Cisco Unified Communications Manager server. ccmQualityReport | None. The default specifies this trap as enabled.
clogNotificationsEnabled | False | clogMessageGenerated | To enable trap generation, set clogNotificationsEnable to True. See CISCO-SYSLOG-MIB trap parameters, on page 141.
clogMaxSeverity | Warning | clogMessageGenerated | When you set clogMaxSeverity to warning, a SNMP trap generates when Cisco Unified Communications Manager applications generate a syslog message with at least a warning severity level. CISCO-SYSLOG-MIB trap parameters, on page 141.

### SNMP Management Information Base (MIB)

SNMP allows access to Management Information Base (MIB), which is a collection of information that is organized hierarchically. MIBs comprise managed objects, which are identified by object identifiers. A MIB object, which contains specific characteristics of a managed device, comprises one or more object instances (variables).
Cisco Unified Communications Manager supports the following MIBs except for CISCO-UNITY-MIB. Cisco Unified Communications Manager Business Edition 5000 supports all the following MIBs. Cisco Unity Connection supports the following MIBs except for CISCO-CCM-MIB.

Note

The SNMP interface provides these Cisco Standard MIBs:

- CISCO-CCM-MIB
- CISCO-CDP-MIB
- CISCO-SYSLOG-MIB
- CISCO-UNITY-MIB

The Simple Network Management Protocol (SNMP) extension agent resides in the server and exposes the CISCO-CCM-MIB, which provides detailed information about devices that are known to the server. In the case of a cluster configuration, the SNMP extension agent resides in each server in the cluster. The CISCO-CCM-MIB provides device information such as device registration status, IP address, description, and model type for the server (not the cluster, in a configuration that supports clusters).

The SNMP interface also provides these Industry Standard MIBs:

- SYSAPPL-MIB
- MIB-II (RFC 1213)
- HOST-RESOURCES-MIB

For vendor-specific supported hardware MIBS, refer to the Vendor-Specific MIBs, on page 124 section.

Cisco Unified Communications Manager SNMP Interface supports the following MIBs.

**CISCO-CDP-MIB**

Use the Cisco Unified Communications Manager CDP subagent to read the Cisco Discovery Protocol MIB, CISCO-CDP-MIB. This MIB enables Cisco Unified Communications Manager and Cisco Unity Connection to advertise themselves to other Cisco devices on the network.

The CDP subagent implements the CDP-MIB. The CDP-MIB contains the following objects:

- cdpInterfaceIfIndex
- cdpInterfaceMessageInterval
- cdpInterfaceEnable
- cdpInterfaceGroup
- cdpInterfacePort
- cdpGlobalRun
- cdpGlobalMessageInterval
- cdpGlobalHoldTime
- cdpGlobalLastChange
- cdpGlobalDeviceId
SYSAPPL-MIB
Use the System Application Agent to get information from the SYSAPPL-MIB, such as installed applications, application components, and processes that are running on the system.
System Application Agent supports the following object groups of SYSAPPL-MIB:
  • sysApplInstallPkg
  • sysApplRun
  • sysApplMap
  • sysApplInstallElmt
  • sysApplElmtRun

MIB-II
Use MIB2 agent to get information from MIB-II. The MIB2 agent provides access to variables that are defined in RFC 1213, such as interfaces, IP, and so on, and supports the following groups of objects:
  • system
  • interfaces
  • at
  • ip
  • icmp
  • tcp
  • udp
  • snmp

HOST-RESOURCES MIB
Use Host Resources Agent to get values from HOST-RESOURCES-MIB. The Host Resources Agent provides SNMP access to host information, such as storage resources, process tables, device information, and installed software base. The Host Resources Agent supports the following groups of objects:
  • hrSystem
  • hrStorage
  • hrDevice
  • hrSWRun
  • hrSWRunPerf
  • hrSWInstalled
**CISCO-SYSLOG-MIB**

Syslog tracks and logs all system messages, from informational through critical. With this MIB, network management applications can receive syslog messages as SNMP traps:

The Cisco Syslog Agent supports trap functionality with the following MIB objects:

- clogNotificationsSent
- clogNotificationsEnabled
- clogMaxSeverity
- clogMsgIgnores
- clogMsgDrops

**CISCO-CCM-MIB/CISCO-CCM-CAPABILITY MIB**

The CISCO-CCM-MIB contains both dynamic (real-time) and configured (static) information about the Cisco Unified Communications Manager and its associated devices, such as phones, gateways, and so on, that are visible on this Cisco Unified Communications Manager node. Simple Network Management Protocol (SNMP) tables contain information such as IP address, registration status, and model type.

SNMP supports IPv4, although the CISCO-CCM-MIB includes columns and storage for IPv6 addresses, preferences, and so on.

---

**Note**

Cisco Unified Communications Manager supports this MIB in Cisco Unified Communications Manager and Cisco Unified Communications Manager Business Edition 5000 systems. Cisco Unity Connection does not support this MIB.

To view the support lists for the CISCO-CCM-MIB and MIB definitions, go to the following link:


To view MIB dependencies and MIB contents, including obsolete objects, across Cisco Unified Communications Manager releases, go to the following link: [http://tools.cisco.com/Support/SNMP/do/BrowseMIB.do?local=en&step=2&mibName=CISCO-CCM-CAPABILITY](http://tools.cisco.com/Support/SNMP/do/BrowseMIB.do?local=en&step=2&mibName=CISCO-CCM-CAPABILITY)

Dynamic tables get populated only if the Cisco CallManager service is up and running (or the local Cisco CallManager service in the case of a Cisco Unified Communications Manager cluster configuration); static tables get populated when the Cisco CallManager SNMP Service is running.

**Table 33: Cisco-CCM-MIB Dynamic Tables**

<table>
<thead>
<tr>
<th>Table(s)</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>ccmTable</td>
<td>This table stores the version and installation ID for the local Cisco Unified Communications Manager. The table also stores information about all the Cisco Unified Communications Manager in a cluster that the local Cisco Unified Communications Manager knows about but shows “unknown” for the version detail. If the local Cisco Unified Communications Manager is down, the table remains empty, except for the version and installation ID values.</td>
</tr>
<tr>
<td>Table(s)</td>
<td>Contents</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>ccmPhoneFailed, ccmPhoneStatusUpdate, ccmPhoneExtn, ccmPhone, ccmPhoneExtension</td>
<td>For the Cisco Unified IP Phone, the number of registered phones in ccmPhoneTable should match Cisco Unified Communications Manager/RegisteredHardwarePhones perfmon counter. The ccmPhoneTable includes one entry for each registered, unregistered, or rejected Cisco Unified IP Phone. The ccmPhoneExtnTable uses a combined index, ccmPhoneIndex and ccmPhoneExtnIndex, for relating the entries in the ccmPhoneTable and ccmPhoneExtnTable.</td>
</tr>
<tr>
<td>ccmCTIDevice, ccmCTIDeviceDirNum</td>
<td>The ccmCTIDeviceTable stores each CTI device as one device. Based on the registration status of the CTI Route Point or CTI Port, the ccmRegisteredCTIDevices, ccmUnregisteredCTIDevices, and ccmRejectedCTIDevices counters in the Cisco Unified Communications Manager MIB get updated.</td>
</tr>
<tr>
<td>ccmSIPDevice</td>
<td>The CCMSIPDeviceTable stores each SIP trunk as one device.</td>
</tr>
<tr>
<td>ccmH323Device</td>
<td>The ccmH323DeviceTable contains the list of H323 devices for which Cisco Unified Communications Manager contains information (or the local Cisco Unified Communications Manager in the case of a cluster configuration). For H.323 phones or H.323 gateways, the ccmH.323DeviceTable contains one entry for each H.323 device. (The H.323 phone and gateway do not register with Cisco Unified Communications Manager. Cisco Unified Communications Manager generates the H.323Started alarm when it is ready to handle calls for the indicated H.323 phone and gateway.) The system provides the gatekeeper information as part of the H323 trunk information.</td>
</tr>
<tr>
<td>ccmVoiceMailDevice, ccmVoiceMailDirNum</td>
<td>For Cisco uOne, ActiveVoice, the ccmVoiceMailDeviceTable includes one entry for each voice-messaging device. Based on the registration status, the ccmRegisteredVoiceMailDevices, ccmUnregisteredVoiceMailDevices, and ccmRejectedVoiceMailDevices counters in the Cisco Unified Communications Manager MIB get updated.</td>
</tr>
<tr>
<td>ccmGateway</td>
<td>The ccmRegisteredGateways, ccmUnregistered gateways, and ccmRejectedGateways keep track of the number of registered gateway devices or ports, number of unregistered gateway devices or ports, and number of rejected gateway devices or ports, respectively. Cisco Unified Communications Manager generates alarms at the device or port level. The ccmGatewayTable, based on CallManager alarms, contains device- or port-level information. Each registered, unregistered, or rejected device or port has one entry in ccmGatewayTable. The VG200 with two FXS ports and one T1 port has three entries in ccmGatewayTable. The ccmActiveGateway and ccmInActiveGateway counters track number of active (registered) and lost contact with (unregistered or rejected) gateway devices or ports. Based on the registration status, ccmRegisteredGateways, ccmUnregisteredGateways, and ccmRejectedGateways counters get updated.</td>
</tr>
</tbody>
</table>
Table(s) | Contents
--- | ---
ccmMediaDeviceInfo | The table contains a list of all media devices which have tried to register with the local CallManager at least once.
ccmGroup | This table contains the Cisco Unified CM groups in a Cisco Unified Communications Manager cluster.
ccmGroupMapping | This table maps all Cisco Unified CMs in a cluster to a Cisco Unified CM group. The table remains empty when the local Cisco Unified CM node is down.

Table 34: CISCO-CCM-MIB Static Tables

| Table(s) | Content |
--- | --- |
ccmProductType | The table contains the list of product types that are supported with Cisco Unified Communications Manager (or cluster, in the case of a Cisco Unified Communications Manager cluster configuration), including phone types, gateway types, media device types, H323 device types, CTI device types, voice-messaging device types, and SIP device types.
ccmRegion, ccmRegionPair | ccmRegionTable contains the list of all geographically separated regions in a Cisco Communications Network (CCN) system. The ccmRegionPairTable contains the list of geographical region pairs for a Cisco Unified Communications Manager cluster. Geographical region pairs are defined by Source region and Destination region.
ccmTimeZone | The table contains the list of all time zone groups in a Cisco Unified Communications Manager cluster.
ccmDevicePool | The tables contains the list of all device pools in a Cisco Unified Communications Manager cluster. Device pools are defined by Region, Date/Time Group, and Cisco Unified CM Group.

**Note**

The “ccmAlarmConfigInfo” and “ccmQualityReportAlarmConfigInfo” groups in the CISCO-CCM-MIB define the configuration parameters that relate to the notifications that are described.

**CISCO-UNITY-MIB**

The CISCO-UNITY-MIB uses the Connection SNMP Agent to get information about Cisco Unity Connection.
To view the CISCO-UNITY-MIB definitions, go to the following link and click SNMP V2 MIBs:

Note
Cisco Unity Connection supports this MIB. Cisco Unified Communications Manager does not support this MIB.

The Connection SNMP Agent supports the following objects.

Table 35: CISCO-UNITY-MIB Objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ciscoUnityTable</td>
<td>This table contains general information about the Cisco Unity Connection servers such as host name and version number.</td>
</tr>
<tr>
<td>ciscoUnityPortTable</td>
<td>This table contains general information about the Cisco Unity Connection voice messaging ports.</td>
</tr>
<tr>
<td>General Unity Usage Info</td>
<td>This group contains information about capacity and utilization of the Cisco Unity Connection voice messaging ports.</td>
</tr>
</tbody>
</table>

Vendor-Specific MIBs

The following MIBs exist on various Cisco MCS, depending on vendor and model number. To query these MIBs, you can use the standard MIB browsers that the hardware vendors develop; for example, HP Systems Insight Manager (SIM) and IBM Director Server+Console. For information on using the MIB browsers, refer to the documentation that the hardware vendor provides.

To review the vendor-specific MIB information, see the following tables:

<table>
<thead>
<tr>
<th>MIB</th>
<th>OID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported for browsing only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM-SYSTEM-HEALTH-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.30</td>
<td>Provides temperature, voltage, and fan status</td>
</tr>
<tr>
<td>IBM-SYSTEM-ASSETID-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.60</td>
<td>Provides hardware component asset data</td>
</tr>
<tr>
<td>IBM-SYSTEM-LMSENSOR-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.80</td>
<td>Provides temperature, voltage, and fan details</td>
</tr>
<tr>
<td>IBM-SYSTEM-NETWORK-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.110</td>
<td>Provides Network Interface Card (NIC) status</td>
</tr>
<tr>
<td>IBM-SYSTEM-MEMORY-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.120</td>
<td>Provides physical memory details</td>
</tr>
<tr>
<td>IBM-SYSTEM-POWER-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.130</td>
<td>Provides power supply details</td>
</tr>
</tbody>
</table>
**Table 36: HP MIBs**

<table>
<thead>
<tr>
<th>MIB</th>
<th>OID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM-SYSTEM-PROCESSOR-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.140</td>
<td>Provides CPU asset/status data</td>
</tr>
<tr>
<td>IBM-SYSTEM-TRAP</td>
<td>1.3.6.1.4.1.2.6.159.1.1.10</td>
<td>Provides temperature, voltage, fan, disk, NIC, memory, power supply, and CPU details</td>
</tr>
<tr>
<td>IBM-SYSTEM-RAID-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.200</td>
<td>Provides RAID status</td>
</tr>
</tbody>
</table>

Supported for system traps

<table>
<thead>
<tr>
<th>MIB</th>
<th>OID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPQSTDEQ-MIB</td>
<td>1.3.6.1.4.1.232.1</td>
<td>Provides hardware component configuration data</td>
</tr>
<tr>
<td>CPQSINFO-MIB</td>
<td>1.3.6.1.4.1.232.2</td>
<td>Provides hardware component asset data</td>
</tr>
<tr>
<td>CPQIDA-MIB</td>
<td>1.3.6.1.4.1.232.3</td>
<td>Provides RAID status/events</td>
</tr>
<tr>
<td>CPQHLTH-MIB</td>
<td>1.3.6.1.4.1.232.6</td>
<td>Provides hardware components status/events</td>
</tr>
<tr>
<td>CPQSTSYS-MIB</td>
<td>1.3.6.1.4.1.232.8</td>
<td>Provides storage (disk) systems status/events</td>
</tr>
<tr>
<td>CPQSM2-MIB</td>
<td>1.3.6.1.4.1.232.9</td>
<td>Provides iLO status/events</td>
</tr>
<tr>
<td>CPQTHRSH-MIB</td>
<td>1.3.6.1.4.1.232.10</td>
<td>Provides alarm threshold management</td>
</tr>
<tr>
<td>CPQHOST-MIB</td>
<td>1.3.6.1.4.1.232.11</td>
<td>Provides operating system information</td>
</tr>
<tr>
<td>CPQIDE-MIB</td>
<td>1.3.6.1.4.1.232.14</td>
<td>Provides IDE (CD-ROM) drive status/events</td>
</tr>
<tr>
<td>CPQNIC-MIB</td>
<td>1.3.6.1.4.1.232.18</td>
<td>Provides Network Interface Card (NIC) status/events</td>
</tr>
</tbody>
</table>
SNMP trace configuration

For Cisco Unified Communications Manager, you can configure trace for the Cisco CallManager SNMP agent in the Trace Configuration window in Cisco Unified Serviceability by choosing the Cisco CallManager SNMP Service in the Performance and Monitoring Services service group. A default setting exists for all the agents. For Cisco CDP Agent and Cisco Syslog Agent, you use the CLI to change trace settings, as described in the Command Line Interface Reference Guide for Cisco Unified Solutions.

For Cisco Unity Connection, you can configure trace for the Connection SNMP agent in the Trace Configuration window in Cisco Unity Connection Serviceability by choosing the Connection SNMP Agent component.

Set up SNMP

The following table provides an overview of the steps for configuring SNMP.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Install and configure the SNMP NMS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the Control Center - Network Services window, verify that the system started the SNMP services.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Unified CM and Unified CM BE only: In the Service Activation window, activate the Cisco CallManager SNMP service. Connection only: The Connection SNMP Agent service automatically activates.</td>
</tr>
<tr>
<td>Step 4</td>
<td>If you are using SNMP V1/V2c, configure the community string.</td>
</tr>
<tr>
<td>Step 5</td>
<td>If you are using SNMP V3, configure the SNMP user.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Configure the notification destination for traps or informs.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Configure the system contact and location for the MIB2 system group.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Configure trap settings for CISCO-SYSLOG-MIB.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Unified CM and Unified BE only: Configure trap settings for CISCO-CCM-MIB.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Restart the Master Agent service.</td>
</tr>
<tr>
<td>Step 11</td>
<td>On the NMS, configure the Cisco Unified Communications Manager trap parameters.</td>
</tr>
</tbody>
</table>

**Related Topics**

- SNMP services, on page 114
- Activate feature services, on page 87
- Set up community string, on page 127
- Set up SNMP user, on page 134
- Set up notification destination, on page 131
- Set up notification destination, on page 138
- SNMP Management Information Base (MIB), on page 118
- Set up MIB2 system group, on page 140
- CISCO-SYSLOG-MIB trap parameters, on page 141
- CISCO-CCM-MIB trap parameters, on page 142
SNMP V1 and V2c

This section describes how to configure SNMP versions 1 and 2c, so the network management system can monitor Cisco Unified Communications Manager.

Tip

If you use SNMP version 3, see the SNMP V3, on page 133.

Find community string

Tip

The Add New button does not display in the SNMP Community String Configuration window until you click the Find button. If no community strings exist and you want to add a community string, click the Find button and wait for the window to refresh. The Add New button displays.

To find a community string, perform the following procedure:

Procedure

Step 1 Choose Snmp > V1/V2c > Community String. The Find/List window displays.
Step 2 From the Find Community Strings where Name drop-down list box, choose the specific search criteria that you want to use for the community string.
Step 3 Enter the community string for which you want to search.
Step 4 In the Server field, enter the hostname or IP address of the server where the community string exists.
Step 5 Click Find. After you click the Find button, the Add New button displays. After the search results display, the Apply to All Nodes check box displays.
Step 6 Unified CM clusters only: If you want to apply the configuration from one of the options in the search results to all nodes in the cluster, check the check box next to the name of the option and check the Apply to All Nodes check box.
Step 7 From the list of results, click the community string that you want to view.
Step 8 To add or update a community string, see the Set up community string, on page 127.

Set up community string

Because the SNMP agent provides security by using community strings, you must configure the community string to access any management information base (MIB) in a Cisco Unified Communications Manager system. Change the community string to limit access to the Cisco Unified Communications Manager system. To add, modify, and delete community strings, access the SNMP Community String configuration window.
Procedure

Step 1 Perform the procedure in the Find community string, on page 127.

Step 2 Perform one of the following tasks:
   a) To add a new community string, click the Add New button and go to step 3.
   b) To modify an existing community string, locate the community string, as described in the Find community string, on page 127; click the name of the community string that you want to edit and go to step 3.
      You cannot change the name of the community string or the server.
   c) To delete a community string, see the Delete community string, on page 129.

Step 3 Enter the configuration settings, as described in Community string configuration settings, on page 128.

Tip Before you save the configuration, you can click the Clear All button at any time to delete all information that you entered for all settings in the window.

Step 4 After you complete the configuration, click Add New to save a new community string or click Save to save changes to an existing community string.

Step 5 A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

Note Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service. For information on how to restart the service, see the Configuring services, on page 87.

The system refreshes and displays the SNMP Community String Configuration window. The community string that you created displays in the window.

Community string configuration settings

The following table describes the community string configuration settings.

Table 37: Community String Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server          | This setting in the Community String configuration window displays as read only because you specified the server choice when you performed the procedure in the Find community string, on page 127.  
                  To change the server for the community string, perform the procedure in the Find community string, on page 127. |
| Community String | Enter a name for the community string. The name can contain up to 32 characters and can contain any combination of alphanumeric characters, hyphens (-), and underscore characters (_).  
                  **Tip** Choose community string names that will be hard for outsiders to figure out. 
                  When you edit a community string, you cannot change the name of the community string. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept SNMP Packets from any host</td>
<td>To accept SNMP packets from any host, click this radio button.</td>
</tr>
<tr>
<td>Accept SNMP Packets only from these hosts</td>
<td>To accept SNMP only from specified hosts, click this radio button.</td>
</tr>
<tr>
<td>Tip</td>
<td>In the Host IP Address field, enter a host from which you want to accept</td>
</tr>
<tr>
<td></td>
<td>packets and click Insert. Repeat this process for each host from which you</td>
</tr>
<tr>
<td></td>
<td>want to accept packets. To delete a host, choose that host from the Host</td>
</tr>
<tr>
<td></td>
<td>IP Addresses list box and click Remove.</td>
</tr>
<tr>
<td>Access Privileges</td>
<td>From the drop-down list box, choose the appropriate access level from the</td>
</tr>
<tr>
<td></td>
<td>following list:</td>
</tr>
<tr>
<td></td>
<td><strong>ReadOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The community string can only read the values of MIB objects.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadWrite</strong></td>
</tr>
<tr>
<td></td>
<td>The community string can read and write the values of MIB objects.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadWriteNotify</strong></td>
</tr>
<tr>
<td></td>
<td>The community string can read and write the values of MIB objects and send</td>
</tr>
<tr>
<td></td>
<td>MIB object values for a trap and inform messages.</td>
</tr>
<tr>
<td></td>
<td><strong>NotifyOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The community string can only send MIB object values for a trap and inform</td>
</tr>
<tr>
<td></td>
<td>messages.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadNotifyOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The community string can read values of MIB objects and also send the values</td>
</tr>
<tr>
<td></td>
<td>for trap and inform messages.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>The community string cannot read, write, or send trap information.</td>
</tr>
<tr>
<td>Tip</td>
<td>To change the trap configuration parameters, you need to configure a</td>
</tr>
<tr>
<td></td>
<td>community string with NotifyOnly, ReadNotifyOnly, or ReadWriteNotify</td>
</tr>
<tr>
<td></td>
<td>privileges.</td>
</tr>
<tr>
<td>Unified CM clusters only:</td>
<td>To apply the community string to all nodes in the cluster, check this check</td>
</tr>
<tr>
<td>Apply To All Nodes</td>
<td>box.</td>
</tr>
</tbody>
</table>

**Delete community string**

To delete a community string, perform the following procedure:
Procedure

Step 1  Locate the community string, as described in the Find community string, on page 127.
Step 2  From the list of matching records, check the check box next to the community string that you want to delete.
Step 3  Click Delete Selected.
Step 4  A message indicates that the system will delete notification entries that relate to this community string. To continue the deletion, click OK.
Step 5  A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

Tip  Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service. For information on how to restart the service, see the Set up status of services, on page 90.

After the window refreshes, the string that you deleted no longer displays in the results.

SNMP notification destination

The following sections apply to SNMP V1/V2c notification destination configuration.

- Find notification destination, on page 130
- Set up notification destination, on page 131
- Notification destination configuration settings, on page 132
- Delete notification destination, on page 132

Find notification destination

Tip  The Add New button does not display in the SNMP Notification Destination Configuration window until you click the Find button. If no notification destinations exist and you want to add a notification destination, click the Find button and wait for the window to refresh. The Add New button displays.

To find a notification destination for V1/V2c, perform the following procedure:

Procedure

Step 1  Choose Snmp > V1/V2c > Notification Destination.

The Find/List window displays.
Step 2  From the Find Notification where Destination IP drop-down list box, choose the specific search criteria that you want to use to find the notification destination.

Step 3  Enter the notification destination for which you want to search.

Step 4  In the Server field, enter the hostname or IP address of the server that supports the notification destination.

Step 5  Click Find. After you click the Find button, the Add New button displays. After the search results display, the Apply to All Nodes check box displays.

Step 6  Unified CM clusters only: If you want to apply the configuration from one of the options in the search results to all nodes in the cluster, check the box next to the name of the option and check the Apply to All Nodes check box.

Step 7  To view the configuration for one of the items in the search results, click the item.

Step 8  To add or update a notification string, see the Set up notification destination, on page 131.

Set up notification destination

To configure the notification destination (trap/inform receiver) for V1/V2c, perform the following procedure.

Procedure

Step 1  Perform the procedure in the Find notification destination, on page 130.

Step 2  Perform one of the following tasks:
   a) To add a new SNMP notification destination, click the Add New button and go to step 3. You configure the notification destination for the server that you choose in the Server drop-down list box in the Find/List window.
   b) To modify an existing SNMP notification destination, locate the notification destination, as described in the Find notification destination, on page 130; click the name of the SNMP notification destination that you want to edit and go to step 3.
   c) To delete an SNMP notification destination, see the Delete notification destination, on page 132.

Step 3  Enter the configuration settings, as described in Notification destination configuration settings, on page 132. Tip  Before you save the configuration, you can click the Clear button at any time to delete all information that you entered for all settings in the window.

Step 4  To save a notification destination, click Insert, or click Save to save changes to an existing notification destination.

Step 5  A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent, click OK.

Note  Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.

For information on how to restart the service, see the Configuring services, on page 87.
Notification destination configuration settings

The following table describes the notification destination configuration settings for V1/V2c.

Table 38: Notification Destination Configuration Settings for V1/V2

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you specified the server when you performed the procedure in the Find notification destination, on page 130. To change the server for the notification destination, perform the procedure in the Find community string, on page 127.</td>
</tr>
<tr>
<td>Host IP Addresses</td>
<td>From the drop-down list box, choose the Host IP address of the trap destination or choose Add New. If you choose Add New, enter the IP address of the trap destination. For existing notification destinations, you cannot modify the host IP address configuration.</td>
</tr>
<tr>
<td>Port Number</td>
<td>In the field, enter the notification-receiving port number on the destination server that receives SNMP packets.</td>
</tr>
</tbody>
</table>
| V1 or V2c           | From the SNMP Version Information pane, click the appropriate SNMP version radio button, either V1 or V2c, which depends on the version of SNMP that you are using.  
  * If you choose V1, configure the community string setting.  
  * If you choose V2c, configure the notification type setting and then configure the community string. |
| Community String    | From the drop-down list box, choose the community string name to be used in the notification messages that this host generates. Only community strings with minimum notify privileges (Read-Write-Notify or Notify Only) display. If you have not configured a community string with these privileges, no options appear in the drop-down list box. If necessary, click the Create New uiCommunity String button to create a community string, as described in the Set up community string, on page 127. |
| Notification Type   | From the drop-down list box, choose the appropriate notification type. |
| Unified CM clusters only: Apply To All Nodes | To apply the notification destination configuration to all nodes in the cluster, check this check box. |

Delete notification destination

To delete a notification destination, perform the following procedure:
Procedure

Step 1
Locate the notification destination, as described in the Find notification destination, on page 130.

Step 2
From the list of matching records, check the check box next to the notification destination that you want to delete.

Step 3
Click Delete Selected.

Step 4
A message asks whether you want to delete the notification entries. To continue the deletion, click OK.

Step 5
A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

Tip
Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

For information on how to restart the service, see the Configuring services, on page 87.

After the window refreshes, the notification destination that you deleted no longer displays in the results.

SNMP V3

This section describes how to configure SNMP v3, so the network management system can monitor Cisco Unified Communications Manager or Cisco Unity Connection.

Tip
If you use SNMP v1 or v2c, see the SNMP V1 and V2c, on page 127.

Find SNMP user

Tip
The Add New button does not display in the SNMP User Configuration window until you click the Find button. If no users exist and you want to add a user, click the Find button and wait for the window to refresh. The Add New button displays.

To find a SNMP user, perform the following procedure:

Procedure

Step 1
Choose Snmp > V3 > User.

The SNMP User Configuration window displays.
Step 2  From the Find User where Name list box, choose the specific search criteria that you want to use to find the user; for example, begins with.

Step 3  Enter the user name for which you want to search.

Step 4  From the Server drop-down list box, choose the hostname or IP address of the server where you access the user.

Step 5  Click Find.
After you click the Find button, the Add New button displays. After the search results display, the Apply to All Nodes check box displays.

Step 6  Unified CM clusters only: If you want to apply the configuration from one of the options in the search results to all nodes in the cluster, check the check box next to the name of the option and check the Apply to All Nodes check box.

Step 7  From the list of results, click the user that you want to view.

Step 8  To add or update a user, see the Set up SNMP user, on page 134.

---

**Set up SNMP user**

To configure user(s) for SNMP, perform the following procedure:

**Procedure**

---

**Step 1**  Find the notification destination.

**Step 2**  Perform one of the following tasks:

a) To add a new SNMP user, click the Add New button in the SNMP User Configuration Find/List window and go to step 3.

b) To modify an existing SNMP user, locate the user and then click the name of the SNMP user that you want to edit. Go to step 3.

   **Tip**  See topics related to finding the notification destination for information about locating the user.

c) To delete an SNMP user, see topics related to deleting an SNMP user.

**Step 3**  Enter the configuration settings, as described in SNMP user configuration settings, on page 135.

   **Tip**  Before you save the configuration, you can click the Clear All button at any time to delete all information that you entered for all settings in the window.

**Step 4**  To add a new user, click Insert, or click Save to save changes to an existing user.

**Step 5**  A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

   **Tip**  Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.

**Note**  To access this server that has the user that you configure, make sure that you configure this user on the NMS with the appropriate authentication and privacy settings.
Related Topics

- Delete SNMP user, on page 136
- Find notification destination, on page 137

SNMP user configuration settings

The following table describes the SNMP user configuration settings for V3.

**Table 39: SNMP User Configuration Settings for V3**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you specified the server when you</td>
</tr>
<tr>
<td></td>
<td>performed the procedure in the Find notification destination, on page 137.</td>
</tr>
<tr>
<td></td>
<td>To change the server where you want to provide access, perform the procedure</td>
</tr>
<tr>
<td></td>
<td>in the Find SNMP user, on page 133.</td>
</tr>
<tr>
<td>User Name</td>
<td>In the field, enter the name of the user for which you want to provide access</td>
</tr>
<tr>
<td></td>
<td>The name can contain up to 32 characters and can contain any combination of</td>
</tr>
<tr>
<td></td>
<td>alphanumeric characters, hyphens (-), and underscore characters (_).</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Enter users that you have already configured for the network</td>
</tr>
<tr>
<td></td>
<td>management system (NMS). For existing SNMP users, this setting displays as</td>
</tr>
<tr>
<td></td>
<td>read only.</td>
</tr>
<tr>
<td>Authentication Required</td>
<td>To require authentication, check the check box, enter the password in the</td>
</tr>
<tr>
<td></td>
<td>Password and Reenter Password fields, and choose the appropriate protocol. The</td>
</tr>
<tr>
<td></td>
<td>password must contain at least 8 characters.</td>
</tr>
<tr>
<td>Privacy Required</td>
<td>If you checked the Authentication Required check box, you can specify privacy</td>
</tr>
<tr>
<td></td>
<td>information. To require privacy, check the check box, enter the password in</td>
</tr>
<tr>
<td></td>
<td>the Password and Reenter Password fields, and check the protocol check box.</td>
</tr>
<tr>
<td></td>
<td>The password must contain at least 8 characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> After you check the Privacy Required check box, the DES (Data</td>
</tr>
<tr>
<td></td>
<td>Encryption Standard) check box automatically appears checked. The DES</td>
</tr>
<tr>
<td></td>
<td>protocol prevents packets from being disclosed.</td>
</tr>
<tr>
<td>Accept SNMP Packets from any host</td>
<td>To accept SNMP packets from any host, click the radio button.</td>
</tr>
<tr>
<td>Accept SNMP Packets only from these hosts</td>
<td>To accept SNMP packets from specific hosts, click the radio button. In the Host IP Address field, enter a host from which you want to accept SNMP packets and click <strong>Insert</strong>. Repeat this process for each host from which you want to accept SNMP packets. To delete a host, choose that host from the Host IP Addresses pane and click <strong>Remove</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Access Privileges</td>
<td>From the drop-down list box, choose one of the following options for the access level:</td>
</tr>
<tr>
<td></td>
<td><strong>ReadOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The user can only read the values of MIB objects.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadWrite</strong></td>
</tr>
<tr>
<td></td>
<td>The user can read and write the values of MIB objects.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadWriteNotify</strong></td>
</tr>
<tr>
<td></td>
<td>The user can read and write the values of MIB objects and send MIB object values for a trap and inform messages.</td>
</tr>
<tr>
<td></td>
<td><strong>NotifyOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The user can only send MIB object values for trap and inform messages.</td>
</tr>
<tr>
<td></td>
<td><strong>ReadNotifyOnly</strong></td>
</tr>
<tr>
<td></td>
<td>The user can read values of MIB objects and also send the values for trap and inform messages.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>The user cannot read, write, or send trap information.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong></td>
</tr>
<tr>
<td></td>
<td>To change the trap configuration parameters, you need to configure a user with NotifyOnly, ReadNotifyOnly, or ReadWriteNotify privileges.</td>
</tr>
<tr>
<td>Unified CM clusters only: Apply To All Nodes</td>
<td>To apply the user configuration to all nodes in the cluster, check this check box.</td>
</tr>
</tbody>
</table>

**Delete SNMP user**

To delete a user for SNMP, perform the following procedure:

**Procedure**

1. **Step 1** Locate the SNMP user, as described in the Find SNMP user, on page 133.
2. **Step 2** From the list of matching records, check the check box next to the user that you want to delete.
3. **Step 3** Click Delete Selected.
4. **Step 4** A message indicates that the system will delete notification entries that relate to this user. To continue the deletion, click OK.
5. **Step 5** A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.
Tip: Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service. For information on how to restart the service, see the Configuring services, on page 87.

After the window refreshes, the user that you deleted no longer displays in the results.

### SNMP notification destination

The following sections apply to SNMP V3 notification destination configuration.

- Find notification destination, on page 137
- Set up notification destination, on page 138
- Notification destination configuration settings, on page 138
- Delete notification destination, on page 139

### Find notification destination

#### Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Choose Snmp &gt; V3 &gt; Notification Destination.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>From the Find Notification where Destination IP drop-down list box, choose the specific search criteria that you want to use to find the notification destination; for example, begins with.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Enter the IP address/hostname of notification destination for which you want to search.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>In the Server field, choose the hostname or IP address of the server that supports the notification destination.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Click Find. After you click the Find button, the Add New button displays. After the search results display, the Apply to All Nodes check box displays.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Unified CM clusters only: If you want to apply the configuration from one of the options in the search results to all nodes in the cluster, check the check box next to the name of the option and check the Apply to All Nodes check box.</td>
</tr>
<tr>
<td><strong>Step 7</strong></td>
<td>From the list of results, click the notification destination that you want to view.</td>
</tr>
<tr>
<td><strong>Step 8</strong></td>
<td>To add or update a notification destination, see the Set up notification destination, on page 138.</td>
</tr>
</tbody>
</table>
Set up notification destination

To configure the trap/Inform receiver, perform the following procedure:

**Procedure**

**Step 1**
Perform the procedure in the Find notification destination, on page 137.

**Step 2**
Perform one of the following tasks:

a) To add a new SNMP notification destination, click the Add New button in the search results window and go to step 3.

b) To modify an existing SNMP notification destination, locate the notification destination in the search results window; click the name of the SNMP notification destination that you want to edit and go to step 3.

c) To delete an SNMP notification destination, see the Delete notification destination, on page 139.

**Step 3**
Configure the settings, as described in Notification destination configuration settings, on page 138.

**Tip**
Before you save the configuration, you can click the Clear button at any time to delete all information that you entered for all settings in the window.

**Step 4**
To save a notification destination, click Insert, or click Save to save changes to an existing notification destination.

**Step 5**
A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

**Tip**
Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.
For information on how to restart the service, see the Configuring services, on page 87.

### Notification destination configuration settings

The following table describes the notification destination configuration settings for V3.

**Table 40: Notification Destination Configuration Settings for V3**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you specified the server when you performed the procedure in the Find notification destination, on page 137. To change the server for the notification destination, perform the procedure in the Find notification destination, on page 137.</td>
</tr>
<tr>
<td>Host IP Addresses</td>
<td>From the drop-down list box, choose the Host IP address or choose Add New. If you chose Add New, enter the IP address for the host.</td>
</tr>
<tr>
<td>Port Number</td>
<td>In the field, enter the notification-receiving port number on the destination server.</td>
</tr>
</tbody>
</table>
From the drop-down list box, choose **Inform** or **Trap**.

**Tip** Cisco recommends that you choose the Inform option. The Inform function retransmits the message until it is acknowledged, thus, making it more reliable than traps.

**Remote SNMP Engine Id**

This setting displays if you chose Inform from the Notification Type drop-down list box.

From the drop-down list box, choose the engine ID or choose **Add New**. If you chose Add New, enter the ID in the Remote SNMP Engine Id field, which requires a hexadecimal value.

**Security Level**

From the drop-down list box, choose the appropriate security level for the user.

- **noAuthNoPriv**
  
  No authentication or privacy configured.

- **authNoPriv**
  
  Authentication configured, but no privacy configured.

- **authPriv**
  
  Authentication and privacy configured.

**User Information pane**

From the pane, perform one of the following tasks to associate or disassociate the notification destination with the user.

1. To create a new user, click the **Create New User** button and see the Set up SNMP user, on page 134.
2. To modify an existing user, click the radio button for the user and click **Update Selected User**; then, see the Set up SNMP user, on page 134.
3. To delete a user, click the radio button for the user and click **Delete Selected User**.

The users that display vary depending on the security level that you configured for the notification destination.

**Unified CM clusters only:**

Apply To All Nodes

To apply the notification destination configuration to all nodes in the cluster, check this check box.

---

**Delete notification destination**

To delete a notification destination, perform the following procedure:
Procedure

**Step 1** Locate the SNMP notification destination, as described in the Find notification destination, on page 137.

**Step 2** From the list of matching records, check the check box next to the notification destination that you want to delete.

**Step 3** Click Delete Selected.

**Step 4** A message asks you if you want to delete the notification destination. To continue the deletion, click OK.

**Step 5** A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent, click Cancel. To restart the SNMP master agent service, click OK.

**Tip** Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

For information on how to restart the service, see the Configuring services, on page 87.

After the window refreshes, the notification destination that you deleted no longer displays in the search results window.

---

**SNMP system group**

Cisco Unified Serviceability provides the MIB2 System Group Configuration window where you can configure the system contact and system location objects for the MIB-II system group. For example, you could enter Administrator, 555-121-6633, for the system contact and San Jose, Bldg 23, 2nd floor, for the system location.

**Set up MIB2 system group**

Perform the following procedure to configure a system contact and system location for the MIB-II system group.

**Tip** This procedure supports SNMP v1, v2c, and v3 configuration.

**Procedure**

**Step 1** Choose Snmp > SystemGroup > MIB2 System Group.

**Step 2** Configure the settings, as described in MIB2 system group configuration settings, on page 141.

**Step 3** Click Save.

**Step 4** A message indicates that changes will not take effect until you restart the SNMP master agent. To continue the configuration without restarting the SNMP master agent service, click Cancel. To restart the SNMP master agent service, click OK.

**Note** To clear the System Contact and System Location fields, click the Clear All button. To delete the system configuration, click the Clear All button and the Save button.
**MIB2 system group configuration settings**

The following table describes the MIB2 System Group configuration settings.

*Table 41: MIB2 System Group Configuration Settings*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>From the drop-down list box, choose the server for which you want to configure contacts; then, click <strong>Go</strong>.</td>
</tr>
<tr>
<td>System Contact</td>
<td>In the field, enter a person to notify when problems occur.</td>
</tr>
<tr>
<td>System Location</td>
<td>In the field, enter the location of the person that is identified as the system contact.</td>
</tr>
<tr>
<td>Unified CM clusters only: Apply To All Nodes</td>
<td>To apply the system configuration to all of the nodes in the cluster, check the check box.</td>
</tr>
</tbody>
</table>

**SNMP trap settings**

This section describes how to use CLI commands to set configurable trap settings. [SNMP traps and informs, on page 115](#) provides the SNMP trap configuration parameters and recommended configuration for CISCO-SYSLOG-MIB, CISCO-CCM-MIB, and CISCO-UNITY-MIB.

**CISCO-SYSLOG-MIB trap parameters**

Use these guidelines to configure CISCO-SYSLOG-MIB trap settings on your system:

- Set clogsNotificationEnabled (1.3.6.1.4.1.9.9.41.1.1.2) to true by using the SNMP Set operation; for example, use the `net-snmp set` utility to set this OID to true from the linux command line using:

  ```
  snmpset -c <community string> -v2c <transmitter ipaddress> 1.3.6.1.4.1.9.9.41.1.1.2.0 i 1
  ```

  You can also use any other SNMP management application for the SNMP Set operation.

- Set clogMaxSeverity (1.3.6.1.4.1.9.9.41.1.1.3) value by using the SNMP Set operation; for example, use the `net-snmp set` utility to set this OID value from the linux command line using:

  ```
  snmpset -c public -v2c <transmitter ipaddress> 1.3.6.1.4.1.9.9.41.1.1.3.0 i <value>
  ```

  Enter a severity number for the `<value>` setting. Severity values increase as severity decreases. A value of 1 (Emergency) indicates highest severity, and a value of 8 (Debug) indicates lowest severity. Syslog agent ignores any messages greater than the value that you specify; for example, to trap all syslog messages, use a value of 8.

  You can also use any other SNMP management application for the SNMP Set operation.
Before logging, Syslog truncates any trap message data that is larger than the specified Syslog buffer size. The Syslog trap message length limitation equals 255 bytes.

CISCO-CCM-MIB trap parameters

Unified CM and Unified CM BE only: Use these guidelines to configure CISCO-CCM-MIB trap settings on your system:

- Set `ccmPhoneFailedAlarmInterval (1.3.6.1.4.1.9.9.156.1.9.2)` to a value in the range 30-3600 by using the SNMP Set operation; for example, use the net-snmp set utility to set this OID value from the Linux command line using:

  ```
  snmpset -c <community string> -v2c <transmitter ipaddress> 1.3.6.1.4.1.9.9.156.1.9.2 .0 i <value>
  ```

You can also use any other SNMP management application for the SNMP Set operation.

- Set `ccmPhoneStatusUpdateAlarmInterval (1.3.6.1.4.1.9.9.156.1.9.4)` to a value in the range 30-3600 by using the SNMP Set operation; for example, use the net-snmp set utility to set this OID value from the Linux command line using:

  ```
  snmpset -c <community string> -v2c <transmitter ipaddress> 1.3.6.1.4.1.9.9.156.1.9.4.0 i <value>
  ```

You can also use any other SNMP management application for the SNMP Set operation.

CISCO-UNITY-MIB trap parameters

Connection only: The Connection SNMP Agent does not enable trap notifications, though traps can be triggered by Cisco Unity Connection alarms. You can view Cisco Unity Connection alarm definitions in Cisco Unity Connection Serviceability, on the **Alarm > Definitions** screen.

You can configure trap parameters by using the CISCO-SYSLOG-MIB. See the CISCO-SYSLOG-MIB trap parameters, on page 141.
The Call Home feature introduced in Cisco Unified CM 8.6(1) requires back-office support from Smart Call Home (SCH) 3.2 planned for release in 2HCY2011. Please do not enable the feature in Cisco Unified CM serviceability until SCH 3.2 is released. Please check http://cisco.com/go/smartcall to confirm availability of SCH 3.2 prior to configuring Cisco Unified CM Call Home.

This chapter provides an overview of the Cisco Unified Communications Manager Call Home service and describes how to configure the Cisco Unified CM Call Home feature. The Call Home feature allows to communicate and send the diagnostic alerts, inventory, and other messages to the Smart Call Home back-end server.

Smart Call Home

Smart Call Home provides proactive diagnostics, real-time alerts, and remediation on a range of Cisco devices for higher network availability and increased operational efficiency. It accomplishes the same by receiving and analyzing the diagnostic alerts, inventory, and other messages from Smart Call Home enabled Cisco Unified Communications Manager. This particular capability of Cisco Unified CM is called as Cisco Unified CM Call Home.

Smart Call Home offers:

- Higher network availability through proactive, fast issue resolution by:
  - Identifying issues quickly with continuous monitoring, real-time, proactive alerts, and detailed diagnostics.
  - Making you aware of potential problems by providing alerts that are specific to only those types of devices in the network. Resolving critical problems faster with direct, automatic access to experts at Cisco Technical Assistance Center (TAC).

- Increased operational efficiency by providing customers the ability to:
Use staff resources more efficiently by reducing troubleshooting time.
Generate Service Requests to Cisco TAC automatically and route it to the appropriate support team that provides detailed diagnostic information and speedy resolution.

Fast, web-based access to needed information that provides customers the ability to:
- Review all Call Home messages, diagnostics, and recommendations in one place.
- Check Service Request status quickly.
- View the most up-to-date inventory and configuration information for all Call Home devices.

Figure 20: Cisco Smart Call Home Overview

Smart Call Home contains modules that perform the following tasks:
- Raise Service Requests with Cisco TAC.
- Notify Customer of Call Home messages.
- Provide impact analysis and remediation steps.

For more information about Smart Call Home, see the Smart Call Home page at this location:
Smart Call Home interaction

If you have a service contract directly with Cisco Systems, you can register Unified CM for the Cisco Smart Call Home service. Smart Call Home provides fast resolution of system problems by analyzing Call Home messages that are sent from Unified CM and providing background information and recommendations.

The Cisco Unified CM Call Home feature delivers the following messages to the Smart Call Home backend server:

- Alerts - Contain alert information for various conditions related to environment, hardware failure, and system performance. The alerts can be generated from any node within the Cisco Unified Communications Manager cluster. The alert details contain the node and other information required for troubleshooting purposes, depending on the alert type. See topics related to Smart call home interaction for alerts that are sent to the Smart Call Home backend server.

<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Default Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Alerts</td>
<td></td>
</tr>
<tr>
<td>CallProcessingNodeCPUPegging</td>
<td>Trigger up to 3 alerts within 30 minutes</td>
</tr>
<tr>
<td>CodeYellow</td>
<td>Trigger alert on every poll</td>
</tr>
<tr>
<td>CPUPegging</td>
<td>Trigger up to 3 alerts within 30 minutes</td>
</tr>
<tr>
<td>LowActivePartitionAvailableDiskSpace</td>
<td>Trigger up to 3 alerts within 30 minutes</td>
</tr>
<tr>
<td>LowAvailableVirtualMemory</td>
<td>Trigger up to 3 alerts within 30 minutes</td>
</tr>
<tr>
<td>LowSwapPartitionAvailableDiskSpace</td>
<td>Trigger up to 3 alerts within 30 minutes</td>
</tr>
<tr>
<td>Database - Related Alerts</td>
<td></td>
</tr>
<tr>
<td>DBReplicationFailure</td>
<td>Trigger up to 1 alert within 60 minutes</td>
</tr>
<tr>
<td>Failed Calls Alerts</td>
<td></td>
</tr>
<tr>
<td>MediaListExhausted</td>
<td>Trigger alert on every poll</td>
</tr>
<tr>
<td>RouteListExhausted</td>
<td>Trigger alert on every poll</td>
</tr>
<tr>
<td>Crash - Related Alerts</td>
<td></td>
</tr>
<tr>
<td>Coredumpfilefound</td>
<td>Trigger alert on every poll</td>
</tr>
<tr>
<td>CriticalServiceDown</td>
<td>Trigger alert on every poll</td>
</tr>
<tr>
<td>Environment - Related Alert</td>
<td></td>
</tr>
<tr>
<td>HardwareFailure</td>
<td>Trigger alert on every poll</td>
</tr>
</tbody>
</table>
To control flooding of alert emails, you can change the default frequency of specific alert in RTMT. For more information on alerts, see the *Cisco Unified Real-Time Monitoring Tool Administration Guide*.

- Configuration messages - Contain information about the row count for each database table that is related to a configuration. The configuration data consists of table name and row count for each table across the cluster.
- Inventory messages - Contain information about the cluster, nodes, and license.
- Telemetry messages - Contain information about the number of devices (IP phones, gateways, conference bridge, and so on) for each device type that is available on a Cisco Unified CM cluster. The telemetry data contains the device count for the entire cluster.

The configuration, inventory, and telemetry messages are sent periodically (first day of every month) to the Smart Call Home back-end server. The information in these messages enables TAC to provide timely and proactive service to help customers manage and maintain their network.

**Related Topics**

- Smart Call Home interaction, on page 145

**Pre-requisites for Call Home**

To support the Cisco Unified CM Call Home service, you require the following:

- A Cisco.com user ID associated with a corresponding Cisco Unified Communications Manager service contract.
- Internet Explorer (IE) 6.0 or later, Mozilla Firefox, or Safari browsers.
- It is highly recommended that both the Domain Name System (DNS) and Simple Mail Transfer Protocol (SMTP) servers are setup for the Cisco Unified CM Call Home feature.
  - DNS setup is required to send the Call Home messages using Secure Web (HTTPS).
  - SMTP setup is required to send the Call Home messages to Cisco TAC or to send a copy of the messages to a list of recipients through email.

**Access Call Home**

To access Unified CM Call Home, go to Cisco Unified Serviceability Administration and choose **CallHome** (Cisco Unified Serviceability > CallHome > Call Home Configuration).

**Call Home settings**

The following table lists the default Cisco Unified CM Call Home settings.
Table 42: Default Call Home Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Home feature status</td>
<td>Disabled</td>
</tr>
<tr>
<td>Send Data to Cisco Technical Assistance Center (TAC) using</td>
<td>Secure Web (HTTPS)</td>
</tr>
</tbody>
</table>

Call Home configuration

In Cisco Unified Serviceability, choose Call Home > Call Home Configuration.

The Call Home Configuration window appears.

The following table describes the settings to configure the Cisco Unified CM Call Home.

Table 43: Cisco Unified CM Call Home Configuration Settings

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Home Message Schedule</td>
<td>Displays the date and time of the last Call Home messages sent and the next message scheduled.</td>
</tr>
<tr>
<td>Customer Contact Details</td>
<td></td>
</tr>
<tr>
<td>Enable Call Home</td>
<td>Check this check box to activate the Cisco Unified CM Call Home service. This setting is disabled by default.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enter the contact email address of the customer. This is a mandatory field.</td>
</tr>
<tr>
<td></td>
<td>The email address validations are:</td>
</tr>
<tr>
<td></td>
<td>• The address format of email address:</td>
</tr>
<tr>
<td></td>
<td>&lt;username&gt;@&lt;domain&gt;.&lt;top-level-domain&gt;</td>
</tr>
<tr>
<td></td>
<td>• The address format can support hierarchical domain names; for example, <a href="mailto:abc@def.ghi.com">abc@def.ghi.com</a></td>
</tr>
<tr>
<td></td>
<td>• The username can start and end only with an alphanumeric character.</td>
</tr>
<tr>
<td></td>
<td>• The username can contain special characters like hyphen (-), dot (.), and underscore (_).</td>
</tr>
<tr>
<td></td>
<td>• The top level domain can vary from two to nine characters.</td>
</tr>
<tr>
<td>Company</td>
<td>(Optional) Enter the name of the company. You can enter up to 255 characters.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contact Name</td>
<td>(Optional) Enter the contact name of the customer. You can enter up to 128 characters. The contact name can contain alphanumeric characters and some special characters like dot (.), underscore (_) and hyphen (-).</td>
</tr>
<tr>
<td>Address</td>
<td>(Optional) Enter the address of the customer. You can enter up to 1024 characters.</td>
</tr>
<tr>
<td>Phone</td>
<td>(Optional) Enter the phone number of the customer.</td>
</tr>
<tr>
<td>Send Data to Cisco Technical Assistance Center (TAC)</td>
<td>Check this check box to communicate the Call Home messages securely to TAC. For communication, you can choose either Secure Web (HTTPS) or email option from the list.</td>
</tr>
</tbody>
</table>
| Send a copy to the following email addresses   | Check this check box to send a copy of the Call Home messages to the specified email addresses. The email address validations are:  
• Multiple email addresses are separated by a comma but must not end with a comma.  
• The address format of email address: `<username>@<domain>.<top-level-domain>`  
• The address format can support hierarchical domain names; for example, abc@def.ghi.com  
• The username can start and end only with an alphanumeric character.  
• The username can contain special characters like hyphen (-), dot (.), and underscore (_).  
• The top level domain can vary from two to nine characters.  
Note: To enable the Call Home feature, you must check either the Send Data to Cisco Technical Assistance Center (TAC) or Send a copy to the following email addresses check box. |
| Save                                           | Saves your Call Home configuration.  
Note: After you save your Call Home Configuration, an End User License Agreement (EULA) message appears. If you are configuring for the first time, you must accept the license agreement.  
Tip: To deactivate the Call Home service that you activated, uncheck the Enable Call Home check box; then, click Save. |
| Reset                                          | Resets to last saved configuration.                                                                                                                                                                                                                                                                                                       |
| Save and Call Home Now                         | Saves and sends the Call Home messages instantly (on demand).                                                                                                                                                                                                                                                                               |
Limitations

The following limitations apply when Cisco Unified CM server is down or unreachable:

• Call Home Message Schedule - Fails to capture the date and time of the last Call Home messages sent and the next message scheduled, until the server is reachable.

• Call Home Now - Does not send the Call Home messages on demand, until the server is reachable.

References for Call Home

For more information about Smart Call Home, refer the following URL:

• Smart Call Home Service Introduction
PART II

Cisco Unified Serviceability for IM and Presence Service

- Introduction, page 153
- Alarm setup and definitions in Cisco Unified Serviceability, page 159
- Trace setup, page 167
- Feature and network services, page 185
- Services setup and viewing services, page 197
- Simple Network Management Protocol, page 205
- SNMP V1/V2c setup, page 215
- SNMP V3 setup, page 223
- MIB2 system group, page 231
- Trace field descriptions, page 233
Introduction

- Cisco Unified Serviceability overview, page 153
- Cisco Unified Serviceability access, page 154
- About the Cisco Unified IM and Presence Serviceability interface, page 155
- More information, page 157

Cisco Unified Serviceability overview

Cisco Unified Serviceability, a web-based troubleshooting tool for the IM and Presence Service, provides the following functionality:

- Saves alarms and events for troubleshooting and provides alarm message definitions.
- Saves trace information to various log files for troubleshooting.
- Monitors real-time behavior of components through the IM and Presence Real-Time Monitoring Tool (RTMT).
- Provides feature services that you can turn on, turn off, and view through the Service Activation window.
- Provides an interface for starting and stopping feature and network services.
- Generates and archives daily reports; for example, alert summary or server statistic reports.
- Allows IM and Presence to work as a managed device for SNMP remote management and troubleshooting.
- Monitors the disk usage of the log partition on a node (or all nodes in the cluster).
- Monitors the number of threads and processes in the system; uses cache to enhance the performance.

Tip

Cisco RIS Data Collector provides Process and Thread statistic counters in the IM and Presence RTMT. To configure the maximum number of processes and threads that are allowed, so Cisco RIS Data Collector can provide these associated counters, access the Maximum Number of Threads and Process service parameter for the Cisco RIS Data Collector service in Cisco Unified CM IM and Presence Administration.
Cisco Unified Serviceability access

To access Cisco Unified Serviceability, you must browse to the application from a computer that runs the supported browser. Cisco Unified Serviceability uses Hypertext Transfer Protocol (HTTPS) to establish secure connections.

Tip
Cisco Unified Serviceability does not support the buttons in your browser. Do not use the browser buttons, for example, the Back button, when you perform configuration tasks.

Remote serviceability tools

To supplement the management and administration of the IM and Presence service, you can use remote serviceability tools. Using these tools, you can gather system and debug information for diagnostic help or remote troubleshooting. The tools can process and report on a collection of local or remote IM and Presence configuration information. With customer permission, technical support engineers sign into an IM and Presence node and get a desktop or shell that allows them to perform any function that could be done from a local sign-in session.

IM and Presence supports the following capabilities for remote serviceability:

• Simple Network Management Protocol (SNMP)—Provides remote management for managed devices such as IM and Presence.
• Show Command Line Interface—Displays IM and Presence system data.
• Syslog Analysis tools monitor and manage a wide range of events and error messages

Access Cisco Unified IM and Presence Serviceability

After you sign into Cisco Unified IM and Presence Serviceability, you can access all applications that display in the Navigation list box without having to sign into each application. Select the application you require from the list box, and select Go.

Before You Begin

If you have already signed into one of the applications that display in the Navigation list box (not Cisco Unified IM and Presence OS Administration or IM and Presence Disaster Recovery System), you can access Cisco Unified IM and Presence Serviceability without signing in. From the Navigation list box, select Cisco Unified IM and Presence Serviceability; then, select Go.
Procedure

Step 1 Enter https://<server name or IP address>, where the server name or IP address equals the server where the Cisco Unified IM and Presence Serviceability service runs.

Step 2 Sign into Cisco Unified CM IM and Presence Administration.

Step 3 If the system prompts you about certificates, you must enable HTTPS to secure communications between the browser client and the web server.

Step 4 Enter the application username and application user password that you specified during installation when the system prompts you for a user name and password.

Step 5 After Cisco Unified CM IM and Presence Administration displays, select Navigation > Cisco Unified IM and Presence Serviceability from the menu in the upper, right corner of the main window.

About the Cisco Unified IM and Presence Serviceability interface

Cisco Unified IM and Presence Serviceability interface

In addition to performing troubleshooting and service-related tasks in Cisco Unified IM and Presence Serviceability, you can perform the following tasks:

• To display documentation for a single window, select Help > This page.
• To display a list of documents that are available with this release of IM and Presence (or to access the online help index), select Help > Contents.
• To go directly to the home page in Cisco Unified IM and Presence Serviceability from a configuration window, select Cisco Unified IM and Presence Serviceability from the Navigation drop-down list box in the upper, right corner of the window.
• To access Cisco Unified CM IM and Presence Administration or other applications, select the appropriate application from the Navigation list box in the upper, right corner of the window and select Go.
• To use the icons in Cisco Unified IM and Presence Serviceability, see the following table.

Table 44: Icons in Cisco Unified IM and Presence Serviceability

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Adds a new configuration</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Cancels the operation</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Clears the configuration that you specify</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Deletes the configuration that you select</td>
</tr>
</tbody>
</table>
### Accessibility features

Cisco Unified IM and Presence Serviceability provides functionality for users that allows them to access buttons on the window without using a mouse. These navigation shortcuts assist visually impaired or blind attendants to use the application.

Use the following table as a guide for navigating the interface by using keyboard shortcuts.

#### Table 45: Navigation Shortcuts for Cisco Unified IM and Presence Serviceability

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt</td>
<td>Moves focus to the browser menu bar.</td>
</tr>
<tr>
<td>Enter</td>
<td>Selects the item with focus (menu option, button, and so on.)</td>
</tr>
<tr>
<td>Alt, arrow keys</td>
<td>Moves between browser menus.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Toggles control</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves focus to the next item in the tab order or to next control group</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves focus to the previous item or group in the tab order</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves among controls within a group</td>
</tr>
<tr>
<td>Keystroke</td>
<td>Action</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Home</td>
<td>Moves to the top of the window if more than one screenful of information exists. Also, moves to the beginning of a line of user-entered text.</td>
</tr>
<tr>
<td>End</td>
<td>Moves to the end of a line of user-entered text. Moves to the bottom of the window if more than one screenful of information exists.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scrolls up one screen.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scrolls down one screen.</td>
</tr>
</tbody>
</table>

**More information**

Cisco strongly recommends that you review the following documents for more details about installing and maintaining the IM and Presence Service, and for related compatibility information.

- *Installation Guide for IM and Presence Service*
  This document describes procedures to follow when installing IM and Presence.

- *Cisco Unified Communications Operating System Administration Guide*
  This document provides information about software upgrades, and informs you how to access and use the utilities that are available through the operating system GUI and the command line interface.

- *Deployment Guide for IM and Presence Service on Cisco Unified Communications Manager, Release 9.0*
  This document provides an overview of the configuration process for IM and Presence and Cisco Unified Communications Manager, and Cisco Jabber.

- *Disaster Recovery System Administration Guide*
  This document describes how to configure the backup settings, back up IM and Presence data, and restore the data.

- For product compatibility information relating to an IM and Presence release, refer to the following URL:

Set up Cisco Unified IM and Presence Serviceability alarms

Perform the following tasks to set up Cisco Unified IM and Presence Serviceability alarms:

Procedure

- **Step 1** Select the server and service for which you want the alarm information.
- **Step 2** Select the destination of the alarm
  - All services can go to the SDI (System Diagnostic Interface) log (but must be configured in Trace also).
  - All services can go to the SysLog Viewer.
  - To send syslog messages to the Remote Syslog Server, check the Remote Syslog destination and specify a host name.
- **Step 3** Select the alarm event level.
- **Step 4** If desired, add a definition to an alarm.
- **Step 5** If you chose an SDI trace file as the alarm destination, collect traces and view the information with the trace and log central option in RTMT. See the *Cisco Unified Real-Time Monitoring Tool Administration Guide* for more information.
- **Step 6** If you chose local syslog as the alarm destination, view the alarm information in the SysLog Viewer in RTMT. See the *Cisco Unified Real-Time Monitoring Tool Administration Guide* for more information.
Step 7  See the corresponding alarm definition for the description and recommended action.

Related Topics
- Alarm definitions and user-defined descriptions, on page 162
- Alarm setup and update for a service, on page 160

Alarm setup and update for a service

This section provides information to setup and update alarms for a service.

Alarm setup for a service

Cisco Unified IM and Presence Serviceability alarms provide information about runtime status and the state of the system. This information allows you to troubleshoot problems that are associated with your system, for example, to identify issues with the Disaster Recovery System.

You can configure the alarm interface to send alarm information to multiple locations, and each location can have its own alarm event level (from debug to emergency). You can direct alarms to the Syslog Viewer (local syslog), Syslog file (remote syslog), an SDI trace log file, or to all destinations. When a service issues an alarm, the alarm interface sends the alarm information to the locations that you configure (and that are specified in the routing list in the alarm definition) (for example, SDI trace). The system can either forward the alarm information, as is the case with SNMP traps, or the system can write the alarm information to its final destination (such as a log file).

You can configure alarms for services, such as Cisco Database Layer Monitor, on a particular node, or you configure alarms for a particular service on all nodes in the cluster.

To configure an alarm for a service, you select an alarm event level, such as Error, and the location(s), such as Syslog Viewer (local syslog), where you want the system to send the alarm information. Choosing an event level accomplishes the following tasks: helps you narrow the types of alarms that get collected and prevents the Syslog and trace files from becoming overloaded.

You view alarm information to determine whether problems exist. The method that you use to view the alarm information depends on the destination that you chose when you configured the alarm. You can view alarm information that is sent to the SDI trace log file by using the Trace and Log central option in RTMT or by using a text editor. You can view alarm information that is sent to local syslog by using the SysLog Viewer in RTMT.

Set up or update alarm for a service

Perform this procedure to configure or update an alarm for a service. See your online Operating System documentation for more information on how to use your standard registry editor.

Note
Cisco recommends that you do not change SNMP Trap and Catalog configurations.

You can set the alarm destination, see the following table:
The alarm destination options vary depending on the service group and service that you select.

### Table 46: Alarm Destinations

<table>
<thead>
<tr>
<th>Name</th>
<th>Destination description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Alarm for Local Syslogs</td>
<td>SysLog Viewer. The program logs IM and Presence errors in the Application Logs within SysLog Viewer and provides a description of the alarm and a recommended action. You can access the SysLog Viewer from the Serviceability Real-Time Monitoring Tool.</td>
</tr>
<tr>
<td>Enable Alarm for Remote Syslogs</td>
<td>Syslog file. Check to enable the Syslog messages to be stored on a Syslog server and to specify the Syslog server name. You can specify up to five Syslog server names. If this destination is enabled and no server name is specified, IM and Presence does not send the Syslog messages. Note: If you want to send the alarms to Cisco Unified Operations Manager, specify the Cisco Unified Operations Manager server name.</td>
</tr>
<tr>
<td>Enable Alarm for SDI Trace</td>
<td>The SDI trace library. Check this to log alarms in the SDI trace log file, and then check Trace On in the Trace Configuration window for the chosen service.</td>
</tr>
</tbody>
</table>

You can also set the event level for the alarm, see the following table:

### Table 47: Alarm Event Levels

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
<td>Designates system as unusable.</td>
</tr>
<tr>
<td>Alert</td>
<td>Indicates that immediate action is needed.</td>
</tr>
<tr>
<td>Critical</td>
<td>IM and Presence detects a critical condition.</td>
</tr>
<tr>
<td>Error</td>
<td>Signifies an error condition exists.</td>
</tr>
<tr>
<td>Warning</td>
<td>Indicates that a warning condition is detected.</td>
</tr>
<tr>
<td>Notice</td>
<td>Designates a normal but significant condition.</td>
</tr>
<tr>
<td>Informational</td>
<td>Designates information messages only.</td>
</tr>
</tbody>
</table>
### Procedure

**Step 1** Select **Alarm > Configuration**.

**Step 2** Select the server for which you want to configure the alarm from the **Server** list box.

**Step 3** Select **Go**.

**Step 4** Select the category of service, for example, Database and Admin Services, for which you want to configure the alarm from the **Service Group** list box.

**Step 5** Select **Go**.

**Step 6** Select the service for which you want to configure the alarm from the **Service** list box.

**Step 7** Select **Go**.

*Note* The list box displays all services (active and inactive).

**Step 8** Check the required alarm destination.

The options that display vary depending on the service group and service you select.

**Step 9** Select the desired alarm event level from the **Alarm Event Level** list box.

**Step 10** Check **Apply to All Nodes** to apply the current settings for selected services to all nodes in a cluster.

**Step 11** Perform one of the following actions:

a) Select **Save** to save your configuration.

b) Select **Set to Default** to revert to the default settings and select **Save**.

### Related Topics

Set up trace parameters, on page 172

### Alarm definitions and user-defined description additions

This section provides information about alarm definitions and user-defined description additions.

### Alarm definitions and user-defined descriptions

Alarm definitions describe alarm messages: what they mean and how to recover from them. You search the **Alarm Definitions** window for alarm information. When you select any service-specific alarm definition, a description of the alarm information (including any user-defined text that you have added) and a recommended action display.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug</td>
<td>Designates detailed event information that Cisco TAC engineers use for debugging.</td>
</tr>
</tbody>
</table>
You can search for definitions of all alarms that display in Cisco Unified IM and Presence Serviceability. To aid you with troubleshooting problems, the definitions, which exist in a corresponding catalog, include the alarm name, description, explanation, recommended action, severity, parameters, monitors, and so on.

When the system generates an alarm, it uses the alarm definition name in the alarm information, so you can identify the alarm. In the alarm definition, you can view the routing list, which specifies the locations where the system can send the alarm information. The routing list may include the following locations, which correlate to the locations that you can configure in the Alarm Configuration window:

- **SDI** — The system sends the alarm information to the SDI trace if you enable the alarm for this option and specify an appropriate event level in the Alarm Configuration window.

- **Sys Log** — The system sends the alarm information to the remote syslog server if you enable the alarm for this option, specify an appropriate event level in the Alarm Configuration window, and enter a server name or IP address for the remote syslog server.

- **Event Log** — The system sends the alarm information to the local syslog, which you can view in the SysLog Viewer in the Real-Time Monitoring Tool (RTMT), if you enable the alarm for this option and specify an appropriate event level in the Alarm Configuration window.

- **Data Collector** — System sends the alarm information to the real-time information system (RIS data collector) (for alert purposes only). You cannot configure this option in the Alarm Configuration window.

- **SNMP Traps** — System generates an SNMP trap. You cannot configure this option in the Alarm Configuration window.

The system sends an alarm if the configured alarm event level for the specific location in the Alarm Configuration window is equal to or lower than the severity that is listed in the alarm definition. For example, if the severity in the alarm definition equals WARNING_ALARM, and, in the Alarm Configuration window, you configure the alarm event level for the specific destination as Warning, Notice, Informational, or Debug, which are lower event levels, the system sends the alarm to the corresponding destination. If you configure the alarm event level as Emergency, Alert, Critical, or Error, the system does not send the alarm to the corresponding location.

For each Cisco Unified IM and Presence Serviceability alarm definition, you can include an additional explanation or recommendation. All administrators have access to the added information. You enter information into the User Defined Text pane that displays in the Alarm Details window. Standard horizontal and vertical scroll bars support scrolling. Cisco Unified IM and Presence Serviceability adds the information to the database.

**View alarm definitions and add user-defined descriptions**

**Before You Begin**

Review the description of alarm definition catalogs.

**Procedure**

1. **Step 1** Select Alarm > Definitions.
2. **Step 2** Perform one of the following actions:
   a) Select an alarm as follows:
Alarm Catalog descriptions

This section provides alarm catalog descriptions.

System Alarm Catalog descriptions

The following table contains the System Alarm Catalog alarm descriptions.

Table 48: System Alarm Catalogs

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClusterManagerAlarmCatalog</td>
<td>All cluster manager alarm definitions that are related to the establishment of security associations between nodes in a cluster.</td>
</tr>
<tr>
<td>DBAlarmCatalog</td>
<td>All Cisco database alarm definitions</td>
</tr>
<tr>
<td>DRFAAlarmCatalog</td>
<td>All Disaster Recovery System alarm definitions</td>
</tr>
<tr>
<td>GenericAlarmCatalog</td>
<td>All generic alarm definitions that all applications share</td>
</tr>
</tbody>
</table>
You cannot use the alarm configuration GUI to configure Java Applications alarms. You generally configure these alarms to go to the Event Logs and to generate SNMP traps to integrate with Cisco Unified Operations Manager.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JavaApplications</td>
<td>All Java Applications alarm definitions.</td>
</tr>
<tr>
<td>LoginAlarmCatalog</td>
<td>All login-related alarm definitions</td>
</tr>
<tr>
<td>LpmTctCatalog</td>
<td>All log partition monitoring and trace collection alarm definitions</td>
</tr>
<tr>
<td>RTMTAlarmCatalog</td>
<td>All IM and Presence Real-Time Monitoring Tool alarm definitions</td>
</tr>
<tr>
<td>SystemAccessCatalog</td>
<td>All alarm definitions that are used for tracking whether SystemAccess provides all thread statistic counters together with all the process statistic counters.</td>
</tr>
<tr>
<td>ServiceManagerAlarmCatalog</td>
<td>All service manager alarm definitions that are related to the activation, deactivation, starting, restarting, and stopping of services.</td>
</tr>
<tr>
<td>IMSAlarmCatalog</td>
<td>All user authentication and credential definitions.</td>
</tr>
<tr>
<td>CertMonitorAlarmCatalog</td>
<td>All certificate expiration definitions.</td>
</tr>
<tr>
<td>EMAAlarm</td>
<td>All Extension Mobility alarm definitions</td>
</tr>
<tr>
<td>CDPAlarmCatalog</td>
<td>Alarms for Cisco Discovery Protocol (CDP) service.</td>
</tr>
<tr>
<td>LBMAAlarmCatalog</td>
<td>All Location Bandwidth Manager (LBM) alarm definitions.</td>
</tr>
</tbody>
</table>

**IM and Presence Alarm Catalog descriptions**

The following table contains the IM and Presence Alarm Catalog description.

**Table 49: IM and Presence Alarm Catalog**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CiscoUPSCfgAgent</td>
<td>All Config Agent alarms that notify the IM and Presence SIP Proxy of configuration changes in the IM and Presence IDS database.</td>
</tr>
<tr>
<td>CiscoUPInterclusterSyncAgent</td>
<td>All Intercluster Sync Agent alarms that enable DND propagation to Cisco Unified Communications Manager and synchronize end user information between IM and Presence clusters for intercluster SIP routing.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CiscoUPSPresenceEngine</td>
<td>All Presence Engine alarms that collect information regarding the availability status and communications capabilities of a user.</td>
</tr>
<tr>
<td>CiscoUPSSIPProxy</td>
<td>All SIP Proxy alarms that are related to routing, requestor identification, and transport interconnection.</td>
</tr>
<tr>
<td>CiscoUPSSOAP</td>
<td>All SOAP alarms that provide a secure SOAP interface to and from external clients using HTTPS.</td>
</tr>
<tr>
<td>CiscoUPSSyncAgent</td>
<td>All Sync Agent alarms that keep IM and Presence data synchronized with Cisco Unified Communications Manager data.</td>
</tr>
<tr>
<td>CiscoUPXCP</td>
<td>All XCP alarms that collect information on the status of XCP components and services on IM and Presence.</td>
</tr>
<tr>
<td>CiscoUPServerRecoveryManager</td>
<td>All server recovery manager alarms that relate to the failover and fallback process between nodes in a subcluster.</td>
</tr>
<tr>
<td>CiscoUPReplWatcher</td>
<td>All ReplWatcher alarms that monitor IDS Replication State.</td>
</tr>
<tr>
<td>CiscoUPXCPConfigManager</td>
<td>All Cisco XCP Config Manager alarm definitions that relate to XCP components.</td>
</tr>
</tbody>
</table>

Alarm information, which includes an explanation and recommended action, also includes the application name, server name, and so on, to help you perform troubleshooting, even for problems that are not on your local IM and Presence server.

For more information about the alarms specific to IM and Presence, see the System Error Messages for IM and Presence on Cisco Unified Communications Manager at this location:
Trace setup

- Set up trace, page 167
- Trace parameter configuration, page 168
- Audit log configuration, page 175
- Trace setting troubleshooting, page 182

Set up trace

Perform the following tasks to set up and collect trace for feature and network services in Cisco Unified IM and Presence Serviceability. See the Cisco Unified Real-Time Monitoring Tool Administration Guide for more details.

Procedure

Step 1
To enable trace compression, select Zip Files under Download File Options during Trace Collection setup.

Step 2
Select System > Service Parameters in CiscoUnified CM IM and Presence Administration and configure the values of the TLC Throttling CPU Goal and TLC Throttling IOWait Goal service parameters (Cisco RIS Data Collector service).

Step 3
Configure the trace setting for the service for which you want to collect traces. You can configure trace for the service on one server or on all servers in the cluster.
To configure trace settings, select what information you want to include in the trace log by choosing the debug level and trace fields.

If you want to run predetermined traces on services, set troubleshooting trace for those services.

Step 4
Install the Real-Time Monitoring Tool on a local PC.

Step 5
To generate an alarm when the specified search string exists in a monitored trace file, enable the LogFileSearchStringLengthFound alert in RTMT. Do the following:

a) In CiscoUnified IM and Presence Serviceability, select Alarms > Definitions.
b) In the Find alarms where list box, select the System Alarm Catalog.
c) In the Equals list box, select LpmTctCatalog.

Tip You can find the LogFileSearchStringLengthFound alarm in the LpmTctCatalog.
Step 6  To automatically capture traces for alerts such as CriticalServiceDown, check Enable Trace Download in the Set Alert/Properties dialog box for the specific alert in RTMT; configure how often that you want the download to occur.

Step 7  Collect the traces.

Step 8  View the log file in the appropriate viewer. See the Cisco Unified Real-Time Monitoring Tool Administration Guide for more information.

Step 9  If you enabled troubleshooting trace, reset the trace settings services so the original settings are restored.

Note  Leaving Troubleshooting trace enabled for a long time increases the size of the trace files and may impact the performance of the services.

---

Related Topics

Alarm definitions and user-defined descriptions, on page 162
Set up trace parameters, on page 172
Troubleshoot trace settings window, on page 182

---

Trace parameter configuration

Cisco Unified IM and Presence Serviceability provides trace tools to assist you in troubleshooting issues with your Presence and Instant Messaging application. Cisco Unified IM and Presence Serviceability supports:

- SDI (System Diagnostic Interface) trace
- Log4J trace (for Java applications)

You can configure the level of information that you want traced (debug level), what information you want to trace (trace fields), and information about the trace files (such as number of files per service, size of file, and time that the data is stored in the trace files.) You can configure trace for a single service or apply the trace settings for that service to all servers in the cluster.

In the Alarm Configuration window, you can direct alarms to various locations, including SDI trace log files. If you want to do so, you can configure trace for alerts in the IM and Presence Real-Time Monitoring Tool (RTMT).

After you have configured information that you want to include in the trace files for the various services, you can collect and view trace files by using the Trace & Log Central option in the RTMT. You can configure trace parameters for any feature or network service that is available on any IM and Presence node in the cluster. Use the Trace Configuration window to specify the parameters that you want to trace for troubleshooting problems. If you want to use predetermined troubleshooting trace settings rather than choosing your own trace fields, you can use the Troubleshooting Trace Setting window.

Note  Enabling Trace decreases system performance; therefore, enable Trace only for troubleshooting purposes. For assistance in using Trace, contact Cisco TAC support.

Related Topics

Set up trace parameters, on page 172
Service groups in trace configuration

The following table lists the services and trace libraries that correspond to the options in the Service Group list box in the Trace Configuration window.
Table 50: Service Groups in Trace Configuration

<table>
<thead>
<tr>
<th>Service Group</th>
<th>Services and Trace Libraries</th>
<th>Notes</th>
</tr>
</thead>
</table>
| IM and Presence Services| • Cisco Client Profile Agent<br>• Cisco Config Agent<br>• Cisco Intercluster Sync Agent<br>• Cisco Login Datastore<br>• Cisco OAM Agent<br>• Cisco Presence Datastore<br>• Cisco Presence Engine<br>• Cisco Replication Watcher<br>• Cisco Route Datastore<br>• Cisco SIP Proxy<br>• Cisco SIP Registration Datastore<br>• Cisco Server Recovery Manager<br>• Cisco Sync Agent<br>• Cisco XCP Authentication Service<br>• Cisco XCP Config Manager<br>• Cisco XCP Connection Manager<br>• Cisco XCP Directory Service<br>• Cisco XCP Message Archiver<br>• Cisco XCP Router<br>• Cisco XCP SIP Federation Connection Manager<br>• Cisco XCP Text Conference Manager<br>• Cisco XCP Web Connection Manager<br>• Cisco XCP XMPP Federation Connection Manager | See topics related to feature and network services in Cisco Unified IM and Presence Serviceability for a description of these services.  
• For these services, you should enable all trace for the service, instead of running trace for specific components.  
• For the Cisco Sync Agent you can enable trace for specific components. |
<table>
<thead>
<tr>
<th>Service Group</th>
<th>Services and Trace Libraries</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database and Admin Services</td>
<td>• Cisco AXL Web Service&lt;br&gt;• Cisco Bulk Provisioning Service&lt;br&gt;• Cisco CCMUser Web Service&lt;br&gt;• Cisco Database Layer Monitor&lt;br&gt;• Cisco GRT Communications Web Service&lt;br&gt;• Cisco IM and Presence Admin&lt;br&gt;• Cisco IM and Presence User&lt;br&gt;• Cisco Unified Reporting Web Service&lt;br&gt;• Platform SOAP Services</td>
<td>For most services in the Database and Admin Services group, you enable all trace for the service/library, instead of enabling trace for specific components. For Cisco Database Layer Monitor, you can run trace for specific components. <strong>Note</strong> You can control logging for services in the Cisco Unified IM and Presence Serviceability UI. To change the log level, select the “System Services” group and “Cisco CCMService Web Service” service.</td>
</tr>
<tr>
<td>Performance and Monitoring Services</td>
<td>• Cisco AMC Service&lt;br&gt;• Cisco Audit Event Service&lt;br&gt;• Cisco Log Partition Monitoring Tool&lt;br&gt;• Cisco RIS Data Collector&lt;br&gt;• Cisco RTMT Web Service&lt;br&gt;• Cisco RisBean Library</td>
<td>Selecting the Cisco RTMT Web Service option turns on trace for the RTMT servlets; running this trace creates the server-side log for RTMT client queries.</td>
</tr>
<tr>
<td>Backup and Restore Services</td>
<td>• Cisco DRF Local&lt;br&gt;• Cisco DRF Master</td>
<td>You enable all trace for each service, instead of running trace for specific components.</td>
</tr>
<tr>
<td>System Services</td>
<td>• Cisco CCMService Web Service&lt;br&gt;• Cisco Trace Collection Service</td>
<td></td>
</tr>
<tr>
<td>SOAP Services</td>
<td>• Cisco SOAP Web Service&lt;br&gt;• Cisco SOAPMessage Service</td>
<td>Selecting the Cisco SOAP Web Service option turns on the trace for the AXL Serviceability API.&lt;br&gt;You enable all trace for this service, instead of running trace for specific components.</td>
</tr>
<tr>
<td>Platform Services</td>
<td>Cisco Unified OS Admin Web Service</td>
<td></td>
</tr>
</tbody>
</table>

Trace parameter configuration

Cisco Unified Serviceability Administration Guide, Release 9.0(1)
Set up trace parameters

Perform the following procedure to set up the trace parameters. Changes to trace parameter configuration take effect immediately for all services.

**Note**
The Debug Trace Level options that display vary, depending on which service you are tracing.

Use the following table to set the level of information that you want traced.

**Table 51: Debug Trace Levels**

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arbitrary</td>
<td>Traces all Entry and Exit conditions plus low-level debugging information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Do not use this trace level with the Cisco IP Voice Media Streaming Application service during normal operation.</td>
</tr>
<tr>
<td>Debug</td>
<td>Traces all State Transition conditions plus media layer events that occur during normal operation.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Do not use Debug logging with the Cisco Presence Engine service because this trace level degrades system performance. We strongly recommend that you use the Info trace level to debug issues during normal operation.</td>
</tr>
<tr>
<td>Detailed</td>
<td>Traces all Arbitrary conditions plus detailed debugging information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Do not use Debug logging with the Cisco IP Voice Media Streaming Application service because this trace level degrades system performance. We strongly recommend that you use the Info trace level to debug issues during normal operation.</td>
</tr>
<tr>
<td>Entry/Exit</td>
<td>Traces all significant conditions plus entry and exit points of routines. Not all services use this trace level (for example, IM and Presence does not).</td>
</tr>
<tr>
<td>Error</td>
<td>Traces alarm conditions and events. Used for all traces that are generated in abnormal path. Uses minimum number of CPU cycles.</td>
</tr>
<tr>
<td>Fatal</td>
<td>Traces very severe error events that may cause the application to cancel.</td>
</tr>
<tr>
<td>Info</td>
<td>Traces the majority of servlet problems and has a minimal effect on system performance.</td>
</tr>
<tr>
<td>Significant</td>
<td>Traces all State Transition conditions plus media layer events that occur during normal operation.</td>
</tr>
</tbody>
</table>
Trace parameter configuration

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special</td>
<td>Traces all Error conditions plus process and device initialization messages.</td>
</tr>
<tr>
<td>State Transition</td>
<td>Traces all Special conditions plus subsystem state transitions that occur during normal operation.</td>
</tr>
<tr>
<td>Warn</td>
<td>Traces potentially harmful situations.</td>
</tr>
</tbody>
</table>

Use the following table to set the trace output limit.

**Table 52: Trace Output Limit**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum No. of files</td>
<td>This field specifies the total number of trace files for a given service. IM and Presence automatically appends a sequence number to the file name to indicate which file it is; for example, esp000005. When the last file in the sequence is full, the trace data begins writing over the first file. The default varies by service.</td>
</tr>
<tr>
<td>Maximum File Size (MB)</td>
<td>This field specifies the maximum size of the trace file in megabytes. The default varies by service.</td>
</tr>
</tbody>
</table>

The following table below describes the service trace filter settings for the IM and Presence SIP Proxy.

**Table 53: IM and Presence SIP Proxy Service Trace Filter Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable CTI Gateway Trace</td>
<td>This parameter enables tracing for the CTI Gateway.</td>
</tr>
<tr>
<td>Enable Parser Trace</td>
<td>This parameter enables tracing of parser information related to the operation of the per-sipd child SIP parser.</td>
</tr>
<tr>
<td>Enable SIP TLS Trace</td>
<td>This parameter enables tracing for information related to the TLS transport of SIP messages by TCP services.</td>
</tr>
<tr>
<td>Enable Privacy Trace</td>
<td>This parameter enables tracing for information about processing of PAI, RPID, and Diversion headers in relation to privacy requests.</td>
</tr>
<tr>
<td>Enable Routing Trace</td>
<td>This parameter enables tracing for the Routing module.</td>
</tr>
<tr>
<td>Enable SIPUA Trace</td>
<td>This parameter enables tracing for the SIP UA application module.</td>
</tr>
<tr>
<td>Enable Number Expansion Trace</td>
<td>This parameter enables tracing for the Number Expansion module.</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Presence Web Service Trace</td>
<td>This parameter enables tracing for the Presence Web Service.</td>
</tr>
<tr>
<td>Enable SIP Message and State Machine Trace</td>
<td>This parameter enables tracing for information related to the operation of the per-sipd SIP state machine.</td>
</tr>
<tr>
<td>Enable SIP TCP Trace</td>
<td>This parameter enables tracing for information related to the TCP transport of SIP messages by TCP services.</td>
</tr>
<tr>
<td>Enable Authentication Trace</td>
<td>This parameter enables tracing for the Authentication module.</td>
</tr>
<tr>
<td>Enable Enum Trace</td>
<td>This parameter enables tracing for the Enum module.</td>
</tr>
<tr>
<td>Enable Registry Trace</td>
<td>This parameter enables tracing for the Registry module.</td>
</tr>
<tr>
<td>Enable Method/Event Routing Trace</td>
<td>This parameter enables tracing for the Method/Event routing module.</td>
</tr>
<tr>
<td>Enable CALENDAR Trace</td>
<td>This parameter enables tracing for the Calendar module.</td>
</tr>
<tr>
<td>Enable Server Trace</td>
<td>This parameter enables tracing for the Server.</td>
</tr>
<tr>
<td>Enable Access Log Trace</td>
<td>This parameter enables the proxy access log trace; the first line of each SIP message received by the proxy is logged.</td>
</tr>
<tr>
<td>Enable SIP XMPP IM Gateway Trace</td>
<td>This parameter enables trace for the SIP XMPP IM Gateway.</td>
</tr>
</tbody>
</table>

**Before You Begin**

Review the tasks in the trace set up and collection procedure.

**Procedure**

**Step 1** Select **Trace > Configuration**.

**Step 2** Perform the following actions:

a) Select the server that is running the service for which you want to configure trace from the **Server** list box.

b) Select **Go**.

c) Select the service group for the service that you want to configure trace from the Service Group list box. **Table 50: Service Groups in Trace Configuration, on page 170** lists the services and trace libraries that correspond to the options that display in the **Service Group** list box, and then select **Go**.

d) Select the service for which you want to configure trace from the **Service** list box, and then select **Go**. The list box displays all services (active and inactive).
Note Depending on the service you select and the traces generated by that service, some trace fields may be disabled or selected by default on the Trace Configuration screen.

Note The section in the Trace Filter Settings area that relates to devices is not relevant to IM and Presence.

**Step 3** If you configured Troubleshooting Trace for this service, a message displays at the top of the window that indicates that Troubleshooting Traces have been set. The system disables all fields on the window except the Output Settings. To configure the Output Settings, go to step 9.

**Step 4** Check **Apply to All Nodes** if you want trace to apply to all IM and Presence servers in the cluster.

**Step 5** Check **Trace On**.

**Step 6** Select the level of information that you want traced from the **Debug Trace Level** list box.

**Step 7** Check the relevant trace check boxes for the service that you chose; for example, Cisco SIP Proxy Trace Fields check box.

**Step 8** Check the trace fields that you want to enable if the service that you chose has multiple trace fields, such as the Cisco SIP Proxy service.

**Step 9** Specify the trace output setting to limit the number and size of the trace files.

Note When you change either the Maximum number of files or Maximum file size (MB) parameter, the system deletes all the service log files except the current file if the service is running, or, if the service is not active, the system will delete the files when the service is initially turning on. If you keep a record of the log files, make sure that you download and save the service log files to another server before changing the **Maximum No. of Files** parameter or the **Maximum File Size** parameter.

**Step 10** Perform one of the following actions:

a) Select **Save** to save your trace parameters configuration.

b) Select **Set Default** to set the default.

---

**Related Topics**

- **Set up trace**, on page 167
- **Service groups in trace configuration**, on page 169
- **Trace field descriptions**, on page 233
- **Troubleshoot trace settings window**, on page 182

---

**Audit log configuration**

With audit logging, specific changes to the IM and Presence service get logged in separate log files for auditing: system audit logs, application audit logs, and database audit logs.

**System audit logs**

System audit logs track activities such as the creation, modification, or deletion of Linux OS users, log tampering, and any changes to file or directory permissions. This type of audit log is disabled by default due to the high volume of data gathered. To enable this function, you must manually enable utils auditd using the CLI. After you have enabled the system audit log feature, you can collect, view, download, or delete selected logs through Trace & Log Central from the Real-Time Monitoring Tool. System audit logs take on the format of vos-audit.log.
For information about how to enable this feature, see the Command Line Interface Reference Guide for Cisco Unified Communications Solutions. For information about how to access collected logs from the Real-Time Monitoring Tool, see the Cisco Unified Real-Time Monitoring Tool Administration Guide.

Application audit logs

The Application Audit logs track configuration changes to the IM and Presence service and are stored in separate log files for auditing purposes. The Cisco Audit Event Service, which appears under Control Center—Network Services in Cisco Unified IM and Presence Serviceability, writes the Application Audit logs. The Application Audit logs monitor and record any configuration change to the IM and Presence service by a user or as a result of the user action.

You access the Audit Log Configuration window in Cisco Unified IM and Presence Serviceability to configure the settings for these audit logs.

Audit logging contains the following parts:

- **Audit logging framework**—The framework comprises an API that uses an alarm library to write audit events into audit logs. An alarm catalog that is defined as GenericAlarmCatalog.xml applies for these alarms. Different IM and Presence components provide their own logging.

  The following example displays an API that an IM and Presence component can use to send an alarm:

  ```
  User ID: CUPAdministrator
  Client IP Address: 172.19.240.207
  Severity: 3
  EventType: ServiceStatusUpdated
  ResourceAccessed: CUPService
  EventStatus: Successful
  Description: CiscoUnifiedPresence Service status is stopped
  ```

- **Auditeventlogging**—An auditeventrepresentsanyeventthatisrequiredtobelogged. The following example displays a sample audit event:

  ```
  CUP_TOMCAT-GENERIC-3-AuditEventGenerated: Audit Event Generated
  UserID:CUPAdministrator Client IP Address:172.19.240.207 Severity:3
  EventType:ServiceStatusUpdated ResourceAccessed:CCMService
  EventStatus: Successful
  Description: Cisco Unified Presence Service status is stopped
  ```

Be aware that audit event logging is centralized and enabled by default. An alarm monitor called Syslog Audit writes the logs. By default, the logs are configured to rotate. If the AuditLogAlarmMonitor cannot write an audit event, the AuditLogAlarmMonitor logs this failure as a critical error in the syslog file. The Alert Manager reports this error as part of a SeverityMatchFound alert. The actual operation continues even if the event logging fails. All audit logs get collected, viewed and deleted from Trace and Log Central in the IM and Presence Real-Time Monitoring Tool.

The following components generate audit events:
• IM and Presence Application
• Cisco Unified IM and Presence Serviceability
• Cisco Unified IM and Presence Real-Time Monitoring Tool
• Cisco Unified CM IM and Presence Administration
• Command Line Interface

Cisco Unified IM and Presence Serviceability
Cisco Unified IM and Presence Serviceability logs the following events:
• Activation, deactivation, start, or stop of a service
• Changes in trace configurations and alarm configurations
• Changes in SNMP configurations
• Review of any report in the Serviceability Reports Archive. This log gets viewed on the reporter node

Cisco Unified IM and Presence Real-Time Monitoring Tool
Cisco Unified IM and Presence Real-Time Monitoring Tool logs the following events with an audit event alarm:
• Alert configuration
• Alert suspension
• E-mail configuration
• Set node alert status
• Alert addition
• Add alert action
• Clear alert
• Enable alert
• Remove alert action
• Remove alert

Cisco Unified CM IM and Presence Administration
The following events get logged for various components of Cisco Unified CM IM and Presence Administration:
• Administrator logging (logins and logouts on IM and Presence interfaces such as Administration, OS Administration, Disaster Recovery System, and Reporting)
• User role membership updates (user added, user deleted, user role updated)
• Role updates (new roles added, deleted, or updated)
• Device updates (phones and gateways)
Server configuration updates (changes to alarm or trace configurations, service parameters, enterprise parameters, IP addresses, host names, Ethernet settings, and IM and Presence server additions or deletions)

**IM and Presence Application**

The following events get logged by the various components of the IM and Presence Application:

- End user logging on IM clients (user logins, user logouts, and failed login attempts)
- User entry to and exit from IM Chat Rooms
- Creation and destruction of IM Chat Rooms

**Command Line Interface**

All commands issued via the command line interface are logged.

**Database audit logs**

Database Audit Logs track all activities associated with access to the Informix Database, such as logins.

**Configure audit log settings**

To configure Application Audit Log or Database Audit Log settings, perform the following procedure:

**Procedure**

**Step 1** In Cisco Unified IM and Presence Serviceability, select *Tools > Audit Log Configuration*. The *Audit Log Configuration* window displays.

**Step 2** Configure the settings as described in *Audit log settings*, on page 178.

**Step 3** Select *Save*.

**Audit log settings**

The following table describes the settings that you can configure in the *Audit Log Configuration* window in Cisco Unified IM and Presence Serviceability. Settings can be configured for Application Audit Logs and Database Audit Logs.
Before you begin

Be aware that only a user with an audit role can change the audit log settings. By default, for IM and Presence, the administrator possesses the audit role after fresh installs and upgrades. The administrator can assign any user that has auditing privileges to the Standard Audit Users group in the User Group Configuration window.

If you want to do so, you can then remove administrator from the Standard Audit Users group.

The Standard Audit Log Configuration role in IM and Presence provides the ability to delete audit logs and to read/update access to IM and Presence Real-Time Monitoring Tool, Trace Collection Tool, RTMT Alert Configuration, Control Center—Network Services in Cisco Unified IM and Presence Serviceability, RTMT Profile Saving, Audit Configuration in Cisco Unified IM and Presence Serviceability, and a resource that is called Audit Traces.

For information on roles, users, and user groups in IM and Presence, refer to the Deployment Guide for IM and Presence Service on Cisco Unified Communications Manager.

Table 54: Audit Log Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Server</strong></td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td>Select the server where you want to configure audit logs; then, select <strong>Go</strong>.</td>
</tr>
<tr>
<td>Apply to All Nodes</td>
<td>If you want to apply the audit log configuration to all nodes in the cluster, check the <strong>Apply to All Nodes</strong> box.</td>
</tr>
<tr>
<td><strong>Application Audit Log Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Audit Log</td>
<td>This setting configures the Application Audit logs. When you enable this setting, an audit log gets created for the Application Audit log. For IM and Presence, the application audit log supports configuration updates for IM and Presence graphical user interfaces (GUIs), such as Cisco Unified CM IM and Presence Administration, Cisco Unified IM and Presence Real-Time Monitoring Tool, and Cisco Unified IM and Presence Serviceability. <strong>Note</strong> The Network Service Audit Event Service must be running.</td>
</tr>
<tr>
<td>Enable Text Conferencing Audit Log</td>
<td></td>
</tr>
</tbody>
</table>
### Enable Purging

The Log Partition Monitor (LPM) looks at the Enable Purging option to determine whether it needs to purge audit logs. When you check this check box, LPM purges all the audit log files in RTMT whenever the common partition disk usage goes above the high water mark; however, you can disable purging by unchecking the check box.

If purging is disabled, the number of audit logs continues to increase until the disk is full. This action could cause a disruption of the system. A message that describes the risk of disabling the purge displays when you uncheck the **Enable Purging** check box.

Be aware that this option is available for audit logs in an active partition. If the audit logs reside in an inactive partition, the audit logs get purged when the disk usage goes above the high water mark.

You can access the audit logs by selecting **Trace and Log Central > Audit Logs** in RTMT.

**Note** The Network Service Cisco Log Partitions Monitoring tool must be running.

### Enable Log Rotation

The system reads this option to determine whether it needs to rotate the audit log files or it needs to continue to create new files. The maximum number of files cannot exceed 5000. When the Enable Rotation option is checked, the system begins to overwrite the oldest audit log files after the maximum number of files gets reached.

**Tip** When log rotation is disabled (unchecked), audit log ignores the **Maximum No. of Files** setting.

### Server Name

Enter the name or IP address of the remote Syslog server that you want to use to accept Syslog messages. If server name is not specified, Cisco Unified IM and Presence Serviceability does not send the Syslog messages. Do not specify a Cisco Unified Communications Manager server as the destination because the Cisco Unified Communications Manager server does not accept Syslog messages from another server.

### Remote Syslog Audit Event Level

Select the desired Syslog messages severity for the remote syslog server. All the syslog messages with selected or higher severity level are sent to the remote syslog.

### Maximum No. of Files

Enter the maximum number of files that you want to include in the log. The default setting specifies 250. The maximum number specifies 5000.
<table>
<thead>
<tr>
<th><strong>Maximum File Size</strong></th>
<th>Enter the maximum file size for the audit log. The file size value must remain between 1 MB and 10 MB.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database Audit Log Filter Settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Enable Audit Log</strong></td>
<td>When you enable this check box, DB audit log gets created for the IM and Presence database. Use this setting in conjunction with the <strong>Debug Audit Level</strong> setting, which allows you to create a log for certain aspects of the database.</td>
</tr>
</tbody>
</table>
| **Debug Audit Level** | This setting allows you to choose which aspects of the database you want to audit in the log. From the drop-down list box, select one of the following options. Be aware that each audit log filter level is cumulative.  

- **Schema**—Tracks changes to the setup of the audit log database (for example, the columns and rows in the database tables).

- **Administrative Tasks**—Tracks all administrative changes to the IM and Presence system (for example, any changes to maintain the system) plus all Schema changes.  

  **Tip** Most administrators will leave the **Administrative Tasks** setting disabled. For users who want auditing, use the **Database Updates** level.

- **Database Updates**—Tracks all changes to the database plus all schema changes and all administrative tasks changes.

- **Database Reads**—Tracks every read to the IM and Presence system, plus all schema changes, administrative tasks changes, and database updates changes.  

  **Tip** Select the **Database Reads** level only when you want to get a quick look at the IM and Presence system. This level uses significant amounts of system resources and only should be used for a short time. |
Enable Audit Log Rotation

The system reads this option to determine whether it needs to rotate the database audit log files or it needs to continue to create new files. When the **Enable Audit Log Rotation** option is checked, the system begins to overwrite the oldest audit log files after the maximum number of files gets reached. When this setting is unchecked, audit log ignores the **Maximum No. of Files** setting.

Maximum No. of Files

Enter the maximum number of files that you want to include in the log. Ensure that the value that you enter for the **Maximum No. of Files** setting is greater than the value that you enter for the **No. of Files Deleted on Log Rotation** setting.

You can enter a number from 4 (minimum) to 40 (maximum).

No. of Files Deleted on Log Rotation

Enter the maximum number of files that the system can delete when database audit log rotation occurs. The minimum that you can enter in this field is 1. The maximum value is 2 numbers less than the value that you enter for the **Max No. of Files** setting; for example, if you enter 40 in the **Max No. of Files** field, the highest number that you can enter in the **No. of Files Deleted on Log Rotation** field is 38.

---

**Trace setting troubleshooting**

**Troubleshoot trace settings window**

The **Troubleshooting Trace Settings** window allows you to select the services in Cisco Unified IM and Presence Serviceability for which you want to set predetermined troubleshooting trace settings. In this window, you can select the services on different IM and Presence nodes in the cluster. This populates the trace settings changes for all the services you choose. You can select specific active services for a single node, all active services for the node, specific active services for all nodes in the cluster, or all active services for all nodes in the cluster. In the window, N/A displays next to inactive services.

**Note**

The predetermined troubleshooting trace settings for an IM and Presence feature or network service include SDI, and Log4j trace settings. Before the troubleshooting trace settings are applied, the system backs up the original trace settings. When you reset the troubleshooting trace settings, the original trace settings get restored.

When you open the **Troubleshooting Trace Settings** window after you apply troubleshooting trace settings to a service, the service that you set for troubleshooting displays as checked. In the **Troubleshooting Trace Settings** window, you can reset the trace settings to the original settings.
After you apply Troubleshooting Trace Setting to a service, the Trace Configuration window displays a message that troubleshooting trace is set for the given service(s). From the Related Links list box, you can select the Troubleshooting Trace Settings option if you want to reset the settings for the service. For the given service, the Trace Configuration window displays all the settings as read-only, except for some parameters of trace output settings; for example, Maximum No. of Files.

Troubleshoot trace settings

Before You Begin

Review the tasks in the trace configuration and collection procedure.

Procedure

| Step 1 | Select Trace > Troubleshooting Trace Settings. |
| Step 2 | Select the server where you want to troubleshoot trace settings from the Server list box. |
| Step 3 | Select Go. |
|        | A list of services display. The services that are not active on an IM and Presence node display as N/A. |
| Step 4 | Perform one of the following actions: |
|        | a) To monitor specific services on the node that you selected from the Server list box, check the service in the Services pane. |
|        | For example, the Database and Admin Services, Performance and Monitoring Services, or the Backup and Restore Services pane (and so on). |
|        | This task affects only the node that you selected from the Server list box. |
|        | b) To monitor all services on the node that you selected from the Server list box, check Check All Services. |
|        | c) To monitor specific services on all nodes in a cluster, check Check Selected Services on All Nodes. |
|        | This setting applies for all nodes in the cluster where the service is active. |
|        | d) To monitor all services for all nodes in the cluster, check Check All Services on All Nodes. |
| Step 5 | Select Save. |
| Step 6 | Select one of the following buttons to restore the original trace settings: |
|        | a) Reset Troubleshooting Traces—Restores the original trace settings for the services on the node that you chose in the Server list box; also displays as an icon that you can select. |
|        | b) Reset Troubleshooting Traces On All Nodes—Restores the original trace settings for the services on all nodes in the cluster. |
|        | The Reset Troubleshooting Traces button displays only if you have set troubleshooting trace for one or more services. |
|        | Note Leaving Troubleshooting trace enabled for a long time increases the size of the trace files and may impact the performance of the services. |
|        | After you select the Reset button, the window refreshes and the service check boxes display as unchecked. |

Related Topics

Set up trace, on page 167
Feature and network services

Cisco Unified IM and Presence Serviceability service management includes working with feature and network services and servlets, which are associated with the Tomcat Java Webserver. Feature services allow you to use application features, while network services are required for your system to function.

If something is wrong with a service or servlet, an alarm is written to an alarm monitor. After viewing the alarm information, you can run a trace on the service. Be aware that services and servlets display different trace levels in the Trace Configuration window.

If you upgrade IM and Presence, those services that you activated on the system prior to the upgrade automatically activate and start after the upgrade.

- Feature services, page 185
- Network services, page 188
- Serviceability Reports Archive, page 194
- Access to Serviceability Reports Archive, page 196

Feature services

In Cisco Unified IM and Presence Serviceability, you can turn on (activate), start, and stop feature services. When you turn on (activate) a service, IM and Presence automatically starts the service. After you turn on a service in the Service Activation window, you do not need to start it in the Control Center—Feature Services window. If the service does not start for any reason, you must start it in the Control Center—Features Services window.

You must manually turn on (activate) all feature services on IM and Presence. After you turn on feature services, you can modify associated service parameters in Cisco Unified CM IM and Presence Administration. Cisco Unified IM and Presence Serviceability categorizes feature services into the following groups:

- Database and admin services
- Performance and monitoring services
- IM and Presence services

In the Control Center—Feature Services window, Cisco Unified IM and Presence Serviceability categorizes services into the same groups that display in the Service Activation window.
Database and admin services

Cisco AXL Web Service
The Cisco AXL Web Service allows you to modify database entries and execute stored procedures from client-based applications that use AXL.
This service supports Cisco Unified Communications Manager and Cisco Unity Connection.

Platform SOAP Service
The Platform SOAP service provides a web-based interface to facilitate your system upgrades and COP file installs of IM and Presence. This web-based interface also enables large scale deployments of IM and Presence to be initiated and monitored from a single management client. If you need to manage system upgrades, this service must be turned on for all IM and Presence and Cisco Unified Communications Manager nodes.

Cisco Bulk Provisioning Service
You can activate the Cisco Bulk Provisioning Service only on the first node. If you use the Bulk Administration Tool (BAT) to administer users, you must activate this service.

Performance and monitoring services

Cisco Serviceability Reporter
The Cisco Serviceability Reporter service generates daily reports.
This service is installed on all the IM and Presence nodes in the cluster. Reporter generates reports once a day based on logged information. You can access the reports that Reporter generates in Cisco Unified IM and Presence Serviceability from the Tools menu. Each summary report comprises different charts that display the statistics for that particular report. After you activate the service, report generation may take up to 24 hours.

Related Topics
Serviceability Reports Archive, on page 194

IM and Presence services

Cisco SIP Proxy
The Cisco SIP Proxy service is responsible for providing the SIP registrar and proxy functionality. This includes request routing, requestor identification, and transport interconnection.
Cisco Presence Engine

The Cisco Presence Engine collects, aggregates, and distributes user capabilities and attributes using the standards-based SIP and SIMPLE interface. It collects information regarding the availability status and communications capabilities of a user.

Cisco Sync Agent

The Cisco Sync Agent keeps IM and Presence data synchronized with Cisco Unified Communications Manager data. It sends SOAP requests to the Cisco Unified Communications Manager for data of interest to IM and Presence and subscribes to change notifications from Cisco Unified Communications Manager and updates the IM and Presence IDS database.

Cisco XCP Text Conference Manager

The Cisco XCP Text Conference Manager supports the Chat feature. The Chat feature allows users to communicate with each other in online chat rooms. It supports chat functionality using ad-hoc (temporary) and permanent chat rooms, which remain on a Cisco-supported external database until they are deleted.

Cisco XCP Web Connection Manager

The Cisco XCP Web Connection Manager service enables browser-based clients to connect to IM and Presence.

Cisco XCP Connection Manager

The Cisco XCP Connection Manager enables XMPP clients to connect to the IM and Presence server.

Cisco XCP SIP Federation Connection Manager

The Cisco XCP SIP Federation Connection Manager supports interdomain federation with Microsoft OCS over the SIP protocol. Note that you also turn on this service when your deployment contains an intercluster connection between an IM and Presence Release 9.0 cluster, and a Cisco Unified Presence Release 8.6 cluster.

Cisco XCP XMPP Federation Connection Manager

The Cisco XCP XMPP Federation Connection Manager supports interdomain federation with third party enterprises such as IBM Lotus Sametime, Cisco Webex Meeting Center, GoogleTalk, and another IM and Presence enterprise, over the XMPP protocol.

Cisco XCP Message Archiver

The Cisco XCP Message Archiver service supports the IM Compliance feature. The IM Compliance feature logs all messages sent to and from the IM and Presence server, including point-to-point messages, and messages from adhoc (temporary) and permanent chat rooms for the Chat feature. Messages are logged to an external Cisco-supported database.

Cisco XCP Directory Service

The Cisco XCP Directory Service supports the integration of XMPP clients with the LDAP directory to allow users to search and add contacts from the LDAP directory.

Cisco XCP Authentication Service

The Cisco XCP Authentication Service handles all authentication requests from XMPP clients connecting to IM and Presence.
Network services

Network services

Installed automatically, network services include services that the IM and Presence system requires to function, for example, database and platform services. Because these services are required for basic functionality, you cannot activate them in the Service Activation window. If necessary, for example, for troubleshooting purposes, you may need to stop and start (or restart) a network service in the Control Center—Network Services window.

After the IM and Presence installation, network services start automatically. In the Control Center—Network Services window, Cisco Unified IM and Presence Serviceability categorizes network services into the following groups:

Performance and monitoring services

Cisco CallManager Serviceability RTMT
The Cisco CallManager Serviceability RTMT servlet supports the IM and Presence Real-Time Monitoring Tool (RTMT), which allows you to collect and view traces, view performance monitoring objects, work with alerts, and monitor system performance, performance counters, and so on.

Cisco RTMT Reporter Servlet
The Cisco RTMT Reporter servlet allows you to publish reports for RTMT.

Cisco Log Partition Monitoring Tool
The Cisco Log Partition Monitoring Tool service supports the Log Partition Monitoring feature, which monitors the disk usage of the log partition on a node (or all nodes in the cluster) by using configured thresholds and a polling interval.

Cisco Tomcat Stats Servlet
The Cisco Tomcat Stats Servlet allows you to monitor the Tomcat perfmon counters by using RTMT or the Command Line Interface. Do not stop this service unless you suspect that this service is using too many resources, such as CPU time.

Cisco RIS Data Collector
The Real-time Information Server (RIS) maintains real-time information such as device registration status, performance counter statistics, critical alarms generated, and so on. The Cisco RIS Data Collector service provides an interface for applications, such as the IM and Presence Real-Time Monitoring Tool (RTMT), SOAP applications, and so on, to retrieve the information that is stored in all RIS nodes in the cluster.

Cisco AMC Service
Used for the IM and Presence Real-Time Monitoring Tool (RTMT), this service, Alert Manager and Collector service, allows RTMT to retrieve real-time information that exists on nodes in the cluster.
Cisco Audit Event Service

The Cisco Audit Event Service monitors and logs any administrative configuration change to the IM and Presence server, such as service start/stop and topology configuration. The Cisco Audit Event Service also monitors and logs end user events such as login, logout, and IM chat room entry and exit.

Backup and restore services

Cisco DRF Master

The Cisco DRF Master Agent service supports the DRF Master Agent, which works with the Disaster Recovery System graphical user interface (GUI) or command line interface (CLI) to schedule backups, perform restorations, view dependencies, check status of jobs, and cancel jobs, if necessary. The Cisco DRF Master Agent also provides the storage medium for the backup and restoration process.

Cisco DRF Local

The Cisco DRF Local service supports the Cisco DRF Local Agent, which acts as the workhorse for the DRF Master Agent. Components register with the Cisco DRF Local Agent to use the disaster recovery framework. The Cisco DRF Local Agent executes commands that it receives from the Cisco DRF Master Agent. Cisco DRF Local Agent sends the status, logs, and command results to the Cisco DRF Master Agent.

System services

Cisco CallManager Serviceability

The Cisco CallManager Serviceability service supports Cisco Unified IM and Presence Serviceability, the web application/interface that you use to troubleshoot issues and manage services. This service, which is installed automatically, allows you access to the Cisco Unified IM and Presence Serviceability graphical user interface (GUI). If you stop this service, you cannot access the Cisco Unified IM and Presence Serviceability GUI when you browse into that server.

Cisco CDP

Cisco CDP advertises the voice application to other network management applications, so the network management application, for example, SNMP or Cisco Unified Operations Manager, can perform network management tasks for the voice application.

Cisco Trace Collection Servlet

The Cisco Trace Collection Servlet, along with the Cisco Trace Collection Service, supports trace collection and allows users to view traces by using RTMT. If you stop this service on a server, you cannot collect or view traces on that server.

For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet and the Cisco Trace Collection Service must run on the server.

Cisco Trace Collection Service

The Cisco Trace Collection Service, along with the Cisco Trace Collection Servlet, supports trace collection and allows users to view traces by using the RTMT client. If you stop this service on a server, you cannot collect or view traces on that server.
For SysLog Viewer and Trace and Log Central to work in RTMT, the Cisco Trace Collection Servlet and the Cisco Trace Collection Service must run on the server.

Tip
If necessary, Cisco recommends that, to reduce the initialization time, you restart the Cisco Trace Collection Service before restarting Cisco Trace Collection Servlet.

Platform services

A Cisco DB
A Cisco DB service supports the IDS database engine.

A Cisco DB Replicator
A Cisco DB Replicator service ensures database configuration and data synchronization between the first and subsequent nodes in the cluster.

Cisco Tomcat
The Cisco Tomcat service supports the web server.

SNMP Master Agent
This service, which acts as the agent protocol engine, provides authentication, authorization, access control, and privacy functions that relate to SNMP requests.

Tip
After you complete SNMP configuration in Cisco Unified IM and Presence Serviceability, you must restart the SNMP Master Agent service in the Control Center—Network Features window.

MIB2 Agent
This service provides SNMP access to variables, which are defined in RFC 1213, that read and write variables; for example, system, interfaces, IP, and so on.

Host Resources Agent
This service provides SNMP access to host information, such as storage resources, process tables, device information, and installed software base. This service implements the HOST-RESOURCES-MIB.

Native Agent Adaptor
This service, which supports vendor MIBs, allows you to forward SNMP requests to another SNMP agent that runs on the system. This service will not be present if IM and Presence is installed on a Virtual Machine.

System Application Agent
This service provides SNMP access to the applications that are installed and executing on the system. This implements the SYSAPPL-MIB.
Cisco CDP Agent
This service uses the Cisco Discovery Protocol to provide SNMP access to network connectivity information on the IM and Presence node. This service implements the CISCO-CDP-MIB.

Cisco Syslog Agent
This service supports gathering of syslog messages that various Cisco Unified Communications Manager components generate. This service implements the CISCO-SYSLOG-MIB.

Caution
Stopping any SNMP service may result in loss of data because the network management system no longer monitors the IM and Presence network. Do not stop the services unless your technical support team tells you to do so.

Cisco Certificate Expiry Monitor
This service periodically checks the expiration status of certificates that the system generates and sends notification when a certificate is close to its expiration date. You manage the certificates that use this service in Cisco Unified IM and Presence Operating System Administration.

Database services

Cisco Database Layer Monitor
The Cisco Database Layer Monitor service monitors aspects of the database layer. This service takes responsibility for change notification and monitoring.

SOAP services

Cisco SOAP-Real-Time Service APIs
The Cisco SOAP-Real-Time Service APIs supports client login and third-party APIs for presence data.

Cisco SOAP-Performance Monitoring APIs
The Cisco SOAP-Performance Monitoring APIs service allows you to use performance monitoring counters for various applications through SOAP APIs; for example, you can monitor memory information per service, CPU usage, performance monitoring counters, and so on.

Cisco SOAP-Log Collection APIs
The Cisco SOAP-Log Collection APIs service allows you to collect log files and to schedule collection of log files on a remote SFTP server. Examples of log files that you can collect include syslog, core dump files, Cisco application trace files, and so on.
Admin services

Cisco IM and Presence Admin
The Cisco IM and Presence Admin service supports Cisco Unified CM IM and Presence Administration, the web application/interface that you use to configure IM and Presence settings. After the IM and Presence installation, this service starts automatically and allows you to access the graphical user interface (GUI). If you stop this service, you cannot access the Cisco Unified CM IM and Presence Administration GUI when you browse into that server.

Cisco IM and Presence User
The Cisco IM and Presence User service supports the Cisco Unified CM IM and Presence User Options interface.

IM and Presence services

Cisco Login Datastore
The Cisco Login Datastore is a real-time database for storing client sessions to the Cisco Client Profile Agent.

Cisco Route Datastore
The Cisco Route Datastore is a real-time database for storing a cache of route information and assigned users for the Cisco SIP Proxy and the Cisco Client Profile Agent.

Cisco Config Agent
The Cisco Configuration Agent is a change notification service which notifies the Cisco SIP Proxy of configuration changes in the IM and Presence IDS database.

Cisco OAM Agent
The Cisco OAM Agent service monitors configuration parameters in the IM and Presence IDS database that are of interest to the Presence Engine. When there are changes in the database, the OAM Agent writes a configuration file and sends an RPC notification to the Presence Engine.

Cisco Client Profile Agent
The Cisco Client Profile Agent service provides a secure SOAP interface to or from external clients using HTTPS.

Cisco Intercluster Sync Agent
The Cisco Intercluster Sync Agent service provides the following: DND propagation to Cisco Unified Communications Manager and syncs end user information between IM and Presence clusters for intercluster SIP routing.

Cisco XCP Router
The XCP Router is the core communication functionality on the IM and Presence server. It provides XMPP-based routing functionality on IM and Presence; it routes XMPP data to the other active XCP services
on IM and Presence, and it accesses SDNS to allow the system to route XMPP data to IM and Presence users. The XCP router manages XMPP sessions for users, and routes XMPP messages to and from these sessions. After IM and Presence installation, the system turns on Cisco XCP Router by default.

**Note**

If you restart the Cisco XCP Router, IM and Presence automatically restarts all active XCP services. Note that you must select the Restart option to restart the Cisco XCP Router; this is not the same as turning off and turning on the Cisco XCP Router. If you turn off the Cisco XCP Router, rather than restart this service, IM and Presence stops all other XCP services. Subsequently when you turn on the XCP router, IM and Presence does not automatically turn on the other XCP services; you need to manually turn on the other XCP services.

**Cisco XCP Config Manager**

The Cisco XCP Config Manager service monitors the configuration and system topology changes made through the administration GUI (as well as topology changes synchronized from an InterCluster Peer) that affect other XCP components (for example, Router and Message Archiver), and updates these components as needed. The Cisco XCP Config Manager service creates notifications for the administrator indicating when an XCP component requires a restart (due to these changes) and it automatically clears the notifications once the restarts are complete.

**Cisco Server Recovery Manager**

The Cisco Server Recovery Manager (SRM) service manages the failover between nodes in a subcluster. The SRM manages all state changes in a node; state changes are either automatic or initiated by the administrator (manual). Once you turn on high availability in a subcluster, the SRM on each node establishes heartbeat connections with the peer node and begins to monitor the critical processes.

**Cisco Replication Watcher**

The Cisco Replication Watcher monitors IDS replication state on IM and Presence. Other IM and Presence services are dependent on the Cisco Replication Watcher service. These dependent services use the Cisco Replication Watcher service to delay startup until such time as IDS replication is in a stable state.

On the subscriber nodes, the Cisco Replication Watcher service delays the startup of feature services until IDS replication is successfully established. The Cisco Replication Watcher service only delays the startup of feature services on the problem subscriber node in a cluster, it will not delay the startup of feature services on all subscriber nodes due to one problem node. The Cisco Replication Watcher service behaves differently on the publisher node. It only delays the startup of feature services until a timeout expires. When the timeout expires, it allows all feature services to start on the publisher node even if IDS replication is not successfully established.

**Cisco Presence Datastore**

The Cisco Presence Datastore is a real-time database for storing transient presence data and subscriptions.

**Cisco SIP Registration Datastore**

The Cisco Presence SIP Registration Datastore is a real-time database for storing SIP Registration data.
Serviceability Reports Archive

The Cisco Serviceability Reporter service, which is CPU intensive, generates daily reports in Cisco Unified IM and Presence Serviceability. Each report provides a summary that include different charts that display the statistics for that particular report. The Reporter generates reports once a day on the basis of logged information.

Server statistic reports

The Server Statistics Report provides a number of line charts.

Percentage of CPU per server

The line chart displays the percentage of CPU usage for the server (or for each server in an IM and Presence cluster). The line in the chart represents the data for the server (or one line for each server in a IM and Presence cluster) for which data is available. Each data value in the chart represents the average CPU usage for a 15 minute duration. If no data exists for the server (or for any one server in a IM and Presence cluster), the Reporter does not generate the line that represents that server. If there are no lines to generate, the Reporter does not create the chart. The message “No data for Server Statistics report available” displays.

Percentage of memory usage per server

The line chart displays the percentage of Memory Usage for the IM and Presence server (%MemoryInUse). In an IM and Presence cluster configuration, there is one line per server in the cluster for which data is available. Each data value in the chart represents the average memory usage for a 15 minute duration. If no data exists, the Reporter does not generate the chart. If no data exists for any server in an IM and Presence cluster configuration, the Reporter does not generate the line that represents that server.

Percentage of hard disk usage of largest partition per server

The line chart displays the percentage of disk space usage for the largest partition on the server (%DiskSpaceInUse), or on each server in an IM and Presence cluster configuration. Each data value in the chart represents the average disk usage for a 15 minute duration. If no data exists, the Reporter does not generate the chart. If no data exists for any one server in a cluster configuration, the Reporter does not generate the line that represents that server.

The server (or each server in an IM and Presence cluster configuration) contains log files that match the file name pattern ServerLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- % CPU usage on the server (or each server in an IM and Presence cluster)
- % Memory usage (%MemoryInUse) on the server (or on each server in an IM and Presence cluster)
- % Hard disk usage of the largest partition (%DiskSpaceInUse) on the server (or on each server in an IM and Presence cluster)

Alert Summary Reports

The Alert Summary Report provides details of alerts that are generated for the day.
**Number of alerts per server**

The pie chart provides the number of alerts per IM and Presence node. The chart displays the server-wide details of the alerts that are generated. Each sector of the pie chart represents the number of alerts generated for a particular server in the IM and Presence cluster. The chart includes as many number of sectors as there are servers (for Alert Summary Report which the Reporter generates alerts in the day) in the cluster. If no data exists for a server, no sector in the chart represents that server. If no data exists for all servers, the Reporter does not generate the chart. The message “No alerts were generated for the day” displays.

**Number of alerts per severity for cluster**

The pie chart displays the number of alerts per alert severity. The chart displays the severity details of the alerts that are generated. Each sector of the pie chart represents the number of alerts that are generated of a particular severity type. The chart provides as many number of sectors as there are severities (for which the Reporter generates alerts in the day). If no data exists for a severity, no sector in the chart represents that severity. If no data exists, the Reporter does not generate the chart.

**Top 10 alerts in cluster**

The bar chart displays the number of alerts of a particular Alert Type. The chart displays the details of the alerts that are generated on the basis of the alert type. Each bar represents the number of alerts for an alert type. The chart displays details only for the first 10 alerts based on the highest number of alerts in descending order. If no data exists for a particular alert type, no bar represents that alert. If no data exists for any alert type, the Real-Time Monitoring Tool does not generate the chart.

The server (or each server in an IM and Presence cluster) contains log files that match the file name pattern AlertLog_mm_dd_yyyy_hh_mm.csv. The following information exists in the log file:

- **Time**—Time at which the alert occurred
- **Alert Name**—Descriptive name
- **Node Name**—Server on which the alert occurred
- **Monitored object**—The object that is monitored Performance Protection Report
- **Severity**—Severity of this alert
Access to Serviceability Reports Archive

Activate Serviceability Reports Archive

**Procedure**

**Step 1** From Cisco Unified IM and Presence Serviceability, select **Tools > Service Activation**.
**Step 2** Select the required server from the **Server** list box, and then select **Go**.
**Step 3** Navigate to the **Performance and Monitoring** services pane.
**Step 4** Check the **Cisco Serviceability Reporter** service checkbox, and then select **Save**.
**Step 5** Select **Tools > Control Center - Feature Services**.
**Step 6** Select the required server from the **Server** list box, and then select **Go**.
**Step 7** Navigate to the **Performance and Monitoring** services pane and locate the Cisco Serviceability Reporter.
**Step 8** Verify that the status of the Cisco Serviceability Reporter is Started and Activated. If the Cisco Serviceability Reporter is not running, select the Cisco Serviceability Reporter and select **Start**.

**What to Do Next**

If you opened Cisco Unified IM and Presence Serviceability by entering the server name in the browser, you must sign into Cisco Unified IM and Presence Serviceability before you can view the report.

The Cisco Unified IM and Presence Serviceability service only generates reports on the publisher node even if you turn on the service on other nodes.

Access Serviceability Reports Archive

**Before You Begin**

Activate the Cisco Serviceability Reporter service. After you activate the service, report generation may take up to 24 hours.

**Procedure**

**Step 1** Select **Tools > Serviceability Reports Archive**.
**Step 2** Select the month and year for which you want to display reports in the **Month-Year** section.
**Step 3** Select the link that corresponds to the day for which reports were generated to view the required report.
**Step 4** Select the link of the report that you want to view to view a particular PDF report.
The section in the Trace Filter Settings area that relates to devices is not relevant to IM and Presence.

**Tip** If you opened Cisco Unified IM and Presence Serviceability by entering the server name in the browser, you must sign in to Cisco Unified IM and Presence Serviceability before you can view the report.
Services setup and viewing services

- Set up services, page 197
- Feature services activation and deactivation, page 197
- Start, stop, and restart services in Control Center or CLI, page 201

Set up services

Perform the following tasks when working with services.

Procedure

**Step 1**
Turn on the feature services that you want to run.

**Step 2**
Configure the appropriate service parameters.
All service parameters for the services in Cisco Unified IM and Presence Serviceability display in Cisco Unified CM IM and Presence Administration.

**Step 3**
If necessary, troubleshoot problems by using the Cisco Unified IM and Presence Serviceability trace tools.

Related Topics
- Activate and deactivate feature services, on page 201
- Trace setup, on page 167
- Feature and network services, on page 185

Feature services activation and deactivation

You can turn on (activate) or turn off (deactivate) multiple feature services or select default services to turn on from the Service Activation window in Cisco Unified IM and Presence Serviceability. Cisco Unified IM and Presence Serviceability turns on feature services in automatic mode and checks for service dependencies based on a single-node configuration. When you select to turn on a feature service, Cisco Unified IM and Presence Serviceability prompts you to select all the other services, if any, that depend on that service to run
based on a single-node configuration. When you select the **Set Default** button, Cisco Unified IM and Presence Serviceability selects those services that are required to run IM and Presence based on a single-node configuration. Turning on a service automatically starts the service. You start and stop services from Control Center.

**Recommendations for activation of services in a cluster**

Before you turn on any services for a feature, you must complete all the required configuration on IM and Presence for that feature. See the relevant documentation for each IM and Presence feature.

Before you turn on services in a cluster, review the table below, which provides service recommendations for multi-node configurations.

*Table 55: Service Activation Recommendations*

<table>
<thead>
<tr>
<th><strong>Service/Servlet</strong></th>
<th><strong>Recommendations</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database and Admin Services</strong></td>
<td></td>
</tr>
<tr>
<td>Cisco AXL Web Service</td>
<td>• Turn on this service on the first node only.</td>
</tr>
<tr>
<td></td>
<td>• Failing to turn on this service causes the inability to update IM and Presence from client-based applications that use AXL.</td>
</tr>
<tr>
<td>Cisco Bulk Provisioning Service</td>
<td>• You turn on the Cisco Bulk Provisioning Service only on the first node.</td>
</tr>
<tr>
<td></td>
<td>• If you use the Bulk Administration Tool (BAT) to administer users, you must turn on this service.</td>
</tr>
<tr>
<td><strong>Performance and Monitoring Services</strong></td>
<td></td>
</tr>
<tr>
<td>Cisco Serviceability Reporter</td>
<td>Turn on this service on the publisher node only. The service only generates reports on the publisher node even if you turn on the service on other nodes.</td>
</tr>
<tr>
<td><strong>IM and Presence Services</strong></td>
<td></td>
</tr>
<tr>
<td>Cisco SIP Proxy</td>
<td>Turn on this service on all nodes in the cluster.</td>
</tr>
<tr>
<td>Cisco Presence Engine</td>
<td>Turn on this service on all nodes in the cluster.</td>
</tr>
<tr>
<td>Cisco Sync Agent</td>
<td>Turn on this service on all nodes in the cluster.</td>
</tr>
<tr>
<td>Service/Servlet</td>
<td>Recommendations</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Cisco XCP Text Conference Manager                          | • Turn on this service if you deploy the Chat feature on IM and Presence.  
• Turn on this service on each node that runs the Chat feature.  
Note: The permanent chat feature requires an external database. If you enable the permanent chat feature, you must also configure an external database before starting the Text Conference Manager service. The Text Conference Manager service will not start if the permanent chat feature is enabled and an external database is not configured. See the Database Setup Guide for IM and Presence on Cisco Unified Communications Manager. |
| Cisco XCP Web Connection Manager                           | • Turn on this service if you integrate web clients with IM and Presence.  
• Turn on this service on all nodes in the cluster.                                                                                                                                                                                                                     |
| Cisco XCP Connection Manager                               | • Turn on this service if you integrate XMPP clients with IM and Presence.  
• Turn on this service on all nodes in the cluster.                                                                                                                                                                                                                     |
| Cisco XCP SIP Federation Connection Manager                | Turn on this service if you deploy any of the following configurations:  
• Interdomain federation over the SIP protocol on IM and Presence. Turn on this service on each node that runs SIP federation.  
• Intercluster deployment between a IM and Presence Release 9.0 cluster and a Cisco Unified Presence Release 8.6 cluster. Turn on this service on all nodes in the Release 9.0 cluster. |

---

**Note:**
Cisco XCP Text Conference Manager

- Turn on this service if you deploy the Chat feature on IM and Presence.
- Turn on this service on each node that runs the Chat feature.

**Note:** The permanent chat feature requires an external database. If you enable the permanent chat feature, you must also configure an external database before starting the Text Conference Manager service. The Text Conference Manager service will not start if the permanent chat feature is enabled and an external database is not configured. See the *Database Setup Guide for IM and Presence on Cisco Unified Communications Manager*. 

---

**Note:**
Cisco XCP Web Connection Manager

- Turn on this service if you integrate web clients with IM and Presence.
- Turn on this service on all nodes in the cluster.

---

**Note:**
Cisco XCP Connection Manager

- Turn on this service if you integrate XMPP clients with IM and Presence.
- Turn on this service on all nodes in the cluster.

---

**Note:**
Cisco XCP SIP Federation Connection Manager

- Turn on this service if you deploy any of the following configurations:
  - Interdomain federation over the SIP protocol on IM and Presence. Turn on this service on each node that runs SIP federation.
  - Intercluster deployment between a IM and Presence Release 9.0 cluster and a Cisco Unified Presence Release 8.6 cluster. Turn on this service on all nodes in the Release 9.0 cluster.
<table>
<thead>
<tr>
<th>Service/Servlet</th>
<th>Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco XCP XMPP Federation Connection Manager</td>
<td>• Turn on this service only if you deploy interdomain federation over the XMPP protocol on IM and Presence.</td>
</tr>
<tr>
<td></td>
<td>• Turn on this service on each node that runs XMPP federation.</td>
</tr>
<tr>
<td>Note</td>
<td>Before you turn on the XMPP Federation Connection Manager service on a node, you must turn on XMPP Federation in Cisco Unified CM IM and Presence Administration on that node. See Interdomain Federation for IM and Presence on Cisco Unified Communications Manager.</td>
</tr>
<tr>
<td>Cisco XCP Message Archiver</td>
<td>• Turn on this service if you deploy the Compliance feature on IM and Presence.</td>
</tr>
<tr>
<td></td>
<td>• Turn on this service on any node that runs the IM Compliance feature.</td>
</tr>
<tr>
<td>Note</td>
<td>If you turn on the Message Archiver before you configure an external database, the service will not start. Also, if the external database is not reachable, the service will not start. See the Database Setup Guide for IM and Presence on Cisco Unified Communications Manager.</td>
</tr>
<tr>
<td>Cisco XCP Directory Service</td>
<td>• Turn on this service if you integrate XMPP clients on IM and Presence with an LDAP directory.</td>
</tr>
<tr>
<td></td>
<td>• Turn on this service on all nodes in the cluster.</td>
</tr>
<tr>
<td>Note</td>
<td>If you turn on the Directory Service before you configure the LDAP contact search settings for third-party XMPP clients, the service will start, and then stop again. See the Deployment Guide for IM and Presence on Cisco Unified Communications Manager.</td>
</tr>
<tr>
<td>Cisco XCP Authentication Service</td>
<td>• Turn on this service if you integrate XMPP clients with IM and Presence.</td>
</tr>
<tr>
<td></td>
<td>• Turn on this service on all nodes in the cluster.</td>
</tr>
</tbody>
</table>
Activate and deactivate feature services

You can turn on and turn off feature services in Cisco Unified IM and Presence Serviceability. Some feature services depend on other services, and you always turn on the non-dependent services first.

Note

Cisco Unified IM and Presence Serviceability allows you to turn on and turn off only features services (not network services).

Before You Begin

The service names for the server that you select and the status of the services are displayed in the Service Activation window. Services do not start until you turn them on.

Procedure

Step 1
Select Tools > Service Activation.

Step 2
Select the server from the Server list box, and then select Go.

Step 3
Perform one of the following actions to turn on or turn off services:

a) To turn on the default services required to run on a single server, select Set to Default

   Note
   This option selects default services based on the configuration of a single server, and checks for service dependencies.

b) To turn on all services, check Check All Services.

c) To turn on a specific service, check the service that you want to turn on

d) To turn off a service, uncheck the services that you want to turn off.

Step 4
Select Save after you finish making the appropriate changes.

Tip
To obtain the latest status of services, select Refresh.

Related Topics

Recommendations for activation of services in a cluster, on page 198

Start, stop, and restart services in Control Center or CLI

To perform these tasks, Cisco Unified IM and Presence Serviceability provides two Control Center windows. To start, stop, and restart network services, access the Control Center—Network Services window. To start, stop, and restart feature services, access the Control Center—Feature Services window.

Tip
Use the Related Links list box and the Go button to navigate to Control Center and Service Activation windows.
Start, stop, restart, and refresh services status in Control Center

Control Center in Cisco Unified IM and Presence Serviceability allows you to:

• view status  
• refresh status  
• start, stop, and restart IM and Presence services for a particular server in a cluster

You can only start, stop or restart feature services that you have turned on.  
If you are upgrading IM and Presence, those services that were already started on your system will start after the upgrade.

Procedure

Step 1 Depending on the service type that you want to start, stop, restart or refresh, perform one of the following actions:
   a) Select Tools > Control Center - Feature Services.  
   b) Select Tools > Control Center - Network Services.

Step 2 Select the server from the Server list box, and then select Go.

Step 3 Perform one of the following actions:.
   a) To start a service, select the radio button next to the service that you want to start, and then select Start.  
   The Status changes to reflect the updated status.

   b) To restart a service, do the following:
      1 Select the radio button next to the service that you want to restart, and then select Restart.
      2 Select OK when a message indicates that restarting may take a while.

   c) To stop a service, select the radio button next to the service that you want to stop, and then select Stop.  
   The Status changes to reflect the updated status.

   d) To get the latest status of the services, select Refresh.

   e) To go to the Service Activation window or to the other Control Center window, select the option from  
      the Related Links list box, and select Go.

Related Topics

Feature services activation and deactivation, on page 197

Start, stop, and restart services with Command Line Interface

You can start and stop the following services by issuing a command in the command line interface (CLI).  
You must start and stop all other services from Control Center in Cisco Unified IM and Presence Serviceability.
Procedure

**Step 1**  To start a service, enter **utils service start** `<service name>`, where `<service name>` equals the entire name of the service.

**Step 2**  To stop a service, enter **utils service stop** `<service name>`, where `<service name>` equals the entire name of the service.

**Step 3**  To restart a service, enter **utils service restart** `<service name>`, where `<service name>` equals the entire name of the service.

Related Topics

Start, stop, and restart services in Control Center or CLI, on page 201
Start, stop, and restart services in Control Center or CLI
Simple Network Management Protocol

- Simple Network Management Protocol support, page 205
- Set up SNMP, page 212
- Troubleshooting SNMP, page 213

Simple Network Management Protocol support

SNMP basics

Simple Network Management Protocol (SNMP), an application layer protocol, facilitates the exchange of management information among network devices, such as nodes, routers, and so on. As part of the TCP/IP protocol suite, SNMP enables administrators to remotely manage network performance, find and solve network problems, and plan for network growth.

You use Cisco Unified IM and Presence Serviceability to configure SNMP-associated settings, such as community strings, users, and notification destinations for V1, V2c, and V3. Likewise, in the SNMP configuration windows, you can apply the settings to all nodes in the cluster.

An SNMP-managed network comprises of three key components: managed devices, agents, and network management systems.

- Managed device—A network node that contains an SNMP agent and resides on a managed network. Managed devices collect and store management information and make it available by using SNMP. The first node in the IM and Presence cluster acts as the managed device.

- Agent—A network-managed software module that resides on a managed device. An agent contains local knowledge of management information and translates it into a form that is compatible with SNMP. IM and Presence uses a master agent and subagent components to support SNMP. The master agent acts as the agent protocol engine and performs the authentication, authorization, access control, and privacy functions that relate to SNMP requests. Likewise, the master agent contains a few Management Information Base (MIB) variables that relate to MIB-II. The master agent also connects and disconnects subagents after the subagent completes necessary tasks. The SNMP master agent listens on port 161 and forwards SNMP packets for Vendor MIBs.
The IM and Presence subagent interacts with the local IM and Presence only. The IM and Presence subagents send trap and information messages to the SNMP Master Agent, and the SNMP Master Agent communicates with the SNMP trap receiver (notification destination).

- Network Management System (NMS)—A SNMP management application (together with the PC on which it runs) that provides the bulk of the processing and memory resources that are required for network management. An NMS executes applications that monitor and control managed devices. IM and Presence works with the following NMS:
  - Cisco Unified Operations Manager
  - HP OpenView
  - Third-party applications that support SNMP and IM and Presence SNMP interfaces

**SNMP version 1 support**

SNMP version 1 (SNMPv1), the initial implementation of SNMP that functions within the specifications of the Structure of Management Information (SMI), operates over protocols, such as User Datagram Protocol (UDP) and Internet Protocol (IP).

The SNMPv1 SMI defines highly structured tables (MIBs) that are used to group the instances of a tabular object (that is, an object that contains multiple variables). Tables contain zero or more rows, which are indexed, so SNMP can retrieve or alter an entire row with a supported command.

With SNMPv1, the NMS issues a request, and managed devices return responses. Agents use the Trap operation to asynchronously inform the NMS of a significant event.

In Cisco Unified IM and Presence Serviceability, you configure SNMP v1 support in the **V1/V2c Configuration** window.

**Related Topics**

- SNMP V1/V2c setup, on page 215

**SNMP version 2c support**

As with SNMPv1, SNMPv2c functions within the specifications of the Structure of Management Information (SMI). MIB modules contain definitions of interrelated managed objects. The operations that are used in SNMPv1 are similar to those that are used in SNMPv2. The SNMPv2 Trap operation, for example, serves the same function as that used in SNMPv1, but it uses a different message format and replaces the SNMPv1 Trap.

The Inform operation in SNMPv2c allows one NMS to send trap information to another NMS and to then receive a response from the NMS.

In Cisco Unified IM and Presence Serviceability, you configure SNMP v2c support in the **V1/V2c Configuration** window.

**Related Topics**

- SNMP V1/V2c setup, on page 215
SNMP version 3 support

SNMP version 3 provides security features such as authentication (verifying that the request comes from a genuine source), privacy (encryption of data), authorization (verifying that the user allows the requested operation), and access control (verifying that the user has access to the objects requested.) To prevent SNMP packets from being exposed on the network, you can configure encryption with SNMPv3.

Instead of using community strings like SNMP v1 and v2, SNMP v3 uses SNMP users. In Cisco Unified IM and Presence Serviceability, you configure SNMP v3 support in the V3 Configuration window.

Related Topics

- SNMP V3 setup, on page 223
- SNMP community strings and users, on page 207

SNMP services

To support SNMP, you must use the following services, which display in the Control Center-Network Services screen in Cisco Unified IM and Presence Serviceability.

- SNMP Master Agent
- MIB2 Agent
- Host Resources Agent
- System Application Agent
- Native Agent Adaptor
- Cisco CDP Agent
- Cisco Syslog Agent

Caution

Stopping any SNMP service may result in loss of data because the network management system no longer monitors the Cisco Unified Communications Manager network. Do not stop the services unless your technical support team tells you to do so.

Related Topics

- Feature and network services, on page 185

SNMP community strings and users

Although SNMP community strings provide no security, they authenticate access to MIB objects and function as embedded passwords. You configure SNMP community strings for SNMP v1 and v2c only.

SNMP v3 does not use community strings. Instead, version 3 uses SNMP users. These users serve the same purpose as community strings, but users provide security because you can configure encryption or authentication for them.

In Cisco Unified IM and Presence Serviceability, no default community string or user exists.
SNMP traps and informs

An SNMP agent sends notifications to NMS in the form of traps or informs to identify important system events. Traps do not receive acknowledgments from the destination whereas informs do receive acknowledgments. You configure the notification destinations by using the **SNMP Notification Destination Configuration** windows in Cisco Unified IM and Presence Serviceability.

For SNMP notifications, traps are sent immediately if the corresponding trap flags are enabled. In the case of the syslog agent, the alarms and system level log messages are sent to syslog daemon for logging. Also, some standard third-party applications send the log messages to syslog daemon for logging. These log messages are logged locally in the syslog files and are also converted into SNMP traps/notifications.

The “Syslog message generated” SNMP trap/inform message is sent to a configured trap destination.

Before you configure notification destination, verify that the required SNMP services are active and running. Also, make sure that you configured the privileges for the community string/user correctly.

You configure the SNMP trap destination by selecting **SNMP > V1/V2 > Notification Destination** or **SNMP > V3 > Notification Destination** in Cisco Unified IM and Presence Serviceability.

The following table provides information about IM and Presence trap/inform parameters that you configure on the Network Management System (NMS). You can configure the values in the table below by issuing the appropriate commands on the NMS, as described in the SNMP product documentation that supports the NMS.

Be aware that the parameters that are listed in the table below are part of CISCO-SYSLOG-MIB.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Default Value</th>
<th>Generated Traps</th>
<th>Configuration Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td>clogNotificationsEnabled</td>
<td>False</td>
<td>clogMessageGenerated</td>
<td>To enable trap generation, set clogNotificationsEnable to True.</td>
</tr>
<tr>
<td>clogMaxSeverity</td>
<td>Warning</td>
<td>clogMessageGenerated</td>
<td>When you set clogMaxSeverity to warning, a SNMP trap generates when IM and Presence applications generate a syslog message with at least a warning severity level.</td>
</tr>
</tbody>
</table>
SNMP Management Information Base (MIB)

SNMP allows access to Management Information Base (MIB), which is a collection of information that is organized hierarchically. MIBs comprise managed objects, which are identified by object identifiers. A MIB object, which contains specific characteristics of a managed device, comprises one or more object instances (variables).

The Simple Network Management Protocol (SNMP) extension agent resides in each IM and Presence node. IM and Presence supports the following MIBs.

CISCO-CDP-MIB

Use the IM and Presence CDP subagent to read the Cisco Discovery Protocol MIB, CISCO-CDP-MIB. This MIB enables IM and Presence to advertise itself to other Cisco devices on the network.

The CDP subagent implements the CDP-MIB. The CDP-MIB contains the following objects:

- cdpInterfaceIfIndex
- cdpInterfaceMessageInterval
- CdpInterfaceEnable
- cdpInterfaceGroup
- cdpInterfacePort
- CdpGlobalRun
- CdpGlobalMessageInterval
- CdpGlobalHoldTime
- cdpGlobalLastChange
- cdpGlobalDeviceId
- cdpGlobalDeviceIdFormat
- cdpGlobalDeviceIdFormatCpd

SYSAPPL-MIB

Use the System Application Agent to get information from the SYSAPPL-MIB, such as installed applications, application components, and processes that are running on the system.

System Application Agent supports the following object groups of SYSAPPL-MIB:

- sysApplInstalled
- sysApplRun
- sysApplMap

MIB-II

Use MIB2 agent to get information from MIB-II. The MIB2 agent provides access to variables that are defined in RFC 1213, such as interfaces, IP, and so on, and supports the following groups of objects:

- system
• interfaces
• at
• ip
• icmp
• tcp
• udp
• snmp

HOST-RESOURCES MIB
Use Host Resources Agent to get values from HOST-RESOURCES-MIB. The Host Resources Agent provides SNMP access to host information, such as storage resources, process tables, device information, and installed software base. The Host Resources Agent supports the following groups of objects:

• hrSystem
• hrStorage
• hrDevice
• hrSWRun
• hrSWRunPerf
• hrSWInstalled

CISCO-SYSLOG-MIB
The system supports trap functionality only. The Cisco Syslog Agent supports only the following objects of CISCO-SYSLOG-MIB:

• clogNotificationsSent
• clogNotificationsEnabled
• clogMaxSeverity
• clogMsgIgnores
• clogMsgDrops

Vendor-Specific MIBs
The following MIBs exist on various Cisco MCS, depending on vendor and model number. To query these MIBS, you can use the standard MIB browsers that are developed by the hardware vendors; for example, HP Systems Insight Manager (SIM) and IBM Director Server+Console. For information about using the MIB browsers, refer to the documentation that the hardware vendor provides.

To review the vendor-specific MIB information, see the following tables:
### Table 57: IBM MIBs

<table>
<thead>
<tr>
<th>MIB</th>
<th>OID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supported for browsing only</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM-SYSTEM-HEALTH-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.30</td>
<td>Provides temperature, voltage, and fan status</td>
</tr>
<tr>
<td>IBM-SYSTEM-ASSETID-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.60</td>
<td>Provides hardware component asset data</td>
</tr>
<tr>
<td>IBM-SYSTEM-LMSENSOR-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.80</td>
<td>Provides temperature, voltage, and fan details</td>
</tr>
<tr>
<td>IBM-SYSTEM-NETWORK-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.110</td>
<td>Provides Network Interface Card (NIC) status</td>
</tr>
<tr>
<td>IBM-SYSTEM-MEMORY-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.120</td>
<td>Provides physical memory details</td>
</tr>
<tr>
<td>IBM-SYSTEM-POWER-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.130</td>
<td>Provides power supply details</td>
</tr>
<tr>
<td>IBM-SYSTEM-PROCESSOR-MIB</td>
<td>1.3.6.1.4.1.2.6.159.1.1.140</td>
<td>Provides CPU asset/status data</td>
</tr>
<tr>
<td><strong>Supported for system traps</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM-SYSTEM-TRAP</td>
<td>1.3.6.1.4.1.2.6.159.1.1.0</td>
<td>Provides temperature, voltage, fan, disk, NIC, memory, power supply, and CPU details</td>
</tr>
<tr>
<td>IBM-SYSTEM-RAID-MIB</td>
<td>1.3.6.1.4.1.2.6.167.2</td>
<td>Provides RAID status</td>
</tr>
</tbody>
</table>

### Table 58: HP MIBs

<table>
<thead>
<tr>
<th>MIB</th>
<th>OID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supported for browsing and system traps</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPQSTDEQ-MIB</td>
<td>1.3.6.1.4.1.232.1</td>
<td>Provides hardware component configuration data</td>
</tr>
<tr>
<td>CPQSINFO-MIB</td>
<td>1.3.6.1.4.1.232.2</td>
<td>Provides hardware component asset data</td>
</tr>
<tr>
<td>CPQIDA-MIB</td>
<td>1.3.6.1.4.1.232.3</td>
<td>Provides RAID status/events</td>
</tr>
<tr>
<td>CPQHLTH-MIB</td>
<td>1.3.6.1.4.1.232.6</td>
<td>Provides hardware components status/events</td>
</tr>
<tr>
<td>MIB</td>
<td>OID</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>CPQSTSYS-MIB</td>
<td>1.3.6.1.4.1.232.8</td>
<td>Provides storage (disk) systems status/events</td>
</tr>
<tr>
<td>CPQSM2-MIB</td>
<td>1.3.6.1.4.1.232.9</td>
<td>Provides iLO status/events</td>
</tr>
<tr>
<td>CPQTHRSH-MIB</td>
<td>1.3.6.1.4.1.232.10</td>
<td>Provides alarm threshold management</td>
</tr>
<tr>
<td>CPQHOST-MIB</td>
<td>1.3.6.1.4.1.232.11</td>
<td>Provides operating system information</td>
</tr>
<tr>
<td>CPQIDE-MIB</td>
<td>1.3.6.1.4.1.232.14</td>
<td>Provides IDE (CD-ROM) drive status/events</td>
</tr>
<tr>
<td>CPQNIC-MIB</td>
<td>1.3.6.1.4.1.232.18</td>
<td>Provides Network Interface Card (NIC) status/events</td>
</tr>
</tbody>
</table>

**Set up SNMP**

The following procedure provides the tasks for configuring SNMP.

See the SNMP product documentation that supports the NMS for more information.

**Procedure**

**Step 1** Install and configure the SNMP NMS.

**Step 2** In the **Control Center—Network Services** window, verify that the system started the SNMP services.

**Step 3** If you are using SNMP v3, configure the SNMP user.

**Step 4** Configure the notification destination for traps or informs.

**Step 5** Configure the system contact and location for the MIB2 system group.

**Step 6** Restart the Master Agent service.

**Step 7** On the NMS, configure the Cisco Unified Communications Manager trap parameters.

**Related Topics**

- Set up community string, on page 215
- Configure notification destination for SNMP V1/V2c, on page 218
- Set up notification destination for SNMP V3, on page 226
- Set up SNMP V3 user, on page 223
- Set up MIB2 system group, on page 231
- Feature and network services, on page 185
- SNMP services, on page 207
Troubleshooting SNMP

Review this section for troubleshooting tips. Make sure that all of the feature and network services are running.

Problem
Cannot poll any MIBs from the system
This condition means that the community string or the snmp user is not configured on the system or they do not match with what is configured on the system. By default, no community string or user is configured on the system.

Solution
Check whether the community string or snmp user is properly configured on the system by using the SNMP configuration windows.

Problem
Cannot receive any notifications from the system
This condition means that the notification destination is not configured correctly on the system.

Solution
Verify that you configured the notification destination properly in the Notification Destination (V1/V2c or V3) Configuration window.

Related Topics
   SNMP services, on page 207
SNMP community strings

This section describes how to set up, find and delete community strings.

Set up community string

Because the SNMP agent provides security by using community strings, you must configure the community string to access any management information base (MIB) in an IM and Presence system. Change the community string to limit access to the IM and Presence system. To add, modify, and delete community strings, access the SNMP Community String Configuration window.

The following table describes the community string configuration settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting in the Community String Configuration window displays as read only because you already specified your choice of server.</td>
</tr>
<tr>
<td>Community String Name</td>
<td>Enter a name for the community string. The name can contain up to 32 characters and can contain any combination of alphanumeric characters, hyphens (-), and underscore characters (_). <strong>Tip</strong> Select community string names that will be hard for outsiders to figure out. When you edit a community string, you cannot change the name of the community string.</td>
</tr>
<tr>
<td>Accept SNMP Packets from any host</td>
<td>To accept SNMP packets from any host, select this radio button.</td>
</tr>
</tbody>
</table>
**SNMP community strings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept SNMP Packets only from these hosts</td>
<td>To accept SNMP only from specified hosts, select this radio button. <strong>Tip</strong> In the Host IP Address field, enter a host from which you want to accept packets and select <strong>Insert</strong>. Repeat this process for each host from which you want to accept packets. To delete a host, select that host from the Host IP Addresses list box and select <strong>Remove</strong>.</td>
</tr>
<tr>
<td>Access Privileges</td>
<td>From the list box, select the appropriate access level from the following list: • <strong>ReadOnly</strong>—The community string can only read the values of MIB objects. • <strong>ReadWrite</strong>—The community string can read and write the values of MIB objects. • <strong>ReadWriteNotify</strong>—The community string can read and write the values of MIB objects and send MIB object values for a trap and inform messages. • <strong>NotifyOnly</strong>—The community string can only send MIB object values for a trap and inform messages. • <strong>ReadNotifyOnly</strong>—The community string can only read the values of MIB objects, send MIB object values for a trap, and inform messages. • <strong>None</strong>—The community string cannot read, write, or send trap information. <strong>Tip</strong> To change the IM and Presence trap configuration parameters, you need to use a community with NotifyOnly or ReadWriteNotify privileges.</td>
</tr>
<tr>
<td>Apply To All Nodes</td>
<td>Check to apply the community string to all nodes in the cluster.</td>
</tr>
</tbody>
</table>

**Before You Begin**

Review the tasks in the procedure to set up SNMP.

**Procedure**

**Step 1** Select **Snmp > V1/V2c > Community String**.

**Step 2** Select the required server from the **Server** list box, and then select **Find**.

**Step 3** To add a new community string, select **Add New** and enter the community string configuration settings as outlined in the table above. **Tip** The **Add New** button does not display in the **SNMP Community String Configuration** window until you select the **Find** button. If no community strings exist and you want to add a community string, select the **Find** button and wait for the window to refresh. The **Add New** button displays. If you are adding a new community string, you can select **Clear All** at any time to delete all information that you entered for all settings.

**Step 4** To modify an existing community string, search for the community string, select it and enter the community string configuration settings as outlined in the table above.
Note You cannot change the name of the community string or the server for the community string.

**Step 5**
After you complete the configuration, select **Save**.

**Step 6**
Perform one of the following actions:

a) Select **OK** to restart the SNMP master agent service and effect the changes.
   Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

b) Select **Cancel** to continue the configuration without restarting the SNMP master agent.

**Tip** If you are adding a new community string, you can select **Clear All** at any time to delete all information that you entered for all settings.

---

**Related Topics**

- Set up SNMP, on page 212
- Set up community string, on page 215
- SNMP V3 setup, on page 223
- MIB2 system group, on page 231
- Services setup and viewing services, on page 197

---

**Find community string**

**Before You Begin**
Review the tasks in the procedure to set up SNMP.

If you use SNMP version 3, see topics related to setting up SNMP v3 in Cisco Unified IM and Presence Serviceability.

**Procedure**

**Step 1** Select `Snmp > V1/V2c > Community String`.

**Step 2** Select the specific search criteria that you want to use for the community string from the **Find Community Strings where** Name list box.

**Step 3** Enter the community string for which you want to search.

**Step 4** Select the hostname or IP address of the server where the community string exists in the **Server** list box.

**Step 5** Select **Find**.

**Step 6** If you want to apply the configuration from one of the options in the search results to all nodes in the cluster, check the name of the option and check **Apply to All Nodes**.

**Step 7** Select the community string that you want to view from the list of results.

**Tip** The **Add New** button does not display in the **SNMP Community String Configuration** window until you select the **Find** button. If no community strings exist and you want to add want a community string, select the **Find** button and wait for the window to refresh. The **Add New** button displays.
Delete community string

Before You Begin
Review the SNMP configuration checklist.

Procedure

Step 1 Locate the community string.
Step 2 Check the community string that you want to delete from the list of matching records.
Step 3 Select **Delete Selected**. A message indicates that the system will delete notification entries that relate to this community string.
Step 4 Select **OK** to continue the deletion. A message indicates that changes will not take effect until you restart the SNMP master agent.
Step 5 Perform one of the following actions:
   a) Select **Cancel** to continue the configuration without restarting the SNMP master agent.
   b) Select **OK** to restart the SNMP master agent service.

   **Note** We recommend that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

SNMP notification destinations

The procedures to configure SNMP notification destination depend on the SNMP version that you support.

Configure notification destination for SNMP V1/V2c

You can configure the notification destination (trap/inform receiver) for V1/V2c. The following table describes the notification destination configuration settings for SNMP V1/V2c.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you already specified the server.</td>
</tr>
</tbody>
</table>
### SNMP notification destinations

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host IP Addresses</td>
<td>From the list box, select the Host IP address of the trap destination or select <strong>Add New</strong>. If you select Add New, enter the IP address of the trap destination. For existing notification destinations, you cannot modify the host IP address configuration.</td>
</tr>
<tr>
<td>Port Number</td>
<td>In the field, enter the notification-receiving port number on the destination server that receives SNMP packets.</td>
</tr>
<tr>
<td>V1 or V2C</td>
<td>From the SNMP Version Information pane, select the appropriate SNMP version radio button, either V1 or V2C, which depends on the version of SNMP that you are using.</td>
</tr>
<tr>
<td></td>
<td>• If you select V1, configure the community string setting.</td>
</tr>
<tr>
<td></td>
<td>• If you select V2C, configure the notification type setting and then configure the community string.</td>
</tr>
<tr>
<td>Community String</td>
<td>From the list box, select the community string name to be used in the notification messages that this host generates. Only community strings with minimum notify privileges (ReadWriteNotify, ReadNotifyOnly, or Notify Only) display. If you have not configured a community string with these privileges, no options appear in the list box. If necessary, select the <strong>Create New Community String</strong> button to create a community string.</td>
</tr>
<tr>
<td>Apply To All Nodes</td>
<td>Check to apply the notification destination configuration to all nodes in the cluster.</td>
</tr>
</tbody>
</table>

### Before You Begin

Review the tasks in the procedure to set up SNMP.

### Procedure

1. **Step 1** Select **Snmp > V1/V2c > Notification Destination**.
2. **Step 2** Select the required server from the **Server** list box.
3. **Step 3** Select **Find**.
4. **Step 4** To add a new SNMP notification destination, select **Add New** and enter the configuration settings as described in the table above. You configure the notification destination for the server that you select in the Server list box in the **Find/List** window. You can select **Clear** at any time to delete all information that you entered for all settings.
The Add New button does not display in the SNMP Notification Destination Configuration window until you select the Find button. If no notification destinations exist and you want to add want a notification destination, select the Find button and wait for the window to refresh. The Add New button displays.

Step 5 To modify an existing SNMP notification destination, locate the notification destination and select the name of the SNMP notification destination that you want to edit. Enter the configuration settings as described in the table above.

Step 6 Perform one of the following actions:
- Select Insert to save a notification destination.
- Select Save to save changes to an existing notification destination. A message indicates that changes will not take effect until you restart the SNMP master agent.

Step 7 Select OK to restart the SNMP master agent or select Cancel to continue the configuration without restarting the SNMP master agent.

Note Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.

Related Topics
- Set up SNMP, on page 212
- SNMP notification destinations, on page 218
- Find notification destination for SNMP V3, on page 228
- Set up notification destination for SNMP V3, on page 226
- Delete notification destination for SNMP V3, on page 229

Find notification destination for SNMP V1/V2c

Before You Begin
Review the SNMP configuration checklist.

Procedure

Step 1 Select Snmp > V1/V2c > Notification Destination.
Step 2 Select the specific search criteria that you want to use to find the notification destination from the Find Notification where Destination IP list box.
Step 3 Enter the notification destination for which you want to search.
Step 4 Select the hostname or IP address of the server that supports the notification destination in the Server list box.
Step 5 Select Find.
Step 6 Perform one or more of the following actions:
- To apply the configuration from one of the options in the search results to all nodes in the cluster, check the name of the option and check Apply to All Nodes.
- Select an item in the search results to view the configuration for that item.
The Add New button does not display in the SNMP Notification Destination Configuration window until you select the Find button. If no notification destinations exist and you want to add want a notification destination, select the Find button and wait for the window to refresh. The Add New button displays.

### Related Topics
- Set up SNMP, on page 212
- Configure notification destination for SNMP V1/V2c, on page 218

## Delete notification destination for SNMP V1/V2c

### Before You Begin
Review the tasks in the procedure to set up SNMP.

### Procedure

**Step 1** Locate the notification destination.

**Step 2** Check the notification destination that you want to delete from the list of matching records.

**Step 3** Select **Delete Selected**. A message asks whether you want to delete the notification entries.

**Step 4** Select **OK** to continue the deletion. A message indicates that changes will not take effect until you restart the SNMP master agent.

**Step 5** Select **OK** to restart the SNMP master agent service, or select **Cancel** to continue the configuration without restarting the SNMP master agent.

**Note** Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

### Related Topics
- Set up SNMP, on page 212
- Start, stop, and restart services in Control Center or CLI, on page 201
SNMP V3 setup

- SNMP users, page 223
- SNMP notification destinations, page 226

SNMP users

This section describes how to set up, find and delete SNMP V3 users.

Set up SNMP V3 user

You can set up an SNMP user for V3. The following table describes the configuration settings.

Table 61: Configuration Settings for SNMP User for V3

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you already specified the server.</td>
</tr>
<tr>
<td>User Name</td>
<td>In the field, enter the name of the user for which you want to provide access. The name can contain up to 32 characters and can contain any combination of alphanumeric characters, hyphens (-), and underscore characters (_). <strong>Tip</strong> Enter users that you have already configured for the network management system (NMS). For existing SNMP users, this setting displays as read only.</td>
</tr>
<tr>
<td>Authentication Required</td>
<td>Check to require authentication, then enter the password in the Password and Reenter Password fields, and select the appropriate protocol. The password must contain at least 8 characters.</td>
</tr>
<tr>
<td>Privacy Required</td>
<td>If you checked Authentication Required, you can specify privacy information. Check to require privacy, and then enter the password in the Password and Reenter Password fields, and select an appropriate protocol. The password must contain at least eight characters.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Accept SNMP Packets from any host</td>
<td>To accept SNMP packets from any host, select the radio button.</td>
</tr>
<tr>
<td>Accept SNMP Packets only from these hosts</td>
<td>To accept SNMP packets from specific hosts, select the radio button. In the Host IPAddress field, enter a host from which you want to accept SNMP packets and select Insert. Repeat this process for each host from which you want to accept SNMP packets. To delete a host, select that Host from the Host IP Addresses pane and select Remove.</td>
</tr>
</tbody>
</table>
| Access Privileges | From the list box, select one of the following options for the access level:  
  • **ReadOnly**—The user can only read the values of MIB objects.  
  • **ReadWrite**—The user can read and write the values of MIB objects.  
  • **ReadWriteNotify**—The user can read and write the values of MIB objects and send MIB object values for a trap and inform messages.  
  • **NotifyOnly**—The user can only send MIB object values for a trap and inform messages.  
  • **None**—The user cannot read, write, or send trap information.  
  
To change the trap configuration parameters, you need to configure a user with NotifyOnly or WriteNotify privileges. |
| Apply To All Nodes | Check to apply the user configuration to all nodes in the cluster. |

**Before You Begin**

Review the tasks in the procedure to set up SNMP.

**Procedure**

**Step 1**  
Select **Snmp > V3 > User**.

**Step 2**  
Select the required server from the **Server** list box.

**Step 3**  
Select **Find**.

**Step 4**  
To add a new SNMP user, select **Snmp > V3 > User > Add New** and enter the configuration settings as described in the table above.

**Note**  
The **Add New** button does not display in the **SNMP User Configuration** window until you select the **Find** button. If no users exist and you want to add a user, select the **Find** button and wait for the window to refresh. The **Add New** button displays.

**Tip**  
You can select **Clear All** at any time to delete all information that you entered for all settings.

**Step 5**  
To modify an existing SNMP user, locate the user, select the name of the SNMP user that you want to edit and enter the configuration settings as described in the table above.  
See the SNMP user for V3 configuration settings table for field descriptions.

**Tip**  
You can select **Clear All** at any time to delete all information that you entered for all settings.
Step 6  Select Save to save changes to an existing user.

Step 7  Perform one of the following actions when a message indicates that changes will not take effect until you restart the SNMP master agent:
   a) Select OK to restart the SNMP master agent service.
   b) Select Cancel to continue the configuration without restarting the SNMP master agent.
       Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP
       master agent service.

Tip  To access this Cisco Unified Communications Manager server that has the user that you configure,
    make sure that you configure this user on the NMS with the appropriate authentication and privacy
    settings.

Related Topics
   MIB2 system group, on page 231
   Find notification destination for SNMP V3, on page 228
   Find SNMP user, on page 225
   Set up SNMP, on page 212
   SNMP V1/V2c setup, on page 215

Find SNMP user

Before You Begin
   Review the SNMP configuration checklist.

Procedure

Step 1  Select Snmp > V3 > User.

Step 2  Select the specific search criteria that you want to use to find the user; for example, begins with.

Step 3  Enter the user name for which you want to search.

Step 4  Select the hostname or IP address of the server where you access the user from the Server list box.

Step 5  Select Find.
       After you select the Find button, the Add New button displays. After the search results display, Apply to All
       Nodes displays.
       Tip  The Add New button does not display in the SNMP User Configuration window until you select the
            Find button. If no users exist and you want to add a user, select the Find button and wait for the
            window to refresh. The Add New button displays.

Step 6  Check the name of the option and check Apply to All Nodes.

Step 7  Select the user that you want to view from the list of results.

Related Topics
   Set up SNMP, on page 212
Delete SNMP user

Before You Begin
Review the tasks in the procedure to set up SNMP.

Procedure

Step 1 Locate the SNMP user.
Step 2 Check the user that you want to delete from the list of matching records.
Step 3 Select Delete Selected. A message indicates that the system will delete notification entries that relate to this user.
Step 4 Select OK to continue the deletion. A message indicates that changes will not take effect until you restart the SNMP master agent.
Step 5 Perform one of the following actions:
   a) Select OK to restart the SNMP master agent service.
   b) Select Cancel to continue the configuration without restarting the SNMP master agent.
Cisco recommends that you wait until you finish all the SNMP configuration before you restart the SNMP master agent service.

Related Topics
Services setup and viewing services, on page 197
Set up SNMP, on page 212

SNMP notification destinations

This section describes how to set up, find and delete notification destinations for SNMP V3.

Set up notification destination for SNMP V3

You can configure the trap and inform receiver. The following table describes the notification destination configuration settings for SNMP V3.

Table 62: Notification Destination Configuration Settings for SNMP V3

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>This setting displays as read only because you already specified the server.</td>
</tr>
<tr>
<td>Host IP Addresses</td>
<td>From the list box, select the Host IP address or select Add New. If you chose Add New, enter the IP address for the host.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>In the field, enter the notification-receiving port number on the destination server.</td>
</tr>
<tr>
<td>Notification Type</td>
<td>From the list box, select <strong>Inform</strong> or <strong>Trap</strong>.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Cisco recommends that you select the Inform option. The Inform function retransmits the message until it is acknowledged, thus, making it more reliable than traps.</td>
</tr>
<tr>
<td>Remote SNMP Engine Id</td>
<td>This setting displays if you chose Inform from the Notification Type list box. From the list box, select the engine ID or select <strong>Add New</strong>. If you chose Add New, enter the ID in the Remote SNMP Engine Id field, which requires a hexadecimal value.</td>
</tr>
<tr>
<td>Security Level</td>
<td>From the list box, select the appropriate security level for the user.</td>
</tr>
<tr>
<td></td>
<td>- <strong>noAuthNoPriv</strong>—No authentication or privacy configured.</td>
</tr>
<tr>
<td></td>
<td>- <strong>authNoPriv</strong>—Authentication configured, but no privacy configured.</td>
</tr>
<tr>
<td></td>
<td>- <strong>authPriv</strong>—Authentication and privacy configured.</td>
</tr>
<tr>
<td>User Information pane</td>
<td>From the pane, perform one of the following tasks to associate or disassociate the notification destination with the user.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Create New User</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Select the radio button for the user and select <strong>Update Select end User</strong> to modify an existing user.</td>
</tr>
<tr>
<td></td>
<td>- Select the radio button for the user and select <strong>Delete Selected User</strong> to delete a user.</td>
</tr>
<tr>
<td></td>
<td>The users that display vary depending on the security level that you configured for the notification destination.</td>
</tr>
<tr>
<td>Apply To All Nodes</td>
<td>Check to apply the notification destination configuration to all nodes in the cluster.</td>
</tr>
</tbody>
</table>

### Before You Begin
Review the tasks in the procedure to set up SNMP.
Procedure

Step 1  Select Snmp > V3 > Notification Destination.
Step 2  Select the required server from the Server list box.
Step 3  Select Find.
Step 4  To add a new SNMP notification destination, select Add New and configure the settings for V3 as described in the above table.
   Note  The Add New button does not display in the SNMP Notification Destination Configuration window until you select the Find button. If no users exist and you want to add want a user, select the Find button and wait for the window to refresh. The Add New button displays.
Step 5  To modify an existing SNMP notification destination, locate the notification destination, select the name of the SNMP notification destination that you want to edit and configure the settings for V3 as described in the above table.
   Tip  You can select Clear at any time to delete all information that you entered for the settings.
Step 6  Perform one of the following actions to save a notification destination:
   a)  Select Insert.
   b)  Select Save to save changes to an existing notification destination.
       A message indicates that changes will not take effect until you restart the SNMP master agent.
Step 7  Select OK to restart the SNMP master agent service or select Cancel to continue the configuration without restarting the SNMP master agent.
   Note  Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.

Related Topics

SNMP V1/V2c setup, on page 215
Services setup and viewing services, on page 197
Find notification destination for SNMP V3, on page 228
Set up SNMP, on page 212
MIB2 system group, on page 231

Find notification destination for SNMP V3

Before You Begin

Review the SNMP configuration checklist.
### SNMP notification destinations

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Select SNMP &gt; V3 &gt; Notification Destination.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select the specific search criteria that you want to use to find the notification destination; for example, begins with.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter the IP address or hostname of notification destination for which you want to search.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the hostname or IP address of the server that supports the notification destination in the Server field.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Select Find. After you select the Find button, the Add New button displays. After the search results display, Apply to All Nodes displays.</td>
</tr>
</tbody>
</table>

**Note** The Add New button does not display in the SNMP Notification Destination Configuration window until you select the Find button. If no users exist and you want to add want a user, select the Find button and wait for the window to refresh. The Add New button displays.

| Step 6 | Check the name of the option and check Apply to All Nodes. |
| Step 7 | Select the notification destination that you want to view from the list of results. |

**Related Topics**

- Set up SNMP, on page 212
- Set up notification destination for SNMP V3, on page 226

### Delete notification destination for SNMP V3

**Before You Begin**

Review the SNMP configuration checklist.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Locate the SNMP notification destination.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Check the notification destination that you want to delete from the list of matching records.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Select Delete Selected. A message asks you if you want to delete the notification destination.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select OK to continue the deletion. A message indicates that changes will not take effect until you restart the SNMP master agent.</td>
</tr>
</tbody>
</table>
| Step 5 | Perform one of the following actions:  
  a) Select OK to restart the SNMP master agent service.  
  b) Select Cancel to continue the configuration without restarting the SNMP master agent.  

**Note** Cisco recommends that you wait until you finish the SNMP configuration before you restart the SNMP master agent service.
Related Topics

- Set up SNMP, on page 212
- Services setup and viewing services, on page 197
- SNMP notification destinations, on page 226
MIB2 system group

This chapter provides information to configure the system contact and system location objects for the MIB-II system group. For example, you could enter Administrator, 555-121-6633, for the system contact and San Jose, Bldg 23, Second floor, for the system location.

- Set up MIB2 system group, page 231

Set up MIB2 system group

You can configure a system contact and system location for the MIB-II system group. The following table describes the MIB2 system group configuration settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>1 Select the server for which you want to configure contacts from the list box.</td>
</tr>
<tr>
<td></td>
<td>2 Select Go.</td>
</tr>
<tr>
<td>System Contact</td>
<td>Enter a person to notify when problems occur.</td>
</tr>
<tr>
<td>System Location</td>
<td>Enter the location of the person that is identified as the system contact.</td>
</tr>
<tr>
<td>Apply To All Nodes</td>
<td>Check to apply the system configuration to all of the nodes in the cluster.</td>
</tr>
</tbody>
</table>

Tip

This procedure supports SNMP v1, v2c, and v3 configuration.
Procedure

Step 1  Select Snmp > SystemGroup > MIB2 System Group.
Step 2  Configure the MIB2 System Group settings as described in the table above.
Step 3  Select Save. A message indicates that changes will not take effect until you restart the SNMP master agent.
Step 4  Select OK to restart the SNMP master agent service or select Cancel to continue the configuration without restarting the SNMP master agent.
Step 5  Perform one of the following actions:
   a) Select Clear All to clear the System Contact and System Location fields.
   b) Select Clear All and Save to delete the system configuration.
Trace field descriptions

This chapter provides the trace field descriptions for the services that support trace activation of specific components. For some services, you can activate trace for specific component instead of enabling all trace for the service. If a service is not included in this chapter, Enable All Trace displays for the service in the Trace Configuration window.

- Cisco Access Log trace fields, page 233
- Trace output settings descriptions and defaults, page 238

Cisco Access Log trace fields

The following table describes the Cisco Access Log trace fields.

Table 64: Access Log Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Access Log Trace</td>
<td>Turns on Access Log trace.</td>
</tr>
</tbody>
</table>

Cisco Authentication trace fields

The following table describes the Cisco Authentication trace fields.

Table 65: Authentication Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Authentication Trace</td>
<td>Turns on authentication trace.</td>
</tr>
</tbody>
</table>
Cisco Calendar trace fields

The following table describes the Cisco Calendar trace fields.

*Table 66: Calendar Trace fields*

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Calendar Trace</td>
<td>Turns on Calendar trace.</td>
</tr>
</tbody>
</table>

Cisco CTI Gateway trace fields

The following table describes the Cisco CTI Gateway trace fields.

*Table 67: CTI Gateway Trace Fields*

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable CTI Gateway Trace</td>
<td>Turns on CTI Gateway trace.</td>
</tr>
</tbody>
</table>

Cisco Database Layer Monitor trace fields

The following table describes the Cisco Database Layer Monitor trace fields.

*Table 68: Cisco Database Layer Monitor Trace Fields*

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DB Library Trace</td>
<td>Turns on database library trace for C++ applications.</td>
</tr>
<tr>
<td>Enable Service Trace</td>
<td>Turns on service trace.</td>
</tr>
<tr>
<td>Enable DB Change Notification Trace</td>
<td>Activates the database change notification traces for C++ applications.</td>
</tr>
<tr>
<td>Enable Unit Test Trace</td>
<td>Do not check. Cisco engineering uses it for debugging purposes.</td>
</tr>
</tbody>
</table>

Cisco Enum trace fields

The following table describes the Cisco Enum trace fields.
Table 69: Enum Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Enum Trace</td>
<td>Turns on ENUM trace.</td>
</tr>
</tbody>
</table>

Cisco Method/Event trace fields

The following table describes the Cisco Method/Event trace fields.

Table 70: Method/Event Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Method/Event Trace</td>
<td>Turns on Method/Event trace.</td>
</tr>
</tbody>
</table>

Cisco Number Expansion trace fields

The following table describes the Cisco Number Expansion trace fields.

Table 71: Number Expansion Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Number Expansion Trace</td>
<td>Activates number expansion trace.</td>
</tr>
</tbody>
</table>

Cisco Parser trace fields

The following table describes the Cisco Parser trace fields.

Table 72: Parser Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Parser Trace</td>
<td>Activates parser trace.</td>
</tr>
</tbody>
</table>

Cisco Privacy trace fields

The following table describes the Cisco Privacy trace fields.
Table 73: PrivacyTrace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Privacy Trace</td>
<td>Activates Privacy trace.</td>
</tr>
</tbody>
</table>

Cisco Proxy trace fields

The following table describes the Cisco proxy trace fields.

Table 74: Proxy Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Proxy</td>
<td>Turns on Proxy trace.</td>
</tr>
</tbody>
</table>

Cisco RIS Data Collector trace fields

The following table describes the Cisco RIS Data Collector trace fields.

Table 75: Cisco RIS Data Collector Trace Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable RISDC Trace</td>
<td>Activates trace for the RISDC thread of the RIS data collector service (RIS).</td>
</tr>
<tr>
<td>Enable System Access Trace</td>
<td>Activates trace for the system access library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable Link Services Trace</td>
<td>Activates trace for the link services library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable RISDC Access Trace</td>
<td>Activates trace for the RISDC access library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable RISDB Trace</td>
<td>Activates trace for the RISDB library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable PI Trace</td>
<td>Activates trace for the PI library in the RIS data collector.</td>
</tr>
<tr>
<td>Enable XML Trace</td>
<td>Activates trace for the input/output XML messages of the RIS data collector service.</td>
</tr>
</tbody>
</table>
Cisco Access Log trace fields

The following table describes the Cisco Access Log trace fields.

Table 79: Access Log Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activatestraceforthe</td>
<td>Activates trace for the troubleshooting perfmon data logging in the RIS data</td>
</tr>
<tr>
<td>troubleshooting</td>
<td>Used to trace the name of the log file, the total number of counters that</td>
</tr>
<tr>
<td>perfmon data logging</td>
<td>are logged, the names of the application and system counters and instances,</td>
</tr>
<tr>
<td>in the RIS data</td>
<td>calculation of process and thread CPU percentage, and occurrences of log file</td>
</tr>
<tr>
<td>collector. Used to</td>
<td>rollover and deletion.</td>
</tr>
<tr>
<td>trace</td>
<td></td>
</tr>
</tbody>
</table>

Cisco Registry trace fields

The following table describes the Cisco Registry trace fields.

Table 76: Registry Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Registry Trace</td>
<td>Activates Registry trace.</td>
</tr>
</tbody>
</table>

Cisco Routing trace fields

The following table describes the Cisco Routing trace fields.

Table 77: Routing Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Routing Trace</td>
<td>Activates Routing trace.</td>
</tr>
</tbody>
</table>

Cisco Server trace fields

The following table describes the Cisco Server trace fields.

Table 78: Server Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Server Trace</td>
<td>Activates Server trace.</td>
</tr>
</tbody>
</table>

Cisco SIP Message and State Machine trace fields

The following table describes the Cisco SIP Message and State Machine trace fields.
Table 79: SIP Message and State Machine Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SIP Message and State Machine Trace</td>
<td>Activates SIP Message and State Machine trace.</td>
</tr>
</tbody>
</table>

Cisco SIP TCP trace fields

The following table describes the Cisco SIP TCP trace fields.

Table 80: SIP TCP Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SIP TCP Trace</td>
<td>Activates SIP TCP trace.</td>
</tr>
</tbody>
</table>

Cisco SIP TLS trace fields

The following table describes the Cisco SIP TLS trace fields.

Table 81: SIP TLS Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SIP TLS Trace</td>
<td>Activates SIP TLS trace.</td>
</tr>
</tbody>
</table>

Cisco Web Service trace fields

The following table describes the Cisco Web Service trace fields.

Table 82: Web Service Trace fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Presence Web Service Trace</td>
<td>Activates Presence Web Service trace.</td>
</tr>
</tbody>
</table>

Trace output settings descriptions and defaults

The following table contains the trace log file descriptions and defaults.
When you change either the Maximum No. of Files or the Maximum File Size settings in the Trace Configuration window, the system deletes all service log files except for the current file, that is, if the service is running; if the service has not been activated, the system deletes the files immediately after you activate the service. Before you change the Maximum No. of Files setting or the Maximum File Size setting, download and save the service log files to another server if you want to keep a record of the log files; to perform this task, use Trace and Log Central in RTMT.

Table 83: Trace Output Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum No. of Files</td>
<td>This field specifies the total number of trace files for a given service. Cisco Unified IM and Presence Serviceability automatically appends a sequence number to the file name to indicate which file it is; for example, cus299.txt. When the last file in the sequence is full, the trace data begins writing over the first file. The default varies by service.</td>
</tr>
<tr>
<td>Maximum File Size (MB)</td>
<td>This field specifies the maximum size of the trace file in megabytes. The default varies by service.</td>
</tr>
</tbody>
</table>
Trace output settings descriptions and defaults
INDEX

A

A Cisco DB service 62, 190
accessibility features 12, 156
accessing 7, 10
   CAR 10
   web interface 7
alarm definitions 15, 24, 25, 26, 164, 165
   CallManager Alarm catalog 26
   creating user-defined text for 24
   overview 15
   searching for and viewing 24
   System Alarm Catalog 25, 164, 165
Alarm definitions 162
   searching and viewing 162
   procedure 162
alarms 13, 14, 15, 16, 17, 18, 19, 20, 25, 26, 159, 164, 165, 167
   CallManager Alarm Catalog 26
   Cisco Syslog Agent Enterprise Parameters 17
   configuration checklist 16, 159
   configuration overview 14
   configuration settings 20
   configuring 17, 18
   definitions 15
   destinations 20
   event level settings 20
   Event Viewer 20
   NT Event Viewer 20
   overview 13, 167
   SDI trace library 20
   SDL trace library (CUM and UCMBE only) 20
   service groups for 19
   Syslog 20
   System Alarm Catalog 25, 164, 165
   updating 18
   viewing information 16
Alarms 160
   destination settings 160
   destinations 160
   event level settings 160
   event levels 160
   Event Viewer 160

Alarms (continued)
   SDI trace library 160
   SDL trace library 160
   Syslog 160
   alert summary report 83
   audit log 99, 102
      configuration settings (table) 102
      configuring 102
      understanding 99

B

browser support 6

C

call activities report 78
call home 143, 147
   configuring 147
   understanding 143
CallManager Alarm Catalog 26
CDR general parameter 95
Cisco AMC Service 60, 188
Cisco AXL Web Service 52, 186
Cisco Bulk Provisioning Service 52
Cisco CallManager Admin service 67
Cisco CallManager Cisco IP Phone Services 66
Cisco CallManager Personal Directory service 66
Cisco CallManager service 54
Cisco CallManager Serviceability service 61, 189
Cisco CAR Scheduler service 66
Cisco CAR Web Service 58
Cisco CDP Agent service 62
Cisco CDP service 61, 189
Cisco CDR Agent service 66
Cisco Certificate Authority Proxy Function (CAPF) service 58
Cisco Certificate Expiry Monitor service 62
Cisco CTIManager service 54
Cisco CTL Provider service 58
Index

Cisco Database Layer Monitor service 65, 191
Cisco DB service 62, 190
Cisco DHCP Monitor service 54
Cisco Dialer Analyzer service 54
Cisco DirSync service 59
Cisco DRF Local 61, 189
Cisco DRF Master 61, 189
Cisco Extended Functions service 59
Cisco Extension Mobility Application 66
Cisco Extension Mobility service 54
Cisco IP Manager Assistant Service 57
Cisco IP Voice Media Streaming App service 54
Cisco License Manager service 62
Cisco Log Partition Monitoring Tool service 60, 188
Cisco Messaging Interface service 54
Cisco RIS Data Collector service 60, 188
Cisco RTMT Reporter Servlet 60, 188
Cisco Serviceability Reporter service 53, 186
Cisco SOAP - CDR on Demand Service 58
Cisco SOAP-Log Collection APIs 65, 191
Cisco SOAP-Performance Monitoring APIs service 65, 191
Cisco SOAP-Real-Time Service APIs service 65, 191
Cisco Syslog Agent service 62
Cisco TFTP service 54
Cisco Tomcat service 62
Cisco Tomcat Stats Servlet 60, 188
Cisco Trace Collection Service 61, 189
Cisco Trace Collection Servlet 61, 189
Cisco Trust Verification Service 64
Cisco Unified CallManager 172
Cisco Unified Mobile Voice Access Service 54
Cisco UXL Web Service 52
Cisco WebDialer Web Service 57
CISCO-CCM-CAPABILITY MIB 118
CISCO-CCM-MIB 118, 142, 209
dynamic tables 118
static tables 118
trap parameters 142
configuring 142
Cisco-CDP-MIB 118, 209
CISCO-SYSLOG-MIB 118, 141, 209
trap parameters 141
configuring 141
CISCO-UNITY-MIB 118, 142
objects 118
trap parameters 142
configuring 142
CLI 91
starting services 91
stopping services 91
cluster 88
service activation recommendations 88
community string 215
community strings 115, 127, 128, 129, 207
configuration settings 128
configuring 127
deleting 129
description 115
finding 127
Control Center 68, 90, 202
feature services 68
network services 68
overview 68
starting services 68, 90, 202
stopping services 68, 90, 202
viewing service status 68
viewing status 90, 202

D
debug trace levels 36, 38, 39, 41, 43, 44, 45, 46, 47, 234, 236
Cisco CallManager 39, 41
SDI fields 39
SDL fields 41
Cisco CTIManager 43
SDI fields 43
SDL fields 43
Cisco Extended Functions fields 44
Cisco Extension Mobility fields 45
Cisco IP Manager Assistant fields 45
Cisco IP Voice Media Streaming Application fields 46
Cisco Web Dialer Web Service fields 47
Database Layer Monitor fields 38, 234
RIS Data Layer Monitor fields 39, 236
service settings 36
Servlet settings 36
TFTP fields 47
device name based trace monitoring 32
device statistics report 70
disk allocation 95
document xviii
product security overview xviii

E
error codes 155
event levels for alarms 20, 160
exclude end point alarms 20

F
feature services 51, 68, 87, 90, 185, 197, 201, 202
activating 51, 87, 185, 201
feature services (continued)
  configuration checklist 68, 197
deactivating 87, 201
overview 51, 185
starting 51, 90, 185, 202
stopping 51, 90, 185, 202
viewing status 51, 90, 185, 202

G
general parameter settings 95

H
Host Resources Agent service 62
HOST-RESOURCES MIB 118, 209
HTTPS 8, 9
  overview (IE and Netscape) 8
  saving certificate to trusted folder (IE) 9

I
informs 115, 130, 131, 132, 137, 138, 139, 208, 218, 226
  configuration parameters 115, 208
  configuration settings 132, 138
  configuring 131, 138
  deleting 132, 139
  finding 130, 137
  overview 115, 208
  V1/V2 218
  V3 226

L
Locations Bandwidth Manager 52
logging out of interface 10

M
Management Information Base (MIB) (continued)
  HOST-RESOURCES MIB 118, 209
  MIB-II 118, 209
  overview 118
  SYSAPPL-MIB 118, 209
  MIB-II 118, 209
  MIB2 231
    configuring system group 231
  MIB2 Agent service 62
  MIB2 system group 140
    configuring 140

N
navigating to other web interfaces 10
Network Agent Adaptor service 62
network services 59, 90, 188, 202
  Control Center 59, 188
  overview 59, 188
  starting 59, 90, 188, 202
  stopping 59, 90, 188, 202
  viewing status 59, 90, 188, 202
notification destination 218, 226
  V1/V2 218
  V3 226
notification destination (V1/V2) 130, 131, 132
  configuration settings 132
  configuring 131
  deleting 132
  finding 130
notification destination (V3) 137, 138, 139
  configuration settings 138
  configuring 138
  deleting 139
  finding 137
NT Event Viewer 20, 160

O
output settings for trace 47, 238
overview 3, 4, 5, 6, 7, 8, 10, 12, 13, 15, 29, 30, 51, 59, 68, 111, 112, 115,
  118, 154, 155, 167, 185, 188, 205, 208, 209
  accessibility features 12
  accessing CAR 10
  accessing Dialed Number Analyzer 10
  accessing error codes 155
  accessing interface 154
  accessing online help 10, 155
  accessing web interface 7
  alarm definitions 15
  alarms 13, 167
overview (continued)
browser support 6
CAR 4
Cisco Unified Serviceability 3
Dialled Number Analyzer 4
feature services 51, 185
HTTPS 8
icons in interface (table) 155
informs 115, 208
logging out of interface 10
MIBs 118, 209
navigating to other web interfaces 10
network services 59, 188
remote serviceability 5
RTMT 4
serviceability archive reports 68
serviceability reports archive 68
SNMP 111, 112, 205
trace 29
trace collection 30
traps 115, 208
troubleshooting trace settings 30
verifying version 10, 155

P
performance protection report 85
product security overview xviii

R
Real-Time Monitoring Tool 60, 69, 70, 73, 75, 78, 83, 85, 188
alert summary report 83
call activities report 78
device statistics report 70
performance protection report 85
server statistics report 73
service 60, 188
Cisco AMC Service 60, 188
Cisco CallManager Serviceability RTMT 60, 188
Cisco Log Partition Monitoring Tool 60, 188
Cisco RIS Data Collector 60, 188
Cisco RTMT Reporter Servlet 60, 188
Cisco Tomcat Stats Servlet 60, 188
service statistics report 75
serviceability reports archive 69
service parameters 69
remote serviceability 5
report 70, 73, 75, 78, 83, 85
alert summary 83
call activities 78
report (continued)
device statistics 70
performance protection 85
server statistics 73
service statistics 75
reporting tools 4
overview 4

S
SDL configuration 41, 43
characteristics 41, 43
Cisco CallManager service 41
Cisco CTIManager service 43
filter settings 41, 43
Cisco CallManager service 41
Cisco CTIManager 43
security 9
HTTPS for IE 7 9
server statistics report 73
service 18, 32, 36, 51, 52, 53, 54, 57, 58, 59, 60, 61, 62, 64, 65, 66, 67, 68, 87, 90, 185, 186, 188, 189, 190, 191, 197
A Cisco DB 62, 190
activating 87
activating trace 32
Cisco AMC Service 60, 188
Cisco AXL Web Service 52, 186
Cisco Bulk Provisioning Service 52
Cisco CallManager 54
Cisco CallManager Admin 67
Cisco CallManager Cisco IP Phone Services 66
Cisco CallManager Personal Directory 66
Cisco CallManager Serviceability 61, 189
Cisco CallManager Serviceability RTMT 60, 188
Cisco CAR Scheduler 66
Cisco CAR Web Service 58
Cisco CCM SNMP Service 53
Cisco CDP 61, 189
Cisco CDP Agent 62
Cisco CDR Agent 66
Cisco Certificate Authority Proxy Function (CAPF) 58
Cisco Certificate Expiry Monitor 62
Cisco CTIManager 54
Cisco CTL Provider 58
Cisco Database Layer Monitor 65, 191
Cisco DHCP Monitor Service 54
Cisco Dialed Number Analyzer 54
Cisco Dialed Number Analyzer Server 54
Cisco DirSync 59
Cisco DRF Local 61, 189
Cisco DRF Master 61, 189
Cisco Extended Functions 59
service (continued)
Cisco Extension Mobility 54
Cisco Extension Mobility Application 66
Cisco IP Manager Assistant 57
Cisco License Manager 62
Cisco Log Partition Monitoring Tool 60, 188
Cisco Messaging Interface 54
Cisco RIS Data Collector 60, 188
Cisco RTMT Reporter Servlet 60, 188
Cisco Serviceability Reporter 53, 186
Cisco SOAP - CDRonDemand Service 58
Cisco SOAP-Log Collection APIs 65, 191
Cisco SOAP-Performance Monitoring APIs 65, 191
Cisco SOAP-Real-Time Service APIs 65, 191
Cisco Syslog Agent 62
Cisco TFTP 54
Cisco Tomcat 62
Cisco Tomcat Stats Servlet 60, 188
Cisco Trace Collection Service 61, 189
Cisco Trace Collection Servlet 61, 189
Cisco Trust Verification Service 64
Cisco Unified Mobile Voice Access Service 54
Cisco UXL Web Service 52
Cisco WebDialer Web Service 57
configuration checklist 68, 197
configuring alarms for 18
Control Center overview 68
deactivating 87
debug trace levels 36
feature services 51, 185
Host Resources Agent 62
MIB2 Agent 62
Native Agent Adaptor 62
network services 59, 188
SNMP Master Agent 62
starting 90
starting services 68
stopping 90
stopping services 68
System Application Agent 62
viewing service status 68
viewing status 90
service activation 87, 88, 201
activating 87, 201
deactivating 87, 201
recommendations for a cluster 88
service groups 19, 33, 169
alarms 19
for trace 33, 169
service statistics report 75
serviceability 153, 154, 155
accessing 154
accessing error codes 155
serviceability (continued)
icons (table) 155
introduction 153
verifying version 155
serviceability reports archive 68, 69, 70, 73, 75, 78, 83, 85, 86, 92, 194
alert summary report 83
call activities report 78
configuration checklist 86
configuring 92, 194
device statistic report 70
overview 68
performance protection report 85
server statistic report 73
service parameters 69
service statistics report 75
services 37, 201, 202, 233
activating 201
deactivating 201
starting 202
stopping 202
trace field descriptions 37, 233
viewing status 202
servlet 36
debug trace levels 36
configuring community string 215
configuring MIB2 system group 231
configuring user (V3) 223
informs (V1/V2) 218
notification destination (V1/V2) 218
notification destination (V3) 226
traps (V1/2) 218
SNMP 53, 62, 111, 112, 113, 114, 115, 118, 126, 127, 128, 129, 130, 131,
132, 133, 134, 135, 136, 137, 138, 139, 140, 141, 142, 143, 144, 145, 146, 205, 206, 207,
208, 209, 212, 213, 215, 218, 223, 226, 231
basics 112, 205
CISCO-CCM-MIB trap parameters 142
configuring 142
CISCO-SYSLOG-MIB trap parameters 141
configuring 141
CISCO-UNITY-MIB trap parameters 142
configuring 142
community strings 115, 127, 128, 129, 207
configuration settings 128
configuring 127
deleting 129
description 115
finding 127
configuration checklist 126, 212
configuration requirements 113
configuring community string 215
configuring MIB2 system group 231
configuring user (V3) 223
SNMP (continued)
informs 115, 130, 131, 132, 137, 138, 139, 208
configuration parameters 115, 208
configuration settings 132, 138
configuring 131, 138
deleting 132, 139
finding 130, 137
overview 115, 208
informs(V1/V2) 218
MIB 118, 209
MIB2 system group 140
configuring 140
notification destination (V1/V2) 130, 131, 132, 218
configuration settings 132
configuring 131
deleting 132
finding 130
notification destination (V3) 137, 138, 139, 226
configuration settings 132
configuring 131
deleting 132
finding 130
overview 111, 205
remote monitoring with 111, 205
service 53, 62
Cisco CCM SNMP Service 53
Cisco CDP Agent 62
Cisco Syslog Agent 62
Host Resources Agent 62
MIB2 Agent 62
Network Agent Adaptor 62
SNMP Master Agent 62
System Application Agent 62
services 114
SNMPv1 114, 206
SNMPv2c 114, 206
SNMPv3 114, 207
trace configuration 126
traps 115, 130, 131, 132, 137, 138, 139, 208
configuration parameters 115, 208
configuration settings 132, 138
configuring 131, 138
deleting 132, 139
finding 130, 137
overview 115, 208
traps(V1/V2) 218
troubleshooting 213
user 115, 133, 134, 135, 136
configuration settings 135
configuring 134
deleting 136
description 115
finding 115
users 207

SNMP Master Agent service 62
SOAP 58, 65, 191
service 58, 65, 191
Cisco SOAP - CDRonDemand Service 58
Cisco SOAP-Log Collection APIs 65, 191
Cisco SOAP-Performance Monitoring APIs 65, 191
Cisco SOAP-Real-Time Service APIs 65, 191
SYSAPPL-MIB 118, 209
System Alarm Catalog 25, 164, 165
System Application Agent service 62

T
trace 29, 30, 31, 32, 33, 36, 37, 38, 39, 41, 43, 44, 45, 46, 47, 48, 126, 167, 169, 233, 234, 236, 238
called party trace 31
Cisco CallManager service 39, 41
SDI trace fields 39
SDL trace fields 41
Cisco CTIManager service 43
SDI trace fields 43
SDL trace fields 43
Cisco Database Layer Monitor service 38, 234
trace fields 38, 234
Cisco Extended Functions service 44
trace fields 44
Cisco Extension Mobility service 45
trace fields 45
Cisco IP Manager Assistant service 45
trace fields 45
Cisco IP Voice Media Streaming App service 46
trace fields 46
Cisco RIS Data Collector service 39, 236
trace fields 39, 236
Cisco TFTP service 47
trace fields 47
Cisco Web Dialer Web Service 47
trace fields 47
collection 30
configuration and collection checklist 31, 167
configuration overview 29
configuring 32
debug trace levels for service 36
debug trace levels for servlet 36
device name based trace monitoring 32
output settings 47, 238
overview 29
recommendations for SNMP 126
service groups for 33, 169
trace and log central 30
trace field descriptions 37, 233
troubleshooting trace settings 30, 48
Trace 167, 172
  configuration 167
  described 167
  list of topics 167
  configuring 172
  device name based trace monitoring 172
trace collection 30
traps 115, 130, 131, 132, 137, 139, 208, 218, 226
  configuration parameters 115, 208
  configuration settings 132, 138
  configuring 131, 138
  deleting 132, 139
  finding 130, 137
overview 115, 208
V1/V2 218
V3 226
troubleshooting 30, 48
  trace settings 30, 48

U

user-defined alarm descriptions 24
users (SNMP) 115, 133, 134, 135, 136, 207
  configuration settings 135
  configuring 134
  deleting 136
  description 115
  finding 133

V

viewing alarm information 16